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GoALS

Become familiar and 
comfortable with the 

Desktop, Finder, and Home

Get to know the Finder 
windows and how   

to use them

Create your own folders

Understand the Dock

Use the Trash basket

Know how and when to use 
keyboard shortcuts

Learn to watch for tool tips 
and other visual clues

Know where to go for more 
information
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LESSON 1

Introduction to the  
Mac os x Lion Desktop

If you have a Mac running Lion (oS X version 10.7), you’re ready 

to jump right in! In this lesson you’ll become familiar with using 

the basic features of your Mac and its Desktop/Finder.

This book assumes you are familiar with how to operate 

a computer—how to use a mouse or trackpad, select items 

from menus, distinguish one icon from another, move files 

and folders and windows around, how and why to save the 

documents you create, etc. If you are brand new to computers 

in general, we strongly suggest you use The Little Mac Book, 

Lion Edition before you read this book—The Little Mac Book

introduces you to using a computer in much more detail and at 

a much slower pace than this book.
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get to know your desktop and finder
When you turn on your Mac, you’ll always see your Desktop,.shown below. This is 
also called the Finder, although technically the Finder is the application that runs 
the Desktop. Whenever you see a direction that tells you to go to the Desktop or to 
the Finder, this is where you need to go. 

Because of the way the computer works, you might see the Desktop  
but not actually be in the Finder. Get in the habit of checking the application menu 
(shown top-left and on the opposite page). When you are really in the Finder or at the 
Desktop, the application menu will show “Finder.” 

For an uncluttered Desktop appearance, the “Hard Disk” icon (usually 
shown in the top-right corner) is not visible by default in Lion. If you’re accustomed to 
seeing it there and want to bring it back, see page 276. 

Menu bar.

Application menu.  
This menu names the application 
that is “active” at the moment.

Desktop.
This entire 

background area 
is the Desktop.

Apple menu.

Finder window.
See pages 5–7.

Dock. 
See pages  
22–23.

Documents and 
Downloads folders. 

See pages 24–25.

Trash. 
See pages   
26–27.

Finder icon.   
See the next 

two pages.

Spotlight. 
See Lesson 19.
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Make sure you can get to the Desktop or Finder  
whenever necessary
As you work on your Mac, you will be using a number of applications to create your 
documents, but you’ll often want to go back to the Finder, which is like home base. 
The name of the active application, the one that’s currently open and available to use 
(including the Finder), will always be displayed in the application menu. Keep an eye 
on that menu.

To go to the Finder at any time, do one of these things:

n	 Single-click on any blank area of the Desktop. 

n	 Single-click on any Finder window (shown below) that you see. 

n	 Single-click the Finder icon in the Dock (shown on the opposite page). 

Check to make sure the application menu says “Finder,” as shown circled below.
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*Important: Scroll bars are hidden until you start to 
scroll by dragging a mouse, swiping a trackpad with 

two fingers, or swiping a Magic Mouse with one finger. 
If you use an older mouse or you want the scroll 

bars to be visible, go to System Preferences, choose 
“Appearance,” then set “Show scroll bars” to “Always.”

To move a window, 
press on the title bar or 
status bar and drag it.

get to know your finder Window
Below, you see a typical Finder window. This is called a Finder window to 
distinguish it from similar (but different) windows you will use in your  applications. 
You will access just about everything on your Mac through a Finder window, and 
you will store everything you create in a Finder window. A window can open into a 
number of different views, so take a few minutes to read the following pages about 
the views you might see, and read pages 280–284 about customizing the windows.

Title bar.  
This is the name of the 
folder whose contents 
are shown in the window.

Item arrangement. 
Choose how to arrange 
items in the window (see 
pages 280–285 for details).Toolbar. 

View buttons.   
See pages 14–18.

Status bar. 

Sidebar.
See pages 12–13.

Drag this 
edge to resize 
the Sidebar.

Spotlight 
search.  
See Lesson 19.

Scroll 
bar
area.*

Path 
bar.

Drag any 
corner or any 
edge to resize 
the window.

Hover the pointer over   
the area to the right of the 

“Devices” or “Shared” item   
to reveal a “Show”   
or “Hide” option.

Drag to resize 
icons when in 
Icon view, as 
shown here.

 See opposite page.

Other computers 
on your network.   

See Lesson 21.
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Become comfortable with “swiping”
Lion has many features that are much more useful and easier to work with if you use 
one of the Multi-Touch devices such as a Magic Mouse, a Magic Trackpad, or a built-in 
trackpad on your laptop with gestures enabled. For instance, in the window shown 
on the opposite page, you can swipe left or right to display the files. See page 19. 

Use the buttons in the Finder Window
There are several buttons in the Toolbar of every Finder window.

Red, yellow, and green buttons
●	 Single-click the red button to close the window.

●	 Single-click the yellow button to minimize the window, which  
sends a tiny icon down into the Dock, on the right side. Try it.

	  To open that window again, single-click its icon in the Dock.

●	 Single-click the green button to toggle between the previous window size 
and the current window size.

Previous and Next buttons
These buttons go back and forward through the contents of windows you have 
viewed (just like the Previous and Next buttons on web pages). Every time you open  
a new window, these buttons start over.

Hide/Show the Toolbar, Sidebar, Path Bar, and Status Bar
To hide the Toolbar, Sidebar, Path Bar, or Status Bar, go to the View menu, then 
choose “Hide Toolbar” (or “Hide Sidebar” etc.). If an item is already hidden, the 
menu says “Show Toolbar,” etc.

The Path Bar shows a location path to the selected item.

Toolbar.

Sidebar.

Status Bar.

The same window with the Toolbar, 
Sidebar, Path Bar, and Status Bar hidden.
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get to know your Sidebar and its home folders
When you open a Finder window in Lion, the default is to show you the contents 
of the folder named All My Files, which displays every file you’ve ever created 
or copied to your computer, arranged in rows of categories (see page 13 for more 
details about All My Files). The other items in the Sidebar are folders that are 
actually stored in what’s called your Home folder, where everything you create is 
saved; putting the Home folders in the Sidebar saves you one step in that you don’t 
have to first open your Home folder to access them. (Also see pages 36–38.)

If you’re an experienced Mac user, you might notice that Apple seems to want us to 
transition away from using the traditional os x Home folder to using the Sidebar to 
access the folders. You can put your Home folder in the Sidebar, as described below.

n	 To open a Finder window, single-click on the Finder icon (shown to the left) 
in the Dock (the Dock is that row of icons that is usually found across the 
bottom of your screen). A Finder window provides access to everything on 
your Mac.

n	 To put your Home folder in the Sidebar (skip this if you don’t miss your 
Home folder or don’t even know what it is): From the Finder menu, choose 

“Preferences…” (shown below-right). Click the “Sidebar” icon in the toolbar. 
Put a check next to your Home folder name and icon. Click the little red close 
button in the corner to put it away.

I put a Home folder in the Sidebar above so you could 
see the folders that are stored in it. 
In the preferences (shown to the right), you can 
uncheck any items you don’t need to see in the Sidebar.
The Public folder is used for sharing files; see Lesson 21.
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What each folder in your Sidebar is for
All My Files All your document and image files (not folders) are displayed in this 

window. You cannot put anything in this folder yourself. See page 13.

AirDrop Don’t worry if you don’t see this item. This is a window for sharing 
files; see page 399.

Applications This folder holds all your applications that came with your Mac, and 
when you install new ones, they will go in this folder. See page 48.

Desktop This folder holds any files that might be sitting directly on the 
Desktop (see page 4). Putting files on the Desktop is like keeping 
them on your office desk instead of putting them in a filing cabinet. 
Having this folder to hold the same files means you can get to them 
when you’re not actually at the Desktop, as when you want to open 
a file from within an application. 

Documents At first, your Mac makes sure every document you create is safely 
tucked into this Documents folder. Later, you can create your own 
folders (see pages 10–11) and store your documents in them.

Downloads This folder holds most of the files that you download through 
Bonjour, iChat, or the Internet. Files that come to you through 
email will also end up here if you click the “Save” button in an  
email message. The Downloads folder in the Dock holds exactly  
the same files. See pages 24–25.

Movies The iMovie application uses this folder to automatically store  
the files necessary for creating the movies you make. You can also 
store movies here that you’ve acquired from any source other than 
iMovie, such as from the Internet or email. 

Music The iTunes application uses this folder to automatically keep track 
of all the music files you buy and all of your playlists.

Pictures The iPhoto application uses this folder to automatically keep  
track of all your photos and albums. Use it to store any photos, or 
folders of photos, even if they haven’t been imported into iPhoto. 

Do not change the names of the folders in the Home folder or throw them away 
unless you are very clear on what you’re doing and why you’re making that choice! 
You can, however, Command-drag any folder out of the Sidebar; if you ever want 
to replace that folder, open your Home folder and drag it back in.   
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create your Own folders
At any time, you can create your own folders where you can store your documents 
and organize your files. For instance, you might want a folder in which to store 
all your financial documents, another folder for all your newsletter files, and yet 
another for the screenplays you’re writing. All of these documents could go inside 
the Documents folder, but that’s like putting every document in your office in one 
big manila folder.

Use digital folders on your Mac as you would use manila folders in a metal filing 
cabinet. When you save a file, save it directly into your custom folders.

n	 To make a new folder, go to the File menu and choose “New Folder.”  
It is ready to name—simply type the new name, then hit Return. 
Click anywhere to deselect the folder.

	 The new folder appears inside the window whose name is in the title 
bar (shown circled, below). That is, if you want to put the new folder 
into the Documents folder, first open the Documents folder before you 
make the new one.

In my Documents folder, I made a new folder called “The Shakespeare Papers.” 
Inside that folder, I made these six new folders. 



ptg6934589

Lesson 1 Introduction to the Mac OS X Desktop 

11

n	 To rename a folder:
1 Single-click the folder to select it. 

2 Hit the Return key to highlight the name (you’ll see a blue outline  
around the name). Or single-click on the name. 

3 Type to replace the existing name. (You don’t need to delete the original 
name first.)

4 Hit Return or Enter to set the name. 

n	 To open a folder, double-click it. 

n	 To go back to the contents of the previous folder, single-click the left-pointing 
triangle, called the Previous button (shown to the left).

n	 To move a folder, just drag it to another window or another folder. 

n	 To put something inside a folder, drag the item and drop it on top of  
the folder icon or into its column. Or save a file directly into that folder  
(see page 44 for details). 

In Column View (shown and explained on page 16), you can see how we’ve got folders 
inside of folders. Just picture it like a filing cabinet in which you store file folders, and 
the understanding of organizing your information will come easily. 

www.allitebooks.com

http://www.allitebooks.org
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take advantage of the Sidebar
The Sidebar of every Finder window is customizable—you can add or remove any 
folder or document as often as you like. Items in the Sidebar are always aliases, or 
icons that merely represent the real file. This means you can delete an icon from the 
Sidebar and it does not delete the actual file that it represents.

Each of the icons in the Sidebar actually represents a file or folder somewhere else 
on your hard disk. 

Because a folder or document in the Sidebar is a picture (alias) of the real thing, 
you can drop files into the icon in the Sidebar (just drag and drop them) or into the 
original folder and they go to the same place. Try it: Drop a file into the Documents 
folder in the Sidebar, then open the Documents folder in the Home window and 
you’ll see the new document.

Add a folder or document to the Sidebar. This makes it easier to find a folder and put 
other files in it, and it makes a document easier to find and open (just single-click it). 
It’s also easier when you are working in an application and want to save a file, because 
the folder shows up in the sidebar of open and Save As dialogs.

n	 To add a folder or document to the Sidebar, simply drag the icon from  
any window or from the Desktop and drop it into the Sidebar.

n	 Use the Finder preferences to add hard disk icons and more (as explained  
on the opposite page). 

Remove folder or document icons from the Sidebar that you don’t use. Don’t 
worry—removing the picture of a folder from the Sidebar does not throw away  
the original folder nor anything in it!

n	 To remove an item from the Sidebar, hold down the Command key, press 
on the name with the mouse, and drag it out of the Sidebar. Let go when 
the mouse pointer is on the Desktop. As you can see below, the icon disap-
pears in a puff of smoke. Notice that although I removed the Movies folder 
from the Sidebar, the original Movies folder is still safe and sound in the 
Home window (as shown on the opposite page).
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Customize the Sidebar to contain just the items you want to see: Click on the 
Desktop to make the Finder the current active application, then from the Finder 
menu (next to the Apple icon), choose “Preferences….” Click the “Sidebar” icon in 
the toolbar (circled, above-right). Check the items you want to show in the Sidebar, 
and uncheck items that you don’t want. If you uncheck all items in a category, such 
as “Devices,” the entire category, including the header, disappears from the Finder 
window sidebar.

All My Files
This item in your Sidebar displays every file and photo you ever create or store on 
your Mac. This is not the most useful feature when you’ve got more than 10,000 files 
in one window (like we do), although if you set the arrangement by date, the latest 
things you’ve worked on will show up right in front of you. You cannot add files to 
this window—it is done automatically; you might think you are dropping a file in this 
window, but the Mac actually stores the file in an appropriate folder and just shows 
you the icon. You can delete files or rename them, and you are actually deleting or 
renaming the original file. Keep the Path Bar visible (see page 7) so you know where 
the files are located.

The default for the All My Files view is that it is arranged by Kind, which is what puts 
all the files in rows, each row being a category; within these rows, the first items you 
see are the newest. This makes it handy to find something you were recently working 
on—open All My Files and your most recent documents are right there.

See pages 280–285 to learn to control the arrangement in this window and others. 
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Enhanced Icon View: Enlarge the icons with the size slider for easy viewing. You 
can preview multipage documents and movies right in the icon: In the View options 
(as shown above-right), check “Show icon preview” (if it isn’t already). 

change the View of the finder Window
  








The Icon View
obviously, this displays every file as an icon, or small picture. Double-click an icon 
to open it. To view the icons in categorized rows like you see in the “All My Files” 
window on page 6, see pages 280–281.

Drag this slider to resize icons.

Hover the pointer over 
the icon of a multipage 
document. To browse 
through the pages, click 
the left and right arrows 
that appear at the 
bottom of the icon. 

Hover the 
pointer over the 
icon of a movie, 
then click the 
Play button that 
appears. 

Sidebar.

Icon View button. Show View Options.

From left to right, the View buttons display  
Icon View, List View, Column View, Cover Flow view. 
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The List View
In the List View, you can organize the list of files alphabetically by names, by the 
dates the files were last modified, by what kind of items they are, and other options. 
You can also see the contents of more than one folder at once. 

The blue column heading is a visual clue that the contents are organized, or “sorted,” 
by that heading. You can see, above, that the files in this window are sorted by 

“Name.” To organize the contents by the dates they were modified, their size or kind, 
single-click that column heading (you might have to open the window wider or 
scroll to the right to see the other columns and headings). If you cannot make any 
changes to the columns, it probably has an “arrangement” applied; see page 283.

The tiny triangle in the column heading (circled above-right) is a visual clue that 
tells you whether the information is sorted from first to last or last to first. Single-
click the triangle to reverse the order. Try it.

In the List View, single-click vs. double-click:
Folder icon: Single-click the disclosure triangle to the left of a folder  
to display its contents as a sublist, as shown circled above-left. You can  
view the contents of more than one folder at once. 

	 Double-click the folder icon to display its contents in the window,  
which will replace the contents you currently see in the window. 

Document icon: Double-click a document to open not only that 
document, but also the application it was created in.

	 Application icon: Double-click an application icon to open the 
application. 

List View button.
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The Column View
Viewing a Finder window in columns allows you to see the contents of a selected 
folder or hard disk and easily keep track of where each file is located. You can also 
view the contents of another folder without losing sight of the first one. This view 
helps you understand where everything is kept in your computer. 

If you have photographs, graphic images, movies or pdfs in your folders, the last 
column displays previews of the items. You can even play a small movie in this preview 
column, if a movie file is selected. Some documents can display previews as well. 

You won’t see additional columns to the right until you single-click a folder or a file—
then a new column to the right appears to display the contents of that folder or a 
preview of the file. A triangle indicates that file is a folder that can contain other files. 

In the example above, you can see that the “top level” folder is the Home folder, 
“robin.” In “robin,” I selected the folder “Documents” (I clicked once on it) and in 
that folder I selected “The Shakespeare Papers,” and in that folder I selected “past 
issues” and then selected a pdf document. The last column displays a preview of the 
selected file and information about it.

Column View button

To resize an individual column, drag one of the vertical divider lines. 
To expand the column to reveal the longest file name, double-click 
the divider line. 
To resize all columns, Option-drag a vertical line (hold down the 
Option key while you drag a line). You might see small “thumb” 
marks at the bottom of the column divider; if so, you must drag  
that thumb mark to move the column. 

The Path Bar shows another view of the path to the selected file. Double-click 
any folder shown in the Path Bar (or in the Column view) to open it.
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In the Column View, single-click files to display columns:

Folder icon: Single-click a folder to display its contents in the column  
to the right. If there is no column to the right, one will appear. 

Document icon: Single-click a document to see a preview in the 
column to the right. Not all documents can provide content previews, 
but the preview will at least give you information about that file.

	 Double-click a document to open not only that  document, but also  
the application it was created in.

Application icon: Single-click an application icon to preview 
information about it, such as its version and date of modification.

	 Double-click an application icon to open that  application. 

You can customize many features about the Finder windows, such 
as the font size, the icon size, even the color inside the window. You can organize 
the List View by different columns of information, choose to turn off the preview 
in Column View, and more. See Lesson 15, Personalize Your Mac.

No matter which view you are in, you can always open a folder into a 
new, separate window: Hold down the Command key and double-click any folder in 
any view (the original window stays open). 

Hold down the Option key and double-click a folder to open the folder in a new window 
and close the original window. 
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The Cover Flow View
The Cover Flow View displays your files graphically in a slideshow-like format at the 
top of the window. To flip through them, you can click on the icons on either side of 
the center image, drag the slider bar, click the triangles on the left or right side of the 
slider bar, or click the items in the list below the Cover Flow pane. You can even use 
the arrow keys on your keyboard to move through the Cover Flow view.

For the columns below the Cover Flow pane, organize and use them just as you 
would in List View, as described on the previous pages. If you find you cannot move 
the columns, it means there is an “arrangement” applied; go to the Arrange menu 
(see callout, below) and choose “None.”

Double-click a Cover Flow image to 
open that document or application.

Single-click an icon here 
to display it in the Cover 
Flow view window above.
Double-click an icon 
here to open that 
document or application.

Click the end triangles 
to navigate through 
the Cover Flow files, 
or drag the slider bar.

Drag this 
“thumb grip” 
to enlarge the 
Cover Flow 
area of the 
window.

Single-click any item in the 
Sidebar to display it or   

its contents in the window. 

Cover Flow View button. Arrange menu.
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Use gestures to Navigate your Mac
Lion can take advantage of something called gestures—movements of your fingers 
on a special Multi-Touch input device. These devices include the Apple Magic 
Mouse, the Apple Magic Trackpad that you can use with your desktop computer, 
and trackpads that are built in to newer Apple laptops. Below are some of the basic 
Multi-Touch gestures that you can use with these special devices (if you don’t have 
one, ignore this page). Note: A tap is a gentle tap, not a click.

Some of these gestures might be different for you because you can customize them in 
the Mouse or Trackpad system preferences (see page 290). This preferences pane also 
shows you little movies of how things work. Gestures might be confusing at first, but 
it’s surprising how quickly you get accustomed to your favorite ones.

On a Magic Mouse
To go forward or back through web pages, swipe left or right with one finger.

To show all open windows of an application, hover over the application’s icon  
in the Dock, then swipe up with two fingers.

To flip between Launchpad screens (see page 49), swipe left or right on the 
Multi-Touch surface with three fingers.

To switch between Spaces (see pages 298–301), swipe left or right with two fingers.

To open Mission Control (see Lesson 16), double-tap with two fingers on the 
Multi-Touch surface. To return to the Desktop, double-tap with two fingers 
again, or click one of the items in Mission Control (a file, app, or Space).

On a Magic Trackpad or built-in MultiTouch trackpad
To go forward or back through web pages, swipe left or right with two fingers.

To show all open windows of an application, hover over the app’s icon in the Dock, 
then swipe up with two fingers. 

To flip between Launchpad screens (page 49), swipe left or right with two fingers.

To show the Desktop and hide all open windows in the screen edges, spread  
four fingers on the Multi-Touch surface. To return, pinch four fingers. 

To switch between screens and Spaces, swipe left or right with three fingers.

To open Mission Control, swipe up with three fingers. To return to the Desktop, 
swipe down with three fingers, or click one of the items shown in Mission Control 
(a file, app, or Space).
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Quick Look
Quick Look lets you quickly preview almost any kind of file without actually 
opening it. Simply select a file, then press the Spacebar to preview it in Quick Look. 

To put a Quick Look button in the toolbar of Finder windows: Right-click on a 
window toolbar; choose “Customize Toolbar….” From the sheet that drops down, 
drag the Quick Look button and drop it on the window’s toolbar. Click “Done.”

When you preview a text file, you can actually scroll through the document. When 
you preview a Keynote presentation, you’ll see your slides and notes. When you  
preview a pdf with many pages, you can scroll through the pages.

To open a Quick Look preview, select one or more files, then do any of the following:
n	 Tap the Spacebar. 
n	 Click the Quick Look button described above, or press Command Y.
n	 Go to the File menu and choose “Quick Look filename.” 
n	 Right-click and choose “Quick Look filename.”

once a Quick Look preview is open, you can single-click other files in the Finder or 
use the arrow keys to cycle through files, and they will appear in that preview. 

If more than one file is open in Quick Look, you can use the Previous and Next
arrow buttons (shown below) to cycle through the files. 

Close Quick Look.

Click to enlarge the preview. 
Click again to return to 
original preview size.

Show selected files 
as an Index Sheet   

(see the next page).

Open with an application 
appropriate for the file type.

Drag any corner 
or edge to enlarge.
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To view multiple files as an index sheet, click the “Index Sheet” button (shown to 
the left and on the previous page).

To close Quick Look:
n	 Hit the Spacebar. 
n	 Press Command Y.
n	 Click the x in the upper-left corner of the Quick Look window.
n	 Go to the File menu and choose “Close Quick Look.”

While in Index Sheet mode, 
click a thumbnail to display 
a large version in the Quick 
Look panel. 

A selection of various file types, shown in Quick Look’s 
Index Sheet. 

Quick Look also works in email and iChat. When you see a web address (a url) in 
email or iChat, hover the cursor over the url to reveal a Data Detector icon to its 
right (circled, below-left). Click that icon to display the web page in Quick Look.

Click the Data 
Detector icon to 

open the link in 
Quick Look.

www.allitebooks.com

http://www.allitebooks.org
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Use the dock
The Dock is that strip of icons across the bottom of the screen*. The specific icons 
that appear in the Dock will change as you open and close applications, view photos, 
or customize what’s in the Dock. “Hover” your mouse over an icon (position the 
pointer and hold it there, but don’t click) to see a label appear that tells you the 
name of the application or file.

n	 To open an application or document from the Dock, single-click its icon.

Keep an eye on the application menu in the top-left corner of the screen (as 
explained on pages 4–5) to verify which application is the currently “active” appli-
cation. You can also enable a visual clue that tells you which applications in the 
Dock are open. Right-click the dividing line in the Dock, choose “Dock Preferences,” 
then select “Show indicator lights for open applications.” A tiny blue light appears 
under the icon of open applications (as shown below, under three applications). 

You can rearrange any of the icons. You can add or remove applications from the 
left side of the dividing line (see callouts, above), and you can add or remove folders, 
documents, and web page locations from the right side of the dividing line:

n	 To rearrange an icon, press the mouse on it and drag it left or right.  
The other icons will move over to make room.

n	 To add an application icon, first open the Applications folder (click the 
Applications icon in the Sidebar of any Finder window) or open Launchpad 
(see page 49). Drag an application icon down to the Dock, to the left side of 
the dividing line. The existing icons will move over to make room. 

n	 Whenever you open an application, its icon is automatically and temporarily 
put in the Dock. To keep an application icon in the Dock, press on the icon 
while it’s in the Dock, choose “options,” then choose “Keep in Dock.”

Finder
pages 4–5 

Mail
Lesson 5

Facetime
Lesson 9 iPhoto

System 
Preferences

Lesson 15

Address Book
Lesson 6 

Trash Documents 
page 26 Folder 

App Store
Lesson 12

Safari 
Lesson 7 

iCal
Lesson 8 

Preview
Lesson 11

Photo Booth
Lesson 12 

Downloads 
Stack, pages 
24–25, 107

iTunes
Lesson 10

Dividing line 

Launchpad
page 49
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n	 To add an often-used folder or a document, drag it to the right side of  
the dividing line. Then you can easily open it with a single click.

n	 To remove any icon from the Dock, press on it with the mouse and drag it 
upward, off the Dock. Let go of the mouse and the icon will disappear in a 
poof of smoke. This doesn’t hurt anything! Never will you delete any original 
item by removing its icon from the Dock. You can also Control-click (or right-
click) a Dock item, choose “options,” then choose “Remove from Dock.”

n	 To add a web page, open your browser application, Safari (see Lesson 7 about 
Safari). Go to the web page that you want to have easy access to in your Dock. 
Drag the tiny icon that you see on the left of the web page address in the 
location field (circled, below) and drop it in the Dock—on the right side of  
the dividing line. 

	 The advantage of putting a web page icon in your Dock is that while you’re 
working in any application, you can click that web icon and your browser 
opens to that page—you don’t have to go find your browser first and then  
find the bookmark.

*Is the Dock missing?
The Dock can be customized in many ways. It might be on either side of the screen 
instead of at the bottom, or it might even be hidden. If you don’t see the Dock 
anywhere, push your mouse to the far left, the far right, or the deep bottom of the 
screen and the hidden Dock will appear from one of those edges. See Lesson 15 for 
details on how to customize the Dock to fit your needs.

Both the Documents folder and the Downloads stack, shown on the previous page, 
can be changed to regular folder icons, as shown above. See the following page.
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Documents and Downloads folders in the Dock
The right side of the Dock holds copies of the Documents and Downloads folders 
that are stored in your Home folder. The icons in the Dock provide convenient 
access to the files you’ve created or downloaded to your Mac through Bonjour, 
iChat, or the Internet. Files attached to email will also end up in the Downloads 
folder when you click the “Save” button in an email message.

Downloads folder, shown as a stack of icons.

Choose how you want to 
show a folder in the Dock: 
as a Folder or as a Stack.

Documents folder.

You can choose to display these folders in the Dock as a Folder icon (as the 
Documents folder shown above) or as a Stack icon (also shown above): 

1 Control-click one of the folders to get the pop-up menu shown below. 

2 In the “Display as” section of the pop-up menu, choose “Folder” or “Stack.” 

  If you choose “Stack,” the icon on top of the Stack is the most recent file added 
to the folder. Dazzling, but not very useful. I prefer the Folder display. 

You can also choose to remove these icons from your Dock—just drag the icons 
out of the Dock and drop them on the Desktop. The original folders in your Home 
folder are still there, safe and sound.
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View contents as a Fan. View contents as a Grid. View contents as a List.

To view its contents, single-click the folder or stack icon. 

You can choose how to display the contents: Control-click (or right-click) the Folder 
or Stack to open the pop-up menu shown on the previous page. From the “View 
content as” section, choose “Fan,” “Grid,” or “List.” If you choose to view content as 
“Automatic,” the Stack opens in Fan view when eleven or fewer items are present; 
more than eleven items opens in Grid view. Single-click a file or folder to open it.  
Each view includes an “open in Finder” command. 

The Grid view of contents makes navigation of folders easy: Click a folder in Grid 
view (below, left) to see its contents (below, right). To return to the previous folder, 
click the return path button (to the previous folder) in the top-left corner.

When there are too many items to display, a dark gray scroll bar appears on the 
right side of the window. 

Current folder.
To previous folder.

Click this icon to show 
the folder contents in a 
normal Finder window.

Choose “Options” to 
change Stack settings. 
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Use the trash
The Trash basket in the Dock is where you throw away any files you don’t want. 

n	 To put a file in the Trash, press on any file in the Finder and drag it to the 
Trash basket. When the tip of the pointer touches the basket, the basket 
changes color—this means you’re in the right place. Let go of the mouse 
button and that file is in the Trash. Remember, it’s the tip of the pointer, not 
the icon image, that selects the Trash basket. 

	 You can also use a contextual menu to trash things; see pages 42–43.

n	 To empty the Trash, press (don’t click) on the Trash icon and a little menu 
pops up with an option that says, “Empty Trash.” Choose that option,  
or go to the Finder menu and choose “Empty Trash.”

	 When you empty the Trash, you’ll get a warning asking if that’s what you really 
want to do. Some people like to have this reminder; others hate it. You can tell 
your Mac to stop reminding you about emptying the Trash (next page). 
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n	 To turn the Trash warning off (or on) :
1 From the Finder menu, choose “Preferences….”

2 Click the “Advanced” icon in the toolbar at the top.

3 Uncheck (or check) the box to “Show warning before emptying the Trash.”

4 Click the red button in the upper-left of the pane to put it away.

n	 To see what’s in the Trash, single-click the Trash icon in the Dock. This opens 
the Trash window, as shown below. 

n	 To take an item out of the Trash, single-click the Trash icon to open its 
window. If there is an item you don’t want to throw away, drag it out of the 
window and put it back where you want it. 

	 Or select one or more items in the Trash window, go to the File menu, and 
choose “Put Back” (or use the keyboard shortcut, Command Delete).

	 Or see pages 42–43 about contextual menus. one of the options for a trashed 
item is “Put Back.” 
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take advantage of keyboard Shortcuts
Most actions that you can do with the mouse and menus can also be done with 
keyboard shortcuts. often this is not only faster, but more convenient because you 
don’t have to take your hands off the keyboard to pick up and maneuver the mouse. 
You will see lots of keyboard shortcuts in the menus across the top of the screen, 
such as the ones shown below in the Edit menu. Use a keyboard shortcut instead  
of going to the menu.

Recognize the common modifier keys 
	






   ⎋ Escape (esc)
	   ⇞	⇟ PageUp or PageDown
	   ⌫ Delete
	   ↑↓←→ Arrow keys

	   	 Enter 
	  ` Grave accent (tilde key)

Fkeys are those keys across the top of the keyboard that are labeled with the letter  
F and a number, such as F2 or F13. 

The fn key (function key) enables individual keys to do more than one function. 

Keyboard shortcuts typically use one or more modifier key(s), plus one number, 
character, or Fkey, as you can see in the example of the Edit menu above: The 
keyboard shortcut to copy selected text is ⌘C, or Command C. 

Take careful notice of which modifier keys  
and which character keys are used. 
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Use a keyboard shortcut
The trick to using a keyboard shortcut is this: Hold down the modifier keys all 
together and keep them held down, then tap the associated letter, number, or Fkey
just once for each time you want to perform an action. 

For instance, the keyboard shortcut to close a window is Command W, so hold the 
Command key down and tap the letter W just once. If there are three windows open 
on your Desktop, you can hold the Command key down and tap the letter W three 
times and it will close three windows.

Notice gray versus black commands 
When commands in a menu are gray instead of black, the Mac is giving you an 
important visual clue. Here’s a short exercise to demonstrate.

1 Click an empty spot on the Desktop. 

2 Now take a look through the Finder menus and notice the shortcuts for different 
actions or commands. Notice how many commands are gray.

  If a command is gray, that means you cannot use that command at the 
moment. often this is because you have not selected an item first, an  
item to which the command should apply. For instance, you can’t use  
the  command to close a window unless an open window is selected.

3 Now open a Finder window (if there isn’t one already) and select  a folder icon  
(click once on it).

4 Look at the File menu again, and notice how many more commands  
are available (they’re in black, not gray). 

5 In the File menu, find the keyboard shortcut to “open,” but don’t choose  
the command from the menu—just notice and remember the shortcut 
(Command o). Click somewhere off the menu to make the menu go away.

6 Make sure a folder is selected. Now use the keyboard shortcut, Command o,  
to open it. 
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Learn More about Mac os x
There are a number of ways to learn more about your Mac and how to use it,  
all available right from your Desktop. Keep these tips in mind as you spend time  
on your Mac—you will learn a lot from them. 

Tool tips
Most applications and dialog boxes provide little tool tips that pop up when you 

“hover” your pointer over an item. They tell you what the items do. Just hold the 
pointer still over a button or icon for about three seconds; if there is a tool tip,  
it will appear, as shown in the examples below.

TextEdit toolbar.

Preview toolbar.

Font Panel toolbar.
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Hover tips
As mentioned on the opposite page, tool tips appear when you hover the pointer.  
For instance, you’ve probably already noticed that when you hover over an item in the 
Dock, the name of that item appears. Actually, all kinds of things appear when you 
hover—try it on everything! Below are some examples. Remember, “hover” means to 
hold your mouse still while pointing to an item—don’t click or press the button.

In Mail, hover over a name in an email to see 
which address it came from. 

In Safari (your web browser), hover over a link name to see exactly 
where it goes—the destination appears in the Status Bar at the 
bottom of the window. (If you don’t see this Status Bar, go to the 
View menu in Safari and choose “Show Status Bar.”)

In iChat, hover over a name to 
see that person’s information.

www.allitebooks.com
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Help files
No matter where you are on the Mac or which application you are working in, you’ll 
always find Help just a click away. At the Finder, go to the Help menu to look up tips 
and techniques on just about anything.

Every application has a Help menu, and it’s always at the far right end of the menu 
choices, as shown below. Choose the Help option for that particular application, 
then type in a word or two that you want to look up. You see two different kinds of 
options available, “Menu Items” and “Help Topics.”

Menu Items This tells you where the item you’re looking for can be found in the 
menus. It doesn’t explain anything about that item. When you select 
an option in the “Menu Items” list, a menu drops down and a big 
moving arrow points to the item you’re looking for. 

Help Topics If the software vendor has written information in the Help file, you 
will see a list of the possible topics. Choose one and the Help file 
opens to that piece of information.

Enter text in this field.
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Support pages
The Apple web site has a huge number of support pages. Here you can find manuals 
that you can view on screen or download (copy) to your computer.

You’ll also find discussion pages where other users talk about different products and 
software packages on the Mac, ask questions, and answer questions. 

You can sign up for training at a local Apple store, read the product question-and-
answer pages for hardware and software, and more. Go to www.apple.com/support.

Mac video tutorials
Apple provides hundreds of video tutorials about Mac basics, Mac applications 
(such as iPhoto, iMovie, iWeb, GarageBand, iWork, and MobileMe) on its web site. 
Visit www.apple.com/startpage and look for Video Tutorials. or just use Safari to 
do a Google search for “Mac video tutorials.” 

You’ll find more video and text tutorials at www.apple.com/findouthow/mac that 
include additional topics, from “Get Started with Mac” to “Using iChat.” 

MobileMe tutorials
If you are a MobileMe member, take advantage of the MobileMe page where you’ll 
find lots of tutorials to help you learn more about how to take advantage (and have 
fun) using the features included with a MobileMe membership. You don’t have to be 
a MobileMe member to see the tutorials, just go to www.apple.com/mobileme.

A MobileMe membership costs $99.95 a year and includes lots of features that make 
your Mac experience many times more empowering, creative, enjoyable, and just 
plain useful. 

Apple Support Communities
Join Apple Support Communities to find an online community focused on a 
product or topic you’re interested in. Sign in using your Apple id to find answers 
to existing questions, ask your own questions, or join a discussion. After you join, 
you can customize your homepage to show topics you’re interested in, read existing 
discussions to check on the latest issues and tips, post responses, and more. Visit 
Apple Support Communities at discussions.apple.com.

www.Apple.com/support
www.Apple.com/startpage
www.Apple.com/findouthow/mac
www.Apple.com/mobileme
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LESSON 2

A Bit Beyond the Basics

If you’re feeling comfortable with the techniques and 

features described in the previous lesson, then carry on 

into this lesson and learn a few more advanced (but still 

everyday and useful) features. If anything overwhelms 

you in this lesson (or any lesson), feel free to skip it and 

come back later.
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Understand the Sections of the Sidebar
The Sidebar is divided into sections, each with a particular purpose.

Favorites
The Favorites section displays folders and files on your own computer. To make any 
file or folder easily accessible, drag it from the Finder window to this section of the 
Sidebar. When you no longer need easy access to the item, Command-drag it out of 
the Sidebar. It disappears in a poof of digital smoke. If you decide to put that item 
back in the Sidebar, just drag it into the Sidebar again.

Shared
The Shared section (if you see it in your Sidebar) displays any other computers or 
disks that you can connect to through your local network. A local network is one 
in which computers in a small area, such as a home or office, are all connected via 
wires or a wireless connection. 

To hide shared items or devices in the Sidebar, hover the cursor 
over the area just to the right of the “Shared” or “Devices” title until 
the word “Hide” appears. Click “Hide” to hide the items. 

To show shared items or devices, hover the cursor over the same 
area as above, until the word “Show” appears. Click “Show” to 
make the items appear in the Sidebar again.

You can choose 
which items 

are displayed 
in the Sidebar; 

see page 276.
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Devices
In the “Devices” portion of the Sidebar, you probably see something similar to the 
example shown below—you might see more icons and you might see fewer in your 
Sidebar. The icons under “Devices” represent hard disks, other computers on the 
network, a cd or dvd, an iPod, or any other type of removable media. 

Display the contents of each media item the same way you do any of the items in 
the Sidebar: Single-click the name or the icon.

The Hard Disk is your computer, the disk that holds the operating system and all 
your files. You can rename your hard disk at any time, just as you rename a folder  
(as explained on page 11).

The iDisk is your personal storage space on Apple’s computers, which is something 
you get when you sign up for a MobileMe account; see page 33. A single click on the 
iDisk icon connects you to that storage space. 

The round disk icon in the Sidebar is a music cd inserted in the cd drive.  
The square disk icon called External Disk is a removable drive connected to this 
computer. Removable media always have Eject symbols to the right of the names.

When you see the Eject symbol to the right of an icon (the triangle with a bar  
under it), that means it is a removable disk of some sort. It might be a cd, a dvd,  
an iPod, or another computer you are connected to over the network. Click on the 
symbol to eject or disconnect the item.

Choose which devices, if any, appear on your Desktop. See page 276. 
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View your Home folder from the “Hard Disk”
Below you see another way of looking at your Home folder, using the Column View 
(as explained on pages 16–17). As you open folders, the contents appear in a new 
column to the right, creating a visual path. 

You can see by the highlight in the Sidebar that I first clicked on the drive icon 
labeled “Hard Disk”; the Hard Disk is where all your files are stored (although you or 
someone might have renamed your hard disk). This click displays the folders stored 
on that Hard Disk; you can see them in the column to the right. 

Then I clicked on “Users,” which displays my Home folder in the next column. If you 
create any other users, as explained in Lesson 18, you will see all of those users listed 
in this folder/column. 

Then I clicked on “jt,” which displays my own Home folders in the next column. 

Do you see the Applications folder in the screen shot below? Notice that it’s in the 
top level (first column) of the Hard Disk. Your Applications icon in the Sidebar makes 
it easy to access this folder so you don’t have to dig into the Hard Disk to find it. 

Experiment with different ways of getting to your Home folders until you feel 
comfortable about where things are stored on your Mac.

The name of the currently selected 
item appears in the title bar.
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Understand the Various Library folders
As you work with your Mac, you’ll run across a number of folders with the same 
name: Library. Do you see the two Library folders in the illustration below? And  
there are others.

Library folders contain information that the operating system and certain applica-
tions need to function. Unless you have a really good reason and know exactly what 
you’re doing, leave the Library folders alone—don’t put anything in them and 
don’t take anything out. 

The Library folder you see above, in the first column, is at the top level of your hard 
disk. It contains files that are critical to running your entire computer, and the files 
it contains pertain to all users who use this Mac. For instance, the Library folder 
in the first column has a folder inside called “Fonts,” and all fonts that are installed 
into this top level folder are available to all users. (For details about multiple user 
accounts and how to create them, please see Lesson 18.)

The Library folder in the second column, above, is in the System folder, a folder that 
contains files critical to the operation of the computer. Don’t change anything in the 
System folder unless you’re expert at working with systems. 

A third Library exists in the User’s Home folder, but it’s hidden. If you know what 
you’re doing and really need to see this hidden Library folder, in the Finder go to 
the Go menu and hold down the option key. While the option key is down, select 
the “Library” item from the menu. This is where your user account stores your 
application preferences, web page bookmarks, Address Book contact information, 
email, and other personal information.  

That’s all you really need to know about your Library folders—and leave them alone 
for now!
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Select Multiple items in the finder
To select an individual item in a Finder window, you simply single-click it, as  
you probably know. But often you’ll want to select more than one item at a time.  
To select multiple items, there are two ways to do it, as explained below. once 
items are a group, you can move, trash, or open all the selected files at once,  
change their labels (see page 278 about labels), and more.

In the Icon View
To select multiple items in the Icon View, hold down the Command key or the Shift 
key and single-click the items you want to group together. You can only select items 
from one window while in the Icon View. 

Or press a blank spot in the window and drag the cursor around the items you want 
to select. Any icon that is at least partially enclosed by the rectangle you draw with 
the cursor will be selected.

In the List View, Column View, or Cover Flow view
In these views, using the Shift key is different from using the Command key.

Hold down the Command key and single-click multiple items. 

In the List View and the Cover Flow View, you can select items from several 
different folders in the same window, as long as their contents are showing in 
the list. See the examples on the opposite page.

In the Column View, you can select multiple items from one column at a time. 

The rectangle I 
dragged partially 
overlaps six files. 
When I release the 
cursor, all six files 
are selected.

Icon View.
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The Shift key lets you select a group of items that are contiguous, or next to each 
other in the list. Single-click on the first item you want to select in a list. Then hold 
down the Shift key and click the last item you want in the list. Everything between 
the two clicks will be selected. See the example below.

To deselect an item from any group in any view: Command-click it. 

To deselect all items from any group in any view: Single-click any blank  
area in the window.

Cover Flow View.

Shift-click to select contiguous items.

Command-click to select or deselect non-contiguous items.

List View.

www.allitebooks.com
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Look for contextual Menus
These are great. You can Control-click just about anywhere (hold down the Control 
key—not the Command key—and click), and a menu pops up right where you click. 
This is a contextual menu that is specific to the item you Control-click on, meaning 
what you see in the pop-up menu is dependent on what you click (as opposed to 
menus in the menu bar or in dialog boxes that always contain the same items). 

To display a contextual menu, hold down the Control key and click on an icon, a 
blank spot on the Desktop, inside a Finder window, on a title bar, toolbar, or just 
about anywhere. A little menu pops up, as you can see by the examples. 

If you have a two-button mouse, you don’t need the Control key—just use  
the right-hand button (the secondary mouse button) to display a contextual menu.  
If your right button isn’t working, go to the preferences for Mouse (see page 290) 
and make sure you have assigned the secondary button.

There is no visual clue for a contextual menu—just keep checking. You’ll find them 
in applications, on web pages, in toolbars, in the Sidebar, and everywhere. 

A contextual 
menu on a blank 

spot on the 
Desktop.

This is great. 
Select a number 

of files, and 
the contextual 

menu gives you 
an option to put 

them all into a 
new folder. The 

new folder appears 
ready for you to 

type its new name.
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 In Finder windows, the 
Action menu does many of the same things 
as the contextual menu, and more. 
Try it: Single-click to select a folder or file, 
then click the Action button to see what the 
contextual menu options are. 

A contextual menu 
on a Toolbar.

This is an example of a contextual 
menu in an  application:
Control-click (or right-click) a 
misspelled word in a new email 
message to get a contextual menu 
with possible spellings. 
Select the correct word, let go 
of the cursor, and the misspelled 
word is instantly replaced with the 
correct one.

Try the “Speech” option—selected 
text will be read aloud to you.
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Open and Save as dialog boxes
When you’re working in an application and need to open a file you created earlier, 
most of the time you’ll go to the File menu and choose “Open…” to get the dialog 
box shown below. Keep in mind that you can change the view of the open dialog 
in the same way you change a Finder window view. Also in the same way, you can 
select items in the Sidebar to navigate to the folder in which you have stored the file 
you want to open. 

It’s good to get in the habit of saving your file directly into its appropriate folder
so you can keep your thousands of files organized. As usual, save your new file right 
away (Command S). In the dialog that opens, find your folder (or make a new one), 
and select it so your new file goes straight into it.  

Starting from the 
Sidebar (or the 

menu), choose the 
folders in which 
you have stored 

files to find the one 
you want to open.

If the disk or folder in which you want 
to save a file is not listed here, click the 
disclosure triangle to open the fuller 
window, shown to the right.

Find the specific folder you want to save into. 
If you haven’t created a specific folder, you can 
do so now: Click the “New Folder” button. That 
new folder will be stored inside the folder that is 
currently selected in this window.

The disk or folder name shown here is the one that 
your new file (or new folder) will be saved into. 
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Mac OS X Applications in Lion
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The Apps Store:   
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LESSON 3

Introduction to  
os x Applications

one of the greatest things about Mac applications is that they 

are consistent, which makes them easy to learn and easy to use— 

what you learn in one application applies easily to just about any 

other application. 

In this short introductory lesson, we present a brief overview of 

the major apps (applications) that come with your Mac. All of the 

Apple applications are integrated with other apps, and they all 

share certain features and tools. In the following chapters, we’ll 

go into more detail about individual programs, and in Lesson 13 

you’ll learn how to use the tools that all Apple applications share.
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know your applications folder
In the Sidebar of any Finder window is an icon labeled Applications. Single-click 
this icon to display the contents of the Applications window. These are the programs 
you will use to create your work on your Mac.

At any time, you can put the application you use most often in the Dock so you’ll 
have easy access to it: Just drag the application icon from this window and drop it  
on the Dock (the other items will move over to make room). If you accidentally lose 
something from the Dock, you can always go back to the Applications window to 
drag the item back in.

When you open an application that’s not already in the Dock, its icon automatically 
appears in the Dock. When you quit the application, the icon disappears from the 
Dock. To keep the application icon in the Dock, press on it (while it’s in the Dock) 
to show a pop-up menu, choose “options,” then choose “Keep in Dock” (shown 
below-right).

Some applications that you buy 
will display their folders here in 
the Applications window instead 
of the application icons. 

If you see that an application is 
stored in a folder, open that folder 
and find the actual application
icon to drag to the Dock.
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Use the Launchpad
To display a full-screen view of all your application icons, single-click the 
Launchpad icon in the Dock. Then single-click an application icon to open that app. 

If you have more apps than will fit on a screen, the others are shown on additional 
screens: Swipe left with two fingers on a trackpad; use one or two fingers on a Magic 
Mouse. Swipe the other direction to return to previous screens. If you have an older 
mouse, press-and-drag the mouse left or right to switch screens.

These dots tell you how many Launchpad 
screens are present, and which one is visible. 

Click a dot to go to that page of apps. 

Launchpad.

This type of icon indicates a folder of applications. 
Single-click it to show all the apps inside. 

Single-click 
an icon to 
open that 
application.

Click a blank 
space to exit 
Launchpad.

To add applications to Launchpad: Drag an application icon and drop it on top of 
the Launchpad icon in the Dock.

To create a new folder (a group) of applications: Drag an icon and drop it on top 
of another icon that you want to group it with. A folder (it doesn’t look like a real 
folder) is automatically created with both apps inside. Drag and drop any other apps 
on the same “folder” to add them to the group.

To exit Launchpad: Click on a blank space of the screen, or tap the Esc key.

To open an app location in the Finder and exit Launchpad: Control-Command-
click the icon. Launchpad closes and a Finder window opens with the app selected.

To delete an app from Launchpad (this will delete the app from your entire 
computer!): Hold down the option key until all icons start to shake and an x
appears in the top-left corner of each one. While the option key is down, click the x
to remove the app from Launchpad.
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know the common features of Mac apps
Most Mac applications have these features in common. 

Windows and window controls  
When you open an application, you’ll actually be working in a 
window. If you worked through Lesson 1, you already know all 
about windows, even ones you haven’t seen before. You see the 
same red, yellow, and green buttons to close, minimize, and resize 
the window. The document name and a tiny icon appear in the title 
bar. You can drag the title bar or the status bar (at the bottom of the 
window, if it’s showing) to move the window. 

Application menu  
The application menu (directly to the right of the Apple menu) 
always tells you the name of the currently active application, the 
one you’re working in (even if there is no document window open 
on the screen). You’ll always find the Quit command at the bottom 
of the application menu.

File and Edit menus  
You’ll always find File and Edit as the first two menus to the right  
of the application menu. 

Although each application includes specific features in its menus, 
in the File menu you’ll always find the commands to open an 
existing document or create a new one, save the document or save 
as with another name, close the active window, and print the active 
document. 

From the Edit menu, as 
shown on the right, you can 
always undo or redo, cut, 
copy, paste, delete, select 
all, check the spelling and 
grammar, and access the 
Special Characters.
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Preferences Every application has its own preferences where you can customize
the application to suit yourself. You’ll always open the preferences 
from the application menu (shown on the previous page). To open 
the preferences for an app, open the application, then from the 
application menu, choose “Preferences….” Typically, you’ll see a 
toolbar across the top of the preferences pane; single-click an icon 
in that toolbar to set the preferences for that particular feature. 

Safari preferences. The Tabs pane is selected.

This is a typical 
sheet that drops 

down from a 
toolbar so you 

can customize it.
Drag icons from 
this sheet to the 

toolbar, then 
click “Done.”

Toolbars Most applications have a Toolbar across the top of the window. 
Usually, you can customize this Toolbar: Check the View menu for 
a command called “Customize Toolbar… ,” or use the contextual 
menu (Control-click or right-click on the window’s toolbar).  

www.allitebooks.com
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Sidebars  
Many applications have a Sidebar, or a sort of pane on the side of 
the window. Single-click the icons you see in a Sidebar to display  
its particular contents in the window.

Special collections  
Several applications use collection metaphors such as Albums
in iPhoto, Playlists in iTunes, Bookmark Collections in Safari, 
Mailboxes in Mail, Groups in Address Book. Use these to store  
and organize your stuff. 

Open and Save As dialog boxes  
Whenever you open an existing document or save a new one, the 
dialog boxes you see to open a new document or save a document 
always look familiar (see page 44). 

Help files Every application has a Help menu with Help files specific to that 
application. Use the Help menu you see on your screen; some apps 
have a keyboard shortcut such as Command ? to bring up the Help 
files. You’ll find a search field where you can type in key words, then 
hit Return to display the answers. See page 32 for more details.

Here the iTunes 
Store is selected 

in the iTunes 
Sidebar.
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Action button and menu  
In many application windows, you’ll see the Action button (shown 
to the left) that displays the Action menu. Every application has 
different options—always click on it to see what is available.

Search Just about every application has a search feature. It’s usually in the 
upper-right corner of the window, as you can see in the iTunes 
window on the opposite page and in Mail, below. Just exactly what 
the search feature searches depends on the application. See the 
individual overviews in the lessons for each application.

Smart Folders  
Many applications have some version of Smart Folders that 
automatically update themselves according to your specified 
criteria. See Lesson 19 on Spotlight to learn how to take advantage 
of this great feature. 

other applications have similar types of smart folders: The Address 
Book has Smart Groups that will add appropriate contacts to 
themselves; iTunes has Smart Playlists that will add music to 
themselves; Mail has Smart Mailboxes that gather up messages.  
See the individual lessons for each application. 

Preview before you print  
At the bottom of most Print dialog boxes (especially in Apple apps) 
is a button called “pdf.” Click this to display a menu where you can 
choose to “open pdf in Preview.” This creates a quick pdf of your 
document and opens it in the Preview application where you can 
see what it will look like when printed. If you like the way it looks, 
continue to print from Preview, or close the preview window and go 
back to your document to continue printing. 

Search field.
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full-Screen apps
Many of the applications that come with a Mac can be used in full-screen mode, 
such as Mail, Safari, iCal, Preview, iTunes, and iPhoto. Full-screen mode hides 
Desktop clutter while you work. When you put an app in full-screen mode, it 
occupies a Space, all by itself (see Lesson 16 about Mission Control and Spaces).  
You can open that Space by choosing it while in Mission Control, or click its icon  
in the Dock to bring forward the Space that contains that full-screen application.

If you like working in the full-screen mode, you can just leave the applications open 
in their own Spaces, then switch Spaces when you’re ready to use a certain one.  

To enter full-screen mode, click the Full-Screen button, the double-arrow button 
that appears in the top-right corner of some application windows (shown below).

To exit full-screen mode, move your pointer all the way to the top edge of the 
screen to reveal the top menu bar, then click the blue Exit Full-Screen button.

To switch between full-screen apps, do one of the following:
n	 Click an application icon in the Dock. If the Dock is hidden because you’re 

already working in another full-screen app, move your pointer to the bottom 
edge of the screen to reveal the Dock.

n	 Enter Mission Control, then click the Space thumbnail that contains the full-
screen app you want to work with.

n	 Swipe left or right with two fingers on the surface of a Magic Mouse to move 
between all Spaces. or swipe left or right with three fingers on the surface of  
a Multi-Touch trackpad to move between all Spaces. 
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application integration
All of the Apple applications share certain tools such as the Spell Checker and 
Grammar Checker, the Fonts palette, the Colors palette, the Special Character 
palette, and more. Common tool elements are explained in detail in Lesson 13.

Also keep in mind that all of these applications work together in amazing ways. You 
can drag text and graphics from one app to another, save files into different formats, 
save notes or events from Mail directly into iCal, create a pdf in TextEdit that you 
can read and annotate in Preview, and more. See the individual application chapters 
and Lesson 14 for details.

What We can’t cover!
We introduce iTunes in Lesson 10, but we don’t cover iPhoto, GarageBand, iWeb, 
iMovie, or idvd because they belong to a specialized suite of apps called iLife and 
are not part of the Mac operating system. other authors cover those, however, in a 
variety of books published by Peachpit Press, www.PeachpitPress.com. Some iLife 
books are more than 500 pages, so you can see why we don’t cover all of that in this 
book! At Peachpit you’ll also find much more information than we can provide in 
this introductory book about such programs as Mail, iCal, and iChat. 

Nor do we cover Pages, Numbers, or Keynote in this book because they each 
deserve their own book. If you have any of those programs, know that Peachpit 
publishes books about them (including Robin’s Non-Designer’s Presentation Book
which is mostly about Keynote), and don’t forget that the applications have good 
Help files built right in.  

We fully expect you to be proactive in your learning! Poke around in the preferences 
for each application, explore the menus, click on things. You’ll be surprised at the 
little treasures you’ll constantly encounter. 

www.PeachpitPress.com
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GoALS

Find and replace   
words or phrases

Create favorite styles   
for quick formatting

Take advantage of the 
“Complete” feature

Turn on typographer’s quotes

Become familiar with   
tabs and indents

Create lists and simple tables

Create live web or email links

Select non-contiguous text

Print page numbers

Learn how to open Microsoft 
Word documents and save 
TextEdit files as Word docs
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LESSON  4

TextEdit for  
Word Processing

TextEdit is a small yet surprisingly powerful word processor. Use 

it to write memos, letters, diaries, novels, grocery lists, memoirs, 

or any other text document. You can create simple tables and 

automatically numbered or bulleted lists, add shadows to type, 

insert images, search and replace text, and more. But it’s not a full-

blown word processor such as Apple’s Pages (check the App Store 

in your Dock) or MarinerWrite (MarinerSoftware.com) or the sweet, 

new Pagehand (Pagehand.com). Although TextEdit can’t do all 

the fancy things a big word processor can, it’s excellent for many 

projects. 

If you’ve never used a word processor before and you don’t know 

how to open an application and save files, enter text, select text for 

formatting, cut/copy and paste, etc., please read The Little Mac 

Book first! This chapter assumes you know the basics of working in 

a word processor. 
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“Wrap to Window” fills the page 
with no visible margins. 

An unsaved file has 
no options in the 
upper-right corner.

A saved file displays  
a disclosure triangle  
when you mouse over it.

“Wrap to Page” displays the text as 
it will look when printed on paper. 

Once you save a file, 
TextEdit lets you know when 
there are unsaved changes.

create and Save a textedit document
open TextEdit (it’s in your Applications folder and in Launchpad). Then from its 
File menu, choose “New.” A blank window opens for you to start typing.  

Choose how you want to see the document: From the Format menu, choose “Wrap 
to Window” (below, left) or “Wrap to Page” (below, right). 

Save your document as usual (from the File menu, choose “Save…” give it a name, 
and store it in a folder where you’ll find it again). As you continue to work on 
your TextEdit document, an “Edited” button appears in the top-right corner of the 
document window. This is a visual clue that the document has been changed and 
you might want to save the changes (press Command S). 

You can click that “Edited” button or triangle to choose from several options: 

  Lock prevents further changes. If you try to type, you get an option to Unlock
it. This is not a secure lock—anyone can click the Unlock button.

  Revert to Last Saved Version gives you the option to revert to the last time it 
was saved (either by you or by TextEdit), or you can revert to an older version, 
as explained on the opposite page. 

  Browse All Versions—see the opposite page. 
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AutoSave and versions
TextEdit automatically saves your document every hour as you work on it, as well 
as when you close it (it doesn’t ask—it just saves). In addition, you can (and should) 
save more often (press Command S). 

As soon as you save and name a document, TextEdit keeps track of all previous 
versions of that document; that is, every time you save or TextEdit saves, a new 
version is stored. You can return to any of these versions, as explained below. 

To manually save the current version, go to the File menu and choose “Save a 
Version,” or press Command S. 

To save a document with another name or in another file format, go to the File 
menu and choose “Duplicate.” Save this new file with a new name. 

Restore a previous version
To turn to a previous version of the document, click the top-right corner to get the 
menu shown below. Choose “Browse All Versions….” All previous versions of your 
document appear, as shown at the bottom of this page.

The current document version. Previous document versions. Timeline.

Click on the title bars to go back in time to previous versions, or click in the vertical 
timeline to view various versions. When you find the one you want, click the 

“Restore” button at the bottom of the screen.  
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find and Replace Words or Phrases
Did you write your entire screenplay using your sweetheart’s name, Hamlet, as 
the hero? And now Hamlet has abandoned you and you want to replace the hero’s 
name with Romeo? No problem:

1 From the Edit menu, choose “Find…,” or press Command F. A search field 
appears below the ruler bar.  

2 Click the “Replace” checkbox to open a Replace text field below the search field. 

3 In the Find field, type the word you want to find, such as Hamlet.

4 In the Replace field, type the word or phrase that will replace the found word, 
such as Romeo.  

5 Find and replace:

  Replace: Replaces the currently selected occurrence of the word or phrase,  
then automatically finds the next occurrence.

All: Replace all occurrence of the found text. Press (don’t click) on the “All” 
button to see more options.

  To manually find other occurrence of the text, click the Previous and  
Next buttons. 

  For more search options, click the small double-arrows next to the  
magnifying glass icon on the left side of the window. 

6 Click “Done” to put the Find and Replace fields away.

Previous and Next buttons.

Press to show more replace
and select options.

Click for more 
search options.

The “Insert Pattern” 
option opens a menu 
of search criteria that 
includes searches for 
email, web addresses,  
or phone numbers.
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Paste text to Match the existing text
This is one of my favorite features. Let’s say you’re writing a term paper and you 
copy a quote from a web page to add to your paper (properly cited, of course). 
Typically the copied text pastes in with the typeface, style, size, and color that were 
originally applied to it. But to add this quotation to your term paper, you want it to 
look like the rest of your page. Use this great feature instead of the regular paste:

  From the Edit menu, choose Paste and Match Style,  
or use the keyboard shortcut, option Shift Command V.

The pasted text will pick up all the formatting from the character to the left of the 
flashing insertion point. This technique works in Mail as well.

Use your favorite text Styles easily
TextEdit doesn’t have the powerful style sheets of a full-blown word processor, but it 
does make your writing life much easier by letting you create favorite styles of basic 
type features so you can apply them quickly. A “style” contains all of the formatting 
information, such as typeface, size, color, indents, etc., so you can apply everything 
to selected text with one click of a button.

These styles are saved with TextEdit, not with an individual document, so you can 
use the same styles in different documents. 

To create your own favorite style:
1 Type some text, any text, and set up the typeface, size, color, linespace,  

and the ruler the way you want it. 

2 Click anywhere in that formatted text. 

3 Click the Paragraph Styles button,  
then choose “Show Styles…”

4 In the sheet that slides down (right), 
click the button, “Add To Favorites.”

5 Name the style and choose your options. 
Click “Add.”

To apply a style, select a range of characters, then choose the style name from the 
Paragraph Styles pop-up menu in the toolbar. All of the formatting that you saved 
with that style will be automatically applied to the selected text.
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tabs and indents
The tab and indent markers in TextEdit function as in any word processor. 

To set a right-aligned tab, single-click in the ruler. 
To set any other tab, Control-click (or right-click) in the ruler and choose  
a tab marker (shown below), or double-click a marker to change it.
To remove a tab, drag the marker off the ruler. 
To indent just the first line of text or both the left and right edges,  
drag the indent markers shown below.

First lines of paragraphs start at 
this First Line Indent marker.

All lines but the first one 
in a paragraph start at 

this Left Indent marker.

To create an indent, drag 
the First Line Indent 

marker to the right. 
The rest of the text will 

automatically align at the 
Left Indent marker. 

The right edge of text 
stops at this Right Indent 
marker.

These are your tab options.

Examples of tab and indent settings
The following are some examples of how to set up your tabs and indents to create 
certain effects. Remember, after you’ve set a tab, hit the Tab key before you type the 
text. once you’ve got tabs set up, you can select the text, then move the tab and the 
selected text will follow. 

The tab applies only to the selected paragraphs—you only need to click inside a 
paragraph to select the entire paragraph. To select more than one paragraph, press 
and drag to highlight a range of text in each paragraph. Follow the directions as 
explained in each window and its caption.
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To creat an outdent,
where the first line is 

outdented farther than 
the other lines: Move the 

Left Indent marker (the 
triangle) to the right of the 

First Line Indent marker. 

To indent an individual 
paragraph on both sides: 

Select the paragraph, then 
move both the Left Indent 

and the Right Indent 
markers inward. 

To create columns: Remove all 
tabs except the few you need, 

and reposition those about 
where you want the columns 

to align. Now hit ONE tab to 
move the insertion point to the 

first column, and type. Hit ONE 
more tab to get to the second 
column, etc. At the end of the 

line, hit a Return and start over. 

This is a common setup. 
It might seem a little 

tricky at first, but once 
you get it, you’ll love 

knowing how to do 
it. Set the markers as 
shown and follow the 

directions. 
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create Lists that Number themselves
If you have a list of items, TextEdit can number them for you with numbers, capital 
or lowercase letters, or other options. When you add or delete items from the list, 
TextEdit automatically updates the numbering. 

List options.

List bullets and 
numbering 
button.

When you click the List button (circled above) and choose a numbering option, the 
numbers apply to either of the following:

If you select text on the page before you go to the Lists menu, your choice of 
list numbering will apply only to the selected text.  

If there is no selected text, the flashing insertion point is “filled” with the list 
specifications, and everything you type from that point on will be in the list 
format. This is a good way to start a new list: Just make sure your insertion 
point is flashing where you want the list to begin, then go to the List menu  
and choose your numbering system, then start typing. 

Each time you hit a Return, TextEdit considers that line to be the next item  
in the list.

To end the sequencing of numbers in a list, hit the Return key twice at the end of 
the last item. 

To delete the list numbers, single-click anywhere in the list. open the Lists menu 
and choose “None.”’

To easily access the advanced List options after you’ve started a list, click anywhere 
within a list, then Control-click (or right-click) in the list to show a contextual menu 
and choose “List….”
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  As you type in a cell, the cell expands downward to fit the text. 

  Change the formatting of the text as you do on a regular TextEdit page: 
Select the text first, then choose the settings from the menus or toolbar. 

4 To resize rows and columns, position your pointer over the edge of a cell.  
The pointer turns into a two-headed arrow. With that two-headed arrow, 
press-and-drag on a cell edge to resize it. 

Click the color well  
to get the Colors panel.

create tables
If you like working with tables, you can create simple ones in TextEdit. This table 
feature also helps ensure that tables created in a Word document will open in some 
form in TextEdit.

To create a table in TextEdit:
1 Position your insertion point where you want the table to begin.

2 Go to the Format menu and slide down to “Table….”

3 The Table palette appears, as shown below. Choose how many rows and 
columns you want in the table. You can determine how the text is aligned 
vertically as well as horizontally in each cell (use the “Alignment” icons), and 
more. Spend a few minutes to familiarize yourself with the tools.

If you don’t want any 
border, enter 0 (zero).

First choose “Color Fill” from 
the menu to the left, then click 
the well to choose a color.
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To create a PDF that you can share with others, 
click here, then choose “Save as PDF….”

Print automatic Page Numbers
You can add page numbers to a printed document (the numbers won’t appear on 
the screen). This feature also automatically adds the name of the document in the 
upper-left corner of the page (including the extension, probably .rtf ), the date and 
time in the upper-right corner, and the words “Page ___ of ___” in the bottom-right 
corner. That is, in TextEdit you can’t choose one or the other of these—they all 
appear on the page, or none. 

To print the page numbers (and everything else), press Command P (or go to the 
File menu and choose “Print…”). In the Print dialog box, shown below-left, click 

“Show Details.” In the expanded Print dialog (below, right), check the box to “Print 
header and footer.” Click “Print” to print the document. 

automatic Spelling correction
TextEdit can automatically correct many spelling errors as you type. To enable 
this feature, open the TextEdit Preferences (from the TextEdit menu). Make sure 
the “New Document” tab is chosen. Toward the bottom of the window, check the 

“Correct spelling automatically” box. Close the Preferences pane.

If TextEdit can’t figure out how to spell it or if automatic correction is turned on, 
you’ll probably see a red dotted line under misspelled words. See pages 248–251  
to learn to use the spell checker.
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A selection of  
non-contiguous text.

Select Non-contiguous text
This is really quite wonderful. “Contiguous” means “sharing a common border.”  
Very few applications allow you to select individual sections of text that are not 
physically next to each other (text that is non-contiguous). This technique lets you 
apply formatting or copy, cut, or delete separate sections of text all at once.

To select non-contiguous text:
1 Press-and-drag to select a section of text.

2 Hold down the Command key. Press-and-drag to select some other text  
that is not contiguous! 
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Create live web links and email links
It’s easy to create web links and email links on a TextEdit page. If you send someone 
the TextEdit file, that person can click on a web link; her browser will open and go to 
the page you specify. An email link in the document opens her email program, pre-
addressed to whomever you specified. 

If you make a pdf of your document (see page 73), the links will work in the pdf. 

Create links as you type web addresses:
1 Go to the Edit menu, slide down to “Substitutions,” then choose “Smart Links.”  

If there is a checkmark next to “Smart Links,” it’s already on.

Show Substitutions 
TextEdit “Substitutions” (from the Edit menu or contextual menu) makes automatic 
substitutions for you as you type. For instance, “Text Replacement” corrects obvious 
spelling mistakes (it substitutes the for teh, etc.) and turns a typed fraction, such as 
7/8, into a real fraction, ⅞. Below are several of the other substitution options.

Use typographer’s quotes
TextEdit provides typographer’s quotes, or Smart Quotes. Smart quotes (and apos-
trophes) are the curly quotes, not the straight, typewriter quotes. Nothing will make 
your work look as amateurish as typewriter quotes.

typewriter quotes smart quotes

It's "QueenB" to you. It’s “QueenB” to you.
The Substitutions panel provides extra options for Smart Quotes so you can acti-
vate automatic quotation styles for other languages. Turn Smart Quotes off when 
you want to type feet and inch marks. For instance, i am 5' 7" tall, not 5’7” tall. To 
get this panel, go to the Edit menu, choose “Substitutions,” and then choose “Show 
Substitutions.”

International  
quotation mark styles.
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  Or Control-click in the document, slide down to “Substitutions,”  
then choose “Smart Links.” 

2 on your TextEdit page, just type the web address. You don’t need the www part 
of the web address, or the http:// part. If the address ends with .com, .edu, or 
.org, the link appears automatically. You’ll know if it’s working because the text 
will turn into a blue, underlined link.

  If the domain (the .com part) is more unusual, such as .info, you’ll have to 
manually add the link, as explained below.

Sometimes the text on the page is not an actual address, but you want the link to  
go to an email or web address. For instance, perhaps you wrote, “Please visit our 
Mary Sidney web site,” and you want the link attached to “Mary Sidney” to go 
to MarySidney.com, or you want to say Email me! as a link to your actual email 
address. In either case, use the manual process described below to add a link. 

To manually create a web link or an email link on a TextEdit page:
1 Type the text that you want to turn into a link. This text can be anything— 

it doesn’t have to be the email or web address itself !

2 Select the text that you just typed in.

3 From the Edit menu, choose “Add Link….”

4 Web address: type the address. Make sure you include this code at the  
beginning of the web address: http: // 

  Email: Type into the field: mailto:  
Immediately after the colon, type the entire email address just as you would 
address it: mailto:name@domain.com

5 Click ok.

To remove a link from the text on a TextEdit page:
1 Click in the text a few characters away from the link to set the flashing  

insertion point. Use the left or right arrow keys to move the insertion point 
into the linked text.

2 From the Edit menu, choose “Add Link….”

3 Click “Remove Link,” then click ok.
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Automatically detect 
address data in text. 

Show a map  
to the address.

Use Data Detectors 
Data Detectors is one of several Substitutions available in TextEdit that enhance 
your text. The Data Detectors feature, like Smart Links, makes your text interactive. 
When you hover the cursor over a street address or phone number in a TextEdit 
document, the cursor draws a marquee around the address and/or phone number. 
Click the triangle button that appears to show a contextual menu of options (circled, 
below). You will see different options depending on what is selected. 

Data detection is probably turned on already. If it isn’t: To turn on data detection,
go to the Edit menu, choose “Substitutions,” then select the “Data Detectors” option. 

You can also right-click (or Control-click) on any empty spot in the document 
to open a contextual menu. Slide down to “Substitutions,” then choose “Data 
Detectors.” A checkmark next to a Substitution item means it is enabled; select  
it again to disable it. 

Change case (as in upper- and lowercase)
The Edit menu also contains a command called Transformations to change the case
of selected letters quickly and easily. That is, you can change a word that starts with 
a lowercase letter to one that starts with a capital letter, or if someone wrote you 
something in all caps you can change it to lowercase with the click of a button.

Select some text and Control-click (or right-click) on that selection, or simply 
Control-click (or right-click) directly on an unselected word. From the Edit menu, 
go to the Transformations submenu and choose “Make Upper Case,” “Make Lower 
Case,” or “Capitalize” (which capitalizes just the first letters of each selected word). 
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extra tips and Notes
Ruler: If the ruler isn’t showing, press Command R. Without the ruler showing,  
you can’t set tabs, indents, or margins.

Formatting: If text won’t let you apply formatting, go to the Format menu and 
choose “Make Rich Text.” 

Wrap to Page: If text stretches the entire width of the window, you might want to 
switch to “Wrap to Page.” Go to the Format menu and choose “Wrap to Page.”  

If your text prints really tiny, go to the Format menu and change “Wrap to Window” 
to “Wrap to Page.”

Complete: To automatically complete a word that you start typing (a word that 
you’re not sure how to spell, or a word that’s so long you don’t want to type it all), 
go to the Edit menu and choose “Complete,” or use the keyboard shortcut option 
Escape. A pop-up menu that contains a list of possible matches opens. Select the 
word you want from the list, then hit Return (or click the word in the list). 

Speech: Let your Mac read selected text to you aloud. Go to the Edit menu, choose 
“Speech,” then choose “Start Speaking.” To stop the speech, choose “Stop Speaking.” 
To read aloud just a certain portion of text, select that range of text, then choose the 

“Start Speaking” command.  

Look up words in the Dictionary: To look up a word (such as “Santa Fe”) in the 
Dictionary, right-click on the word or the selected phrase to open a contextual 
menu, then choose Look Up “Santa Fe.”

If your trackpad supports multi-touch gestures, double-tap the word with three 
fingers to look up the selected word, as shown below. Your own gesture commands 
may vary, depending on the Mouse or Trackpad settings in your System Preferences 
(see page 290).
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Read Microsoft Word files
Do you need to send or read Microsoft Word files, but you prefer to keep a 
Microsoft-free environment on your own computer? TextEdit can open Word 
files and save as Word files. Some of the advanced features will be missing, but 
this works great for basic text documents, including those with simple tables or 
numbered/bulleted lists. 

If you don’t have Microsoft Word installed on your Mac, file names ending with  
.doc or .docx (which are usually Word files) automatically open in TextEdit when 
you double-click them. 

To force a Word document to open in TextEdit (if it doesn’t automatically), drag 
the file and drop it on the TextEdit icon. 

If TextEdit is not in your Dock, it’s in the Applications folder and in Launchpad: 
Click the Launchpad icon in the Dock. Find the TextEdit icon, then drag and drop  
it in the Dock so it’s always easily accessible.

Change the default application to open Word files
If you own Microsoft Word and want your .doc files to open in Word, not TextEdit, 
you can change the default application: 

1 Control-click (or right-click) the Word document icon to get its pop-up menu.

2 While the menu is visible, also hold down the option key. This changes 
the “open With” command to “Always open With.”

3 Choose “Always open With.” If Microsoft Word is on your Mac,  
you’ll see it listed in the pop-out menu. Or select “other…,” then choose  
the application you want to always open the selected file.
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To see the options shown 
here, single-click this 
disclosure button.

If you have set 
your Finder 

preferences to 
show all filename 
extensions (page 

279), you won’t 
see this checkbox.

Save TextEdit files as Word docs
You can save any TextEdit file as a Microsoft Word document to send to people who 
insist on that format.

To save a TextEdit file as a Word document: 
1 Go to the File menu and choose “Duplicate.”

2 Press Command S to save this duplicate. 

3 In the “File Format” menu at the bottom of the dialog box, choose “Word 2007 
Format (docx).” This automatically adds the Word extension, .docx, to the end 
of your file name. 

  If you don’t see an extension (see page 444) at the end of a file name—and  
you want to—click the disclosure button to the right of the “Save As” field  
(circled below). Uncheck the box to “Hide Extension.” To show the extension, 
of course, check the box. 

Save TextEdit files as pdfs 
From the File menu, choose “Print…,” then click the “pdf” button (in the bottom-
left corner of the Print dialog). Choose “Save as pdf….”

The “File Format” menu lets you 
save your files in several other 
formats. Keep this in mind!



ptg6934589

5
GoALS

Set up an account in Mail

Read and send email

Create fancy html
stationery

Organize your mail   
with mailboxes and   

Smart Mailboxes

Filter junk mail   
from your inbox

Personalize your   
messages with signatures

Use searches and Rules   
to find and organize   

your messages

Use Notes to collect   
all your thoughts and ideas

Send and receive 
attachments
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LESSON  5

Mail for Email and Notes

Mail is Apple’s application for sending and receiving email. If you 

have more than one email account on more than one server, Mail 

can check them all at the same time, and you can send email from 

any of your accounts right through Mail.

With Mail’s stationery, create fancy html email messages with 

special fonts, images, and design—all with the click of a button. 

And take advantage of the Notes that coordinate instantly with 

your iCal information and sync to your iPhone. 

For those who use Windows systems at work, Lion has built-in 

support for Microsoft Exchange Server. Now you can use your 

Mac apps (Mail, iCal, Address Book) to access Exchange services, 

such as email, calendar invitations, and Global Address Lists. 
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Set Up a New email account 
It’s easy to add your email account to Mail if you didn’t do it when you first installed 
Lion or turned on your new Mac, and it’s easy to add a new account. If your account 
is already set up, skip to page 81. To get a free trial MobileMe email address (which 
you can keep after the trial period), go to apple.com/mobileme. 

To set up a Mail account (or an iChat account, Calendar settings, and/or to 
transfer your Address Book):

1 open the “Mail, Contacts & Calendars” preferences: From the Apple menu, 
choose “System Preferences…,” then click the icon shown to the left. You’ll see 
the pane shown below-left.

2 Click the type of existing account you have. You’ll be asked for your email 
address and its password and a couple of other questions. If all goes well,  
your Mac sets up your account and that’s it! 

3 At any time you can click the account name on the left, then choose  
to turn on or off the various services.  

To set up a pop account (which is just about any other email account besides the 
services listed above), click “other.” Enter your email address and password, and if 
the Mac can set it up, it will. 

But it might tell you that it’s not able to do it and pass you off to the manual setup, 
which is shown on the following pages; start with Step 2.
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This is the name that will 
be visible to the people to 
whom you send email. 

Choose pop (Post Office Protocol, this is the most common) if you have 
an email account with your isp, or if you have a domain name that you paid 
for and you opted for an email account with it. 

Choose imap (Internet Mail Access Protocol) if you can access your 
account on different computers and always see your mail (besides webmail). 
This is usually with a paid service or a large company intranet (although 
most pops can be set up as imap if you ask your provider). 

Choose Exchange if your company uses the Microsoft Exchange server 
and the administrator has configured it for imap access. See your system 
administrator for details.

Whether the process on the opposite page makes you set up an account yourself or 
you just prefer to do it yourself, it’s not difficult.

1 In Mail, go to the File menu and choose “Add Account….” 

2 A pane, shown below, appears. If you enter your MobileMe account name 
and password, you’re done—your Mac fills in everything else and your email 
appears in the viewer window. Skip the rest of these setup instructions.

If you have an email account that is not a MobileMe account, enter the 
information required, then click “Continue.”

3 The next pane asks technical details about your account. If you don’t know 
what kind of account it is, call your Internet Service Provider and ask. 
Generally speaking, this is how to choose the type of account:

—continued
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This is what will appear in 
your Mail Sidebar so you 
know which account it is.
See below.
See below.

  Each account type has slightly different information to enter. 

  For instance, if you choose a pop account, Mail wants to know the Incoming 
Mail Server. It’s usually something like pop.domain.com or mail.domain.com. 
The “domain,” of course, is to be replaced with the domain name of your email. 
For instance, I use mail.TheShakespearePapers.com for my email that comes 
from that web site. If you’re not sure, check your email host’s web site or call 
and ask for the “incoming mail server.”

  The User Name for a pop account is usually your entire email address; 
occasionally it might be something different altogether. If your email address 
doesn’t work as the user name, ask your provider. 

  Enter your password as provided by your provider or set up by you when you 
opted for the email account.

  Click “Continue.”

4 The Outgoing Mail Server, or smtp (Simple Mail Transfer Protocol, shown 
on the following page) has a couple of options. For instance, your MobileMe 
account will be automatically set up with a MobileMe smtp and a Google mail 
account with a Gmail smtp. 

  However, we’ve found that the most reliable smtp is the one provided by 
your Internet service provider. For instance, if you use Comcast, your best 
smtp is “smtp.comcast.net.” That is, your most reliable outgoing mail server 
is the company that you pay to connect you to the Internet. So if Mail is not 
going out, try changing the smtp to the one provided by your isp (also see 
pages 387–389).
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  Some Internet providers may have a low-end broadband option that does 
not allow you to have an outgoing mail server, requiring you to use web mail 
to check and send your mail (and thus read their advertising). If that’s your 
situation and you don’t like it, call your provider and upgrade your service so 
you can get an smtp address (or change providers). 

  The Description field lets you name this smtp so you can choose it from 
certain menus. Enter something that will make it clear to you.

  User Authentication: Unless your provider insists (for security reasons), you 
usually don’t have to enter a user name and password for authentication, so 
for now you can leave those blank. If it doesn’t work with those options blank, 
you’ll need to call your provider because the user name and password it wants 
are typically not your email account and password! It wants the user name and 
password for your provider account, not your email account.  

5 In the Account Summary pane that opens, check the “Take account online” 
box, then click “Create.”  The new account is now available in Mail. 
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Edit, delete, add, or put on hold an account
At any time you can add another account, or delete or edit an existing one by using 
the Mail preferences. 

1 Go to the Mail menu and choose “Preferences….” 

2 Click the “Accounts” icon in the toolbar.

3 To edit an existing account, single-click the account name in the pane,  
then use the pane on the right to edit.

  To add a new account, single-click the + sign at the bottom-left of the 
Accounts pane. You will see the same information panes as explained on the 
previous three pages.

  To delete an account, single-click the account name in the pane on the left. 
Single-click the – sign at the bottom of the Accounts pane. 

  To put an account on hold, single-click the account name in the pane on the 
left. Click the “Advanced” tab. Uncheck the boxes labeled “Enable this account” 
and “Include when automatically checking for new messages.”

4 When finished, just close the preferences or click on another icon in the 
Toolbar. A message will appear asking if you want to save these changes.
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Read your email
The default in Mail is to automatically check your mail every five minutes (if you use 
a dial-up connection, go to the Mail preference, the “General” tab, and change the 

“Check for new messages” option to “Manually”). If you have used Mail in the past 
and hate this redesigned version, you can revert to the classic version: Go to the 
Mail preferences, select the “Viewing” tab, and click “Use classic layout.”

To read mail that has arrived:
1 open Mail: Single-click the Dock icon. 

  If you see “Mail” in your menu but no window, go to the File menu and choose 
“New Viewer Window.” You’ll see something that looks like the sample below.

2 on the left is a column that displays your messages, each one showing the 
subject and the first couple of lines of the message. Unread messages have a 
blue orb next to them. 

3 To read a message, single-click it and the message is displayed on the right side. 
Or double-click a message and it opens into a new, separate window.

Single-click 
a message to 
display it on 

the right.
Double-click 
a message to 
open it in its 
own window.

This photo 
comes from 
your Address 
Book. 

Click “New Message” to compose and send a message.

To see text labels under the icons, 
Command-click (or right-click) 
and choose “Icon and Text.”

To determine the number of lines that show in 
the Message List, go to the Mail menu, choose 
“Preferences…,” click the “Viewing” tab, and 

choose from the “List Preview” menu.  

These symbols are invisible until  
you hover your cursor in this spot.  
The symbols mean delete, reply,  
reply to all, or forward the message.

—continued
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Features of your email window

Click here to see your 
original message.  
It’s lovely—the 
message unfolds. 

The Favorites Bar.  
A downward-pointing 
triangle indicates a 
menu. Numbers in 
parentheses indicate 
unread messages in 
that mailbox. 

To include the photos 
from your Address 

Book, go to the 
Mail menu, choose 

“Preferences…,” click 
the “Viewing” tab, 

and check the box to 
“Show contact photos.”   

Data detectors are  
at work; see page 102.

Customize the toolbar:
Right-click on the toolbar; 
use the menu.

To resize the window,  
drag any corner or any edge.

To resize the panes,  
drag any vertical dividing bar.

To open in full-screen,  
click these corner arrows.

This view shows you an expanded Conversation, as indicated here in 
the Message List with a stack of messages; see pages 84–85.

The Favorites Bar makes it easy to access your most-used options.  
If it’s not showing, go to the View menu and choose “Show Favorites Bar.”  
Drag items from the Sidebar into the Favorites Bar. Drag the items left  
or right to rearrange. Drag items to the Desktop to remove from the Bar.

Choose how you want to organize 
your Message List from the teeny, 
tiny, pale gray menu just above the list. 
To organize by Date, choose one of 
the Date options, and then go back 
to the menu and choose or unchoose 

“Ascending Order” to view messages 
by oldest or newest first. 
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Mail has a seemingly endless variety of ways to present information to you. on this 
and the following pages we present some of the multitudinous ways to customize 
Mail to suit your needs. Be sure to poke around and experiment with Mail; many  
of its features are invisible or only appear when necessary

You won’t see a 
Drafts folder until 
you save a message. 
Mail saves drafts 
of every message 
automatically;  
to save manually,
press Command S.

This view shows the 
Sidebar, the Message 
List, and the Message 
Pane. To resize all the 
panes or make them 
disappear or appear, 
drag the dividing lines, 
as shown above. 

If you don’t have a 
Message Pane, double-
click a message and 
it opens to a new, 
separate window.
To show the Message 
Pane again, double-
click on this edge. 

Hide or show 
the Sidebar.

Position the cursor over a column line and the icon 
changes; this icon means you can drag the line. If you 
want to get rid of the Message Pane so you don’t have 
to look at junk mail when it arrives, drag this line all 
the way to the right, or double-click on the line.  

The green orb tells me this person 
is online and available in iChat.

The blue orb tells me this 
is an unread message.

—continued
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Conversations in your email window
Conversations include everyone who sent a message regarding this subject, 
numbered in order of being received; if a message in another mailbox pertains
to this subject, it also appears in the Conversation, but without a number. The 
examples below show a message not included in a Conversation, and then how  
it appears when it is included in a Conversation.

This is a typical Mail layout, with the Sidebar showing your Inboxes,  
the Message List showing your mail, and the Message Pane showing the email text. 

From the View menu, choose “Organize by Conversation.” The Message List 
condenses the related messages and puts the most recent sender at the top with a 
number in the Message List indicating how many messages are in the Conversation.
All the related messages are in the Message Pane; scroll down to read them. The 
number in the Message Pane indicates which number message this is in that particular 
Conversation (also called a thread).
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Once your email is in Conversation view, go to the View menu and choose 
“Expand All Conversations.” The newest email in the thread displays rows of 
previous messages beneath it, as shown above. Once you select a message,  
you can use your arrow keys to select other messages in that Conversation.  
To view your message in the thread, click a curved arrow (circled, above).

Notice the triangle (circled, above) next to the number in the first message now 
points downward, indicating the Conversation is expanded. Click that number and 
it will “collapse” the Conversation (or from the View menu, choose “Collapse All 
Conversations”).

Important note: If you delete the top (most recent) message in a Conversation, 
every email in that Conversation goes to the Trash! To save an individual message 
from the Conversation, you can move an email from a Conversation and drop it into 
another mailbox; it remains part of the thread, but it won’t get deleted along with 
the others. 

Also be sure to check out the preferences for Conversations: From the Mail menu, 
choose “Preferences….” Click the “Viewing” tab. The bottom portion of the pane 
provides options for you to consider regarding Conversations. For instance, if you 
prefer not to view messages by Conversations, you could have related message 
highlighted with a color instead.

Although this 
looks like four 

messages,   
the top part 

is actually the 
first message 

in the list 
beneath. 



ptg6934589

Lesson 5 Mail for Email and Notes

86

compose and Send a Message
To compose and send an email message:

1 New message: Click the “New Message” button in the toolbar, or press 
Command N.

  Reply, Reply All, Forward: Mouse over the dividing line between return 
address and the message to show the reply buttons (as shown on page 81).

Send

Click the A to show or hide the formatting pane.

Use one of these 
symbols to assign 
a priority.

2 In the “To” field, enter an email address. 

  If this person is in your Address Book or if you’ve sent a message to him before, 
as soon as you start typing, the rest of the email address appears. If there is more 
than one person with those beginning letters, you’ll get a list of possibilities. Use 
the arrow keys to go up or down the list and select the address you want; hit 
Return to put that address in the field. (Manage addresses you’ve sent to in the 
Previous Recipients list from the Window menu.)

  Or from the Window menu, choose “Address Panel” to bring up a limited 
version of your Address Book. Double-click on anyone’s name to add it to the 

“To” field. To add someone’s email address to the Cc or Bcc fields, select a name 
in the list, then click the “Cc:” or “Bcc:” button.

3 In the “Subject” field, enter a subject that does not sound like junk mail.

4 In the Message Pane, type your message. Mail automatically checks your 
spelling and displays suspect words with a red dotted underline. You can 
change the font, color, size, alignment, and more, using the Format menu in 
the toolbar. You can also use the Font panel, Colors panel, Spelling Checker, 
and all the other Mac os x features—see Lesson 13 for details. 
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if you can’t format the text in a message, such as change the color 
or make words bold, go to the Format menu and choose “Make Rich Text .” If it says 

“Make Plain Text” in that menu instead of “Rich Text,” that means you’re already work-
ing in rich text. If you still can’t make bold or italic text, then the font you chose does 
not have bold or italic versions. Check the Fonts panel (press Command T) to see if 
the font you’re using includes bold and italic versions. See pages 252–253 for details.

5 To send an attachment of some sort, just drag it into the message window and 
drop it (see pages 104–107 for more details). 

6 Hit the “Send” button (it looks like a paper airplane). Or press Command S to 
save it for later; to open that letter later, go to the Drafts folder in the Sidebar. 

Customize the message window
You can customize the mail message for every message you open in the future, 
or just the one you’re writing now. To make some settings your defaults, use the 

“Composing” pane in the Mail preferences (from the Mail menu).
n	 Click the Customize button to add or delete fields, or to add or delete a return 

address menu, an smtp server menu (see pages 78–79), signature options 
(see pages 94–95), or the priority button (see the opposite page). 

	 Cc: Sends a copy of this message; the main addressee can see Cc addresses.
	 Bcc: Sends a private copy; no one in the To or Cc field knows this person 

also received a copy.
	 Reply to: If you want a return email to go to a different address than the one 

you are sending it from, put that address here.

If you have more than one email address 
set up in Mail, you can choose from 
which address to send your message. 

If you have more than 
one smtp available, you 
can choose it here.

All signatures you 
have created appear 
in this menu.

Customize 
the options in 

this row.

As usual, you 
can Command-

click to get 
the option to 

Customize the 
toolbar.

Stationery; see the 
following pages.

Get photos;  
see page 89.
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Use Stationery to Send fancy email
It’s actually called “html” mail, not “fancy” mail. html just means it has html code 
written into the message for you that creates the layout, the space for photos, the 
fonts, etc. You don’t have to write one single piece of code. All you do is choose the 
stationery template, type your message, and drag photos to replace the existing ones. 

To create an email with stationery:
1 open a new email message (Command N or click the “New Message” icon).

2 Single-click the button on the far-right side of the message toolbar; if your text 
labels are showing, it’s called “Show Stationery.” (If you don’t see that button, 
open the window wider, or click on the arrow you see where the button should 
be—that will pop out a menu with “Show Stationery” on it.)

3 A row of stationery templates appears, as shown below. Single-click a category 
on the left, then choose a template on the right. 

4 To replace the text, click it and Mail automatically selects all the text in that 
section. Whatever you type replaces that text, but retains the font.

Resize image.

Reposition image 
within frame.
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Save as stationery
To save your own designs as stationery, set up a message, then go to the File menu 
and choose “Save as Stationery.” A new category appears in the list, called “Custom.” 
Click on it to see your own stationery. To delete stationery you made, position your 
mouse over it, then click the little x that appears in the upper-left corner. 

5 To add photos, you can do several things.
	n Click the “Photo Browser” button in the toolbar (shown below). The Photo 

Browser displays all the photos in iPhoto, Aperture, and Photo Booth. Just 
drag an image from the Photo Browser and drop it directly on top of the 
image you want to replace.

	n Drag an image from anywhere on your Mac and drop it on an existing image.
	n open iPhoto and drag an image directly from iPhoto onto an existing image.

6 To resize photos, click an image and a little slider bar appears, as shown on the 
opposite page. Drag the slider right or left to enlarge or reduce the image.

7 To reposition the image within the frame, click the image. Then press-and-
drag on the image to reposition it within its frame (you can’t reposition the 
frame itself ). 

  To get back to a blank white page, choose the “Stationery” option, then click 
the “original” template.

You can change templates at any point—if there are fewer photos in the new 
template, some of them will disappear. Your text will reappear in the new template. 

Click the “Hide Stationery” button so you have more room in which to write. 
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create Mailboxes to Organize your Mail
Organize your mail with mailboxes in the same way that you make folders in a 
Finder window to organize all the files on your Mac, or the same way you use folders 
for papers in your office filing system. Everything in your Sidebar is considered a 
mailbox, even though most of the “mailboxes” look just like folders. 

once you’ve got your mailboxes set up, drag messages to your mailbox folders to 
organize your email. Better yet, use filters (called Rules; see the opposite page) to 
automatically send incoming mail to the different folders/mailboxes. Also check out 
pages 92–93 about Smart Mailboxes.

To make new mailboxes, do one of the following:
n From the Mailbox menu, choose “New Mailbox….” You get a dialog in which 

to choose where to place that mailbox and what to name it. You can assign a 
mailbox to a specific Inbox account, or nest it inside an existing mailbox.

n Or Control-click (or right-click) directly on the icon in the Sidebar in which you 
want to put the new mailbox. If you put it in an Inbox account, the mailbox 
will appear in the lower portion of the Sidebar, under the name of that account.   

I’ve got three email accounts 
in my Inbox folder.

Mail created these folders   
for me as I needed them.

Once you Flag messages or make Notes, 
you’ll see a disclosure triangle next to this 
folder indicating there is something inside.

These are folders I made to help organize my 
email. I chose to put them “On My Mac,” so 

they are stored on my hard disk (as opposed to 
storing them on the MobileMe servers at Apple).

These are folders that I chose to store in my 
MobileMe account, which means I can access 

them on the web, my iPad, and my iPhone.
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filter your incoming Mail with Rules
Create rules, or filters, to do things like sort incoming mail into an appropriate 
mailbox, highlight certain messages in a particular color, automatically forward to a 
different address, delete a message before it even appears in your box, send an auto-
reply, and more. All filters apply to all email accounts unless you specifically choose 
an account in the Rule itself. If you plan to sort mail into different mailboxes, first 
create the mailboxes you want so you can organize with them (see opposite page). 

To create and apply a rule:
1 From the Mail menu, choose “Preferences….”

2 Single-click the “Rules” icon. Single-click “Add Rule.”

3 Choose your parameters for the type of mail coming in and what to do with 
it. (If you forgot to make a special mailbox for something, you can actually do 
it while the Rules pane is open on your screen: go to the Mailbox menu and 
choose “New Mailbox….” The new mailbox immediately appears in the pop-up 
menu, shown below.)

  In the example below, I first made a new mailbox called “Nikki.”
  Then I created a new rule to find any incoming mail “From” my editor,  

Nikki McDonald, by entering the beginning of her email address. 
  When found, I want that message to move straight into the “Nikki”  

folder and play a little sound so I know it arrived. 

Click the pop-up menu 
button (under here) 
to choose the mailbox 
into which this Rule will 
move messages.

Click + to add more 
options.

The choices 
here, any 
or all, are 
useful to 

limit your 
results.

Poke around in here at all the 
options in all the menus. Add 

more conditions and choose more 
actions to your heart’s content.
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Smart Mailboxes
You can create Smart Mailboxes that will hold all the email messages that meet 
certain search criteria. If you are familiar with Rules (filters), as explained on the 
previous page, you’ll notice there are a couple of differences between Rules and 
Smart Mailboxes.  

n	 A Rule is an action that is applied to incoming messages, such as filtering 
certain email into a certain folder. The original email is moved into the folder.

n	 A Smart Mailbox applies your search criteria to mail that is already in your 
box, not just to future incoming mail.

n	 A Smart Mailbox contains messages that match search criteria. No action  
is taken on the messages. 

n	 A Smart Mailbox does not contain the original message, thus the same 
message can be “stored” in a number of Smart Mailboxes. 

n	 A Smart Mailbox automatically updates itself as messages come in  
or are deleted.

You might be involved in leading a project that involves several people who are each 
working on an individual part of it. Thus you might use Rules to filter their messages 
into subfolders in a main project folder, and you might use a Smart Folder to collect 
all the email pertaining to this project in one place. 

I created a Smart Folder, then inside that 
folder I created two Smart Mailboxes to 
keep track of the project. 
Eventually I might make more Smart 
Folders, and the appropriate messages 
would automatically appear in it.
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3 If you need to edit the parameters of your new Smart Mailbox, select it, then 
either Control-click, right-click, or go to the Mailbox menu and choose “Edit 
Smart Mailbox….”

Create Smart Mailboxes
There are several ways to create a Smart Mailbox. You can use the Mailbox menu 
(below) or the + sign at the bottom of the Message List, or use the parameters 
you’ve designated in a saved search, explained on page 97.

To create a Smart Mailbox:
1 If you go to the Mailbox menu, you’ll see there are two similar options,  

“New Smart Mailbox Folder…” and “New Smart Mailbox….” 

  The Smart Mailbox Folder creates a folder with no search parameters;  
it is simply for organizing other Smart Mailboxes inside (as shown on  
the opposite page). You will only be asked to name the folder and click ok. 

  If you want your Smart Mailbox to be inside of an existing Smart Folder,  
first select that folder in the Mailboxes Sidebar; if not, make sure a Smart 
Folder is not selected. 

  Or click the + sign at the bottom-left and choose “New Smart Mailbox….”

2 You’ll see the dialog sheet below. Name your Smart Mailbox, choose your 
parameters, and click ok.

This Smart Mailbox Folder is selected, so the new Smart Mailbox will be 
placed inside.
Before I created this particular Smart Mailbox, I created the three folders 
and applied Rules to filter specific messages into each one.
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add Signatures to your Messages
An email signature is the little blurb you can automatically add to the bottom of 
your messages. A signature might include your contact information, promotion for 
your upcoming art show or book publication, your favorite quote, or even a small 
graphic. You can make more than one signature, then choose which one you want 
for an individual email message, as a default signature that automatically appears,  
or you can let Mail randomly choose one for you.

This is a signature.

If you have 
created more than 
one signature, you 
can choose which 
one to use in the 
message.

To create a signature:
1 From the Mail menu, choose “Preferences….”

2 Single-click the “Signatures” icon. You’ll see the window shown on the  
opposite page.

3 At the top of the left-hand pane, single-click “All Signatures.”

4 In the middle pane, single-click the plus sign (+). The new one is called  
“Signature #1.” Name it something more relevant.

5 In the right-hand pane, type your signature. From the Format menu at the top 
of your screen, choose “Show Fonts,” then choose a font, size, style, alignment, 
and color. You can use Returns and Tab keys in your signature.

  Don’t choose a font that you have bought or acquired along the way because 
most of your recipients probably won’t have that same font installed. Use one 
of the fonts that came with your Mac.
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6 If you want an image to appear in this signature, drag the image from the Finder 
and drop it into the right-hand pane. Keep in mind that this should be a very 
small image, both in file size and in visual size!

If you like, drag 
an image from the 
Finder and drop it 
in this pane.

7 To assign signatures to email accounts: Drag a signature from the middle 
column and drop it on the account name in the left column. You can have lots 
of signatures, yet choose only certain ones for different email accounts. 

8 Each email account can have its own default signature that automatically 
appears in each email message you write: First select an account in the left-hand 
pane, then use the “Choose Signature” menu circled above (you can always 
choose a different one from the menu, even if one is assigned as a default). 

To use a signature, put the “Signature” menu in your message window:
1 open a new message as if you’re going to write a letter.

2 Single-click the Action button on the left, as shown below, then choose 
“Customize….”

3 Put a checkmark in the box next to “Signature.”

4 Click ok. Now you will see the Signature menu in every new mail  message, as 
shown below. Choose the one you want to use for each individual  message.

You won’t see 
an option to add 
signatures if you 
haven’t made any yet!

Action button.
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Search your Mail
In Mail, the Search feature makes it easy to find just about anything.

1 The default is to search all folders and mailboxes in Mail. To limit the search to 
a particular inbox or mailbox, select it in the Sidebar; to select more than one, 
Command-click each one. If you have messages or Notes flagged with various 
colors, you can choose to limit the color of flag to be included in the search.

2 Enter a word or phrase in the search field (you can use Boolean search terms 
such as or, and, or not, as explained on page 364). note: The Mail search 
only finds words that begin with the letters you enter. That is, if you search for 
quest you will find question, but not request.

  As you start typing in the Search field, the Favorites Bar turns into a Search 
Bar and a menu of suggestions in several categories appears. 

3 As you type more characters, the results narrow and become more specific.  
If you see what you think you’re looking for, click on that item; the Message 
List on the left displays only items that match that suggestion. 

I made a choice 
in the “People” 
category, and 
Mail immediately 
provides more 
options to narrow 
it down, as you 
can see here.

Results are 
categorized by 
Dates, People, 
and Subjects 
(which has 
nothing do to 
with the Subject 
line in a message).

The Search Bar 
appears. At any 

point you can 
click any item in 
the Bar to limit 
your search to 

that item.

4 As soon as you select one of the items in the list of suggestions, the Search 
field gives you yet another option to narrow the search, as shown below.  
What this option displays depends on the category your choice was in. 
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Create a Smart Mailbox from a saved search
You can create a Smart Mailbox (as explained on pages 92–93) by saving a search. 
Anything that satisfies the search criteria will leave a copy in this mailbox. 

1 Do a search as usual, as explained above. 

2 If the search gives you what you need and you think you’ll want to use  
the same search again, click the “Save” button (it’s just below the Search field). 

3 The saved search is automatically named with the search phrase you just used. 
You can refine your search in the edit box, if you like. When ready, click ok. 

5 Your results, be they messages or Notes, appear in the Messages List. 

6 To display all your messages again, click the gray x in the search field.  
As long as there is even one character in the search field, you will see the  
search results instead of your mail.

To search within an individual message, open the message and press Command F.

In this example, 
I made a choice 
in the “Subjects” 
category, so now 
Mail lets me limit 
the search phrase 
to the Subject 
line of the 
message or to the 
entire message.

4 If you need to edit the parameters of your new Smart Mailbox, select it, then 
either Control-click, right-click, or go to the Mailbox menu and choose “Edit 
Smart Mailbox….”
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check your dock icon
When email comes in, your Mail icon in the Dock displays a little red badge that 
tells you how many messages are unread. There is more to that Dock icon than 
meets the eye:

Single-click this Mail icon to bring the Mail window to the front. (You don’t 
have to quit Mail when you’re finished working in it.) 

Right-click (or Control-click) the Mail icon to open a pop-up menu of 
commands and options (below-left), such as “Compose New Message.” These 
commands are also available in the File menu and the Application menu.

Press (hold down the mouse button) the Mail icon to pop up a menu with other 
options (below), such as “Quit,” “Hide,” and “Keep in Dock.”  

The appearance and content of 
this contextual menu changes, 
depending on if the application 
is already open or not. 

Choose “Show All Windows” to display 
all your open messages, as shown below.
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create Notes for yourself
Mail is more than a place to send and receive mail—it’s your central location for 
information. Notes is a handy way to store ideas, thoughts, reminders, or any other 
information you want to keep track of, and the Notes you create can be synchronized 
with your iPhone.  

Create a new Note
To create a new Note, click the “Note” button in Mail’s toolbar. (This button is in 
the toolbar when you’re in the main viewer window, but not when an email message  
is open in a floating window.)

A new, blank Note opens in which you can type a message. Mail uses the first line of 
text as the title of the Note. If you click the “Send Note” button in the Note’s toolbar 
to send the Note as an email, Mail puts the first line of the Note in the email’s 
Subject field. 

To create an automatically bulleted or numbered list,
go to the Format menu, select “Lists,” then choose the 
type of list you want (bulleted or numbered). Type your 
list, hitting a Return after each item. To stop the list so 
you can type regular text, hit the Return key twice.  

If multiple Mail accounts are active, the Note is added 
to the Mail account that was selected in the Mailboxes 
category in the Sidebar.

Compose new Note. 

Message List.

Select a Note in the Message List. Or to show only Notes in the 
Message List, click the “Notes” item in the Sidebar. 

Email this Note. 
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Sync iPhone Notes with Mail
If you create Notes on an iPhone, you can sync those Notes with Mail when you sync 
your Mac and iPhone. Notes created on your Mac are also synced to your iPhone.

1 With your iPhone connected to your Mac, open iTunes,  
then click the iPhone icon in the iTunes Sidebar.

2 Click the “Info” button in the bar at the top of the main window.

3 In the “other” category, check the “Sync Notes” item.

4 Click “Sync.”

View Notes in Mail
Click the Notes mailbox in the Sidebar to display them, as shown below. 

To flag Notes with color-coded flags, making it easier to find later, right-click a 
Note in the list, then choose a flag color from the pop-up menu.

Once a Note or an email 
message is flagged, you can 
choose to see only items 
with a certain color of flag. 
Both email messages and 
Notes will appear in the 
same flagged list. 
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Format and add attachments to a Note
You can format the text in a Note just as you can in an email message, and you can 
add attachments. Just click the appropriate buttons in the Note toolbar.  

To send a Note as email, click the “Email Note” button.

To add an attachment, click the paperclip button; in the sheet that slides down 
from the toolbar, select a file to attach. Or drag a file from anywhere on your 
Mac to the body area of the Note.

To format the Note font style, size, and other formatting, first select the text 
you want to format, then click the “Show Fonts panel” button. In the Fonts 
panel, choose the formatting options you want.

To delete an attachment, click to select it, then press Delete.

To open an attachment in its application, double-click the attachment in the 
Note or in the email message. Single-page pdf attachments are displayed in 
the message as an image, similar to the jpeg shown below; multiple-page pdf 
attachments appear in the message as a file icon that you must click to open 
and view.

Use these buttons to: 
Email Note (see the example below). 
Attach a document or photo to this Note. 
Show Fonts panel to format and color text.

When you click the Email Note button, an email 
window opens with the Note inside the message area.



ptg6934589

Lesson 5 Mail for Email and Notes

102

automatic data detection in Messages
This is amazing. As you might have seen in TextEdit, your pointer becomes a data 
detector, capable of recognizing dates and location information. When you hover 
the cursor over a day, date, or address in an email message (or a note), the infor-
mation highlights with a gray dotted outline and adds a data detector button  
(a triangle symbol, shown below).  

If you click the data detector button on a date, you can create an iCal Event for that 
date. Click it on an address, and you can show a map of the address or create a new 
contact in Address Book, using the address information.

Create an iCal Event from date and time info
1 Hover the pointer over a date in a message. A gray dotted line appears around 

the date (or month, day of the week, or even a word like “tomorrow”).

2 Click the data detector button (the triangle) to show a pop-up calendar with  
the date inserted (shown at the top of the next page). 

  To add the information to iCal as an Event, click “Add to iCal” in the 
top-right corner of the pop-up. 

  To expand the pop-up and add more information, or to edit the existing 
information, click the “Edit” button. In the expanded calendar dialog, you can 
select a calendar to put the Event in, change the time, create alerts, etc.

3 After editing, click “Create.”
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When you click a date or time that’s highlighted by the data detector in your pointer, 
the information is automatically added to a minimal calendar form (above, right). 

Choose “Show Map” to open a Google map 
of the location.

Create a contact, add to an existing contact, or show a map
1 Hover the pointer over an address in a message. The pointer’s data detectors 

sense location information and border the address with a dotted line and a 
data detector button (a gray triangle).

2 Click the data detector button to show a pop-up menu of options: “Create  
New  Contact…” (in Address Book), Add to Existing Contact…,” “Show Map,” 
and “Copy” (an easy way to copy an address so you can paste it into a Note). 
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Mail attachments
one of the greatest things about email is the ability to send files and photos back 
and forth. Mail has some great features for attachments, making it easier than ever. 

To send an attachment:
1 open a new message window and type your message.

2 Click the Attach button in the toolbar (the paperclip). 
  A sheet drops down from the message window toolbar. Find your file, select 

it, and click “Choose File.” To select multiple files to attach, hold down the 
Command key and single-click each file.

  Or drag a file or photo from anywhere on your Mac and drop it directly into 
the message window. Or click the Photo Browser button in the top-right 
corner of the message window, then navigate to the photo you want to attach.

3 The file appears in your message window. If it’s a one-page pdf or a photo, the 
actual image appears, as shown below. If the attachment is a multi-page pdf, a 
text file, or any number of other file types, it appears as a file icon, not an image. 

4 Send the email (click the paper airplane button).

Resize the image, if necessary, 
before you send it.

Open the Photo Browser 
and find photos to attach.

Send.
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Control-click (or right-click)  
a file icon in a message to  
open a pop-up menu of options.

To receive and download an attachment:
1 An attachment appears in a Mail message as an actual image or as a file icon, 

shown below, left.  

2 If it’s a file or photograph, you can do any of several things:

  Drag the file to the Desktop or directly into any window or folder  
on your Mac, or into a folder in a Finder window Sidebar. 

  Or Control-click (or right-click) the file name. Choose an option from the 
pop-up menu that opens (shown below).

  Or if the attachment is 
an image, save it directly 
into iPhoto: Control-click 
(or right-click) the photo 
(or select all the photos), 
then from the pop-up 
menu, choose “Export to 
iPhoto.”

—continued

The option you’ll probably use 
most is “Export to iPhoto.” 
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View lots of photo attachments as a contact sheet
This happens often: Someone sends you multiple photographs in an email message. 
Instead of scrolling through them, you can view them as a contact sheet or as a 
slideshow, using Quick Look.

From the File menu, choose “Quick Look Attachments.” In the Quick Look window:
Use the arrow buttons in the toolbar to cycle through the photos like a slideshow. 
Or click the “Contact Sheet” button to show all photos at once.    
Or click the “open with Preview” button to open all the photos in the Preview app. 
Or press (don’t click) on the button to open a pop-up menu of other options, such 
as “Add to iPhoto.”  

This email contains four  
large photo attachments.
Quick Look provides the 
viewing options shown below.

Slideshow buttons. View as a Contact Sheet.

Click a thumbnail in the Contact 
Sheet (below) to display the image 
full-frame, as shown to the left.
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Save attachments to a location you choose
To save one or more file attachments, go to the File menu and choose “Save 
Attachments…,” then choose a location in which to save them. By default the 
Downloads folder is selected (although you can choose any location you want). 
open the Downloads folder (in the Dock or in your Finder window Sidebar) to get 
to the saved files. 

A copy of the Downloads folder is in the Dock; you can view the contents as a 
“Stack” (a stack of icons) or as a “Folder,” as shown at the bottom of the page. To 
determine how the folder is displayed in the Dock, Control-click (or right-click) 
the Downloads folder in the Dock to show a pop-up menu, then select “Folder” 
or “Stack” (below, right). Next, to determine how the content of the folder is 
displayed when you select the folder in the Dock, choose “Fan,” “Grid,” or “List”  
(all shown at the bottom of the page).

Downloads content viewed as a Fan. The same content viewed as a Grid. The content viewed as a List.

Control-click the Downloads folder 
in your Dock to set the view options. 

The Downloads folder in your Sidebar (above) is the  
same as the Downloads folder in the Dock (below).
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GoALS

Make and edit   
contact cards

Add photos   
to your contacts

Designate your own card   
for automatic fill-in   

on web pages

Create mailing lists (Groups) 
and Smart Groups

Search your Address Book

Share your contacts   
with MobileMe members

Print envelopes, a list   
of contacts, and more

An introduction to iCloud
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LESSON  6

Address Book  
for Contact Info
The Address Book is a great contact list that is much more com-

plete than its simple appearance might lead you to believe!

Enjoy the drag-and-drop ease of creating groups and sending 

everyone in the group a message. Create Smart Groups so that 

new contacts that meet certain criteria are automatically added to 

the group. Show a Google map of an address with a single click, 

start a new email message with a contact, and more.

Address Book is integrated with Mail and iCal so you can easily 

and quickly send messages and invitations to your contacts.

Address Book supports directories hosted on network servers, such 

as Microsoft Exchange, Lightweight Directory Access Protocol 

(ldap) servers, and Internet accounts such as Yahoo! and MobileMe.

Address Book syncs automatically with iCloud (Apple’s free auto-

matic storage and syncing solution) to keep all of your devices sycned 

and updated.
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how you’ll Use your address book
First is a brief description on how you can use this great application.

You can customize individual cards and/or add new fields to all of them. For 
instance, you can add a birthday field or a nickname field. You can change the labels, 
add a photo or image, and customize the address for another country. 

You can create Groups of addresses to make a mailing list so you can mail everyone 
in the Group with one click. 

In Mail, all the contacts you put in your Address Book will be available via the 
Address Pane (you can’t add, edit, delete, or group addresses in that pane—you  
can just access them for emailing; see page 86). 

While in Mail (not Address Book) you can automatically add an address from an 
email you receive: open the email, Control-click (or right-click) the email address 
in the “From” field to get a contextual menu, then choose “Add to Address Book.”  
If that contact information is already in your Address Book, the pop-up menu item 
says “Show Contact Card.” 

Your iPhone or iPad will synchronize with all the addresses or with certain Groups 
that you specify (when using iTunes to sync your mobile device). As you add contacts 
to your iPhone or iPad, they will automatically be added to your Address Book on 
your Mac the next time you connect and sync your mobile device. 

Click here to show Groups.

To resize 
the Address 
Book, drag 
any corner or 
any edge.

Select a contact on the left to show the contact information on the right.
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create and edit New cards
To make a new card, (sometimes called a vCard, or virtual card), click the + sign in 
the bottom-right corner of the “All Contacts” page. The new, blank contact card is 
displayed on the right page, ready for you to add information.

To edit an existing card, select the card name on the “All Contacts” page on  
the left, then click the “Edit” button on the card on the right. When finished, 
click “Done.” 

After you fill in a field, hit the Tab key to highlight the next field, ready for you 
to type in it. To skip that field, hit the Tab key again.

To delete a field, click the red button to the left of it (although if a field is empty, 
it will disappear when you finish editing). 

To change an existing field label name, click a label (a field name). A menu 
pops up with a list of other label options. If none of them fits, click the 

“Custom…” item and create your own label. 
To open a card in its own floating window, double-click a contact name. 

Only fields that contain information are visible after you leave edit mode.
Check out the preferences for Address Book (from the Address Book application menu): 
Use the “Phone” pane to automatically format phone numbers so you don’t have to type 
hyphens and parentheses. Use the “General” pane to choose a sort option for names. 
Use the “Accounts” pane to synchronize your contacts with your MobileMe, Yahoo!, or 
Exchange accounts.

Choose 
a display 

mode.

You can 
alphabetize 

(sort) by first 
or last name; 
see the tip at 

the bottom of 
this page.

Toggle between 
Edit and Done.

Click a field and 
type. You don’t 
have to delete 
first—the blue 
color indicates 
it’s ready for 
you to type.
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Add a photo to a card
You can add a photo to any contact card. That photo will appear in email that you 
receive from that person; it will be transferred to your iPhone so you can see his 
handsome face when he calls; and you can print it with his contact info. 

To add a photo to a contact card:
1 Go to that card in your Address Book. 

2 Double-click the empty photo space to the left of the name. A sheet appears:

3 Drag any type of image into the pane, or click “Choose…” to find a photo 
on your hard disk, or click the camera icon to take a picture of yourself or 
someone near you.

4 To resize the image, drag the slider to the right or left.
  To reposition the image, drag it around inside the cropped space.
  To apply an effect, click the Effects button.

5 Click “Set” when you like it.

add photos via your iPhone
Next time you add someone’s contact info to your iPhone, take a photo of that 
person. When you sync your iPhone to your Mac, this photo will automatically 
appear in your Address Book; when you get email from this person, his photo  
will appear in the message. 

Apply an effect.Capture a picture.
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A tiny human silhouette to the 
right of your name in Address 
Book marks it as “My Card.”

designate your Own card
In your Address Book, you can designate the card with your contact information on 
it as “My Card.” other applications, Safari and iChat in particular, will use that infor-
mation in various ways, such as filling in forms online, accessing your email address, 
and displaying your photo. 

Enter a card for yourself in the Address Book. Then go to the Card menu and choose, 
“Make This My Card.”  

To keep some of the information private so it won’t show up if you send your vCard 
(virtual card) to someone else (as explained on page 119): 

1 Go to the Address Book preferences (under the “Address Book” menu). 

2 Click the “vCard” icon in the toolbar.

3 Check the box to “Enable private me card” (if it isn’t already.)  
Close the preferences.

4 Go to your own card and click the “Edit” button. You’ll see a blue checkbox  
for each item on your card; the checkmark means it is public information. 
Uncheck the boxes that you want to be private. 
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add fields to One card or all cards
The fields for data only appear on the card if there is data in them; otherwise the 
fields disappear, which is kind of nice. Select a card and click the “Edit” button to 
see what fields you might have on a card that are not filled in. 

You can add a number of other fields to an individual card or to all cards.

To add a field to ONE card: 
1 Select that card. 

2 From the Card menu in the menu bar across the top of your screen,  
slide down to “Add Field,” and make a choice from the pop-out menu  
(such as “Birthday”).

To add a field to EVERY card: 
1 From the Card menu, choose “Add Field,” then choose “Edit Template….” 

  Or go to the Address Book menu and choose “Preferences…,” then from  
that toolbar, click on the “Template” button.

2 Click the “Add Field” button to display its menu. Field names in the list that 
are gray and checkmarked are already on the card template. Choose any field 
name that is black and it will be added to all of your cards. 

  To add more fields to a category, click the green button to the left  
of the field name.

  To remove fields, click the red button to the left of the field name.

Add or remove 
fields from the 
card template.
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check Out the Options 
There are lots of hidden options in the Address Book. For instance, single-click 
the labels to the left of the fields on a card—you’ll get little menus, depending on 
what you click on. Check them out! Click an email label, then choose “Send Email.” 
Select “FaceTime” from the little pop-up menu and your Mac makes a video call to 
the contact’s iPhone 4 (or newer). The FaceTime option is also available in the email 
label, so you can make a FaceTime video call to the contact’s computer (FaceTime 
uses email addresses to call FaceTime users on their computers, and it uses mobile 
phone numbers to call FaceTime users on FaceTime-capable iPhones and iPads).

Map it
You can instantly get a Google map of any address in your Address Book (you must 
be connected to the Internet, of course).  

Click the label to the left of an address in Address Book. A little menu pops up 
where you can choose “Map this Address.” Safari opens to Google Maps and 
displays the location of that address. Very useful!

By default, scroll bars 
don’t show unless you 
start scrolling. You can 
change this setting so 
they always show: Go 
to System Preferences, 
choose “General,” then 
click the button for 

“Show scroll bars: Always.”
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create a group
When you make a Group mailing list, you can send email to the name of that 
Group and your message goes to everyone in the Group. 

To make a new Group: 
1 Click the red Group bookmark icon (shown to the left) to show Groups on 

the left-hand page. When you select a Group on the left-hand page, the group 
members appear on the right-hand page.

2 Click the + sign in the bottom-left corner of the Group page. 

3 A new “untitled group” is created. Rename it (“Family,” for example). 

4 Now select the “All Contacts” group, then drag contact names from the right-
hand page and drop them on the new Group name, as shown below. You can 
put the same name in many different Groups. 

To open a Group: Double-click the Group name in the Group list.

To create a Group from a selection: Select multiple contacts, then from the File 
menu, choose “New Group From Selection.”

To delete a Group: Single-click its name and hit the Delete key.

To email a message to a Group: on the Group page, Control-click (or right-click) a 
Group name, then choose “Send Email to group name.” In Mail, type the name of the 
Group in the “To” field of an email message.

To prevent all the addresses from appearing in the “To” field of everyone’s email:
1 open Mail (not Address Book).

2 From the Mail menu, choose “Preferences…,” click “Composing” in the toolbar, 
then uncheck the box, “When sending to a group, show all member addresses.”

Drag a card over 
a Group name, 
then drop the 
card when the 
Group turns blue.

Click to switch from Groups to individual contacts.
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to discover which groups a contact is in, select a contact 
name, then press the Option key. The selected contact is included in 
every Group that turns blue.

create Smart groups in address book
A Smart Group is a list of contacts that automatically updates itself as new contacts 
are created that meet its criteria or as information for other contacts changes. For 
instance, you might want a Smart Group that automatically adds people who work 
for a certain company or who are part of your literary salon. You can create a Smart 
Group that tells you when birthdays or anniversaries are approaching. or you might 
want to gather a list of everyone in a particular city without having to find them all 
in your Address Book—a Smart Group will automatically collect them.

Most of these searches require, of course, that you have a particular field on your 
card and that it has data in it. For instance, you can’t have a Smart Group that tells 
you when a birthday is coming up if you don’t have the Birthday field on your cards. 
For directions on how to add new fields, see page 114. 

To create a Smart Group:
1 From the File menu at the top of the screen, choose “New Smart Group….”  

Or option-click the + button on the bottom of the Group page. or press on 
the + button, then choose “New Smart Group…” from the pop-up menu. 

2 In the sheet that drops down, choose your parameters.

3 If you need more parameters to narrow or expand the possible items  
in the Group, click the + button in the sheet (circled, above-right).

4 Click ok.
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Search your address book
You can do a standard, simple search for anyone or any information in your 
collection of contacts. And you can do a Spotlight search of anyone in your Address 
Book that searches your entire hard disk for everything related to that person. 

To search your Address Book for a contact:
1 To search your entire database of contacts, select the “All Contacts” group.  

To search within a specific Group, select that Group.

2 Single-click in the search field, or press Command F.

3 Type any letters in the person’s name or any other data you want to find.  
As you type, results appear in the list of contacts on the right-hand page. 

  This search also looks at any words or comments you’ve entered in the “note” 
section at the bottom of a card. 

4 Type more letters to narrow your search, or single-click one of the contacts  
on the search results page.

5 To show all of your contacts again, click the x in the search field to clear it.

Click this x to clear the search field. Search. Search results.
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To search for a person or business in Spotlight:

1 Find the person you want to Spotlight, as explained on the previous page.

2 Control-click (or right-click) the person’s name. From the pop-up menu that 
appears, choose “Spotlight: This Person” (where “This Person” is the name of  
the contact you just searched for; that name automatically appears in the 
menu, as shown below).  

3 A Finder window of Spotlight search results opens, as explained in Lesson 19. 
It shows every file on your computer that is connected with this person, such 
as email she’s sent you, files she’s mentioned within, documents she has created 
and sent to you, images of her, and more.

Send an address book card to Others
So easy: Just click on the “Share” button on any contact card. This opens Mail with 
an email message ready to send that includes the vCard of this contact in the body.
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Merge duplicate cards
This happens all the time: Somehow you have more than one card for a contact; 
one card has partial information, while another card has duplicated information 
or different kinds of information. You can merge these disparate cards into a single 
card, and keep all the information that’s unique to each one. The cards you want to 
merge have to be in the same account, such as “on My Mac” (the contacts on your 
Mac), Carddav, Exchange, ldap, or Yahoo! accounts.

Merge all duplicates
1 If you have accounts other than “on My Mac,” select an account in the Group list. 

2 From the Card menu, choose “Look for Duplicates….”
  An alert tells you if duplicate cards are found, or cards that have the same 

contact name but different information. The alert also tells you if information 
is duplicated on a single card, such as the same email address twice.

3 As an option, you can click the checkbox to “Also merge cards that have the 
same name but contain different information (such as phone numbers and 
addresses)”. This option only appears if such duplicates are found.

4 Click Merge. Address Book merges the unique information from each 
duplicate into a single card.

Merge selected duplicates
Command-click to select the cards you want to merge, then from the Card menu, 
choose “Merge Selected Cards.” 

Address Book creates a single card, merges the unique information from each card, 
and uses the name and picture of the card that appeared first in the list.
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invite contacts to an ical event
Invite specific contacts or an entire Group to an iCal event, such as a wedding party 
for your friends or a meeting for business associates.

1 open iCal.

2 Go back to your Address Book and select one or more contacts or Groups.

3 Drag the selection to the iCal window and drop it on a date in a calendar.

4 iCal creates an Event. Set the time and other Event options. The contacts are 
listed as invitees in the Event window.

5 Click the “Send” button in bottom-right corner of the event window  
(shown below). Email notifications are automatically sent to all invitees.

To remove an invitee from the list, select the name, then press Delete.

For more information about adding events to a calendar, see Lesson 8 on iCal.

If an invitee is not 
highlighted with blue, it 

means that contact card is 
missing an email address. 

Rename the Event anything you want.
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Share your address book contact List
If you are a MobileMe member (see www.Apple.com/mobileme), you can share 
your entire contact list with other MobileMe members. This can be useful for 
families, teens and their friends, organizations, businesses, and others. And you can 
subscribe to someone else’s shared Address Book, provided that person has already 
put you on their shared list. 

Remember, you must have a MobileMe account to share, and the only people who 
can share your Address Book are other MobileMe members running an operating 
system of Mac os x, version 10.4 and newer. The people you want to share with 
must already be in your Address Book as contacts, so if they’re not there yet, add 
them before you follow these steps!

1 From the Address Book menu, choose “Preferences….” 

2 Single-click the “Accounts” icon in the toolbar.

3 Click the “Account Information” tab and check the box “Synchronize with 
MobileMe.” You can also choose to synchronize with Yahoo! or Google, if you 
have accounts with them.

4 This causes a “Sharing” tab to appear, as shown above. Click the “Sharing” tab, 
then check the box to “Share your address book.”

5 You must choose who is allowed to access and share your Address Book: 
Single-click the + sign under the sharing pane.

6 A sheet drops down to display the contacts in your Address Book (shown 
on the next page). Select the names you want to share with; hold down the 
Command key to select more than one name. Click ok.

www.Apple.com/mobileme
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7 After you add names, you can send an email inviting someone to share your 
Address Book: Single-click a name (or Command-click several names), then 
click “Send Invitation” (circled, above).

Subscribe to someone’s Address Book
You can only subscribe to an Address Book that someone else has already shared, 
as explained above. And that person must have already selected you to share with. 
once that’s done:

1 In your own Address Book, go to the File menu and choose “Subscribe  
to Address Book….”

2 Enter the MobileMe email address of the person whose Address Book you 
want to subscribe to, then click ok. 
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You can save the job as a pdf, then send 
that pdf to someone else to print.

Print in a Variety of Ways
From Address Book you can print mailing labels, envelopes, customized lists, and 
even pages that fit into a standard pocket address book. 

1 First, in Address Book, select the names or the Group that you want to print.

2 Press Command P to open the Print dialog sheet, or from the File menu, 
choose “Print.” 

  If you don’t see the full print dialog pane as shown above, click the “Show 
Details” button in the bottom-left corner. After you click the button, it changes 
to say “Hide Details” (shown above). 

3 From the “Style” pop-up menu, choose what you wish to print—envelopes, 
lists, mailing labels, or pocket address book. Each style has different param-
eters to experiment with. Whatever you choose displays in the preview. 

4 In the “Attributes” pane, check the information you want to include.

5 Click “Print.”
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Spend some time poking around this dialog box so you know what all your options 
are. As you can see below, you can add an image to your return address, choose 
different fonts and colors for the text, choose different envelope sizes, and so much 
more that it’s just amazing. 

To print a return address, check the “Print my address” box. Address Book automati-
cally uses your “Me” card for the return address. If you want it to use another card, 
go back to the Address Book, select that other card, go to the Card menu, and choose 

“Make This My Card.” You can switch it back when you’re done printing. of course, 
you can uncheck the box so it doesn’t print any return address at all. 

To add an image or logo to your return address, click the “Label” tab 
(above), then click the “Set…” button next to “Image.” You can also 
change the font, text color, and more.
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back up your entire digital database
There are few things more annoying than losing your entire Address Book that you 
have carefully created over the past year or two. You have a couple of options for 
backing up your entire Address Book. 

n	 one way is to press on the “All Contacts” group name, then drag it to the 
Desktop. A vCard named “All Contacts” is created on the Desktop (shown 
below). You can then copy the vCard to another disk for safekeeping. You  
can also choose any Group or a selection of specific people and drag it to  
the Desktop to create a vCard that contains just those contacts.

	 You can send this vCard to someone else on a Mac; she double-clicks  
it and the addresses automatically get entered in her Address Book.

n	 Or go to the File menu and choose “Export,” then “Address Book Archive….” 
Your Mac will make a file for you and ask you where to store it. 

	 To restore your Address Book, double-click this file. or, from the File menu, 
choose “Import,” then select this Address Book archive. 

	 Remember, a backup is only useful if it’s not in the same place as the original. 
That is, don’t keep it on your hard disk—if your hard disk goes bad or your 
laptop gets stolen, both the original and the backup will be gone! Copy the file 
onto an external disk, upload it to your iDisk if you have a MobileMe account, 
or email it to a colleague for safekeeping.
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View Multiple contacts with exposé
Double-click a contact name to open it in its own floating window. You can open as 
many contacts as you want and have them all visible on the screen at the same time.

To keep the cards separate and accessible, you can minimize them (click the yellow 
dot) behind the Address Book icon in the Dock: Go to System Preferences, choose 

“Dock” preferences, then check the box “Minimize windows into application icon.” 

To access the minimized cards, press (don’t click) on the Address Book icon in the 
Dock until a menu appears that lists the minimized cards. Select a card from the list, 
or to bring forward all minimized cards, choose “Show All Windows.”

Or use Dock Exposé, if you have a Magic Mouse: Position your pointer on top of 
the Address Book icon in the Dock, then double-tap with two fingers on a Magic 
Mouse. This shows the Exposé view of Address Book, shown below. Click one of the 
card thumbnails to bring that card forward, or option-click one of the thumbnails 
to bring all minimized cards forward.

Address Book.

Cards that are 
minimized and hidden 
behind the Address 
Book icon in the Dock.
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GoALS

Take advantage of   
the Top Sites feature

Search web pages 

Organize your bookmarks

Let Safari fill in forms

Block pop-up windows

Use SnapBack so   
you don’t lose a page

Become a more efficient 
web surfer with tabs

Save or email   
entire web pages

Create web clip widgets

Browse privately

Master RSS feeds

Make a Reading List
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LESSON 7

safari for Web Browsing  
and News

Safari is Apple’s beautiful web browser for viewing web pages 

on the Internet. You’ve probably already used it, but you might 

be surprised at the tips and tricks it offers that you haven’t taken 

advantage of yet.

Safari also includes its own “news reader” that brings in rss feeds. 

RSS stands for Really Simple Syndication. It’s an Internet technol-

ogy that “feeds” you news and information of your choice from 

a huge variety of sources. Safari can gather the rss feeds you are 

interested in and display the headlines from many sources in one 

place—a web page. You’ll have access to them with one click of 

a button, and you can  organize the information, filter the feeds, 

automatically update them, and more. 
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Safari Web browser
Below is a brief overview of the main features of the Safari window. Although it 
looks simple, it holds a lot of power in subtle ways.

browse in full-Screen Mode
To enter full-screen mode and fill your screen with the current 
web page, click the full-screen icon in the top right corner of a Safari 
window.   

To exit full-screen mode, move the pointer to the top edge of the 
screen. When the Mac’s menu bar appears, click the blue double-
arrow icon on the far right.

Status Bar. If you don’t see this bar, go to the  
View menu and choose “Show Status Bar.”

Bookmarks Bar.   
If you don’t see 

this bar, go to the 
View menu and 

choose “Show 
Bookmarks Bar.” 

See close-up, 
below.

Drag any edge or the corner 
to resize the window.

Click to enter  
full-screen mode.

Reload  
a web page.

Single-
click the 
magnifying 
glass to send 
your search 
phrase 
to Bing 
or Yahoo 
instead of 
Google.

Customize the Toolbar:
Control-click on it.

Show Top Sites.

Previous/Next page.

Add a bookmark for the current page.

Bookmarks Bar.  Show Reading List.   

Show Bookmarks Cover Flow view.   
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Quickly access your top Sites
Safari keeps track of your top sites, based on how often and how recently you visited 
them. To display your top sites as a wall of previews, click the Top Sites icon in the 
Bookmarks Bar. The top sites change, depending on your browsing activity. 

To open a top site in the browser window, click its preview.  
To open a web page as a tab (see page 137 about tabs), Command-click the preview.  
To search your browsing history, enter a keyword in the “Search History” field.  
To edit your Top Sites display, click the Edit button.

This symbol means 
the page has 
changed since  
you last viewed it.

Enter a keyword 
or phrase to 
search previously 
visited sites.

Click “Edit” to modify the Top Sites content (shown below).

Show Top Sites.

Preview size determines how 
many sites (up to twenty-
four) show in the display.

Click a thumbnail to 
select it, then drag 
it to any position.

Click the X to remove a site from the display.
Click the pushpin to prevent the site from 
being replaced by another site.

Click “Done” when you 
finish editing Top Sites.
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bookmarks
The bookmarks in Safari are powerful and easy to use. 

The Bookmarks Menu, above, drops down from the menu bar at the top of the screen. 

The Bookmarks Bar is the horizontal strip in the Safari window, just below the 
address field, shown on the opposite page. To show it (if it isn’t already showing),  
go to the View menu and choose “Show Bookmarks Bar.”

The Bookmark Collections are the various folders you create to organize lots of 
bookmarks. With Collections (folders), you don’t have to put everything in the 
Bookmarks menu. Click the “Show all bookmarks” button ( ) at the far-left edge 
of the Bookmarks Bar when you want to open the Bookmark Collections and make 
new folders for organizing. 

When you hit Command D to create a bookmark (or click the plus sign on the left 
side of the web address field), a little sheet drops down and asks where you want to 
store it. You can rename the bookmark at that point and choose to store it in any 
folder you have already made in the bookmark Collections. 

Organize your bookmarks with folders (Collections)
1 From the Bookmarks menu, choose “Show All Bookmarks,” or click the  

book icon on the far left of the Bookmarks Bar.

2 In the bottom-left of the window, click the + sign. This puts a new bookmark 
folder (named “Cool sites” in the example on the opposite page) in the Sidebar. 

3 To put this new folder in the Bookmarks Menu or the Bookmarks Bar so 
you can access it easily, click “Bookmarks Menu” or “Bookmarks Bar” in the 
Collections list in the Sidebar. Now drag the new folder from the Sidebar and 
drop it into the bookmark pane on the right. 

 A folder in the Bookmarks Bar displays a small triangle to its right, which is 
your visual clue that the item is a folder full of bookmarks.

Drag bookmarks or folders up and down in the list to rearrange them. You can also 
drag them directly from the Sidebar and drop them onto the Bookmarks Bar.

Choose this option to open the Safari 
Sidebar and show the bookmark Collections, 
shown on the opposite page.
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bookmarks in cover flow View
First of all, if the Bookmarks Bar isn’t visible, go to the View menu and choose “Show 
Bookmarks Bar.” To show a Cover Flow view of all your bookmarks (the Bookmarks 
Library), click the Show all bookmarks icon on the left side of the Bookmarks Bar 
(the book icon, shown to the left and circled below).  

To search a Bookmark Collection listed in the Sidebar or a specific folder of book-
marks you’ve created and organized: Select the item in the Sidebar, then enter a 
keyword or phrase in the search field located in the top-right corner.

Search field.

Search results.  
To open a found page, 
click the large thumbnail 
in the top pane, or 
double-click the file 
name in the bottom pane. 

Create and 
name a new 
folder (such 
as “Cool sites,” 
shown above).

To get rid of 
the Cover 
Flow view, 
drag this tab 
all the way to 
the top.

Safari 
Bookmarks 

Sidebar

Choose to search “All” (History and all folders) 
or just the Collection selected in the Sidebar 

(which in this case is History).

This lower pane ordinarily shows a list of items  
in the currently selected Collection in the Sidebar. 
Right now it shows the search results.
To create a new subfolder in a Collection, select the 
Collection name and then click the plus button.
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3 In the main pane, folders that you’ve put in the Bookmarks Bar have an “Auto- 
Click” checkbox (circled above). Put a check in one of the “Auto-Click” boxes. 
Instantly you’ll notice that the tiny triangle in the Bookmarks Bar next to the 
folder name has changed to a tiny square. Click the tiny book icon to leave the 
Bookmarks pane and go back to a web page.

4 When you click a folder with the tiny square, every rss page in that folder 
opens, each in a different tab (shown below). Single-click a tab to go to that 
page. Drag a tab left or right to change its position in the Bookmarks Bar.

To close a tab, hover 
over it, then click the x

that appears on the left.
To close all tabs,

Option-click the x. Tab is loading a page.Click to close the tab.

auto-click to Open entire collection in tabs
Safari has a nifty feature called “Auto-Click” that lets you load all the web pages in 
a Collection into different tabs with the click of a button. Instead of going to each 
individual page one at a time and losing the previous page, you can open and peruse 
them all, each in its own tab. This only works when the folder (the collection) is 
stored in the Bookmarks Bar (as explained on page 132).

To view all pages in tabs automatically:
1 Click the tiny book icon in the far left of the Bookmarks Bar.

2 In the Sidebar, select the “Bookmarks Bar” collection. 

A square indicates 
that all bookmarks 
in this collection will 
open in separate tabs 
(shown below).
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fill in forms and Passwords automatically
Safari can fill in online forms with the information you have entered into your 
Address Book; it takes the data from the card you have designated as “My Card”  
(use the Card menu in Address Book to do that; see page 113). You can also tell  
Safari to remember your user id and password for specific sites, which is great if  
no one else uses your Mac (or if you have set up different users; see Lesson 18). 

To enable Safari to fill in forms and passwords, go to the Safari Preferences and 
click the “AutoFill” icon. Check the appropriate boxes. 

Next time you start to fill in a form, Safari will fill it in for you. Next time you go to a 
page that needs an ID and password, go ahead and fill them in, then Safari will ask if 
you want to save that information.

To delete saved user names, passwords, or forms, go back to the AutoFill 
preferences, above. Click the “Edit…” button next to the items you want to remove. 
In the sheet that opens, select one or more specific sites, then click “Remove.”  
or click “Remove All.”

AutoFill is turned off when you turn on private browsing, explained on page 143.

block Pop-Up Windows!
Go to the Safari menu and choose “Block Pop-Up Windows.” Woo hoo! only 
pop-up windows that you click on will appear—none of those obnoxious ads.

occasionally, however, this can cause a problem. You might run across a web site 
where you click on a link for extra information and nothing happens. This might 
be because the extra information appears in a pop-up window. If so, go back to the 
Safari menu and choose “Block Pop-Up Windows” again to remove the checkmark. 

Delete your password 
information from websites 
if it’s no longer needed.

Edit the information in 
your Address Book card.
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Snapback to a Search Results Page
Do you see the little orange arrow in the Google search field below? It indicates a  

“SnapBack” page. 

When you do a search through the Google search field in the upper-right corner 
of Safari, you get a page of results. As soon as you click on a link on that page, the 
SnapBack arrow appears. Wherever you surf, you can always click the SnapBack 
arrow to return to the original results page.  

Quickly enlarge or Reduce a Web Page
Safari can scale entire web pages, both text and graphics, to show the page elements 
larger or smaller. This technology is called “resolution independent scaling.” 

To make a web page larger or smaller, use the keyboard shortcut Command + (plus 
sign, larger) or Command – (minus sign, smaller). You don’t have to select anything 
before you use the shortcut. 

You can also add a “scaling” shortcut button to your Toolbar: From the View menu, 
choose “Customize Toolbar….” From the sheet that opens, drag the “Zoom” buttons 
to Safari’s Toolbar. To enlarge a web page, single-click the larger “A”; to reduce a 
web page, single-click the small “A.” 
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tabbed browsing
When you click a link, of course, Safari takes you to another page and thus you lose 
track of the one you were on. Besides taking advantage of the SnapBack feature 
described on the previous page, you can also choose to open web pages in tabs. 
Instead of losing your original page, a tabbed page gets loaded and displays as a tab, 
as shown below. 

To use tabbed browsing, first go to the Safari menu, choose “Preferences,…” then 
click the “Tabs” icon. Spend a few minutes to sort out the options. For instance, if 
you check the second box, shown below, the tabbed window will immediately come 
to the front instead of lining up behind the current page.

Also see page 134 about 
“Auto-Click”: display all 
bookmarks in a folder as 
individual tabs, all at once.

Click a tab to 
display that page. 
Option-click the 
x to close all open 
tabs except the 
one you clicked.
Drag a tab left or 
right to change its 
position.

Hover your pointer over a tab to show this x symbol. Click the x to close the tab.

To open any link into a tabbed page, Command-click the link (hold down the 
Command key and click the link). You can also right-click and choose from a 
number of options.

Command-click on a number of links and they will all load themselves into 
individual tabs. Then when you’re ready, click any tab to display that page, while 
leaving your original results page still available (as a tab).
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find a Word or Phrase on the current Page
To find a word or phrase on the page you are looking at (as opposed to searching the 
Internet for it), press Command F. Then just type—Safari knows to put the search 
term in the search field that appears in the top-right corner. 

To make it easy for you to see the found word or phrase, Safari dims the rest of the 
page and highlights every instance of what you’re looking for, as you can see below. 
Just click on the page to return it to normal. 

To make Safari highlight the next found instance with yellow, press Command G. 
Each time you press Command G, Safari highlights the next found instance of the 
search term you typed.

Safari holds onto that search. You can go to another page and hit Command G 
again—Safari will search for the last word or phrase you requested. In fact, you can 
close or even quit Safari and the next time you open it, Command G will find results 
of the last word or phrase you were looking for. 

This search field 
appears when you 
press Command F 
to find something.
It will stay there 
until you click the 

“Done” button.

Search results. 
Click the arrows 
to show Next or 
Previous matches. 
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email a Web Page or a Link to a Web Page
Safari makes it especially easy to email an entire web page to anyone, complete 
with images and links. 

1 open the web page in Safari. 

2 From the File menu, choose “Mail Contents of This Page.”

3 The Mail application opens with the name of the web page as the subject.  
The entire web page is in the body of the email. All you have to do is add  
the recipient’s address and click the “Send” button. 

or email just the link. Follow the steps above, but choose “Mail Link to This Page.” 

To make emailing a link to a web page easy and fast, customize the Safari toolbar 
with a “Mail” button: Control-click on the Safari toolbar, then choose “Customize 
Toolbar….” From the sheet that appears, drag the “Mail” button to the Safari toolbar. 
Click “Done.” The next time you want to mail a link, click the Mail button.  

View Pdf documents
To view a PDF document right in Safari, just drag the pdf file and drop it into the 
middle of any Safari page. 

To enlarge or reduce the size of the pdf on the screen, Control-click (or right-click) 
anywhere on the pdf page. From the menu that appears, choose one of the sizing 
options (Automatically Resize, Zoom In, Zoom out, or Actual Size). Or hover your 
pointer over the bottom edge of the document to show controls for Zoom, open in 
Preview, and Save to Downloads Folder. 

If the pdf has more than one page, but all you see in Safari is one page, Control-
click (or right-click) and choose “Next Page” or “Previous Page.” You can also choose 
either “Single Page Continuous” or “ Two Pages Continuous,” then use the scroll bar 
to scroll through the document pages.
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Save a Page and everything on it
Safari lets you save a web page with all the images and links and text on the page. 
It creates one file, an archive, that you can open at any time; all the links will work 
(as long as the destination pages haven’t changed). This is particularly handy for 
pages that you know aren’t going to last long, such as online newspaper articles or 
purchase receipts. Keep in mind that some web pages can prevent you from saving 
items on the page.

1 open the web page you want to save.

2 From the File menu, choose “Save As….” or Control-click on a web page  
(not on an image or link), then choose “Save Page As….”

3 From the Format menu in the dialog box, choose “Web Archive,” as shown.

4 Choose the folder you want to save into, then click “Save.”

To save an image from a web page, Control-click  
(or right-click) the image. From the menu that  
pops up, choose one of the image saving options.
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Make a Web clip Widget
There’s a button in the Safari toolbar that lets you make a Dashboard widget of any 
section of any web page. Any buttons, fields, or links that are captured in that widget 
will work in Dashboard. See Chapter 16 for more about Dashboard. 

To make a web clip widget:
1 Put the “open in Dashboard” web clip widget button in the toolbar: Control-

click the toolbar, choose “Customize Toolbar…,” then from the sheet that 
appears, drag the “open in Dashboard” button (shown to the left) and drop it 
onto the toolbar. Click “Done.”

2 Go to any web page in Safari. Click the new widget button.

3 The page turns gray, except for a clear box that follows your pointer around. 
Click in the area that you want to capture as a widget. Immediately eight 
handles appear on the clear box. You can drag any of these handles to reshape 
the box. Press and drag inside the box to move it.

4 When you like where it’s positioned, click the “Add” button in the upper-right.

5 Immediately Dashboard opens, and displays the new widget. 

 Click the tiny i that appears in a bottom corner (circled, below-right) to flip it 
over and add a fancy border, if you like. 

With this Wikipedia 
web clip, I can go to 
Dashboard, enter a 
search term, click Go, 
and I’m there.

The selected area 
above becomes the 
Dashboard widget 
shown to the right. 
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Print Web Pages
There are several specialized options when you print from Safari. You can see a 
preview of how the page will print, you can tell the background not to print, and you 
can make the web address and date appear on the page as headers and footers. 

To print a web page:
1 Go to the web page you want to print, then press Command P to open the 

Print dialog, shown below (or go to the File menu and choose “Print…”).

2 If you don’t see the expanded box shown below, click the button at the bottom 
that says “Show Details.”

3 Make sure the “Safari” option is chosen in the pop-up menu in the middle of 
the pane (shown circled, below). The preview appears on the left.

4 Check or uncheck the boxes to print the background and the headers and 
footers (the web address, page numbers, date and time), circled below. 

5 If the web page needs more than one piece of paper to print, the preview  
will show you every page; use the arrows under the preview pane to display  
the previews of each page.

6 Click “Print.”

Click here to show fewer options in this print dialog. Click again  
(when it says “Show Details”) to expand to the version shown above. 
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Private browsing
You may have noticed that Safari keeps track of where you’ve been and what you’ve 
entered into search fields and which web pages you’ve asked to see. Safari’s AutoFill 
feature even keeps track of user names and contact information you’ve entered on 
sites, as well as passwords and credit card numbers. If there are other people who 
use your computer, or if you are using Safari on someone else’s Mac or at a school or 
an Internet cafe, you probably don’t want Safari keeping track of all that information. 
That’s where private browsing comes in handy.

When you turn on private browsing:
n	 None of the information you enter on any page is saved. 
n	 Any searches you do will not be added to the pop-up menu in the Google 

search field.
n	 Web pages you visit are not added to the History menu. However, you can  

still go back and forward to pages you’ve viewed during the current session.
n	 If you downloaded anything, those items are automatically removed from  

the Download window when you quit Safari or turn off private browsing. 
n	 Cookies are automatically deleted when you turn off private browsing  

or quit Safari.

To turn ON private browsing, go to the Safari menu and choose “Private Browsing.” 
A checkmark appears next to the menu item to indicate it’s turned on.

To turn OFF private browsing, go to the Safari menu and choose “Private Browsing” 
again to remove the checkmark.

When you quit Safari, private browsing is automatically turned off, even if you 
left it on before you quit. So each time you open Safari, you need to turn private 
browsing on again if you want to use it.

To further secure your privacy, when you 
are finished, go to the Safari menu and 
choose “Reset Safari….” You can eliminate 
any trace of your whereabouts from the 
options you see listed here. This, however, 
will remove everything from that feature in 
Safari, not just the ones you used today! 
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Parental controls
If you have a young child (or anyone acting like a young child), you can set up 
some serious parental controls to limit access to web sites. It involves multiple 
users, which are explained in detail in Lesson 18. You’ll need an admin user (you) to 
set up another user for the child. The child will be able to view only web sites you 
have placed in the Bookmarks Bar. He won’t be able to enter web addresses in the 
Address field, modify any bookmarks, or use the Google search field in the toolbar. 

To limit web access to a young user:
1 open the “Users & Groups” system preferences to set up another user  

(details in Lesson 18). Click the box to “Enable parental controls.”

2 Click the button to “open Parental Controls….” 

3 Click the tab labeled “Web.”

4 Click the button to “Allow access to only these websites.”

5 To remove a site in the provided list, select it and click the – button.
  To add a web site, click the + button, choose “Add Bookmark…,” and type  

a web address of your choice.

6 Log in to that user’s account, open Safari, and make sure it’s what you expect. 
Safari puts the web sites chosen in Step 5 into the Bookmarks Bar, as shown 
below, and the user will not be allowed to go anywhere else.

This icon (a padlock on top of the bookmarks icon) 
shows that Parental Controls are  enabled.

  Note: This does not prevent the user from surfing the web with any other 
browser. If you want to limit the applications this user can use, do so in the 

“Apps” section of Parental Controls. 

The Bookmarks Bar 
contains the sites you 

chose in Steps 3–5.
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So What is rss?
All major news organizations—as well as thousands of blogs and individual web 
sites—offer article summaries and headlines in the form of rss feeds. 

To see rss feeds, go to a site that provides an rss feed such as Apple.com and click 
the blue rss icon in the web address field. An Apple rss feed page is shown below. 

Customize the display of an rss feed page: Drag the “Article Length” slider to 
display more or less of an article. Note the other organizational tools in the Sidebar.  

Open an rss article’s web page: Click the headline, or click the “Read more…” link 
that appears at the end of each rss blurb. 

Bookmark rss feeds: See page 148. 
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View the existing rss feeds in Safari
Apple has provided some rss news feeds to get you started. Build your own 
collection of rss bookmarks, as described on the following pages.   

To see all of your rss feeds:
1 open Safari, your web browser. 

2 If the Bookmarks Bar is not showing, press Command Shift B,  
or go to the View menu and choose “Show Bookmarks Bar.”

3 open the Bookmarks Sidebar: Single-click the “Show all bookmarks” icon  
at the far-left end of the Bookmarks Bar (circled, below).

4 In the Sidebar, single-click “All RSS Feeds.” A list of all your rss feeds will appear 
on the right as Cover Flow thumbnails and also as a list. You’ll see a blue rss
icon to the right of each web site in the lower pane.  

5 Double-click a link in the list or single-click a preview image in the Cover Flow 
pane to open its rss feed page (shown on the opposite page). 

To view just the rss feeds in a particular collection, from the Sidebar choose a 
folder that contains rss feed pages. or click on a bookmark in the Bookmarks Bar 
that contains rss feed pages.
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Look for other rss feeds
When you open a web page that has an rss feed, Safari displays a blue rss icon in 
the address field, as shown below.

To view the actual RSS feed, click the rss icon in the address field. If a pop-up 
menu opens with options, choose the “rss” option.

To find a directory of rss feeds, go to your favorite search tool, such as Google.com. 
Search for directory RSS feeds or directory XML feeds.

While other formats 
are sometimes used 
(such as Atom), RSS
is a term that most 
people associate with 
this technology.

Use the Sidebar to 
control certain aspects 
of your RSS feeds.

Search articles.

Sort by several 
different criteria.

Choose how much to 
show on this feed page.

Choose a range of 
recent articles to show.

Available actions.
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View all rss articles in a collection
When you click a bookmarks folder that contains rss feeds (such as “News,” shown 
below), a menu opens. Choose an individual feed that indicates the number of 
unread articles that are available (such as the “Google News” item shown). You 
can also choose to “View All rss Articles,” or “open in Tabs.” The latter option will 
open every feed in the entire folder as a separate tab; to open just the feeds in one 
collection, see the following page.

Bookmark your favorite feeds
There are at least four ways to bookmark a feed you want to follow. To organize 
them, first make Collections (folders) in the Bookmarks Sidebar (see page 133).

To bookmark an RSS feed, do one of the following:
n	 Single-click the rss icon in the address field, as shown on the opposite page. 

This takes you to the news feed page. which is the page you need to bookmark. 
Press Command D to bookmark the page, and in the little sheet that drops 
down, choose the folder you created in which to save the bookmark, or choose 
“Bookmarks Bar” to put the rss feed link directly into the Bookmarks Bar.

n	 Look on the web site page for a small rss, Atom, or xml logo. Single-click it, 
which takes you to the news feed page. Bookmark that page as above.

n	 If you find a link to rss, Atom, or xml on a web page, Control-click on it  
(or right-click). In the menu that opens, choose “Add Link to Bookmarks….”  
Be sure to give it a name that will describe what it is.

n	 Go to the feed page; drag the url icon from the address field to the 
Bookmarks Bar. 

This number tells 
you how many 
unread articles are 
in the RSS feed.

This triangle 
indicates a folder 
of bookmarks. 
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View rss feeds in Mail
To make it even easier to get your info fix, you can send the rss feeds directly to 
Mail so whenever you check your email, you can see if you have news waiting. 
To send the rss feeds to Mail, make a bookmark (press Command D or click  
the + button in the web address field) of an rss feed. In the sheet that drops down, 
check the box to add the feed to “Mail,” as shown below.

Change the rss preferences
In the Safari preferences, you can tell Safari rss how often to check for updates, 
when to remove old articles, and more. 

To open the RSS preferences, go to the Safari menu and choose “Preferences….” 
Then click the “rss” tab to show the rss options.

Even easier! Just 
click “Subscribe 
in Mail.” You can 
rename it, if you 
like, in Mail.
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Use rss feeds as a screen saver
Ha! This is very clever. You can use the current headlines from your favorite rss 
feed as your screen saver. It’s sexier than it sounds.

1 From the Apple menu, choose  
“System Preferences….”

2 Click “Desktop & Screen Saver,”  
then click the “Screen Saver” tab.

3 In the left-hand pane, choose  
“rss Visualizer.”

4 Click the “options…” button  
to choose your favorite feed. After you 
modify your settings, close the pane.

Move the cursor over the bottom edge of the page to reveal controls to enlarge, 
reduce, mail, or print the web page. To exit the Reader, click the x in the pop-up 
controls (below, right), or click the Reader icon in the address field again.

View the Reader Version of a Page
Safari can improve the readability of some web pages by showing only the essential 
text and graphics. When you see a “Reader” badge on the right side of the address 
field (circled, below), click it to display the current page as text and graphics only, 
and hide all of the non-related clutter that’s on the page.     

The original page. The same page displayed in Reader mode.
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Click to hide or show the Reading List sidebar.

Make a Reading List
To create a Reading List of web pages to read later, click the Reading List icon 
(shown on the left) that appears on the left side of the Safari Bookmarks Bar. You 
must be connected to the Internet to create a Reading List and to retrieve and read 
the items in the list. 

To add the current web page to your Reading List, click the “Add Page” button 
(circled below) in the Reading List sidebar that opens. 

To see a list of all bookmarked pages, both read and unread, click the “All” button.

To narrow the list to only unread bookmarked pages, click the “Unread” button.

To clear an individual item from the list, move the pointer over the item, then click 
the circle-x that appears in the corner of the item (circled, below).

To clear all items from the list, click the “Clear All” button.
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Use Multi-touch gestures in Safari
If you have a Multi-Touch input device that recognizes gestures, you can scroll or 
swipe through web pages with just your fingers. The Apple Magic Mouse, Magic 
Trackpad, and the built-in trackpad on newer Apple laptops offer this feature.  

Magic Mouse:
n	 To scroll up or down, brush up or down on the Multi-Touch surface with one 

finger. A short brush left or right will also scroll left or right on one web page.
n	 To navigate forward or back through web pages, swipe left or right  

with one finger.
n	 To enlarge the web page, double-tap with one finger on the Multi-Touch 

surface. To return to the original size, double-tap again.

Trackpad: The movements are the same as above, but use two fingers.

Safari Security
Safari provides several security settings. By default, they are turned on, but you 
should check to make sure now and then.

1 From the Safari menu, choose “Preferences….” 

2 Click the “Security” tab in the toolbar. 

3 Make sure the boxes are checked to “Warn when visiting a fraudulent website.” 
and “Ask before sending a non-secure form from a secure website.”

 If you’re going to a web site that you know is not fraudulent (because it’s yours), 
contact the server of that site to let them know it’s indicating a problem. 

Also see page 143 to learn about private browsing in Safari. 
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When you clear the Downloads list, 
the Downloads button disappears 
from the toolbar. It reappears the 
next time you download a file.

cool Safari tips:
If you have at least one tab open, you’ll see the New Tab button (the plus 
symbol on the right side of the Tabs Bar). Click this to create a new tab that 
opens the Top Sites display. You can change that: open Safari Preferences, 
click “General” in the Preferences Toolbar, then set the “New tabs open 
with” menu to Home Page, Empty Page, Same Page, or Bookmarks.

After the first time you download a file in Safari, this Downloads button 
appears on the right end of the toolbar. Single-click the button to open a 
menu that contains a list of previous downloads (shown below).  
To reveal a download item in the Finder, click the magnifying glass 
icon to the right of the downloaded item in the list.  

Use Multi-Touch gestures to switch between the pages of your current browsing 
session. If you use a Magic Mouse, position the pointer over a web page, then swipe 
left or right with one finger on the surface of the mouse. If you use a Multi-Touch 
trackpad, position the pointer over a web page, then swipe left or right with two 
fingers on the trackpad surface. 

Use the keyboard Arrow keys to scroll up, down, left, and right in a web page.

From the History menu, you can Reopen All Windows From Last Session.    

Consolidate multiple open browser windows into one with multiple tabs:  
From the Window menu, choose “Merge All Windows.”

To create a Bookmark folder from a group of tabbed windows, from the 
Bookmarks menu, choose “Add Bookmark For These Tabs….” In the dialog that 
opens, choose a Bookmark location for the folder. Safari automatically enables 
Auto-Click, so a single click on the folder re-opens all of the tabs in the group.
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and subscribe to others
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LESSON  8

iCal for organizing  
Your Life

iCal is a calendar program that keeps track of Events, creates a 

Reminders list, and sends alert messages to you, among other 

things. You can publish your calendar over the Internet for others 

to see, and they can subscribe to your calendars and get automatic 

updates. iCal is a great tool for keeping track of family activities 

or for coordinating corporate Events. And you can do it all in one 

application because you can create separate calendars for separate 

parts of your life. 

 iCal supports Microsoft Exchange Server, Google, and Yahoo! 

calendars for those who need to sync their work calendars. 

iCloud, Apple’s automatic and free storage and syncing solution, 

keeps your calendars synced to all of your computers and mobile 

decvices.  
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the ical Window
The iCal window is in a familiar paper calendar format, but because it’s digital you 
can switch to different views with the click of a button. View a month at a time, a 
week, or a day; go back in time or forward into the future. Set recurring Events to 
happen every first Friday or every three months. Create Reminders that are attached 
to certain calendars. Turn calendars on or off so you can view just individual ones, 
or view several at a time to see how your events overlap.  

Change date shown. Reminders list.

Drag any edge to 
resize the calendar.

Create a Quick Event. Choose a view mode.

To show the 
list of your 

calendars, 
click this 

button. 

Set Up google, yahoo!, or exchange calendars
You can set up those calendars in iCal. 

1 open iCal’s Preferences and click “Accounts.”

2 Click the Add (+) button in the lower-left corner to create a new account.

3 Enter your Google or Yahoo! email address and password, then click “Create.” 
iCal finds any calendar accounts associated with the email address you entered. 

To turn the page with a Magic Mouse, swipe left or right 
on the surface with one finger. 
On a Multi-Touch trackpad, swipe with two fingers.
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create a group of calendars
Create calendar Groups to organize related calendars. You might want to group 
together the calendars that all have to do with your children. or perhaps a 
particular project has several different calendars associated with it.

To make a Group, go to the File menu and choose  
“New Calendar Group.”  

Name the new Group, then drag other calendars 
into it. If a Group name is selected when you create 
a new calendar, the calendar is automatically added  
to that group.  

create calendars
You can have many different calendars—one for each of your kids, one for work, 
one for your partner, one for home life, one for the charities you volunteer for, etc. 
Choose to see all the calendars and events at once and you’ll have a visual display of 
just how crazy your life is. 

To create a new calendar, go to the File menu, choose “New Calendar,” then choose 
“on My Mac.” Give the calendar a relevant name, then click anywhere.

To hide a calendar’s 
Events and Reminders, 

uncheck its box.

Click here to show the Calendars list.

Click the disclosure triangle to hide 
or reveal a Group’s contents.

To change the color of a calendar or to give it a description, Control-click (or right-
click) the calendar name, then choose “Get Info.” A sheet slides down so you can 
change the calendar color, type a description, or publish the calendar. 

To delete a calendar, Control-click (or right-click) the calendar name in the list, and 
choose “Delete.”
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create events
An Event is what you’d expect it to be—something that happens on a particular day. 
You can create Events in a variety of ways. 

First select the calendar (from the Calendars list) in which you want the Event to 
appear. Then:

n	 In the “Month” view, double-click a day to create a new Event. A New Event 
Info pane opens so you can add more information; click “Done” to put it away, 
or click anywhere outside the Info panel. iCal arranges multiple Events on one 
day according to the times you enter. 

n	 In the “Week” or “Day” view, double-click or press-and-drag on the time grid 
for your Event. Double-click the Event to open the Info panel and add infor-
mation; click “Done” or click anywhere outside the Info panel to put it away.

n	 To stretch the Event out across multiple days, be sure to click the “all-day” 
checkbox in the Info panel, then enter the Event’s dates in the “from” and  

“to” fields.

n	 To create a recurring Event, use the “repeat” feature in the Info panel. iCal 
automatically repeats the Event at a time interval you specify. For instance,  
the Shakespeare readings I host repeats on the first Friday of each month.

To view Event details, as shown above-right, double-click the Event. 
To open the Info panel for a selected Event, ready to edit, press Command E.

Info panel.
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Event invitations
From iCal you can send someone an invitation to an iCal Event. The invitee can 
send a response back to you that shows up in your Info panel for that Event. 

To send an iCal Event invitation:
1 Create a new Event, or double-click an existing Event in iCal. 

2 In the Info panel that opens (click “Edit” if it’s an existing Event), click “Add 
Invitees…,” then type contact names that are in your Address Book. 

3 Edit other Event information if necessary, and add any comments you want  
in the “note” area. 

4 Click the “Send” button.  

Or Control-click (or right-click) an Event in iCal, then choose “Email Event.”  
An email form appears; address the message and send it.  

To respond to an email notification:
1 When you receive an email that contains an iCal Event attachment, click the 

attachment icon (below) in the message to automatically put the Event in iCal. 

2 Go to iCal and double-click the Event that was added automatically. In the Event 
Info panel that opens, respond with an option: Accept, Maybe, or Decline.

The organizer of the Event receives an email with an iCal attachment. When he 
clicks the attachment, the response is added to the Event in his iCal. He can double-
click the Event in iCal to open the Event Info panel and see the responses of invitees.

Type contact names that 
are in your Address Book.

Edit Event information, 
if necessary.

Add a message.
Email invitations.
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create Reminders
Each calendar can have its own list of Reminders. As you check and uncheck the 
calendar checkboxes, their attendant Reminders show and hide accordingly.

To create a Reminder: 
1 If the Reminder pane isn’t showing on the right 

side of iCal, go to the View menu and choose 
“Show Reminders.” 

2 In the Reminders panel on the right, double-click 
in a blank space. Or Control-click (or right-
click) and choose “New Reminder” from the 
contextual menu. 

  Double-click a Reminder to open its Info panel (above). Prioritize your item, 
add a note, give it a due date, change the calendar it’s assigned to, and more. 

3 When the item has been completed, check the “completed” checkbox.

Email a Reminder
You can email a Reminder, and if that person has a Mac, she can choose to click the 
link in the email to add the Reminder item to her iCal. 

To email the Reminder from iCal: 
1 Control-click (or right-click) the item in the Reminders panel, and from the 

menu that pops up, choose “Mail Reminder.”

2 The Mail application opens with the Reminder included as an attachment.  
Address the email form and click “Send.”

3 The recipient clicks the email link in the message (above-left), chooses a 
calendar (above-right), and the Reminder is added to his iCal as an Event. 
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automatic birthdays calendar
iCal can work with your Address Book to create a Birthdays calendar that automati-
cally updates itself. 

1 First you must add the Birthday field to your Address Book, as explained  
on page 114. 

2 Then, in iCal, go to the iCal menu and choose “Preferences….” 

3 Click the “General” icon.

4 Check the box to “Show Birthdays calendar.” 

 The calendar will appear in the “Subscriptions” group of the Calendars list 
(below, right). If you don’t see a Subscriptions group in your calendar list yet, 
don’t worry—iCal will put it there for you when you subscribe. 

 Close the Preferences pane.

Now you can double-click any birthdate event in the calendar to open its Info pane. 
There you can click the link to go straight to that person’s contact information in 
Address Book, from which you can send a birthday email. 

You can’t make any changes to the Birthdays calendar in iCal; in fact, you can’t even 
add alarms to notify you of upcoming birthdays. You could, of course, manually 
create a birthday Event and add an alarm to it. or you can create a Smart Group in 
Address Book that notifies you a designated number of days before the birthdate of 
any of your contacts; see page 117.
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Link events and Reminders
To add an Event to the Reminders list, drag the Event from the calendar grid to the 
Reminders pane. The Event stays put, but now you also have a Reminder relating to it.

To turn a Reminder into an Event, drag the Reminder to a date in the calendar 
grid. The Reminder item stays in the Reminders pane, but now you also have it as an 
Event in your calendar. 

backup the entire calendar of information
To make sure you don’t lose the valuable information you have entered into your 
calendar, go to the File menu, choose “Export,” then choose “iCal Archive….” You 
will be asked where to save the file. If you have a lot of information you don’t want 
to lose, you should save that file onto a separate backup disk, along with your other 
important files.

Preview files attached to events
Use Quick Look to preview Event attachments: Double-click an Event to open its 
Info pane, single-click the attachment name, then tap the Spacebar. Almost any kind 
of file will preview. Tap the Spacebar again to put it away.
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Publish your calendar
You can publish your calendar to a MobileMe account or to Apple’s iCloud (free 
storage and syncing on Apple servers), including the alarms and Reminders if you 
choose, and anyone in the world on any computer can view it. It’s really remarkable. 
Apple’s MobileMe service is being replaced by the free iCloud service.  

To publish, select a calendar in the Calendars list (click the “Calendars” button to 
see it). While that list is displayed, go to the Calendar menu and choose “Publish….” 
A sheet drops down (shown below). Make your choices, then click “Publish.”

A new message appears telling you the web address where the calendar can be 
viewed or subscribed. Click the “Send Mail” button to get an email form ready to 
send to anyone you like.

To notify others later about your published calendar, select the calendar as 
described above, go to the Calendar menu, and choose “Send Publish Email….” 

To unpublish (or unshare MobileMe calendars), follow the steps above to choose a 
calendar, then from the Calendar menu choose to unpublish or stop sharing.

Subscribe to Calendars
To subscribe to a private calendar, go to the Calendar menu in iCal and choose 

“Subscribe… .” Enter the web address you have been given. If you received an email 
invitation to subscribe to a published calendar, click the link in the email invitation. 

There are many public calendars you can subscribe to, such as calendars for the  
pga tours, nascar races, musician’s tour dates, and many more. To subscribe to a 
public calendar, go to the Calendar menu and choose “Find Subscriptions….” This 
takes you to a web site that lists public calendars. Browse through categories such as 

“Most popular” and “Most recent.”

If you have a MobileMe
account, you can “share” 
any of the calendars with 
other MobileMe members. 
The menu item will say 

“Share Calendar” instead of 
“Publish.”
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Use ical in full-Screen Mode
To make iCal fill your entire screen so it’s easy to see and work with, click the 
Full-Screen button (the double-arrows icon) in the top-right corner of the iCal 
window. 

To access the menu bar across the top of the screen while in full screen mode, just 
push the pointer up to the top edge of the screen, and the menu bar appears while 
you need it.

To exit full-screen mode, push the pointer to the top edge of the screen. When the 
Mac menu bar appears, click the blue double-arrow icon in the top-right corner 
(circled, below-right).

To swipe through the pages in any view, use a one-finger horizontal swipe on a Magic Mouse 
or a two-finger horizontal swipe on a Multi-Touch trackpad. Only the Month view gives you 
the page flip effect shown above.
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Print in a Variety of Ways
Check out the great features in the Print dialog box. Each “View” (Month, Day, Week, 
or List) you choose changes the options, so spend a few minutes here exploring the 
possibilities for each view. You can choose to print the data from as many or as few 
calendars as you like. All calendars are color-coded, so you can see how Events in 
different calendars overlap.

To print from iCal: 
1 From the File menu, choose “Print.” 

2 In the “Print” dialog that opens (below) choose a time range, calendars to 
print, and other options provided as checkboxes. 

3 After you customize your settings, click “Continue” to open the usual  
Print dialog where you select a printer and start the print process. 

Drag this slider to 
resize the preview.

Change the view here; the preview 
will immediately change.

Whatever the preview displays 
is what will print.

Click the checkbox to 
hide or show a calendar.
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Set up iChat

Text chat with one person   
or a group of people

Use one window   
for multiple chats

Audio chat with others 

Video chat with up to   
three other people

Create image effects or 
change your background

Share files and even   
iPhoto with others 

Connect to users   
on your local network 

through Bonjour

Record chats

Use Facetime
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LESSON 9

iChat and FaceTime  
for Text, Audio,  
and Video Messaging

With iChat you can communicate with others around the world 

with text messages, audio chatting, or video conferencing—free. 

You can text chat with one person or with a group of people, 

exchange files, send text messages to someone’s phone, display 

images from iPhoto, save printable copies of your chats, and 

record audio or video chats. With a fast Mac and iChat, you can 

have audio chats with up to ten people at a time and video confer-

ences with up to three other people. You can even have one-way 

video chats with someone who doesn’t have a video camera 

attached or built-in (or vice versa). Amazing.

Facetime expands your quick and easy video communication to 

new iPads, iPhones, and some iPods.
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Set Up ichat
When you first open iChat, it asks you to fill in certain information to get started. 
You need a chat account of some sort. The rest is self-explanatory.

Free MobileMe account name: In the setup process, you can click the 
button labeled “Get an iChat Account….” This takes you to Me.com where 
you can get a free iChat buddy name with a sixty-day MobileMe trial 
account, and you can keep the buddy name after the free trial is over even 
if you don’t convert the trial account to a paid one. 

MobileMe account ($99 a year): Among all the other benefits is a “screen 
name” or “buddy name.” When you set up iChat and give others your 
MobileMe buddy name, include the @me.com part of your name.

Free AIM account: Go to www.aim.com and sign up for a free aim
account; you can use that as your buddy name. When you set up iChat 
and give others your aim buddy name, do not include @aim.com.

You can also chat with a Google Talk account (www.Google.com/talk), 
Jabber (register.jabber.org), or Yahoo! Messenger (messenger.yahoo.com)

Double-click a buddy name in 
the panel to open a text chat. 

This is a text chat with one 
other person.

Your chat 
name.

A sample iChat Buddies panel and chat
So you’ll know what to expect after you’ve gone through the process, below you see 
a typical iChat Buddies panel and text chat.

www.aim.com
www.Google.com/talk
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Customize the fonts and 
colors of balloons in your chat 
windows in the “Messages” 
pane of iChat preferences.

See page 172 about this option 
to put multiple individual chats 
into one window.

Check this box to automatically 
save all your text chats. They 
will be in a folder called “iChats,” 
which you’ll find in your 
Documents folder.

Make the account active
once you set up your account, make sure it is active:

1 Go to the iChat menu and choose “Preferences….”

2 Click the “Accounts” icon.

3 Select the account in the left pane, then click “Enable this account.”
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create an ichat buddies List
Set up an iChat Buddies list of names to choose from when you want to chat. 

1 If you don’t see the iChat Buddies panel when you open iChat,  
go to the Window menu and choose “iChat Buddies.”

 If the title bar of the iChat Buddies panel says you are “offline,” click on the  
word “offline” and from the pop-up menu choose “Available.” 

2 To add a new buddy, single-click the + sign at the bottom of the list window  
and choose “Add Buddy….”

 (Note that from this + menu, you can also choose to “Add Group…” This helps 
you organize your names into categories, such as Family, Coworkers, Film 
Club, or whatever. A buddy can be in any number of different groups.)

3 In the dialog box that appears, enter the person’s screen or buddy name in  
the “Account Name” field. Choose an iChat group to put the buddy in.

 Or click the disclosure button to display your Address Book (shown below), 
then choose a buddy from your list of contacts.

4 Click the “Add” button. 
 The account gets automatically entered in the Address Book (if the buddy 

is not already in your Address Book), and the name is placed in the iChat 
Buddies panel. 

Click this disclosure 
button to display your 
Address Book contacts, 
as shown here.

To send text messages to 
a phone, simply enter the phone number 
in the Account name field, preceded by +1
(so it would look like +15551231212). The 
message you type will go to that person’s 
phone, and they can send you messages 
back that you will receive in a chat window 
on your Mac like any other message. 
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chat with One Other Person
To have a one-to-one text chat with someone in the office or on the other side of 
the world (or anywhere in-between):

1 If you don’t see the iChat Buddies panel when you open iChat,  
go to the Window menu and choose “iChat Buddies.”

2 Double-click the name of the buddy you want to chat with.

  Be sure to double-click the buddy name, any blank space, or the buddy icon
in the buddy field, not a camera or phone icon that might be visible.

  Or single-click a buddy name, then single-click the “A” icon at the bottom of 
the iChat Buddies panel to open a text chat window. 

3 A text chat window opens. In the text field at the bottom of the window,  
type a message, then hit Return. 

4 To end the chat, click the red close button in the upper-left of the window.

Type text here, then hit 
Return to send the message.

Click the smiley button in the 
text field; from the pop-up 

collection, single-click a smiley 
to insert in your text message.

This is you.
This tells you with whom 

you are chatting.
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Put Multiple individual chats in one Window
When you want to keep multiple but separate chats going at the same time, it’s 
easier to manage if you put the separate chats in one chat window, then switch 
between them. (This might be the default on your Mac, in which case this page 
explains what is going on! See page 169 to turn the default off or on.)

1 Start individual chats with two or more buddies. If they all open in the same 
window, then read Step 2 but don’t bother going to the Window menu. 

2 Go to the Window menu and choose “Merge All Chat Windows.” A pale blue 
Sidebar, which iChat calls a Tab Bar, opens with each buddy’s name on a 
separate “tab.” 

3 To add other buddies to the Tab Bar, drag them from the iChat Buddies panel 
(or from any other Tab Bar you might have) and drop them on the Tab Bar. 
This person does not join the existing chat!

4 To move from chat to chat, click a buddy name in the sidebar. 

5 To move a chat from the multichat window to an individual window,  
drag the buddy’s name out of the Tab Bar and drop it on the Desktop.

6 To remove a buddy from the Tab Bar, click the x that appears when you hover 
the pointer over a buddy name. (If you’re in a conversation with that person, 
this immediately disconnects her.)

The Tab Bar.

This is the name of the person 
you are currently chatting with.

Click a buddy name in the 
Tab Bar to switch to that 

particular chat.
These are still individual   

chats, but they are all 
available in one window.

None of the other buddies 
can see your chat with 

anyone else. But be careful—
it’s too easy to send a 

message to the wrong person!
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chat with a group of People all together
You can text chat with at least twenty-three different people around the world in 
one Chat Room. 

1 From the File menu, choose “Go to Chat Room.” 

2 In the window that appears, type a name that will become the name of this 
chat room. Make it something distinctive because if anyone else around the 
world types the same word, they’ll end up in your chat room.

3 A Participants drawer pops out to the side of the chat room window.  
Click the + sign and invite someone. 

4 Click the + sign again and again to invite as many people as you like. 

Or tell people ahead of time to all meet in a chat room called, say, “jtroadrunner,” at 
a certain time (use all lowercase). At the prescribed time, tell everyone to do this:

1 open iChat and go to the File menu; choose “Go to Chat Room….” 

2 Enter the chat room name (in this case, jtroadrunner) and click “Go.” Everyone 
around the world who does so will end up in the room together. Remarkable. 

Here John started a 
Chat Room named 

“jtroadrunner” and 
invited Robin and 
Rosalind.

3 To remove yourself from the chat room, click the red close button in the 
upper-left corner of the window. When the last person leaves, the chat room 
will automatically close.



ptg6934589

Lesson 9 iChat for Text, Audio, and Video Messaging

174

The multiple-phone icon 
means this buddy can audio 
chat with multiple buddies 
at the same time.

audio chat with One or More
Talk, literally talk, with other people. Make sure you have a microphone built in or 
connected to your Mac. Your buddies will display little telephone icons next to their 
pictures if they are able to audio chat with you (if he has a video camera, you can 
also do an audio chat). 

To audio chat with someone, she has to be in your iChat Buddies list (see page 170). 
In the list, as shown below, you can have a one-on-one audio chat with anyone who 
displays a telephone icon next to her name.

If a buddy shows multiple telephone icons, like “jtratz” below, that means you can 
invite him to an audio chat that involves more than one person. 

To audio chat, click directly on that person’s phone icon. Or single-click his name, 
then click the phone icon at the bottom of the iChat Buddies panel.

If your Buddy doesn’t have a microphone to chat back with you, select his name, 
then go to the Buddies menu at the top of your screen and choose “Invite to 
one-Way Audio Chat.” Your friend will hear you, but will have to send typed  
instant messages back.

iChat picks up your 
photo from the Address Book; you can 
change the photo there; see page 112. 

If you want to replace 
your buddy’s photo, select any buddy 
name and press Command I to get the 
Info window (or Control-click a buddy 
name and choose “Show Info” from the 
menu that pops up). Click the “Address 
Card” tab, then drag an image into  
the “Picture” image well. To resize  
and reposition it, see page 112.
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Open an audio chat and invite others to join you
To initiate an audio conference with more than one other person, you need a more 
powerful machine than you do to join an audio chat. Any machine purchased within 
the last five years is certainly powerful enough to initiate an audio chat. 

1 Single-click directly on the multiple-phone icon next to a buddy’s name.

2 That person hears a little phone ringing and sees a message on his computer;  
he clicks the message to see who it is, then clicks “Accept.” This begins the chat. 
Your active audio chat window looks like this:

3 Now click the + button to get a pop-up menu (shown below) that lists the other 
people in your iChat Buddies panel who are online and capable of joining an 
audio conference. Single-click a person to add him or her. Add others in the 
same way. 

Click the microphone icon to mute the 
session—the green bar turns orange and 
the microphone turns blue, visual clues
that the sound is muted.

4 To delete someone from the audio conference, hover your pointer over his icon. 
When an x appears, click it and that person is gone. 

5 To end an audio session, click the red close button in the upper-left corner of 
the Audio Chat window.
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Video chat with up to three Other People
See other people on your screen while you talk (not type) with them. To video chat, 
of course you must have a video camera attached to your Mac. All of the newer 
iMacs and laptops have built-in video cameras. You can use Apple’s cute little iSight 
camera if you already have one (they’re not sold anymore), or you can attach any 
FireWire video camera to your Mac, or a USB video camera. 

With whom can you video conference?
A video conference with more than one person takes a powerful Mac and a good 
broadband connection. If you have a machine running Lion, then it is more than 
capable of participating in or initiating a video conference with four people. 
But perhaps you want to video conference with others who have less powerful 
computers—you can tell by the icons in their Buddy tab if they are capable: Any 
Buddy who is able to participate in a video conference with more than one person 
has a stack of camera icons next to his image; if there is only one camera (or none), 
he cannot participate.  

To initiate a video conference with up to four people, it takes a powerful Mac and 
a fast broadband connection. So if it doesn’t work for one of you to start the video 
chat, have the person with the biggest-fastest-newest Mac start it.

Audio and video preferences
You can make some minor adjustments in the Audio/Video pane of the iChat 
preferences. You might try changing the “Bandwidth Limit” to see if it affects your 
video chat one way or another. Depending on your Internet connection and how 
many other people use it, a different setting can work better (or worse). 

To see what iChat capabilities a Buddy has, 
go to the Buddies menu, choose “Show 
Info,” and click the “Profile” tab.
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This computer 
doesn’t have 
a camera 
attached, but 
that person 
joined the audio 
portion of the 
video chat. 

Open a video chat and invite others to join you
Just a reminder: To initiate a video conference with more than one other person, 
you need a more powerful machine than you do to join a video conference.   

1 Single-click a buddy name that shows multiple video camera icons. That 
person hears a little phone ringing and gets a message on her screen inviting 
her to a video chat. When she clicks “Accept,” she appears in your video 
window instead of you. 

2 To add two more people to your video conference, click the + sign; a menu 
drops down with the names of the people in your iChat Buddies panel who are 
online and capable of joining you. 

3 To leave the video chat, click the red close button in the upper-left of the 
window. The last person to leave the chat will terminate the entire session.

If your Buddy doesn’t have a camera with which to video chat, select her name, then 
go to the Buddies menu and choose, “Invite to one-Way Video Chat.” Your friend 
will see you, and if she has a microphone attached to her Mac, you can hear her.
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ichat effects
iChat Effects are useless but fun. You can distort your image, add artistic touches, 
and even add new backgrounds so it looks like you’re somewhere else. 

To preview the various effects: 
1 Before or during a video chat, go to the Video menu and choose  

“Video Preview.” 

2 Now from the same menu choose “Show Video Effects.” 

3 Select an effect from one of four Video Effects panels (two of them are 
shown below) to see what it will do. Click the arrows in the bottom corners 
to navigate all four panels. The last panel contains empty wells so you can 
drag and drop your own backgrounds there and use them. You can make 
backgrounds out of photos or movies.

To apply an effect during a video chat: 
1 During a video chat, click the “Effects” button in the bottom-left corner 

of the chat window (shown on the opposite page). This opens the “Video 
Effects” panel shown above. 

2 The original, non-effect version appears in the middle of the panel.  
Click an effect to apply it as you chat. 

3 To return to the original, non-effect image, click the “original” image  
in the center of the Video Effects panel.

Click to cycle through the 
other video effects options.

Choose movie backgrounds.Choose video effects.
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Click to change video effects during a video chat.

John’s office seems to 
have a plumbing problem.

Add backgrounds
In addition to distorting your video image with various effects, you can add a photo 
or a movie to replace the existing background that’s really behind you (in real life). 
This background replacement feature works best if you have a simple, uncluttered, 
single-color area behind you as you sit in front of the camera. We got the best 
results (but not perfect) by using a background wall that was smooth and almost 
white. Although you can do this in the middle of chatting, you might want to get it 
all set up before you call someone on a video chat and surprise them.

1 In the Video Effects panel (explained on the opposite page), click the right 
arrow button until you get to the panel of background images. Look for 
background photos, not your picture.  

 To add your own background photos or movies, click through the effects  
until you find an empty well. Drag your image or movie into that well. 

2 Click a background image to select it. A text prompt appears and asks you to 
move yourself out of the video frame (do what it says). The prompt notifies you 
a few seconds later with a “Background Detected” message. 

3 Move back into the picture. iChat replaces the original background with the 
photo or movie you selected and places you in front of it. 

 If you want to change to another background, iChat will not ask you to step  
out again—it will just replace the existing one. 
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If the shared file is a movie, the file window displays a Play/Pause button  
and a scrub bar to drag the clip backward or forward (below, left).

To share multiple files of the same or different types, Command-click to select  
files on your hard drive, then drop the files on the video chat window. The files  
play as a slideshow. Slideshow controls are positioned under the image.    

ichat theater
once you’ve initiated a video chat, you can use iChat Theater to show files, photos, 
slideshows, or movies while you continue your chat. This is amazing.

To share a file with iChat Theater:
1 Start a video chat with a buddy.

2 From the File menu, choose “Share a File With iChat Theater….” or click the 
+ button at the bottom of the window, then choose “Share a File With iChat 
Theater” from the pop-up menu. 

3 In the Finder window that opens, select a file, photo, or movie you want  
to share, then click “Share.” Or simply drag any file, photo, or movie from  
your hard disk and drop it onto the video chat window.  

iChat Theater provides movie 
controls for volume, play/pause, 
and a timeline slider that lets you 
drag to any part of the movie. 

When you drag a file to 
the video chat window, the 
buddy’s image minimizes 
to the bottom-left corner 
to make room for an image 
of the file. Your buddy sees 
you as a thumbnail video 
and sees the same file 
image that you see. 
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Select an album to share as a 
slideshow.

Share iPhoto with iChat Theater
You can also share entire iPhoto albums as a slideshow.

1 Start a video chat with a buddy.

2 From the File menu, choose “Share iPhoto With iChat Theater….”

3 In the iPhoto window that opens (below-left), select an album, then click “Share.”

To share a web page with iChat Theater:
1 Start a video chat with a buddy.

2 From the File menu, choose “Share a File With iChat Theater….” In the dialog 
that opens, enter a web address, then click the “Share” button. 

iChat Theater opens a slideshow with slideshow 
controls and random music track.
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If you select “Send text as I 
type,” the recipient of your 
message will see the text as 
you type it. If you leave this 
unchecked, the recipient sees 
an empty little message cloud 
until you finish your message 
and hit Return.

Turn Bonjour on or off.

bonjour on your Local Network
Bonjour is an integrated component of iChat. If you have two or more Macs 
connected through a local area network (an Ethernet network, wireless network, 
or a combination of both), Bonjour automatically detects and connects all of the 
computers on the network. You can send Instant Messages or files to Bonjour 
buddies on your local network. You can have audio or video chats with others on 
the local network (if a microphone or digital video camera is connected to your 
computer, of course). And you can use Screen Sharing to share your computer with 
others or to see another buddy’s computer (see Lesson 21).

You don’t have to have a MobileMe account or aim account or any other kind of 
special account—just computers that are connected on a local network, as in your 
Ethernet or wireless network at home or office or corporate building.

To set up Bonjour:
1 open iChat, then from the iChat application menu, choose “Preferences.”

2 Click the “Accounts” button, then click “Bonjour” in the Accounts pane  
on the left side of the window. 

3 Check the box to “Enable Bonjour instant messaging.”
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Click the triangle 
to show or hide 

other iChat users 
connected via a 

local network.

Robin shows up twice 
in John’s Bonjour list 
because she currently 
has two different 
computers connected 
to the local network. 

Bonjour automatically detects a local network and connects you to it. If you’re in 
a public space, such as an Internet cafe, you should quit iChat or at least turn off 
Bonjour when you’re not using it, to ensure privacy and security. 

To send a file to anyone on the Bonjour List, just drop the file on a buddy name. 
We use this daily in our office.

Or if you are chatting, drag a file into the message field where you type. Hit Return 
and off it goes. If the file is an image, the image itself appears in the chat window; 
your buddy can view it, drag it to his Desktop, or double-click it to open it.

once you’ve enabled Bonjour in iChat Preferences (see the opposite page), Bonjour 
is listed as one of the buddy categories in the iChat Buddies panel. Click the 
disclosure triangle next to Bonjour to show other Bonjour users who are accessible 
on the local network.

If you’re interested in sharing files or sharing computer screens
(where you can actually manipulate the other person’s monitor wherever she is in the 
world), please see Lesson 21 on connecting and sharing files.



ptg6934589

Lesson 9 iChat for Text, Audio, and Video Messaging

184

Record chats 
When an audio or video chat is in progress, you can record the chat. Recorded video 
iChat files require a lot of storage space, approximately one megabyte for every five 
seconds of video.

1 Start an audio or video chat with a buddy.

2 From the Video menu at the top of the screen, choose “Record Chat.”

3 The buddy’s audio or video chat window reveals a “Recording Request” sheet 
(below-left). When the buddy clicks “Allow,” the recording begins.

4 A red Record light alerts both participants that recording is in progress. 

A red Record button means the 
audio chat is being recorded. An audio chat.

A video chat.

Find recorded chats
To locate a video or audio chat file, open the Documents folder, then look in the 
iChats folder. The files can also found in iTunes: Look in the iTunes Sidebar for a 
playlist named “iChat Chats.” Click that playlist to show your recorded video chats.  
If your recorded audio chats are not there also, look in the main iTunes library.

To stop a video recording, from the Video menu choose “Stop Recording.” 
To stop an audio recording, click the red Record button in the Audio Chat 
window (circled, above-right). 
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facetime
FaceTime is not part of iChat, but it’s similar in that it enables you to make video 
calls to friends. You can call anyone who has at least an iPad 2, an iPhone 4, an iPod 
touch, or a Mac with FaceTime installed. With FaceTime, you use a person’s email 
addresses instead of a phone number. 

1 Click the FaceTime icon in the Dock.

2 The first window (below, left) asks you to sign in with your Apple id and 
password, or create a new account to activate FaceTime. If you have an iTunes 
account or a MobileMe account, use the id and password from that.

3 Designate the email address you want people to use to call you.

4 Select a person from the Address Book list that appears on the right side of the 
FaceTime window. If you call this person often and want quick and easy access, 
click the “Add to Favorites” button. 

5 Click the person’s email address. It must be an address that the person has 
designated as the email address to use to call them, as in Step 3. To call an 
iPhone 4, use that phone number. If the person answers, she appears in the 
FaceTime window (below, right). 

6 Click the “End” button to end the video call. 

Enter your Apple Id, type your password 
immediately below your ID, then click the 

“Sign In” button. Or click “Create New 
Account” to get an Apple ID.

To switch to a horizontal orientation, hover 
the pointer over the small thumbnail image, 
then click the rotation symbol that appears.

Mute. Full-screen.
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GoALS

Buy music, movies, and more

Create Playlists of   
selected music

Watch movies or shows   
right in iTunes

Burn your own cds of music

Listen to radio from   
around the world

Create Playlists with iTunes dj
and Genius Playlist

Use the Genius Sidebar   
to find new songs 

Print covers   
for your own cds

Socialize musically with Ping

Visualize your music
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LESSON 10

iTunes for Your  
Listening Pleasure

Import music into iTunes, create Playlists of your favorite songs, 

copy the Playlists to cds so you have your own discs of customized 

music, or stream your music from your office down the hallway to 

hear it in the kitchen. In addition to buying music, you can buy or 

rent movies and tv shows directly through the iTunes Store with 

the click of a button and download them right to your computer. A 

multitude of podcasts are available for free from the iTunes Store, 

including content from many universities (click the iTunes U tab 

in the iTunes Store) and broadcasters.

If you have an iPhone, iPod or iPad, iTunes makes backups for you 

and syncs the music, apps, and data on them. If you’re interested 

in being more social with your music interests, Ping lets you 

follow your favorite artists, celebrities, and friends, sharing music 

information. 
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the itunes Window
Below is an overview of the iTunes window. This short chapter is only an overview; 
if you want an entire guide to using iTunes, please check one of the iLife books from 
Peachpit Press. There is so much to iTunes! We encourage you to explore the menus, 
all the buttons, and the Help files. 

Songs, books, 
movies, etc., are 

imported into 
the Library. 

Click the Play button 
to play all the checked 

songs in the window.
Search for an 
artist or song title.

Current 
song info.

Click to change view mode 
(Cover Flow mode shown).

Add a new Playlist.
Play the current Playlist 

in random order (shuffle).
Click repeatedly to switch 

between repeat modes.
Show album art   

and video viewer.

Full-screen 
mode.

Information about 
your iTunes Library.

Show or hide a 
Sidebar on this side 
of the window that 

contains Genius 
recommendations, Ping 

messages, and more.

Playlists help 
you organize 

all the music in 
the Library (see 
pages 190–191).



ptg6934589

Lesson 10 iTunes for Your Listening Pleasure

189

Single-click the album art preview to open a large version in its own window.
Hide and show video or album art.

buy Music, Movies, or television Shows
To buy music, movies, or television shows, click on “iTunes Store” in the Sidebar. 
To search for something specific, use the search field in the top-right corner. 

The first time you click a “Buy” button, you will be asked to set up an account  
with a credit card number and contact info. After you’ve got an account, you can 
buy and download music, movies, and television shows with the click of a button. 
To watch a show or movie, see page 195.

download album art
When you buy music through iTunes, you automatically get the album art with it. 
If the art is not showing at the bottom of the Sidebar when you select a purchased 
song, click the Show item artwork and video viewer button (circled below). 
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create a Playlist
Everything you buy in iTunes goes into one of the categories in the Library. But 
you can create your own Playlists, which are collections of songs from the Music 
Library. You might create one Playlist for your favorite jazz songs, another of 
Scottish folk music, and another for a particular artist. The same song can be in 
any number of Playlists. This allows you, for instance, to take two songs from this 
cd, one from that cd, etc., to create your own personal collection, then play that 
collection or burn it to a cd of your own. 

1 Playlists are made from songs in your iTunes Library, so first buy songs at 
the iTunes Store (see the previous page) or import songs from cds (see the 
opposite page). You can also drag a song from your Desktop or from a Finder 
window to the Library pane in the Sidebar, or to a Playlist in the Sidebar.

2 Click the + in the bottom-left corner. A new, untitled Playlist appears in the 
Sidebar. Name this new Playlist. 

3 Single-click the “Music” collection in the Library pane.

4 Drag songs displayed in the main window and drop them on the Playlist  
in the Sidebar. 

Apple created these Smart Playlists (with gear icons) 
for you. They automatically add songs to themselves 
based on chosen parameters; see the opposite page.

Hover your pointer here to choose “Hide” or “Show,” 
then click to hide or show its list.

Select multiple songs in 
the main iTunes window, then from the File 
menu, choose “New Playlist from Selection.” 
A new Playlist appears in the Sidebar that 
contains the selected songs. 

Click “iTunes DJ” to automatically create a 
random Playlist from your Music library.

Which options 
you see here 

are based 
on what you 

choose in 
the iTunes 

Preferences, 
in the General 

pane.

Create a new Playlist.
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This Smart Playlist will create a playlist that contains the songs of two 
specific artists in my iTunes library.

CD
Put an audio CD in your disc drive and iTunes automatically opens. If you’re 
connected to the Internet, iTunes goes to an online database and (if it can find the 
cd in the database) gets the artist, album title, song names, times, and more, and 
displays that information in the iTunes window. A message window opens and asks 
if you want to import the cd. If you want to import the entire cd, click “Yes.” 

If you want to import just specific songs on the cd, click “No,” then select the songs 
you want to import—uncheck the checkboxes of songs you don’t want, checkmark 
the songs you do want. You can Command-click to check or uncheck all boxes.

Click the “Import cd” button in the bottom-right corner. only the songs you 
checked will import into the Music library.

create a Smart Playlist
A regular Playlist holds the songs or music videos that you add to it by dragging 
items into it. A Smart Playlist automatically adds certain songs from your Music 
collection all by itself. It’s really great. 

1 Hold down the option key—the + sign at the bottom of the Sidebar turns  
into a gear wheel; click the gear wheel.  
Or go to the File menu and choose “New Smart Playlist… .”  

2 In the dialog box that appears (shown below), open the menus (starting from the 
left) and make your choices. Click the + on the right to add more parameters. 
Click ok.

3 The Smart Playlist appears in the iTunes Sidebar, waiting for you to rename it. 
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Share your Music
There are two ways to share in iTunes. one, called Sharing, allows users on a local 
network to listen to each others’ music by streaming, but not copying. The other, 
Home Sharing, allows you to stream or copy content to your other computers on 
your local network. This is handy when you’ve got a lot of music on one Mac, say 
in your office, and you want to transfer it to your laptop or other computers in your 
home. You can do this on Windows machines that are running iTunes as well.

Sharing (streaming) on your local network
Share your Library of music with other computers on 
your local network. open the iTunes preferences (right). 
Click the “Sharing” tab, then select “Share my library 
on my local network.” If you choose to “Share selected 
Playlists,” check the items you want to share.

Shared music Libraries appear in the iTunes Sidebar, 
under the “Shared” label. Content shared this way can  
be played by, but not copied to, the other computers. 

Use this method when you don’t have an Apple id 
(required for Home Sharing, explained below), or when you don’t want the other 
computers to be able to make a copy of your iTunes content.

Home Sharing on your local network
Home Sharing lets you stream or transfer (copy) your iTunes content (with the 
exception of movie rentals) with up to five other computers (owned by you) through 
your local Ethernet or Wi-Fi network. You’ll need your Apple id, such as an iTunes 
Store or App Store account, to enable Home Sharing on your computer; you need to 
use the same Apple id to enable Home Sharing on the other computers.

Turn on Home Sharing on your Mac
1 Select the “Home Sharing” icon in the iTunes Sidebar,  

shown circled on the right.

  (If the Home Sharing icon is not in the Sidebar, go 
to the Advanced menu and choose “Turn on Home 
Sharing.” of course, you can also turn it off here.)
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2 When the Home Sharing screen appears (above), enter your Apple id and 
password. If you don’t have an Apple id yet, click “Need Apple id?”

3 Click “Create Home Share,” then click “Done” in the next pane that appears. 
once Home Sharing is enabled, the Home Sharing icon in the Sidebar disappears.   

Set up your other computers
 Use the procedure above to enable Home Sharing on your  

other computers. The Library names on the other computers  
will appear in the Sidebar under the “Shared” category.

Use Home Sharing
1 In the Sidebar, select the shared Library that you want to connect to.  

The contents of that iTunes Library appears in your iTunes window.

2 To play a song or movie, double-click its name.

3 To manually transfer (copy) a song or movie to your own iTunes library,  
drag it to the iTunes Library in your iTunes Sidebar. Or select it and then  
click the “Import” button in the bottom-right corner of iTunes.

4 To automatically transfer iTunes content from another computer, select the 
Library in the Sidebar from which you want to copy content, then click the 

“Settings” button in the bottom-right corner of iTunes. Check the type of 
content you want to transfer, then click ok. 

iTunes automatically 
transfers new content the 
next time you download 
movies or songs from the 
iTunes Store.

Click this to choose categories 
and Playlists to enjoy.
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burn a cd of your own collection
You can burn cds of your own Playlists, and you can play those cds on any 
computer or in any cd player. First import the songs and make a Playlist, as 
described on pages 190–192. You can’t just select songs in the music Library to burn 
to a cd—you must make a Playlist. Then:

1 Insert a blank cd-r (don’t use cd+r).

2 In iTunes, select a Playlist. You can only burn one Playlist onto a music cd, 
so make sure it’s got everything you want in it. You can burn about 600 mb 
(megabytes) onto one cd, so add as many songs from as many different artists 
and albums as you like. Check the status bar at the bottom of iTunes to know 
how many megabytes are in the selected Playlist.

3 From the File menu, choose “Burn Playlist to Disc.” 

 In the “Burn Settings” dialog that opens, choose “Audio cd.”   
The default speed option is probably set to “Maximum Possible”; that’s good.

4 Click the “Burn” button. When it’s finished, you’ll see the name of the cd  
in the Sidebar, along with an eject symbol. Eject the cd and enjoy!

 It’s possible to make a huge Playlist that holds many more songs 
than will fit on one cd. When you put in the first disc and click the “Burn Disc” 
button, iTunes will warn you that it will take more than one disc. Click ok; iTunes 
tells you when the first disc is full, ejects the completed disc, and asks you to 
insert another blank disc.
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Watch Movies in itunes
You can buy movies or television shows and watch them directly in iTunes. If you 
buy an Apple TV device and have a wireless system and widescreen tv in your 
home, you can stream the movies and shows from your computer to your television. 
(To do so, you’ll have to read the directions that come with the Apple tv.) 

To watch a movie or tv show in iTunes on your computer:
1 Go to the iTunes Store and buy a movie or television show. After it downloads, 

it appears in the Library pane under “Movies” or “TV Shows.”

2 Select “Movies” or “TV Shows,” then double-click the name of the movie or 
show. The film immediately opens in the iTunes window, as shown below.

  To view it full-screen, either click the arrows (circled below) or hit Command F.

These controls appear when 
you hover the pointer over 

the playing movie. 

Full-screen mode.

To quit 
the movie, 
click here.

Grid view shows re-sizeable thumbnails of your movies.

Resize the 
thumbnails.
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Listen to Radio from around the World
You can listen to radio from around the world with the click of a button. In the 
Sidebar, click the “Radio” icon, circled below. Double-click a category to see the 
variety of stations available in that genre, and double-click the radio stream you 
want to listen to. Amazing. 

audiobooks in itunes
You can buy and listen to audiobooks directly in iTunes. 

To buy an audiobook, go to the iTunes Store, select the “Audiobooks” tab, then shop. 

To play an audiobook once you’ve bought and downloaded it, hover over its 
thumbnail, then click the “Play” button that appears (circled, below).

The books and pdfs 
shown in this top 
section are not 
audiobooks; they are 
files John downloaded 
to his iPad. They appear 
in iTunes because this 
is where he syncs to his 
mobile devices. 
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Update 
the Genius 
Playlist.

iTunes DJ 
Playlist.

itunes dJ, genius Playlist, and genius Sidebar
Why go to the trouble of making Playlists when iTunes will do it for you? Click 
iTunes DJ in the Sidebar. iTunes automatically picks songs from your Music 
collection and creates a random mix that updates after each song. You can change 
all songs in the list (click the “Refresh” button in the bottom-right corner), or 
reorder it (drag items up or down in the list) at any time. 

Click the “Settings…” button (bottom-left corner) to determine how many songs 
appear in the list at a time. If you’ve downloaded the free iPhone or iPod Touch app 
called “Remote,” you can give permission to guests to wirelessly request songs and 
to vote for songs (the vote controls when a song plays)—a good party app.

or instead of creating a random Playlist, create an automatic Genius Playlist of 
songs based on the current selection: Click the Genius Playlist in the Sidebar. iTunes 
automatically creates a Playlist of songs from your library similar to the current song.  

The Genius Sidebar (which appears on the right side of iTunes) recommends songs 
from the iTunes Store, based on your current selection. 
To show the Genius Sidebar, click the Show Genius Sidebar button (bottom-right). 
To hear previews of recommended songs, click the button next to the song.  
To buy a suggested song, click the “Buy” button.  

The Genius 
Sidebar 
recommends 
songs for you.

Show/Hide Genius Sidebar.Refresh the Genius list.Genius Playlist.



ptg6934589

Lesson 10 iTunes for Your Listening Pleasure

198

Socialize Musically With Ping
Ping is a social network for music that’s built right into iTunes. Follow your favorite 
artists and friends, see what music they’re buying, and read their comments about 
albums and songs. You can also allow others to follow your own song choices and 
read comments that you choose to post on Ping. 

To get started, click the “Ping” option in the Sidebar, then click the “Turn on Ping” 
button, shown below. Follow the instructions on the screen to create a new Ping 
account, then start following the artists, celebrities, and friends you’re interested in.

Print a cd cover insert
You can print in a variety of ways from iTunes. This is great when you’ve burned 
your own collection of music to play in the car and want to keep your travel music 
discs labeled and organized.

1 Select a Playlist, then hit Command P to print, or go to the File menu and 
choose “Print….” 

2 Experiment with the options in the window that opens (below).  
Choose a“Print” option, then choose a “Theme” for that print option.
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tune in to Visual effects
To see visual effects that react to the music you’re playing, turn on the beautiful 
iTunes Visualizer. 

1 Choose a visualizer: Go to the View menu and choose “Show Visualizer.” From 
the sub-menu, choose one of the options. “iTunes Visualizer” is the most 
current version;  “iTunes Classic Visualizer” is from previous operating 
systems, but still impressive. 

2 Go to the View menu again and choose “Show Visualizer.”  
Or press Command T to toggle the visualizer on and off.

3 To show the visualizer effects full screen, from the View menu, choose  
“Full Screen.” Or press Command F to toggle between full-screen view  
and a normal iTunes window view (shown below).

For fun, from the View menu, choose “iTunes Visualizer,” then choose “iTunes 
Classic Visualizer,” then tap these keyboard commands to alter the visualizer effects: 

I display track info
C toggle auto-cycle 
F toggle freeze mode
L toggle camera lock

N toggle nebula mode
P change the color palette
R change the mode (very fun; tap it every few seconds).
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Unlock and   
duplicate images

Crop, color adjust,   
and resize images

Make screenshots

Save files into other formats 

Search pdfs 

Create pdf Bookmarks   
for easy retrieval of files

Copy text from a pdf
to paste into another 

document as editable text

Annotate and   
mark up a pdf

Fill in pdf forms

Print documents in a   
variety of ways
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LESSON 11

Preview for Viewing 
Images, PDFs, and more

The small picture-viewing application called Preview does a 

great deal more than merely display photographs for you. It’s 

actually quite a powerful program in which you can open and 

annotate pdfs (even add your signature to a pdf), change file 

formats, crop images, adjust image color or size, make screen 

shots of what you see on your screen, and more. 

As in any of the lessons in this book, we cannot explain every 

single menu command or preference! But take a few moments 

to explore the possibilities in the menus and preferences. 
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Open an image or folder of images
If you haven’t changed the default settings, you can just double-click images or pdfs 
and they open in Preview. Preview is in your Dock (if not, see page 22 to put it there). 

To open an image (or multiple images) in Preview, do any of the following: 
n	 Double-click the file.
n	 Drag one or more images (or pdf files) into the Sidebar.
n	 Drag-and-drop an image or pdf onto the Preview icon in the Dock.  

You can drag an entire folder of images to the Preview icon and they will  
all open and display themselves in the Sidebar, as shown above. 

n	 Control-click an image, select “open With,” and choose “Preview.”

To view multiple images as a contact sheet, click the Contact Sheet 
button in the Toolbar (shown to the right). To enlarge or reduce the 
image sizes in Contact Sheet view, click the + and – zoom buttons  
in the Toolbar.

Drag anywhere on this edge to resize the Sidebar and thumbnails. 

Click the second button to view 
the image plus the Sidebar.

Full-Screen 
mode; see 
page 54.



ptg6934589

Lesson 11 Preview for Viewing Images and pdfs

203

Unlock or duplicate to Make Versions
The moment you try to make any change to an image, a small sheet drops down 
asking you to Unlock or Duplicate the file (shown below-left). 

	 If you unlock the image, your changes will be made to the original file. 
	 If you choose to duplicate the image (unlock it first), a copy or new version of 

the image appears in front of you, as shown below-right. It appears to have a 
new name, but this is just fooling you—nothing will be saved until you press 
Command S (or go to the File menu and choose “Save…”) and rename it

A little message appears in the title bar whenever there are unsaved changes 
(“Edited). Each time you save (Command S) this duplicate file, a new version is 
created for you. Whether or not “Edited” or “Locked” is visible, you can always 
single-click on the title bar (a disclosure triangle appears when you hover the pointer 
over it), and choose to “Browse All Versions.” See pages 58–59 for more details. 

These are the versions 
you have saved, or that 
Preview automatically 
saved for you every 
hour. Click any title bar 
to bring it to the front, 
or use the time slider to 
view other versions. 
Slide the cursor all the 
way to the top of the 
screen to display the 
Preview menu bar. 
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A selection made with the  
Rectangular Selection Tool.

The cropped image.

crop an image
You can crop any photograph or other image very easily in Preview. When you crop 
an image, the part you remove is gone from the original image forever. You might 
want to make a duplicate of the file before you crop (see previous page). 

To crop a photograph or other image:
1 open the image in Preview.

2 Click the “Select” button in the Toolbar and choose a Selection tool from the 
pop-up menu. You can crop into a circle, oval, rectangle, or use the lasso tool 
to draw a shape.

3 To resize the cropped area, drag any of the tiny round “handles” that you see 
on each corner and side (you won’t get handles on a lasso selection).

4 To move the cropped area to a different part of the image, press in the middle 
of the cropping box and drag.

 To cancel, press the Escape (esc) key, or click outside the selected crop area.

5 When you are ready to crop, go to the Tools menu in the upper menu bar  
and choose “Crop.” Or press Command K. 
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The original image. The color-adjusted image.

adjust image colors or Size
Preview can do some limited editing of graphic images and photos (use the Tools 
menu). You can crop, as explained on the opposite page, and also resize, rotate, and 
resample (change the pixels per inch). And you have some pretty powerful color 
adjustments available. The only way to learn how to use them is to experiment! 
Always save a duplicate of the original before you start experimenting. 

To adjust the color (or the size) of an image:
1 open an image in Preview.

2 From the Tools menu, choose “Adjust 
Color…” or “Adjust Size….”; choose whether 
to unlock or duplicate (see page 203).  
To adjust size, fill in the fields; to adjust 
color, you’ll see the panel shown to the right. 

3 Move the sliders left and right to see what 
the options do. The image immediately 
changes as you adjust the sliders. You can 
always click the button (circled, right) to 
“Reset All” and restore the image to the  
way it looked in the first place. 

4 When you’re satisfied with the changes, 
press Command S to save. Then you can 
carry on with more changes that you can 
choose to save or not. Don’t forget that your 
Mac is saving various versions for you (see page 203).

Reset all settings.
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Make Screenshots using Preview
A screenshot is a picture of what your screen looks like at that moment. It’s 
useful when you need to show someone a problem on your screen, or to show off 
something cool that’s only on your Mac. Use it to show a comp of your design idea to  
a client or instead of a large photograph that is too big to reasonably put in email.  

To make a screenshot:
1 open Preview.  

2 Go to the File menu, slide down to “Take Screen Shot,” then choose either:

	 From Selection: A crosshair icon appears. Press-and-drag around an area to  
take a screenshot of just that area. When you let go, it takes the shot.

	 From Window: A camera icon appears, shown below. As you move the 
camera icon on top of different windows on your screen, it highlights each 
one in blue. When the window you want is highlighted, single-click. It takes a 
picture of the entire window, whether or not you can see the whole thing.

	 From Entire Screen: Preview gives you ten seconds to get your screen set up 
the way you want it for a screenshot. For instance, you might want a picture 
of a particular menu with its submenu visible. After ten seconds, Preview 
snaps a screenshot of the entire screen. 

The screenshot immediately and automatically opens in Preview. From the File 
menu, choose “Save….” Choose a format, name the file, and save in a location of 
your choice.

Also see page 444
to learn how to 
take screenshots 
with keyboard 
shortcuts.
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import images from a camera or Scanner
If you have an image device connected, such as a camera, a digital photo card reader, 
or a scanner, you can use Preview to import images. 

From the File menu, choose “Import from Camera…” or “Import from Scanner….” 

If your scanner doesn’t appear in the “Import from Scanner…” menu, go online and 
search for the latest “driver” software for that scanner. After you download and 
install the driver, the scanner name should appear in the menu.  

Save an image as another format
Sometimes you need a file in another format. For instance, maybe the file is in the 
file format called jpg from your camera, but you need it in the format called tiff 
because you need to put it in a brochure that’s going to be printed on a professional 
press. or maybe you have a large png file and you want a smaller jpg of the image.

To change a document into another file type:

1 open the original image.

2 Make a duplicate of the file: Single-click on the title bar and choose “Duplicate,” 
or go to the File menu and choose “Duplicate.” 

3 When the duplicate opens, go back to the File menu and choose “Save…”  
or “Export….” 

4 In the dialog box that opens, click the “Format” pop-up menu to choose a file 
format. Set any necessary adjustments. Name the file. Click “Save.”

Choosing different formats will provide 
you with different adjustment options 
specific to that format. 

Click the disclosure triangle circled 
above to view the larger pane. 
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Working with pdfs
Everyone uses pdfs these days (Portable Document Format files). If you want a few 
more options in working with your pdfs, check out what you can do in Preview.  

Display facing pages or continuous pages
You can display facing pages of pdf documents, as in a book (the first page will always 
display alone, like the first page of a book). This works whether or not the person who 
created the pdf saved the file in the “Spreads” format (which combines facing pages 
in the pdf). In fact, even if someone did create the pdf pages in spreads, you can view 
them in Preview as individual pages. This comes in very handy when you need to print 
the document but don’t want to print two-page spreads on one page.

To switch back and forth from single pages to facing pages (above), go to the  
View menu, then choose “Single Page” or “Two Pages.” Choose “Continuous Scroll” 
to show the pdf document as one long, scrolling page. 

You can open multiple pdfs simultaneously—just drag the files into the Sidebar, or 
drop them on top of the Preview icon in the Dock. Try viewing them in the Contact 
Sheet view; click its button in the Toolbar.

Thumbnails view shows page thumbnails in a Sidebar.
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All search results are highlighted.

Click here to clear all search results.

From the 
Sidebar search 

results list, 
select a page   
to jump to it.

Choose how 
to sort search 

results.

Search field.

Search a pdf
The search feature in Preview is quite amazing. Use the standard keyboard shortcut 
for “Find”: Command F. once you have found an instance on the page, press 
Command G to find the next instance. These are the same shortcuts you’ve probably 
used in Safari to find text on a web page or in TextEdit to find text in your document. 

To search a pdf:
1 open a pdf document, press Command F (or just click in the Search field), 

then type the word or phrase you want to find in the document.

2 The Sidebar opens to show a summary of the search results. Use the buttons 
at the top of the Sidebar to choose how to sort the results: “Search Rank” 
(number of matches per page) or “Page order.” 

3 As you type, Preview starts finding and highlighting words that match.  
The more letters you type, the fewer matches are found. 

4 In the Sidebar summary of results, click any item to go directly to that page.  
Click the Previous and Next buttons to cycle through the matches found.  
or press Command G to go to the next match in the document.
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Create bookmarks in a pdf
A Bookmark puts the name of a file in the Bookmarks menu of Preview so you 
can open the document or photograph immediately without having to go look for 
it—open Preview, then choose a Bookmark listed in the Bookmarks menu (below-
right), and the pdf file opens and displays that particular page. This is an easy way  
to quickly access important pages from different documents.  

To make a bookmark, open a document or image, then press Command D (or from 
the Bookmarks menu, choose “Add Bookmark…” as shown below-left). You will be 
asked to name the bookmark. Give it a name that you’ll recognize in a list.

	 If the pdf is a multipage document, you can make several bookmarks for the 
same document, each one to a different page. Just make sure you are viewing 
the page you want to bookmark before you press Command D.

To open a bookmarked file, open Preview, go to the Bookmarks menu, and choose 
the bookmark name from the list at the bottom of the menu (above-right). 

To edit the name or to remove a bookmark, go to the Bookmarks menu  
and choose “Edit Bookmarks….” The Preview preferences window opens, shown 
below. Click the “Bookmarks” icon in the Toolbar, then:

To delete a file, single-click the file name,  then click the “Remove” button. 

To edit the file name, double-click its name, then edit. 
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Copy text from a pdf to paste elsewhere
You can copy text from a pdf file (as long as the person sending it to you hasn’t 
locked it) and paste it into any other document as editable text. or you can copy  
a section of text as a graphic and paste it into another document as a graphic image 
that can be resized as a unit.

To copy text:
1 Select the Text tool, shown circled below, or press Command 2.

2 Press-and-drag over the text you want to select. 
 To select just a vertical portion of text, as in one column, hold down the 

option key before you start to drag, and keep it held down as you drag.

3 From the Edit menu, choose “Copy,” or press Command C.  
open your other document and paste it in (Command V).

To copy any part of a pdf as a graphic, click the “Select” button in the Toolbar 
(shown below). Press-and-drag in the pdf document to select an area you want  
to copy. Go to the Edit menu and choose “Copy” (or press Command C).

Now you can go to any document in any application and paste that graphic in.  
To paste it, open the other document, press Command V, or go to the Edit menu 
and choose “Paste.”
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Annotate a pdf
You can add comments, highlights, shapes, and more to pdfs to call out items for 
other readers. The “Annotate” button should be in the Toolbar (if not, go to the View 
menu, choose “Customize Toolbar…,” and drag it into the Toolbar). 

To create a text note on a pdf:
1 In an open pdf, click the “Annotate” button in the Toolbar to display the tools. 

Then click the “Note” button in the annotation tools.  

2 Single-click on the page where you need a note or comment.  
Preview places a small Note symbol on the page and immediately  
creates a text Note in a Sidebar. 

3 To type the Note, just start typing; the text appears in the Sidebar.  
By default, Preview adds your name and the date to the note  
(see the Preview preferences if you want to change that). 

4 To move a Note symbol, drag it; the Note text (in the Sidebar) will align itself 
with the Note symbol. 

5 To delete a Note, single-click its symbol to select it, then hit Delete.

Annotations Toolbar. The “Note” button is selected.
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To draw an oval or rectangle annotation:
1 open a pdf; click the “Annotate” button in the Toolbar.  

Double-click the Shape button (the first button) in the annotations Toolbar. 

 To create an oval, select “oval” from the pop-up menu. 

 To create a rectangle, select “Rectangle” from the pop-up menu.

2 With the tool, drag anywhere on the page to create a shape.
3 To resize a shape, single-click to select it, then drag the handles to resize. 

4 To move a shape, single-click the shape, then drag the shape around the page.

5 To delete a shape, single-click the shape to select it, then hit Delete. 

Also experiment with the other annotation tools to highlight, underline, or strike 
through text.

To delete an annotation:
1 open a pdf that has annotations in it; click the “Annotate” button in the Toolbar.  

Double-click the Shape button (the first button) in the annotations Toolbar.

2 Select an item in the list to show it in the Preview window. 
To delete an annotation, select it in this list, then hit the Delete key.

Show Annotations List.

The Annotations List.
Select the other tools 
in the Inspector Toolbar 
to add keywords, crop & 
rotate, and more.
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Create a link on an existing pdf
You can create live links in any pdf; send the pdf on to someone else and the link 
still works. The link can go to any web page, in which case clicking on it opens Safari 
to that page. or the link can go to another page in the same document. For instance, 
you might have a report with a table of contents—you can create links from the 
table of contents to the actual pages in the pdf.  

To create a link:
1 open a pdf, click the “Annotate” button in the Toolbar.  

Single-click the “Link” button in the Annotation Toolbar. 

2 Drag over some text or an image where you want to create a link. What the text 
says on the page has nothing to do with what you will enter as a link. 

3 Preview automatically draws a diagonal pattern on top of the area you just 
selected, indicating this is the hotspot that holds the link information.

4 A link info bar appears next to your selection (shown below). 

  Single-click the pop-up menu at the left end of that bar and choose  
the type of link you want to create: “Page” (a page in this document)  
or “url” (a web address). 

Click here to create or show links.Link info bar.
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If you choose to link to a url (as shown on the previous page), type the entire web 
address including http:// (or whatever it is) into the link info bar. 

If you choose to link to another page in the pdf document (below), type the page 
number to which you want to link into the link info bar.

In the document, the links are invisible unless you click the “Links” button in the 
Annotations Toolbar. When someone moves her pointer over a hotspot link, the 
pointer turns into a hand, and the link address appears in a yellow tooltip (below).

The shaded area 
will be the link.
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Digitize your actual signature for pdfs
When someone sends you a pdf document that requires your signature, you can 
create a digital version of your real signature, size it, and place it in the document.

To create a signature: 
1 open a pdf in Preview. Go to the page that needs a signature.

2 Click the “Annotate” button in the Toolbar. In the bar of annotation tools that 
slides down from the Toolbar (below, left), click the “Signature” button.

3 In the pop-up menu, select “Create Signature from (name of your camera).” 

4 The “Signature Capture” window opens. Sign your name on a piece of white 
paper, then hold the paper up to the Mac’s camera and align it with the blue 
line (below, right).

5 Click the “Accept” button (circled, below-right).

To size and place a signature: 
1 Click the “Signature” button again; from the pop-up menu, select the signature 

you want to use. You can store multiple signatures in Preview.

2 Drag the pointer on the page. The drag determines the size of the signature, 
which can be adjusted later, if necessary, by selecting it and dragging the 
handles that appear when selected.   

Select a signature you created.  
Click “Manage Signatures…”  
to add or delete signatures.

To reposition the signature, drag it.  
To resize the signature, drag the handles.
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Fill in pdf forms
You can actually fill in some web forms right on your screen, if the forms have been 
properly created. Then you can print the fully completed form, instead of printing it 
first and then filling it in by hand. 

The pdf must have been created and saved in such a way that it has fields ready for 
you to enter data. That is, you just can’t start entering data into any old pdf—it must 
be an actual form format. 

To fill in a pdf form:
1 open an appropriate pdf form in Preview. The example below is a tax form 

downloaded from the irs site. 

2 Click on the Text tool, shown circled below.

3 Click in the area where you are supposed to enter data. An insertion point 
appears and the text field becomes visible, as shown below.

4 Type! Be sure to save regularly.
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Print or fax from Preview
You can print or fax any image or document from Preview.

To print an image or document: 
1 If you have multiple images open in Preview, select the ones you want  

to print: Command-click to choose them from the Sidebar or from  
the Contact Sheet view. 

2 From the File menu, choose “Print….” 

 A Print dialog sheet slides down from the title bar, shown below. Spend a few 
minutes looking through all the options; click on the menu that says “Preview” 
to see more options. You can experiment with different settings and see how 
they affect the preview on the left. 

3 When you’re satisfied with your settings, click “Print.”

Click here to collapse this Print dialog sheet 
to a smaller, less detailed dialog sheet.
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To fax an image or document:
Not many computers today have an internal (or external) modem installed, and you 
can’t fax without one. You must have a modem to fax, and it must be connected 
with a phone cable to a telephone outlet—you can’t fax over the Internet. 

If your Mac has a modem that is connected to a phone line, it is automatically 
configured to send faxes.  

1 From the File menu, choose “Print….”

2 Click the “PDF” button in the bottom-
left corner of the Print dialog sheet.

3 Choose “Fax PDF….”

4 Enter the fax number you want to send 
this to.

5 Click the “Fax” button. 
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GoALS

Use the App Store   
to get  more tools!

Use the Burn Folder   
to collect files for burning   

to a cd or dvd

Create bookmarks   
in dvds

Create a pdf from any file

Use Font Book to preview   
and install fonts

Keep track of your life   
with Stickies

Use Photo Booth   
to take still shots   

and movies of yourself

Make movie and audio 
clips to share online with 

QuickTime Player
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LESSON  12

Miscellaneous  
Tools on Your Mac

Your Mac has a number of great tools in the form of small 

applications, some of which get overlooked. This lesson 

introduces you to some features and possibilities that you 

might not be taking advantage of yet.

Burn Folders make it easy to keep track of items you want to 

burn onto discs at a later date. The dvd Player has some great 

features that may surprise you, especially if you teach a class 

and use dvds as part of your presentation. You’ll be surprised 

how easy it is to create a pdf from any file. Font management 

is simple when you use Font Book. Applications like Stickies 

and Photo Booth are both useful and fun. And QuickTime 

Player makes creating, editing, and sharing video and audio 

files easy and fast.

Take a look at what you may have been missing! 
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the app Store: a Shop in your dock
The App Store icon in the Dock puts you a click away from Apple’s online App 
Store where you can shop for all kinds of applications, browse app categories, read 
reviews and view average ratings, update an app, or buy a new one and download 
it directly to your Mac. Downloaded apps are automatically installed and appear in 
Launchpad, ready to go. 

Click the App Store icon in the Dock to open the App Store window. 

Click Launchpad to access apps you downloaded from the App Store.

view the App Store.
Choose how to Click to exit the 

App Store.
Review purchases or 
download app updates. Search for apps.

Click here to connect to the App Store.

You need an Apple account and an active Internet connection. If you don’t already 
have an Apple account, you can create one after you click a “Buy” button, or click the 

“Account” link in the “Quick Links” section of the App Store window (circled, below).

To select and app, and learn more about it,  
click the price button, the app name, or the app icon.



ptg6934589

Lesson 1 2 Miscellaneous Tools on Your Mac

223

When you find the app you want and go to its page, click the “Buy” button. A confir-
mation sheet slides down from the title bar to let you know that after you click the 
“Buy” button, your credit card will be charged (the credit card you used to set up an 
Apple account), and your app will begin to download immediately.

The download process places the new app in your Applications folder, and it is also 
accessible from Launchpad. Third-party apps (those not from Apple) appear in 
Launchpad on a secondary screen, not the first screen (reserved for Apple applica-
tions) that appears when you enter Launchpad. 

To access the additional screens in Launchpad, first click the Launchpad icon in 
the Dock, then do one of the following:

n	 on a Magic Mouse, swipe left with one finger on the mouse surface.
n	 on a Multi-Touch trackpad, swipe left with two fingers on the surface.
n	 Click one of the small dots that appears near the bottom of the Launchpad 

screen, but above the Dock. The white dot indicates which Launchpad screen 
is currently visible. 

n	 Tap the right arrow key to go to the next Launchpad screen; tap the left arrow 
key to return to the previous screen.
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I put this Burn Folder 
in my Home folder. 

Then I dragged it into 
the Sidebar so it’s 

accessible no matter 
what folder I’m viewing. 

The files in the Burn Folder are all aliases—
you can tell by the teeny weeny curved 
arrows in the bottom-left corner of each icon.

Click this refresh button to 
keep track of how much storage 
space you need for the files.  

D
You need to make backups of your important work, as well as any applications, 
fonts, or other files that you download straight from the Internet. 

The steps to burn data files (not music cds or dvd movies) onto a disc are below (to 
burn a music cd, see page 194). A cd holds about 650 megabytes; a single-layer dvd 
holds about 4.3 gigabytes, even though the package might say it holds 4.7. 

Using a Burn Folder makes it very easy to collect your files over a period of time 
and then to burn a disc when you’re ready. You just drop items into this special 
folder; your Mac actually puts aliases of the files in the Burn Folder (see page 443 
for details on aliases) and leaves the originals in their original locations. This means 
that after you burn the disc, you can throw away the entire Burn Folder without 
destroying any original files. 

The great thing is that you can collect items you want to burn without having to 
actually burn the disc at that moment—you can collect files over the span of a 
project and when finished, you have a folder ready to back up onto a disc. 

To create a Burn Folder, put files inside, and burn it:
1 open a Finder window. Select the folder in which you want the Burn Folder to 

appear (you can move it at any time).

2 From the File menu, choose “New Burn Folder.” 

3 A folder with the “Burn” symbol on it (below) appears in the selected window.
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As mentioned, to make the whole process easier, drag the Burn 
Folder into the Sidebar of any Finder window; you can drop files directly on that 
folder while it’s in the Sidebar. The folder displays a burn icon next to it—you can 
single-click that burn icon to start the process.

You can make as many Burn Folders as you want. Rename them like 
any other folder. This makes it easy to have a separate Burn Folder for each project.

To check the amount of storage space used in the folder:
1 Single-click the Burn Folder icon.

2 Press Command I to display the Info window.

3 Click the disclosure triangle next to “Burning.”

4 Click the “Calculate” button to see how much  
you have collected in the folder.

 You can also check the status bar at the bottom of 
the Burn Folder window, as shown on the opposite 
page. The text in the status bar tells you how many 
items are there, and how much disc space will be 
required. (If the status bar isn’t showing in the 
window, go to the View menu and choose “Show 
Status Bar.”)     

4 To put a file or a folder in the Burn Folder for later, just drag the original 
file or folder and drop it into the Burn Folder, either in the Sidebar or in its 
real location. Your Mac puts an alias of the file into the Burn Folder and the 
original stays right where it was, safe and sound.

5 To burn the folder onto a disc, first insert a blank cd or dvd. 

6 Then select the Burn Folder, either the Sidebar icon or the actual folder that 
you made earlier. A dark gray bar across the top of the window appears with  
a “Burn” button, as shown circled on the opposite page.

 Click that “Burn” button to start the process. You will be asked to first name 
the disc. 

 If you change your mind and want to take an unburned disc out of the 
Mac, Control-click (or right-click) on the disk icon and choose “Eject disk name.”
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dVd Player
Besides playing your dvds and allowing you to control viewing as you do on a dvd 
player connected to your television, this DVD Player has several special tricks.

Display the thumbnail bar and controls
When a video plays in full screen mode (Command F), do the following: 

To see the dvd playback controls, move your pointer anywhere on the screen 
and they appear.  

To see the thumbnail bar that displays chapter markers, bookmarks,  
and video clips, move your pointer near the top of the screen. 

To show the dvd application menu bar, move your pointer all the way  
to the top of the screen.

These same controls can be found in the floating dvd player, in the Window menu, 
and in the Controls menu (important to know if you’re not using full-screen view).

Create bookmarks to find specific points in the video
A bookmark lets you skip immediately to certain points in the video that you 
choose. That is, you are not limited to the chapter markers that were created when 
the dvd was made. These bookmarks are not stored with the dvd; they are stored 
only on the Mac on which they were made. If you loan the dvd to anyone, it will not 
include your bookmarks.

To create a bookmark:
1 Start a dvd.  

2 Go to the Window menu and choose “Bookmarks.” The Bookmarks panel 
opens. When you get to the point in the dvd where you want to insert a 
bookmark, click the + button at the bottom of the “Bookmarks” panel.  

 Or go to the Controls menu and choose “New Bookmark….”

3 In the dialog sheet that opens, name the bookmark, then click “Add.”

once you have created bookmarks, use the Go menu and skip straight to any 
bookmark you made, or open the Bookmarks pane from the Window menu and 
double-click the thumbnail that represents the bookmark you want.
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Make dvd video and audio adjustments
To adjust dvd settings for video zoom, audio equalizer, and video color, go to the 
Window menu, then choose the adjustment you want to make. Use the sliders to 
make adjustments. Each set of controls provides a pop-up menu of presets in the 
top-right corner.

DVD region codes
A commercial dvd, such as a Hollywood movie dvd, usually has a region code
assigned to it in an attempt to fight piracy of worldwide releases of movies. The first 
time you use dvd Player to watch a dvd that has a region assigned to it, you will 
get a dialog (shown below) in which to set a “region” number for your dvd drive 
(not for the disk). Different regions of the world have different numbers assigned to 
them, so if you don’t assign the code for your area, you won’t be able to watch dvds 
from that area. 

If in the future you insert a dvd that uses a different region code than the one you 
have assigned, a dialog appears asking if you want to change your dvd drive’s code 
to match it. Be aware, however, that this can be changed only five times (including 
the first setting), and the fifth time is permanent. 

To see your dvd drive’s current region code,
go to the File menu, choose “Get Disc Info,” 
then click the “Regions” icon in the toolbar.

To change your dvd drive’s region code,
click one of the numbered regions on the map. 
North America is Region 1. 
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Drag an image 
into this space.

Create your own personal disc jacket on the screen
This is great—you can add your own image to the dvd so whenever you stop the 
dvd, it displays the image of your choice.

To add your own image to the disk: 
1 open a dvd in the dvd Player. 

2 Go to the File menu and choose “Get Disc Info.” 

3 Click the “Jacket Picture” icon in the toolbar, shown circled below.

4 Drag any image from your hard disk and drop it into the well. Click oK. Cool.

Remember, changes like this don’t really apply to the actual dvd—they are stored 
on your Mac. So the disc jacket will only appear if you show this dvd from the 
computer on which you added it. 

Go back to the Finder
When a dvd is playing full-screen, there are several ways to exit full-screen mode 
without interrupting the dvd playback: 

Press Command F (Command F toggles you in and out of full-screen). 
Or push your pointer to the top of the screen until the top menu appears,  
then go to the Go menu and choose “Switch To Finder.” Or press Command 
option F (both of which put the movie behind any open Finder windows). 
Or tap the Escape key (esc). 
Or go to the View menu and choose one of the size options there  
(including “Exit Full Screen”). 
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—continued

When someone tries to open a password-protected pdf, 
this password dialog opens.

create pdf files
A PDF (Portable Document Format) is a file created in such a way that most people 
can open and read it, no matter what kind of computer they use. The graphics, the 
images, the fonts, and all the formatting are held intact in the document. And it’s 
usually compressed into a smaller file size (not physical size) so it can travel through 
the Internet quickly or be stored efficiently. 

To make a pdf in most applications: 

1 open a document.

2 From the File menu choose “Print….” 

3 Click the “PDF” button in the 
bottom-left corner of the Print 
dialog.

4 Choose “Save as pdf….” 

You can password-protect a pdf file. When you choose to save as a pdf, you’ll see a 
“Security options” button. Click it to open a dialog where you can create a password 
so no one can open, copy, or print the document without it.

“Save as pdf…” saves a regular pdf that you 
can share with others. The graphics are at full 

resolution and the fonts are embedded. 
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Open pdf in Preview  
This comes in handy when you want to annotate the document, 
create links, etc., before sending it to someone else. See Lesson 11.

Save as PostScript  
This saves the document as a PostScript Level 2 file in ascii format, 
meaning that if you open it, you’ll see a lot of code. But you can 
send it directly to a Postscript printer or run it through Acrobat 
Distiller. Don’t choose this option unless you know you need it. 

Fax pdf If you have set up your fax specifications, then your Mac will make 
a pdf of the document and open the fax dialog box where you can 
enter the fax number and a message. Remember, you must have a 
phone modem attached to the Mac with a phone line connected. 

Add pdf to iTunes  
This adds the pdf to the Books section of iTunes. If you use iTunes 
to sync an iPhone or iPad, the pdf will be available on those mobile 
devices in the iBooks app. If you have pdf documents you need to 
read while on the go, this is a great way to make them available on 
your mobile devices.

Mail pdf This creates a pdf of the file, opens Mail, creates a new message, 
and puts this pdf in the message ready to send. This is a great  
time-saver, but we’ve noticed that people using AoL or PCs often  
can’t read these. 

Save pdf to Web Receipts Folder  
I love this. Have you ever bought something on the web and you got 
that page that says, “This is your receipt”? And you know you should 
print it but maybe the printer isn’t turned on at the moment or it’s 
three pages long and you know they’re going to send you an email 
receipt anyway, but what if they don’t send you the email receipt 
and you need this web page receipt? Well, this is a great solution: 
The Mac saves this web page as a PDF and it makes you a folder in 
your Documents folder called “Web Receipts” and it stores this pdf 
(and all others you make like it) in that folder. Thank you.
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Be careful, though—if you make a web receipt from the same site 
more than once, it will probably write over itself with the same 
name. Some sites automatically name their receipt file something 
generic like “Acme Receipt.” So when you create another pdf from 
Acme, it gets named the same thing as all the other receipts from 
Acme, and the newest version replaces the last one you created. 

Since this method doesn’t give you a chance to customize the file 
name, it can be safer to just go ahead and choose “Save PDF” in 
the Print dialog (shown on page 229). You can still create a Web 
Receipts folder in the Documents folder, or wherever you prefer, 
and save your files into it.

If you’re adventurous, you can search the Internet for an 
Applescript that will automatically append a date and time to the 
file name when you choose “Save PDF to Web Receipts Folder.”
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font book
Font Book allows you to install new fonts you acquire, disable fonts in your font 
menus that you never use, and view fonts before you install them.

Preview and install fonts
If you have some fonts or acquire new ones and you don’t know what they are, 
simply double-click the font file. Font Book opens automatically and displays the 
font. To install it, click the “Install Font” button.

Install fonts
If you have a number of fonts to install, this might be easier: 

1 open Font Book (it’s in your Applications folder and in Launchpad). If you don’t 
see the Font Book window (above-right), go to the Window menu and choose 

“Font Book.”

2 In the “Collection” pane, Control-click (or right-click) “All Fonts.” In the sheet 
that slides down, choose “Add Fonts….” Select fonts or folders of fonts (hold 
down the Command key to select multiple files), then click “open.” 

3 The first time you do this, Font Book creates a new collection for you, called 
“User,” and installs the fonts in this collection. These fonts are available only to 
your user account, not to other users you may have created (see Lesson 18).  

4 Font Book puts a copy of the fonts in the default install folder. You can then keep 
the original fonts in their original location, store the originals in some other 
location, copy them to a backup disk, or put them in the Trash.

To install fonts for all users, go to the Font Book menu, choose “Preferences….”  
Set “Default Install Location” to “Computer.”

Select the “All Fonts” collection to see all the fonts available 
to you. The other collections are subsets of “All Fonts.”
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Preview installed fonts
Single-click any typeface name in the “Font” pane of Font Book. A preview appears 
to the right. Use the slider to enlarge or reduce the typeface, or type in a point size.

Go to the Preview menu and choose: 
n	 “Sample” to display the upper and lowercase letters, as well as the numbers.
n	 “Repertoire” to see every glyph (letter, number, punctuation, etc.) in the font.
n	 “Custom,” and then type. Your words will display in this typeface (as shown 

below). Use the slider bar on the right to enlarge the font.

To disable an individual font, find it in the Font list. Single-click to select it, 
then click the little checkmark button (circled, above) at the bottom of the 
Font list. When the checkmark is removed, the font name is dimmed and the 
word “off” appears to the right of the font name. 

To view only the English language fonts, click the Collection named “English.”

Create your own Collections
A Collection is a subset of the installed fonts and is simply an easy way to look at 
fonts you like instead of having to grope through a lengthy font list of typefaces you 
don’t know or want. 

To make a new Collection, single-click the + sign at the bottom of the Collection 
pane, then name it. Click the “All Fonts” collection (so you can access all fonts),  
then drag font names from the Font pane to the new Collection name.

To disable (turn off) an entire Collection, select it in the Collection pane.  
Then go to the Edit menu and choose, “Disable collection name.” 

Drag the slider 
to adjust the 
text preview 
size. Or set a 
point size with 
the “Size” data 
field or pop-up 
menu, in the 
top-right corner. 

Click these 
buttons 

to choose 
Sample 

Repertoire, 
or Custom.
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Stickies
The Stickies application lets you put little sticky notes all over your screen, just 
like you’d stick them around the edge of your monitor (my kids tell me my monitor 
looks like a giant daisy). open Stickies from Launchpad.

Notice in the examples above you can see these features:

n	 The grocery note above is a bulleted list. 
	 To make a bulleted or numbered list, click inside a note. 
	 Hold down the option key and tap the Tab key once. 
	 Let go of the option key and type your first item. 
	 To continue the list, just hit a Return after each item. You can hit  

option-Tab to indent an extra level.
To end the list, hit Return twice.

	 To choose from a variety of bullets and numbers, or add a prefix and/or a 
suffix to the bullet: Control-click anywhere in the list; from the contextual 
menu that appears, choose “List….” The list includes a variety of Greek and 
Asian characters. You can change the bullet formatting at any time. You can 
create a numbered list that uses such prefixes as  (1) or Act 1: or •A• or any 
other combination.  

n	 You can change fonts, size, color, etc., just as in any other Mac application, 
using the Font dialog box (press Command T). See pages 252–253.
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n	 Double-click in the title bar of any Sticky note to “roll it up” so just the title 
bar shows, as you can see on the opposite page. The first line of type appears 
in the title bar. Double-click the title bar again to unroll the note.

n	 Hover your mouse over any note to display a tool tip of information about 
when the note was created and modified, as shown on the opposite page.

n	 Drag a graphic image from anywhere on your Mac and drop it into the  
Sticky note, as shown by the photo on the opposite page. 

n	 A note can hold many pages of text and graphics. You might not see scroll
bars until you start to scroll. Resize a Sticky note just as you would any other 
window—drag any edge or any corner. 

n	 Notice the red dots under the name Brianna. This is a visual clue that the  
spell checker is on and working. Control-click (or right-click) the underlined 
word, then choose one of the suggested spellings from the contextual menu. 
To set spell-checking options, Control-click on the note, choose “Spelling and 
Grammar,” then choose one of the options in the contextual menu. 

n	 If you prefer working with a certain font and a certain size and a certain color 
note, you can set a default so all your notes look like that without having to 
select your favorite specifications for every note. Just set up one note the way 
you like it, then go to the Note menu and choose “Use as Default.”

n	 If you want your Sticky notes to automatically open and appear every time 
you turn on your computer, add Stickies to the Login Items for your user 
account (see page 341). 

n	 To print a note, from the File menu, choose “Print….” Set your print options 
as you would with any other document. If you want to print multiple notes at 
once, you can copy and paste them into a single note, then print.

n	 You can quickly add a screenshot of something on your Desktop and have 
it appear immediately in a note: Click the cursor in the note where you want 
to place a screenshot. Control-click the note, then from the contextual menu 
choose “Capture Selection from Screen.” Drag across the part of the screen 
you want to capture. When you release the drag operation, the captured 
selection automatically appears in the note.

n	 To discard a Sticky note, click the tiny box in the top-left corner.
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When you click the red camera button . . . a countdown begins.

Photo booth
Photo Booth is a convenient and fun way to take snapshots or movies of yourself 
for use as an iChat buddy picture or as your user account picture. You can email the 
photos or movie clips to friends, upload them to web pages, open in Preview to save 
in other formats, or view as a slideshow.

Take a still picture 
	








4 Click a thumbnail to display it in the 
main window. As soon as you do this,  
a new toolbar of sharing tools (shown to 
the right) replaces the first one. Click an 
icon in this toolbar to send the photo in 
an email message, place it in iPhoto, set 
it as your user Account photo, or use it 
as an iChat buddy picture.

To delete a snapshot, select its thumbnail, 
then click the x on the thumbnail.   

Or select a thumbnail, then hit Delete.
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Add effects to snapshots or video
Photo Booth includes a gallery of special effects that you can apply as you take a 
snapshot or record a movie clip. That is, you can’t apply these effects after you’ve 
taken the photo—you have to choose an effect before you snap the photo.

1 Click the Effects button (circled, below-right) to show a pane of effects  
(below-left). The center image always shows a Normal preview (no effects)  
that you can select to remove all effects and return the image to normal. 

2 Click the arrows on either side of the Effects button (below-left) to see the options. 

3 Click the effect you want. A full-size preview displays in the window  
(below-right).

4 Click one of the snapshot buttons on the left side to choose the type of 
snapshot you want (4-up, still picture, or movie clip), then click the red 
camera button. The special effect snapshot (or movie clip, as explained on the 
following page) appears in the row of thumbnails. 

5 Select the image in the thumbnail strip and tools appear in the Toolbar 
(previous page, bottom-right) so you can share it: Attach the image to an email 
message, add it to iPhoto, or set it as your account picture in Mail, Address 
Book, or iChat.

Click one of these four 
gray squares to jump to 
another pane of effects.

Snapshot buttons: After you click an 
effect thumbnail, click one of these 
snapshot buttons: 4-up, still picture, 
or movie clip. 

Or click the arrows on either side of this 
Effects button to cycle through the panes.
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 To preview all of your snapshots that are lined up in the thumbnail 
strip, go to the View menu at the top of the screen and choose “Start Slideshow.” 
to exit the slideshow, press the Escape key.

Create a special effects backdrop
In the gallery of special effects (previous page), the last Effects pane is full of empty 
“User Backdrop” spaces. You can add your own photos or movie clips to be used as 
a special effects backdrop for Photo Booth still photos or movie clips. It works the 
same as creating backdrop effects in iChat, explained on pages 178–179.

The 4-up option
The 4-up button takes four photos, much like the old photo booths that used to be 
in drug stores and malls, at county fairs, and almost everywhere.

To print a 4-up collection of photos, select the 4-up thumbnail,  
then from the File menu, choose “Print.”

To view (or print) just one of the 4-up photos, select the 4-up thumbnail,  
then in the preview pane, click one of the four photos to make it fill the pane.

To save one of the 4-up photos to another location, first click one of the four, as 
described above. When it fills the preview pane, drag it from the preview pane to 
your Desktop, or drag it to any folder or window.  

To locate any of the Photo Booth photo files or movies on your computer,
Control-click a thumbnail, then choose “Reveal in Finder.” 

The 4-up effect.

Don’t forget, you can send this 
4-up image in an email message, 
or send it to iPhoto. Or you can 
select one of the individual shots, 
then share it, or use it as an 
Account picture or Buddy picture.
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The playhead.

Make a movie clip of yourself at your computer
1 Click the movie clip button (the film strip icon, shown here, selected). 

2 The camera button in the center of the toolbar changes to a red video button: 
Click it to begin recording. 

 While recording, the toolbar shows a timer, and the red video button changes 
to a Stop Recording button (below). When you stop recording, a thumbnail of 
the movie clip is placed in the thumbnails pane at the bottom of the window. 

3 Select the movie clip thumbnail, then choose how to use the movie clip.  
You have the following options:

n	 To trim the movie (delete frames from the start or ending) to a smaller 
size, click the “Trim” button on the right side of the scrubber bar. Drag the 
yellow handles to a start point and end point, then click the checkmark to 
commit the change.

n	 Click “Email” to attach a QuickTime version of the clip to a message in 
Mail. or click “iPhoto” to send the movie to iPhoto.

n	 To save the clip locally as a .mov (QuickTime) movie, drag the video 
thumbnail to your Desktop or to any folder on your computer.

n	 To use a single frame of the movie clip for your user Account photo or 
Buddy photo, select the movie thumbnail. Move your pointer over the 
movie preview pane to make the scrubber bar appear. Drag the playhead 
under the clip (circled, below) to select the frame you want, then click the 

“Account Picture” or “Buddy Picture” button (below, right) in the toolbar. 
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Quicktime Player
QuickTime is multimedia software that you can use to play and edit movies 
and audio files. When you double-click a QuickTime file, it should open in the 
QuickTime Player—but it might not. 

If the multimedia file you double-click is an older one, created or saved with 
QuickTime 7, you may get a message with a download link that tells you to 
download QuickTime Player 7 in order to play the old, dusty, ancient file from a 
whole year ago. 

Playing a movie in the newest QuickTime Player is a much more aesthetically 
pleasing visual experience. The QuickTime Player provides controls to trim files 
(edit the movie or audio file duration), as well as menu options that can automati-
cally send a QuickTime file to iTunes, your online MobileMe Gallery (if you have 
a MobileMe account), YouTube (if you have a free YouTube account), and several 
other options. 

You can also use QuickTime Player to create a new movie recording (using your 
Mac’s built-in camera or an external camera), a new audio recording, or a new 
screen recording (capture a movie of whatever is happening on your screen).

Play a movie or audio file 
1 Click the QuickTime icon in the Dock or in Launchpad to open the Player. 

2 From the File menu, choose “open File…” then select a movie (or audio) file 
you want to play.

 An Audio file opens as a small window with 
playback controls (right). 

 A movie opens in QuickTime’s elegant movie 
window, with a playback control bar visible 
(shown on the opposite page). 

If you need this older version  
of QuickTime so you can play  
older QuickTime files, click here.

Click the Play button to play 
the audio file.  
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Reverse, 
Play,  

Fast Forward.

Playhead.Volume control. Access sharing 
options and 
the Trim tool.

Toggle  
full screen.

3 Click the Play button. When you move the pointer away from the window, the 
title bar and control bar disappear to present the movie in an uncluttered window 
(shown below). To show the controls again, move the pointer over the window. 
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Share a movie
QuickTime can quickly and easily send movies to your MobileMe Gallery page, 
YouTube, or iTunes (also see page 245). And you can send audio files to iTunes.   

1 open a movie file in QuickTime (as explained on page 240, “Play a movie or 
audio file”).

2 Click the sharing icon (circled below) in the QuickTime playback control bar.  
From the pop-up menu, choose one of the options: Save your movie to iTunes, 
or to a MobileMe Gallery (a MobileMe paid membership is required), YouTube   
(a free YouTube account is required), or one of the other options, such as Flickr 
or Facebook. You can also go to the Share menu to see these options. 

Trim a movie or audio file
QuickTime makes it very easy to save or share just a partial selection of a movie or 
audio file.   

1 open a movie file in QuickTime (as explained on page 240, “Play a movie or 
audio file”).

2 Click the sharing icon (circled below) in the QuickTime playback control bar. 
From the pop-up menu, choose “Trim…” (or go to the Edit menu and choose 

“Trim…”).

 A thumbnail movie timeline appears at the bottom of the movie window, 
highlighted with a yellow border that has handles on the left and right sides 
(shown on the opposite page). 

The QuickTime playback control bar.
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4 To trim an audio file: open it in QuickTime. From the Edit menu, choose “Trim.” 
An audio waveform bar appears on the file’s window, highlighted with a yellow 
border. Drag the ends of the trim border to 
select the section of the file you want, then 
click the “Trim” button. Now you can export 
or share the audio file. 

3 To trim a movie clip: Drag the left and right sides of the yellow border to  
select the section of video you want to keep. After you make a selection, the 
dark gray “Trim” button highlights in yellow (shown in the bottom example). 
Click “Trim.”

 The movie can now be duplicated (from the File menu, choose “Duplicate”), 
exported (from the File menu, choose “Export…”), or shared (from the Share 
menu, choose iTunes, MobileMe Gallery, YouTube, or other media-sharing 
options). See page 245 for details about exporting and sharing.    
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Make a movie clip of yourself at the computer
If you have a built-in camera or a video camera attached, you can record a movie using 
QuickTime, then share it with others (explained on the opposite page). 

1 open QuickTime. From the File menu, choose “New Movie Recording.”

2 Click the red Record button on the Control bar. If you don’t see a Control bar, 
hover your pointer over the movie window to make it appear; the Control bar 
disappears when you move your pointer away from the window.

3 To stop recording, click the black Stop Recording button that replaced the red 
Record button. The Control bar changes to playback controls, so you can play 
the new movie.

4 If you close the movie window (click the red button in the top-left corner) 
without choosing to export or share it, it is automatically saved in the Movies 
folder in your Home folder, as a file named “Screen Recording.” To export or 
share the movie, see the opposite page.

Make a new audio recording
If you have a built-in microphone or an external mic connected to your Mac, you 
can make audio recordings with QuickTime.

1 open QuickTime. From the File menu, choose “New Audio Recording.”

2 Click the red Record button in the “Audio 
Recording” window (shown to the right).

3 To stop recording, click the black Stop Recording 
button that has replaced the Record button. 

Click here to show 
options such as 
camera and quality 
settings, and where 
to save. 
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Make a new screen recording
If you want to record the activity on your screen—for instructional purposes, or 
perhaps to record a streaming event on the Internet, or for any other reason—use 
QuickTime to make a screen recording. Share your recording as explained above.

1 open QuickTime. From the File menu, choose “New Screen Recording.”

2 In the “Screen Recording” window that opens (below), click the red button. 

To share or export your movie 
Share: Go to the Share menu and choose an option. 

Export: Export your movie, optimized for syncing directly 
with iPad, iPhone, Apple tv, or iPod touch. From the File 
menu, choose “Export….” From the “Format” pop-up menu, 
choose the range of devices you want to optimize for: “iPod 
touch & iPhone 3gs,” or “iPad, iPhone 4 and Apple tv.” 

To export a version optimized for web-delivery to mobile devices (or to your 
computer), go to the File menu and choose “Export for Web….”  A dialog opens 
so you can name and save the movie, and select which web-delivery option 
you want to create a version for: Broadband (fastest connection speed, highest 
quality movie), Wi-Fi (moderate connection speed, pretty good movie quality), 
Cellular (slow connection speed, lowest quality). 

3 The message shown below appears on the screen. Click anywhere on the screen 
to record the entire screen, or drag to select a specific part of the screen.

4 Recording starts as soon as you click or drag. To stop recording, click the  
Stop Recording button that appears in the “Screen Recording” window.

 If you don’t choose to share or export the screen recording, as described below, 
the movie is automatically saved in the Movies folder in your Home folder, 
with the default name “Screen Recording.”

Show options.

Record. Stop Recording.
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Preview a page   
before printing

Dictionary
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LESSON 13 

Common Tools in  
os x Applications

Every Apple application that comes on your Mac uses certain 

tools—the spelling and grammar checker, the Colors panel, the 

Fonts panel, the Dictionary, and a few others. Rather than tell you 

how to use each one within a certain application, included here are 

explanations of how to use each tool regardless of which applica-

tion you’re using it in. 

Many applications from other vendors also take advantage of these 

Apple tools, so look for them—they will make your computing life 

easier and more fun.
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Spell checker
options for the spell checker are found at the bottom of the Edit menu in Apple 
applications. You can also turn these features on or off as defaults in the preferences 
for the application. The menu option will override the default for that document. 

Show Spelling and Grammar: This brings up the dialog box shown below. 
This spell checker runs through your entire document and gives you options 
for each word it thinks is misspelled.  

If you want the spell checker to also alert you to possible grammar mistakes, 
click the box in the bottom-right corner to “Check grammar.”

  



The Mail application has 
a couple of extra options 
that you won’t find in,  
say, TextEdit.

If any of these options 
are checked, you’ll 
see red dots under 
misspelled words and 
green dots under bad 
grammar.

This option is what makes the text correct itself 
as you type. If that makes you crazy, uncheck it.

You can check spelling 
in a number of different 
languages; choose a 
different dictionary 
here. Or let your Mac 
automatically determine 
the correct language. 

Double-click the 
correct spelling.
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Ignore the spelling temporarily: If the spell checker keeps telling you the 
same word is misspelled, but you like the word spelled the way it is, click the 

“Ignore” button when that word is highlighted by the spell checker. The spell 
checker will ignore it for this document, but will correct you again in the next 
document.

Teach your spell checker new words: Spell checkers typically don’t recognize 
most people’s names or jargon specific to different specialities (as shown 
below). If you often use a particular word that the spell checker thinks is a 
mistake (because it’s not in the dictionary it’s using), click the “Learn” button 
in the dialog box and the word gets added to the current dictionary. It will 
never bother you again.

Or if you’re not using the spell checker dialog box at the moment, Control-
click (or right-click) a word that the spell checker thinks is a mistake (it 
probably has little red dots under it). In the contextual menu that pops up, 
click the “Learn Spelling” option while the word is selected. The spell checker 
will add that word to its dictionary and not whine about it being misspelled 
again. If the word is misspelled, spelling suggestions will appear at the top of 
the contextual menu (as shown on page 251). 

—continued

Control-click on a word to 
get this menu of options 
(exactly what you see in 

this menu depends on the 
application you are using 

at the moment).
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Other useful commands for spelling and grammar
The following useful commands are also found in the Edit menu, under “Spelling 
and Grammar.”

Check Document Now 
Choose this command to check the document for misspelling and 
grammar mistakes. Or use this keyboard shortcut (Command ;) to 
skim through the spelling in your document without opening the 

“Spelling and Grammar” dialog box. It will stop at each word it thinks is 
misspelled. Well, the dictionary might think it’s misspelled, but it might 
be your Grandmother’s name, Euphemia, that you don’t want to change.

Check Spelling While Typing  
This marks words that are misspelled as you type them—little red dots 
appear beneath words it thinks are misspelled. Any words not in its 
dictionary are considered misspelled, such as many names of people or 
towns and most specialized jargon.

Check Grammar With Spelling  
Choosing this option automatically selects the checkbox in the dialog 
box, “Check grammar.” It does what it says it does—applies standard 
grammatical rules to your text and lets you know if you’re breaking  
any of those rules. 

Instead of red dots that indicate a misspelled word, the grammar 
checker puts green dots under a word or phrase. Mouse over the word, 
pause to the count of three, and you will see a tool tip appear that tells 
you what the problem is. It’s up to you to fix it. 

Correct Spelling Automatically  
You’ve probably become accustomed to this feature while texting  
on your phone. You can turn it on or off either from the Edit menu  
(which applies to the open document) or globally for all future 
documents (use the preferences panel from the application menu). 



ptg6934589

Lesson 13 Common Tools in Mac OS X Applications

251

To change a misspelled word quickly without bringing up a dialog box: 
1 Control-click (or right-click) a misspelled word (you don’t need to highlight  

the word first). 

2 A contextual menu appears, as shown below. At the top of this menu  
is a short list of alternative spellings for the word you clicked on. 

3 Just single-click the correct spelling in the menu—the word is instantly 
corrected and the menu automatically disappears. 

 If the correct word is not offered, you can either type the correction yourself, 
or slide down to “Spelling and Grammar” in this menu and then choose 

“Check Document Now” from the sub-menu to run a spell check.

Even if the spell checker 
thinks it’s misspelled, use your 
own judgment when deciding 

whether or not to change it.   
In some cases, such as the use   

of an uncommon name or a   
slang word you use frequently,   

you might want to tell it to 
“ignore” unusual spellings.
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fonts Panel
Press Command T in any Apple application and the Fonts panel appears, as shown 
below. If yours doesn’t look like the one below, it might be because the Preview pane 
or the Effects bar is not showing.

Preview
n To display the Preview pane and/or the Effects bar if they’re not already 

visible, single-click the Action menu  button (circled, below). Then choose 
“Show Preview.” Click the menu again and choose “Show Effects.”

	 Or drag the dot shown below.

Drag this dot down 
or up to resize, show, 
or hide the Preview. 

Don’t forget about 
the tool tips!

If the window is too 
narrow, some of the 
Effects disappears. Drag 
here to resize the window.

Action menu.

In any Apple (or Apple-compliant) application, open this Fonts panel to choose 
the typeface Family, the particular style (called “Typeface”), and the Size of type. 
Whatever you choose here will change the selected characters in your document. 
Note that you must first select the text you want to change, then choose the font 
and size. Or position the insertion point (the flashing bar in the text) where you want 
to start typing, then select the font and size right before you start typing.

Preview.

Effects.
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Effects
You can apply shadow effects to selected text with these five controls, as shown 
below. Select text on the page, click the “Text Shadow” button (the button with the 
T), then drag the sliders of the other four tools (opacity, Blur, offset, and Angle). 

When this button is blue, that’s  
a visual clue that the selected  text 
has a shadow effect applied to it.

Collections
The Fonts panel has a number of Collections, which are simply sub-groups of fonts 
from the main list. Making a Collection does not disable or enable any fonts, it just 
makes it easier for you to choose a typeface—you don’t have to scroll through a long 
list of fonts you don’t care for. 

To create a Collection, single-click the plus sign at the bottom of the Collection pane. 
Rename the Collection. Drag font families from the “Family” pane into the new 
Collection—drop the family name directly on the Collection name.

Favorites
If you find you often use a particular family, typeface, point size, and color, turn 
that combination into a Favorite and keep it in the Favorites collection for easy 
access. Just select the text on the page that is formatted as you like it, or choose your 
favorite combination in the Fonts panel. Then go to the Action button and choose 

“Add to Favorites.” 

When you want to use that typeface, single-click the collection called “Favorites”  
to display the combination. Select your text, then choose your favorite.

Action button options
Color: See page 256. 
Characters: This displays the Characters viewer; see the next page.
Typography: Choose sophisticated options for certain typefaces.
Edit Sizes: Customize how font sizes are displayed in the Fonts panel.
Manage Fonts: This opens the Font Book; see pages 232–233.
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characters Viewer
Apple provides access to all sorts of extra characters, such as arrows; technical 
symbols; math and music symbols; dorky little clip art images; emoticons; currency 
symbols from around the world; geometric shapes; divination signs; Korean, Arabic, 
Greek, Cyrillic, Hebrew, and Chinese characters; and more. How do you know 
which characters are available? Use the Characters viewer.

At the bottom of most Edit menus is an option called “Special Characters….” This 
displays the Characters viewer, as shown below. 

To add special characters to your document:
1 open the document in which you want to insert special characters. Type what 

you need in whatever font you like until you get to a point where you want to 
enter a special character. New characters will appear wherever the insertion 
point is flashing, so make sure the insertion point is in the appropriate place. 

2 From the Edit menu, choose “Special Characters….”

3 To add more palettes of special characters (including many languages, ancient 
scripts, musical symbols, and much more), click on the Action menu (the gear 
icon in the Toolbar) and choose “Customize List….” Put checkmarks in all the 
palettes you want to display. Click “Done.” 

4 Single-click the various icons in the Sidebar to find the palette you need. Scroll 
through the characters to find the character.

5 Single-click on the character you want to see on your page. Even though it’s in 
a different font from what you’re typing in, as you continue to type, the font 
goes back to what you started with.

Here are two views of the Characters viewer. Click on 
a symbol in the Sidebar to display those characters.
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data detectors
Many Apple applications take advantage of Data Detectors. You might have noticed 
them already—when you mouse over a street address or a date or an email address, 
the item gets selected and a little arrow appears. This is the Data Detector. 

As your pointer detects data, it gets 
highlighted, as shown above. 

Command-click (or right-click) in the data to 
get a contextual menu that is dependent on 
what you click. Above, the data shows a date  
so the menu offers to look up that date in iCal. 
If the data was a street address, the menu 
would offer to add it to your Address Book. 

Single-click on the little triangle 
and an appropriate info panel 
appears. In this example, since 
the data is a date, the info panel 
is for iCal. 
Click the Edit button and you 
can edit the information as if 
you were in iCal, but iCal doesn’t 
actually open.
If this were a street address, the 
info panel would let you edit the 
information and add it to the 
Address Book, but you don’t 
have to actually open Address 
Book. Way cool.   

If your app isn’t displaying the Data Detectors, see if you can turn them on in the 
application’s preferences (from the application menu). or check the Edit menu 
command called “Substitutions”; it might have “Data Detectors” as an option.
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colors Panel
When you click one of the color buttons (as shown directly below) in the Fonts panel 
or the “Colors” icon in a toolbar, you get a deceptively simple Colors panel. Select text 
in Mail, TextEdit, and other Apple applications, then choose a color.

Experiment with the Colors panel:

n Click one of the icons across the top of the panel (shown below) to choose a 
color mode.

n Click the magnifying glass, and your pointer turns into a magnifying glass. 
Drag it around the screen; when you find a color you want to “pick up,”  
click that color and it is added to the panel.

n In the “Color Wheel” mode (shown below-left), drag the dot around the circle 
to choose a color, and drag the slider up and down to change the color shade. 

n In the “Image Palettes” mode (shown below-right), click the “Palette” menu, 
choose “New from File…,” then choose a graphic or photo. You can also drag 
any image from the Finder and drop it on this palette. Move the pointer 
around the photo to pick up colors you need. Try it. 

Text color. Paper color behind the text.

To save a color, drag it 
from here and drop it 
in one of the squares 

at the bottom.

Drag around this tiny 
dot to choose a color. 

Drag the slider up   
and down to lighten   

or darken the hue.

Drag around 
this tiny dot to 
choose a color. 

Experiment with the 
different ways you 
can select colors. 
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Speech
In many applications where there is typically a lot of text, your Mac can read 
selected text to you. Depending on the application, you will find the “Speech” 
menu and the “Start Speaking” command in the Edit menu. Another way to access 
speech options is to Control-click (or right-click) selected text, then from the 

“Speech” option, choose “Start Speaking.” 

Have your email read out loud
1 open an email message in Mail.

2 Click in the main body of text.

3 Go to the Edit menu, slide down to “Speech…,” and choose “Start Speaking.”

4 The entire text message will be read aloud to you. 
 If you want just a portion read out loud, select that portion before  

you go to the Edit menu.

5 The voice that’s used is the one selected in the “Speech” preferences. 

Use Services for recording speech
In the application menu, you’ll find the Services command that has options you 
might find useful, such as “Add to iTunes as a Spoken Track.” This adds the selected
text to the iTunes “Music” collection as an audio file named “Text to Speech.” 
Double-click the name and rename it whatever you like. 

To use the Services menu, first 
select the text in an application (or 
on a web page in Safari), then go to 
the application menu and choose 
the Services option.

If some services you want don’t 
show in this menu, click here. 
You can turn them on or off. 

See page 270 for more details 
about Services. 
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Preview your Page before Printing
You can preview any page that you create or plan to print. Just open the document 
and choose to print (press Command P, or choose “Print” from the File menu). 

You will either immediately see a preview, as shown below, or a smaller preview  
in a larger dialog pane. But you can also see a full-size preview: 

1 open the document and choose “Print” from the File menu.

2 Click the “pdf” button circled below. 

3 Choose the option to “open pdf in Preview.”  

 The Mac creates a pdf and opens it in the application called Preview  
(see Chapter 11 for details about Preview). You can choose to print from there, 
if it looks fine to you. Or close the document window, return to your appli-
cation, and continue editing.

Make a pdf of a Page or document
From the File menu in most Apple apps, there is a menu item called “Export As 
pdf.” Simply choose that option, then choose what to name it and where to save it.

Another option is in the Print dialog, above, where there is a button labeled “PDF.” 
Click that button to see many options for creating a pdf of the open document.  
See pages 229–231 for details about the various pdfs you can make.

Click “Show Details” to see 
the expanded printing pane.
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dictionary Panel
I keep the Dictionary application in my Dock because I use it many times a day. It’s 
not only a dictionary, but a thesaurus, an Apple resource, and it links directly to 
Wikipedia (if you’re connected to the Internet). The Dictionary is in Launchpad, and 
if you want it in your Dock so it’s always accessible with the click of a button, just 
drag its icon from the Applications folder or the Launchpad and drop it in the Dock.

This Dictionary has a special feature that extends its use out to all other Apple appli-
cations: In TextEdit, Safari, Mail, etc., Control-click (or right-click) a word you want 
to look up in the Dictionary. 

When you Control-click 
a word, you’ll see this 
menu. You don’t need to 
select the word first. 

The Dictionary panel appears 
right on the document page.  If 
the word is in the Thesaurus or 
Wikipedia, you will see entries 
for those.
Double-click on any of the 
entries in the panel to open the 
Dictionary app to that entry.

Click the “All” 
button to display 
results in not only 
the Dictionary, but 
also in the Thesaurus, 
Wikipedia, and  
Apple support,  
if appropriate. 
Single-click a 
result in the left 
pane to display its 
information. 



ptg6934589

14
GoALS

Switch between open 
applications with   

a keyboard shortcut

Quit or hide applications 
with keyboard shortcuts

Drag-and-drop text or files 
between applications

Take advantage   
of the page proxy

Use Services for special   
little features
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LESSON 14

Working between  
os x Applications

Now that you’ve had an overview of the main applications that 

come with oS X, let’s carry it one step further and work between all 

the applications—pop between windows, drag-and-drop content 

and files, use Services, and more. Combine features with the use of 

Mission Control (Lesson 16).

once you realize how easy it is to move data between applications 

and windows, you’ll find more and more uses for it. Plus you’ll feel 

like a Power User.
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Work with Multiple applications at Once
In Mac os x, you can keep lots of applications and windows open at once so they’re 
always accessible. You can just single-click an application icon in the Dock or 
Launchpad to switch to it, but there are also a couple of great shortcuts to switch 
between multiple  applications quickly and easily.

Switch between open applications
No matter which application you are currently using, you can bring up a floating 
palette of open applications, like the one shown below, then select the application 
you want to switch to—without ever having to reach for the mouse or trackpad. 

To get the Application Switcher that displays icons for all the open applications, 
press and hold down the Command key, then hit the Tab key once. Keep the 
Command key down. You’ll see something like this:

Find the display method you feel most comfortable with: 

To cycle through the icons from left to right, hold down the Command key 
and tap the Tab key (or the Right Arrow key) . 

To cycle through the icons in the other direction, right to left, keep the 
Command key down, but also hold the Shift key while you tap the Tab key  
(or use the Left Arrow instead of the Shift-Tab combination).

Or press Command Tab to display the Application Switcher, release the  
Tab key but continue to hold the Command key while you use the cursor  
to select an icon (just hover over it to highlight it, then let go).

However you choose to select an icon, when the application icon you want 
is highlighted in the palette, let go of the keys and that application will come 
forward as the active program. 

If there is no window open in that particular application, it might look like nothing 
happened—always check the application menu (see page 4) to see which one is 
currently active! You might need to hit Command N to open a new window in that 
application once it’s active. 
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Switch back and forth between two applications
Most of us probably spend the greater part of our time between our two favorite 
applications. There’s a shortcut that will switch you back and forth between just 
those two, instead of having to bring up the Application Switcher. 

First, while in one of your favorite applications, switch to the other one (just click 
its icon in the Dock). Now, to switch between those two applications, press 
Command Tab. I know it sounds too similar to the shortcut for switching between 
all applications, but the trick is to hold down the Command key, hit the Tab key just 
once, then let go of both keys right away. 

Quit or hide applications
	













 	

 Quit the active application

Switch between multiple full-screen applications
Most of the applications that come with your Mac can be run in full-screen mode. 
Each full-screen app (see page 54) occupies its own Desktop Space (see pages 
298–301), and you can use gestures (the motion of one or more fingers on a Multi-
Touch input device) to switch between full-screen apps (see page 300).
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Simplify your Work with drag-and-drop
You probably have lots of applications open on your Mac. often you’ll need to move 
data from one open application to another. Your Mac makes this so easy with drag-
and-drop: Drag the information you want from one application and drop it into the 
other application. Below are some examples. Experiment with these, and then try 
dragging and dropping in all sorts of other ways! If it doesn’t work, nothing bad will 
happen—it just won’t work.

Move text around in a document window
In TextEdit or Mail messages, you don’t have to cut-and-paste to move text— 
you can simply drag-and-drop it. 

1 First select the text you want to move: Press-and-drag the cursor over the  
text so it is highlighted. Let go of the mouse button or trackpad.

2 once the text is highlighted, press anywhere in the selected text and hold it  
for a second or two, then drag. 

3 Watch for the insertion point! It’s that thin, flashing, vertical bar. As you drag 
the cursor, the insertion point moves too. When the insertion point (not the 
cursor) is positioned where you want the new text to appear, let go of the 
mouse. Text will always drop in or paste in at the flashing insertion point! 

  Don’t forget to use that great option in the Edit menu to “Paste and Match 
Style,” as explained on page 61.

To move a copy of the selected text to somewhere else in the same document  
(and leave the original text in its place), press the option key and hold it down  
while you drag the text. 

Often you’ll find it works best to select the text or items,  
then press and hold and count to three before you drag. 
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Move text from one application to another
Not only can you drag-and-drop within one application, you can drag text from 
one application window and drop it in another. Let’s say you wrote a nice essay in 
TextEdit—select it and drag it into an email message in Mail. 

This automatically makes a copy of the text (instead of deleting it from the first 
application), so you don’t need to hold down the option key.   

Make a text clipping on the Desktop
Have you ever wanted to save a quote from a web page or a statement from an  
email message? Just select the text, then drag-and-drop it onto the Desktop or  
into any folder or window. This makes a small file with an extension, called  

“filename.textClipping” (if extensions are set to be visible; see pages 73 and 444). 

The clipping names itself with  
the first few words of the text.
You can change the name— 
just select the text and retype.

Anytime you want to see what the text clipping says, just double-click on it. And you 
can drag-and-drop that clipping file into most text windows, such as TextEdit or a 
Mail message, and the actual text will drop onto the page.

Add email addresses to a Mail message
Drag a person’s name from the Address Book or the Address Panel and drop it into 
any of the “To” fields in an email message to automatically address a message. You 
can drag addresses from one field to another. 

To add more than one name at a time, select more than one name in the Address 
Book or Panel: Hold down the Command key and click the names you want to add. 
Then let go of the Command key and drag one of the names to the email “To” field—
all of the selected names will come along. 

To add a Group name, drag the Group name and drop it into one of the “To” fields.
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Send contact information through email
You can send a person’s Address Book data (his card information) 
to anyone who uses Mac os x. Drag a person’s name from the 
Address Book or Address Panel and drop it into the body of a 
Mail message. You’ll see a “vCard” icon, as shown to the left.

The recipient can then drag the vCard to her Address Book where 
it will be added automatically. Or she can double-click the icon in the email message 
and all of the Address Book data will be added to her Address Book. 

Make a web location file
In Safari, you can make a web location file that will take you to a specific web page. 
There is a tiny icon that appears in the location field (called a “fav icon”), directly to 
the left of the web address, shown circled, below. Drag that tiny icon and drop it in 
the Dock (on the right side of the dividing bar), onto the Desktop, or into any folder. 
This creates a web location file, shown below. It has two different appearances, 
depending on where you drop it.

A web location file as it 
appears on the Desktop, 
in a window, or folder.

A web location file as 
it appears in the Dock.

If you drop the icon in the Dock, it looks like a spring (below-left). You can single-
click it to open Safari and that web page. 

If you drop the icon on the Desktop or in a window, it looks like a document file 
(below-right). Double-click the icon, or drag-and-drop it into the middle of any 
open web page. Or drop the web location file on top of the Safari icon in the Dock.

Save into a particular folder
When you are saving a file, first make sure the whole dialog is open (click the 
disclosure triangle next to the “Save As” field, if not). Drag a folder from the Finder 
and drop it in the center pane. The Mac saves the document into that particular folder. 
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Take advantage of the page proxy 
You may not have noticed the tiny page icon that is in the title bar of every 
document you create (it appears after you save the document). It’s called the  

“page proxy.” You can do a lot with this tiny icon.

This tiny arrow indicates this icon 
is an alias. When you double-click 

this icon, it opens the real file.

This green plus button 
indicates a copy of the 
file will be made.

Make sure the document has just been saved before you experiment with any of the 
following techniques (or it won’t work).

To create an alias of the document on the Desktop or in any folder or window, drag 
the page proxy and drop it on the Desktop, on top of any folder icon, or directly into 
any window. You’ll see the telltale sign of an alias’s tiny curved arrow as you drag the 
page proxy (below, left). See page 443 to learn more about aliases.

To create a copy of the document, hold down the option key and drag the proxy. 
Drop it on the Desktop, on top of any folder icon, or directly into any window.  
You’ll see a plus sign as you drag (above, right), indicating your Mac is making a 
copy of the document.

To send the document through iChat or Bonjour, drag the page proxy and drop it 
on a Buddy name in your iChat Buddies list or on any name in your Bonjour list. 

Or drag the page proxy into the text field of an iChat instant message. The 
recipient’s message has the file attached, including a download button to click.

To email the document, drag the page proxy to an email message and drop it 
anywhere in the body of the message. 
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Open documents in other applications
Drag documents (or page proxies, as explained on the previous page) onto 
application icons in the Finder or Dock to open those documents in the targeted 
applications; if an application is capable of opening the document, the application 
icon will highlight. This is great for when you want to open a document in 
something other than the document’s default application.

For instance, open Microsoft Word files in TextEdit—just drag and drop the file 
onto the TextEdit icon, either in the Dock or in the Applications folder. 

or drag a PDF and drop it in the middle of a Safari window or directly on the Safari 
icon, and Safari opens and displays the pdf. 

Take advantage of spring-loaded folders
Combine drag-and-drop with spring-loaded folders to organize the Finder. A 
spring-loaded folder opens as you hover your mouse over it. You can use this 
technique to dig down into folders with a file you are dragging: Hover over a folder, 
its window pops open, hover over the next folder, its window pops open, etc.  

You can set the parameters for how long you have to hover the mouse to open  
a spring-loaded folder—use the Finder preferences (in the Finder menu). 

Or use the Spacebar instead, even if the option for spring-loaded folders is 
unchecked: Whenever you want a folder to open instantly, hover over the folder  
as you drag a file, then hit the Spacebar.
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Drag content, images, or files between applications
Try dragging anything and everything! 

Drag an image from the web onto a TextEdit page or an email message.

Drag a graphic file from the Desktop or a folder and drop it into the text area of your 
application. This works in lots of other applications, not just the ones from Apple. 
For instance, I’m using Adobe InDesign to create this book—I dragged the image 
you see below (of my Grandmother, Pauline Williams, who is now 101 years old and 
fabulous) from the Finder and dropped it on this page (and it’s linked).

Drag text content and/or images from any application and drop them into other 
applications. Not everything will work, or it might work but not quite as you expect, 
but you will discover some wonderfully useful ways for working in your favorite 
applications. 

You don’t even have to open the other application first if you want to drag text from 
one place into a new file in another application. For instance, you can select and 
drag text from a web page and drop it on the Mail icon in the Dock—Mail will open 
a new message window with that text pasted in the message area. or drag text and 
drop it on the TextEdit icon (which I keep in the Dock)—TextEdit will open a new 
window with that text in it. 
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take advantage of Services
Every application, in its application menu, has an item called “Services.” Exactly 
which services are available at any moment depends on which application you have 
open and what you have selected within that application, if anything. 

Some services also show up in contextual menus. Control-click in a window, or on  
a selected item in a window (text or image) to see a pop-up menu of items. The 
items at the bottom of the contextual menu are Services, such as “Add to iTunes  
as a Spoken Track,” “New Email With Selection,” etc.

Services let you use features of one application while you work in another. For 
instance, you can be browsing in Safari and make a new note in Mail from text on 
a web page: Select text on a web page, choose “Services” from the Safari application 
menu, then from the sub-menu, choose “New Note With Selection.” 

Because Services are contextual, only services that are relevant to the application 
you’re using or the content you’re viewing will show up in a Services menu (in both 
the application menu and in the contextual menu that pops up when you Control-
click on a selection).

You can configure the Services menus to show, or hide, the services available. open 
System Preferences and choose “Keyboard”; click the “Keyboard Shortcuts” tab, 
then select the “Services” item in the left pane (or click the “Services Preferences…” 
item at the bottom of the menu). In the pane on the right is a list of services that 
are available: Put checkmarks next to the ones you want to be visible in menus, and 
uncheck the ones you want to hide.

If text is selected on a Safari page, 
you will see options like this.
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15
GoALS

Customize your Dock

Set up your Finder 
windows for the way   

you like to work

Use spring-loaded folders 

Color-code your files   
with labels

Customize your   
Sidebar and Desktop

Learn to use the   
System Preferences to 

customize many features 
of your Mac
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LESSON 15

Personalize Your Mac  
to Meet Your Needs

Now that you’ve learned all the basics of the various applications 

and system settings on your Mac, discover how to customize them 

to suit your particular way of working. Would you prefer to have 

your Dock on the side of the screen instead of at the bottom? Do 

you like a brightly colored Desktop? Do you want to customize the 

insides of certain windows? Color-code your files? Make the icons 

and text bigger? It’s all do-able—and more.
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customize the dock
When you first turn on your Mac, the Dock is sitting along the bottom at a certain 
size. But like everything else on the Mac, you can customize it to suit yourself. 
Would you prefer the Dock along the side of your screen? Would you like it to 
disappear altogether and only appear when you need it? Are the icons too small  
or too big? Do you want the indicator lights to tell you which applications are open? 
You can adjust everything. 

There are three ways to customize the Dock: You can use the System Preferences, 
the Dock options in the Apple menu, or the secret pop-up menu in the Dock itself. 

Customize the Dock using System Preferences
  Go to the Apple menu and choose “System Preferences…,” then single-click  

on the Dock icon. 

Magnification  
If you turn on “Magnification,” the icons in the Dock will enlarge as you 
hover the cursor over them, as shown below. Just how big they enlarge is 
up to you—move the slider (above) to “Max,” then slide the cursor back and 
forth over the Dock (don’t click) and see how big the icons get. 
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Minimize windows using  
Choose between Genie Effect and Scale Effect to visually change how 
windows float down into the Dock when you click the yellow Minimize 
button in a window. Hold the Shift key down when you click the yellow 
button to see the effect in slow motion.

Minimize windows into application icon  
This option sends minimized windows behind their application icon in the 
Dock, instead of taking up space in the Dock. To show minimized windows, 
press on the application’s Dock icon. See page 304–305 for more information 
about this feature, called Dock Exposé.  

Animate opening applications  
This is what makes the icons in the Dock bounce up and down when you 
click to open them. You can turn it off.

Automatically hide and show the Dock  
Click this and the Dock disappears. It reappears whenever you move 
the cursor into that edge where it disappeared. As long as your cursor is 
hovering over the Dock, it stays visible. Move the cursor away, and the Dock 
hides itself again.

Show indicator lights for open applications  
Apple wants us to not worry about how many and which applications are 
open, but we like to see the visual clue that tells us this information. If you 
want to turn on a little light under the open applications, check this box. 

Resize the icons and the whole Dock
n	 When your cursor is positioned over the dividing line in the Dock, it changes 

shape (shown below). Press-and-drag the line to resize the Dock and icons. 

Customize the Dock with the Apple menu or Dock menu
n	 From the Apple menu, select “Dock,” then choose your options.
n	 In the Dock itself, Control-click (or right-

click) the dividing line. From the menu 
that pops up, choose how you want the 
Dock to appear and behave.

The cursor changes into this shape to indicate 
you can resize the Dock and the icons.
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customize the finder
There are a number of features you can customize in the Finder. You might expect 
to find these in the System Preferences, but because the Finder is actually an appli-
cation (it runs the Desktop), its preferences are in the  Finder application menu.

Customize the General preferences
1 From the Finder menu, choose “Preferences… .” Click the “General” icon.

2 Because your Finder window can display the hard disk icons, removable disk 
icons, and servers in the Sidebar (under “Devices”), you can choose that these 
items do not also show up on the Desktop. or if it makes you feel better to see 
cd/dvd icons on the Desktop when you insert them, you can choose to show 
only those. Whatever makes you happy. 

3 Every time you open a new Finder window, it starts over—that is, the Mac 
doesn’t remember the last window you opened. From this menu, choose the 
window you want to see whenever you click the Finder icon in the Dock, or
press Command N to get a new window. For instance, I want to see my Home 
window every time I open a new Finder window. You might prefer to see your 
Hard Disk, the Documents folder, or perhaps a project folder. 

 of course, this implies that your Home folder (the one with your name on it)  
is showing in your Sidebar. If it isn’t yet, see page 279.

Check this item if you want your 
hard disk icon to show in the 
top-right corner of your screen.
Or uncheck it if you think it’s 
redundant to see the icon on 
the Desktop as well as in every 
Finder window. 
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4 If it bothers you to have only one Finder window open to work in, you  
can choose to have a new window open every time you double-click a  
folder icon. 

 Don’t forget that you can always open a separate window for any  individual 
folder: Command–double-click it. 

5 If you turn on spring-loaded folders and windows, then a folder will automati-
cally pop its window open as you hover a file over that folder. That is, drag 
a document over to a folder that you want to put it in and just hold the file 
on top of the folder but don’t click (just hover); the folder will “spring” open. 
This is great when you are dragging a file somewhere—you don’t have to put 
it down to open the folder. And when you let go of the file to put it in the 
window, the Mac immediately takes you back to where you started.

 once the first folder opens, you can spring open another folder and another 
inside of that one—let go of the file, it drops into that folder, and everything 
closes up behind itself.

 The “Delay” slider sets how long your cursor has to hover over a folder before 
it pops open. If you find folders popping open when you least expect it, make  
the delay longer.

 Even if you turn off spring-loaded folders, you can always hit the Spacebar to 
make a folder pop open, as long as your cursor is holding a file over that folder. 
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Create labels for files and folders
Labels are colors that you can apply to any file or folder or application as a tool for 
organizing and searching. 

1 From the Finder menu, choose “Preferences… .” Click the “Labels” icon.

To add the “Label” column to your List View windows, right-click 
on any column heading; from the contextual menu that appears, 
choose “Label.” 
To rearrange the columns, drag the headings left or right (except 
the Name column can’t move). (The columns won’t move if you 
have an arrangement applied; see page 283.)

2 Change the label names for any color label you want; ignore the ones you don’t. 

3 To apply the labels, select a file, then go to the File menu and at the very 
bottom choose a “Label” color. As you hover over the color dot, a tool tip 
appears to tell you the label name. 

 Or Control-click (or right click) a file of any sort. From the contextual menu 
that pops up, choose a color label. Click the x to remove a label. 
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Choose what appears in your Finder window Sidebar
1 From the Finder menu, choose “Preferences….” Click the “Sidebar” icon.

2 Check the items that you want to see in 
the Sidebar of your Finder windows, and 
uncheck the items you don’t want to see. 
Coordinate this with the “General” Finder 
preferences shown on page 276—you don’t 
want to eliminate the hard disk icon, for 
instance, from both the Desktop and the 
Sidebar!

 If you find that the option to show “All My 
Files” is pretty useless, you can turn it off. 

 We make sure to check the box to display 
our Home icon so we have easy access to 
our base of operations and don’t have to 
keep everything listed in the Sidebar. 

What you choose in this menu is what will appear 
as the default when you do a search on your Mac.  

Choose file extensions and turn off the Trash warning
1 From the Finder menu, choose “Preferences….” Click the “Advanced” icon.

2 File extensions are those three- or four-letter abbreviations at the ends  
of file names; see pages 73 and 444. We like to keep them turned on because 
they are useful visual clues about our files. When this box is checked, you will 
not see the option to “Hide Extensions” in Save As dialog boxes.

3 If that warning you see whenever you  
empty the Trash makes you crazy,  
turn it off here.

4 Empty Trash securely overwrites the  
disk space of files in the Trash in a way  
that can’t ever be read or recovered.
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customize the inside of finder Windows
Are the icons too big? The text labels too small? Do you want more columns of 
information available? Fewer columns? In the List View, would you like to rearrange 
the columns? In the Column View, do you want to turn off the preview column?  
You can do anything you want. 

Customize the Icon View
1 open a Finder window and click the “Icon View” button (circled below).

2 From the View menu, choose “Show View options.” The options panel shown 
below-left opens.

Click here and every window in  
Icon View will have these settings.
Option-click to “Restore to Defaults.”

If an arrangement has 
been applied (as above, 
by “Kind”), you cannot 
change the background 

color or picture.

Notice the 
rows of 
categorized 
icons in this 
window? 
That’s 
because 
it has an 
arrangement
applied from 
this menu. 
Experiment 
with it!

3 Choose whether you want this particular window to always open in icon view.
  Notice the title bar of the preferences pane (above-left) shows you the name of 

the  currently active window, the one to which these changes will apply.

Slide to 
resize icons.
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4 Experiment with these options.
n	Use the sliders to change the size of the icons and how far apart they  

will be spaced (the underlying invisible grid spacing). 

 If you hold down the Command key as you move an icon in 
a window, it will snap to the nearest spot on this grid. Whenever you go to 
the View menu and choose “Clean up,” the icons get arranged in this grid.

n	Use the Text size menu to change the size of the text that labels each file. 

n	And use Label position to position the labels (file names) on the left or right 
side of the icons (they’re generally on the “Bottom”).

5 Show item info: This displays information about some icons. For instance,  
the window will display how many items are in each folder or the size  
(in pixels) of graphic files. 

Show icon preview: This displays tiny thumbnail versions of the actual images 
for graphic files and photos, and even for documents.

  Arrange by: Arrange by and Sort by work together. First, choose an arrange-
ment, and you will see rows of icons grouped into those categories, as shown 
on the opposite page. For instance, choose “Kind” and all items will be grouped 
by what kinds of files they are—folders, images, text files, applications, etc.  

Sort by: Then (if you like), open the “Sort By” menu 
and choose how you want the items in each category to 
be organized. For instance, choose “Name,” and any file 
you drag or save into this window is automatically placed 
into its appropriate category and it alphabetizes itself. 

“Label” is also an organizational option, but in this case it 
refers to the colored labels as explained on page 278, not 
the labels (file names) mentioned in Step 4!

 With “Snap to Grid” chosen, you can’t reposition icons— 
they will always jump to the nearest spot in the grid. To override this, hold 
down the Command key as you drag an icon.

Don’t forget that you can always go to the View menu and choose Clean Up or 
Clean Up By (and choose a particular method) to instantly organize your files. The 
menu items apply to the window in Icon View that is selected (click anywhere on a 
window to select it). (If there is an arrangement applied, the Clean Up commands 
are not available.)
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Customize the List View
	




3 Choose whether you want this particular folder (the Documents folder, in the 
example above) to always open in List View. 

4 Choose the icon size you want, the text size for the labels, and which columns
you want visible. This is where you can choose to display the “Label” column if 
you like to use colored labels (see page 278).

 See the opposite page for the option to show “Comments.”

5 Use relative dates: Under the “Date Modified” and “Date Created” columns, you 
will see “Today” or “Yesterday” instead of the actual date. 

Calculate all sizes: With no checkmark in this box, the Size column will 
display the file sizes of documents and graphic images, but not folders. 
Calculating the sizes of very large folders can take extra time.  

Enlarge the icons 
with this button.

This folder, in List View, is arranged by Date Created, as 
circled in the preferences pane to the left. You do not need 
to have that column visible in order to arrange by that criteria. 

Hold down the Option 
key and the button 

changes to this. 
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Add comments and show the Comments column
This is a great feature that not many people take advantage of because few know it 
exists. In the List View options, shown on the opposite page, you see that you can 
choose to show the Comments column. But where are those comments?

You can add comments to the Info window of any file, shown below-left. You might 
add a reminder about what to do with this file, a committee-meeting message to 
someone who will be receiving it, or love notes to your Sweet Heart. This is the same 
field in which you can add keywords for Spotlight to find, as mentioned on page 359. 

To open the file’s Info window and add comments, select a file and press Command I 
(I for Info). Or Control-click (or right-click) a file and choose “Get Info” from 
the contextual menu that appears. Add whatever text you want in the “Spotlight 
Comments” field, as shown below-left.

once you do that, those Comments will appear in the Comments column in the List 
View, as shown below. 

 If you want to add comments to more than one file, select one file and 
press command Option i. This opens the “Inspector” window (it looks exactly like the 

“Get Info” window). Now when you single-click on any other file, that file’s info auto-
matically appears in the already-open Info/Inspector window. 

 If you like to use the contextual menus, Control-click (or right-click)  
a file, then hold down the Option key; “Get Info” changes to “Show Inspector.”

For the Comments column to appear, you must check its box  
in the View Options panel, as shown on page 278. 
To reposition the list, drag its column name. 
note: If you have applied an arrangement, as explained on 
page 281, you cannot move the columns or add new ones 
unless you do this: Change “Arrange by” to “None,” rearrange 
the columns, and then set “Arrange by” again as you choose. 
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Organize the columns in List View
Keep in mind that none of the following options will work if you have applied an 
arrangement to your window, as explained in the callout on page 283, or as chosen 
from the “Arrange by” menu circled below.

n To organize the items in your list by any column, just click a column heading 
to organize everything by that. For instance, if you want all the different sorts 
of files grouped together so you can clearly see which ones are, say, Photoshop 
files, organize by the “Kind” column.

  The selected column heading under which everything is organized is the blue 
one. In the example below, the items are organized by “Name.”

	 n To alphabetize, or sort, the items in the list backward or forward, click the 
heading triangle. That is, perhaps you want the items in the “Name” column to 
be listed alphabetically backward: First click on the “Name” column heading. 
Then single-click the tiny triangle (the “sort” triangle, or arrow) you see on the 
right side of the column heading. 

  If you would like your items to be sorted by “Size” in ascending or descending 
order, first click the “Size” column heading. Then, if necessary, single-click the 
tiny sort arrow to reverse the current order. 

n To horizontally rearrange the order of the columns (except the “Name” column), 
press any column heading (except “Name”) and drag it to the right or left. You 
will see the other columns move over to make room. Drop the column (let go 
of the mouse button) when it’s positioned where you want it. 

n To resize the width of the columns, just press the dividing line between  
any column; the pointer changes to a double-headed arrow, circled below. 
Drag the double-headed arrow to the left or right. 

The cursor 
becomes a two-
headed arrow, 
indicating you can 
resize the column 
on the left.  

This is the “Arrange by” menu. Choose 
“None” when you want to resize and 

change the order of the columns. 



ptg6934589

Lesson 15 Personalize Your Mac to Meet Your Needs 

285

Customize the Column View
1 open a Finder window. Click the “Column View” button, as circled below.

2 From the View menu, choose “Show View options.” 

3 Choose the text size of the labels.
 You can choose not to show icons at all—just a nice, clean list of items. 

Uncheck the box to remove the icons. (But keep in mind that the icon  
can tell you a lot about a file! If you can’t see it, you’ll miss its visual clues.  
This might not matter in a window that is organized by “Kind.”)

 If you uncheck Show preview column, the last column will not display  
a preview image of the selected file, such as a photograph. 

The Column View is what I live in (John prefers the List View). 
I like to see the preview in the last column, and I like to see 
exactly where the files are stored on my computer. 

This is the same Column View as above, but I chose to “Arrange by,” 
as you can see in the View Options, upper left. This puts files in rows 
according to the Kind of files they are. In each row, they are sorted  
by the date each was created, yet you can still see the columns 
showing where the files are. Experiment with the options!
You can also choose an arrangement from the Arrange by menu,  
as shown on the opposite page. 
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Customize the Cover Flow View
1 open a Finder window. Click the “Cover Flow View” button, as circled below.

2 From the View menu, choose “Show View options.”

3 You can’t change the actual view of the covers, except to enlarge or reduce  
the images, depending on the window size. But you can choose the text size  
of the labels.

Click here, and every 
window in Cover Flow View 

will have these settings.
Option-click to restore   

the system defaults.

To make the images in the top panel larger or 
smaller, make the window itself larger or smaller 
(press-and-drag the bottom-right corner). 
Also drag the “thumb” mark (circled in the top pane) 
up or down.
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Customize the Desktop View
1 Click a blank spot on the Desktop to make sure no Finder window  

(or any other window or icon) is selected.

2 From the View menu, choose “Show View options.”

You can resize the icons or the text labels, reposition the labels, show extra file 
information, display an icon preview, snap the icons to a grid, or always keep 
the icons arranged by your chosen criteria, such as alphabetized (“Name”), 
Kind, Label, etc. 

 If you choose Snap to Grid (plus choose something to Sort them by), every file 
you drop onto the Desktop will snap into its appropriate place on the under-
lying invisible grid, keeping all those files on your Desktop nice and neat. 

 To override the grid-snap, hold down the Command key as you drag the file 
and it will land right where you let go. 

If you keep a lot of files on your Desktop and it’s getting messy, don’t forget you can 
always go to the View menu (click on the Desktop first to make sure it’s active), and 
choose Clean Up (which moves the files into the nearest grid space), or Clean Up 
By (which organizes them by the option you choose and lines them all up in neat 
rows). For some files, then choosing Sort By can subcategorize them.   
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take advantage of the System Preferences
The System Preferences control dozens of features on your Mac. Don’t like the 
picture on your Desktop? Do you want your Mac to go to sleep sooner or later or 
never? Do you need to change the time because you moved? Would you like a whiny 
voice to yell at you every time you make a mistake? You can customize these and 
many other things through System Preferences. (Remember, every application has 
its own preferences, as explained on page 51.)

To open System Preferences, click on its icon in the Dock or in Launchpad.  
Or go to the Apple menu and choose “System Preferences….”

If you would rather see these preferences in alphabetical order 
(as shown below) instead of grouped in categories, go to the 
View menu and choose “Organize Alphabetically.”

This is the System 
Preferences icon.
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How to use the System Preferences
once you open the System Preferences pane, single-click an icon to display those 
particular preferences. Most options are self-explanatory—poke around and see 
what they are (don’t forget the tool tips). We’ll look at a couple of examples. 

1 open System Preferences as described on the opposite page.  
Single-click the Keyboard icon, shown to the left.

2 In the Keyboard preferences pane, shown below, single-click the “Keyboard” 
tab to see the settings for that feature.

3 You can adjust how fast any key repeats across the page as you press it down. 

 The Delay Until Repeat refers to how long your fingers can linger on the keys 
before they start repeating. If you find you type lots of double letters or spaces, 
choose a longer delay here. If your fingers are really heavy on the keys, slide the 
blue slider all the way to “off” and the keys will never repeat automatically. 

Global versus user-specific preferences
If you have set up more than one user, as explained in Lesson 18, individual users 
will discover there are some preferences they can’t change because they will affect 
other users; these preferences are “global” and only the master administrator can 
change them. Individual users can change the preferences that are “user-specific” 
because they affect only that one user. So if you run across a System Preference that 
you can’t change, it’s probably because you are not the main administrator (please 
see Lesson 18 for details about users and administrators).

Be sure to look for the tool 
tips (hover over any item). 
They are extremely useful!
If you have a wireless 
keyboard attached, this 
panel will tell you how much 
battery power is left. This button is important because it controls 

whether your keyboard shortcuts need the fn
key held down. Experiment with it. 

Single-click 
the “Show 

All” button 
to see the 

main window 
again, or 

press on this 
button to 

get a menu 
to choose 

from. 
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open System Preferences as explained on page 288; single-click Mouse or Trackpad.
Most of the controls are self-explanatory; be sure to display the tool tips and watch 
the little video clips. 

n	 Tracking determines how far the cursor moves across the screen when you 
move your mouse. 

n	 Scroll with inertia means as you swipe or scroll, you can shove things on their 
way, sort of like pushing a little toy car off on its way. Whoosh—off they go!

n	 Double-Click is how quickly you need to tap the mouse twice so it is 
recognized as a double-click instead of two single clicks. 

n	 Secondary click is what you need to turn on so you can right-click instead of 
holding down the Command key and clicking to get contextual menus. (Some 
people, however, like my Mom, use the right side as the primary button, and 
so a right-click for her is actually a left-click. She prefers it that way.)

These are the mouse options for 
the Apple Magic Mouse. Other 
mouse brands will show slightly 
different choices.
Hover over an option; a white bar 
shows you it that it is selected, 
and a video displays to show you 
how to use that option. 

A trackpad, either on a laptop 
or a wireless trackpad for your 
desktop computer, takes a bit of 
getting used to. It seems people 
either love a trackpad or hate it.  
If you have a laptop and hate the 
trackpad, you can always connect 
a mouse to it.
Spend some time getting used to 
the many trackpad options and 
what they can do for you.  
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This is another fun and useful System Preference—use it to change the color or 
image on your Desktop.

1 open System Preferences as explained on page 288; single-click the “Desktop 
& Screen Saver” icon, then single-click the “Desktop” tab, circled below.

2 In the list on the left, select a folder so its contents display on the right. 

3 Single-click any image on the right to immediately view it on your Desktop.

To use your own photo, first put 
the photo in the “Pictures” folder 
that’s in your Sidebar or Home 
folder, or put it in iPhoto. Then 
you can choose it from here.
Or click the + button, then select 
a folder of photos to add to this list 
so you can swap the photos easily.

The Date & Time preference is one you will use often if you travel with a laptop.  
or on your desktop Mac, maybe you want to see the day of the week in the menu bar.

Use the Clock pane to show 
the day of the week, among 
other options. 

Experiment with the 
Screen Saver options!
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Customize the System Preferences pane
If you don’t like to see System Preferences in your pane that you never use, you 
can hide them. Press on the “Show All” to display a menu. At the bottom is a 

“Customize…” command.  

When you choose “Customize,” each System Preference gets a checkbox, as shown 
below. Uncheck a box to hide the preferences. This doesn’t delete it, just hides it. 

To delete a third-party preference that might have been installed with an application, 
Control-click on the icon; you’ll get a contextual menu with an option to “Remove” 
the preference, as shown above. This doesn’t work for Apple prefs. 

Click “Done” 
when you’re 
finished 
customizing.
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Find the right System Preferences for your task
Sometimes you know you need a System Preference to customize a particular Mac 
feature, but you’re not sure which one has the option you need. That’s where the 
Spotlight feature can help.

open System Preferences (see page 288), and type what you’re hoping to find in the 
search field (shown below). As you type, you’ll see certain System Preference icons 
highlight, and you’ll see a list of possible options. The more you type, the more 
specific the results will be. 

Try the example shown below. I was looking for all the preferences that let me make 
the scroll bars visible. 

Single-click on an option in the list that appears, and the appropriate System 
Preference will flash twice at you and then open.

Don’t forget about other features on your Mac that let you customize and 
personalize your machine! Check out “Mission Control,” the “Speech” options, plus 
all the individual application preferences. If you need to type in another language, 
use the “Language & Text” preference pane. This is your Mac!

The System Preferences 
highlights possible results 
for you.

If System Preferences 
decides that it found exactly 
what you’re looking for, it 
highlights the preference 
with a solid circle of light. 
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GoALS

Understand the concept   
of Mission Control   

to manage your open 
applications and files

Take advantage of Spaces 
to organize your work

Use Exposé to clear your 
screen when necessary

Use Dock Exposé to find 
open files in an application

Make your life easier with 
widgets in Dashboard

Learn about iCloud with 
automatic backups   

and syncing
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LESSON 16

Mission Control to 
organize Your space

Mission Control presents an organized view of all your open 

windows, enabling you to easily and quickly find anything you 

need on a cluttered, messy Desktop. It also lets you create different 

Spaces in which to work and stay organized. For instance, you can 

do all of your word processing in one Space, browse the web with 

Safari in another Space, use iChat or FaceTime in their own Spaces, 

and easily switch between all of the different projects.

Mission Control incorporates Exposé features to clear your screen 

or show open files. In addition, a Dashboard of useful widgets is 

accessible from Mission Control. 

See pages 310–311 for a brief introduction to iCloud and learn how 

you can automatically backup and sync files to your Mac and other 

mobile devices, such as iPhone, iPad, or iPod touch.
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Mission control
Mission Control combines Exposé (a way of showing all open windows at once), 
Spaces (multiple, alternative Desktops), Dashboard (a special screen full of small, 
specialized apps called widgets), and full-screen apps (applications that are in full 
screen viewing mode). 

If your screen becomes cluttered with open documents, applications, and windows, 
Mission Control can display every application and window running on your Mac in a 
single organized screen view so you can select the item you want (shown below).  

The Mission Control screen. Click any window in 
the center part of the screen to bring it forward.

Icons identify the applications that are 
open and running in the selected Space.

These are individual Spaces. Single-click a Space to bring it forward.

Mission Control shows the applications and their windows that are open. The 
center area of the screen shows the windows of the selected Space. You can assign 
up to sixteen alternate “Desktop” Spaces, plus open, full-screen applications occupy 
additional Spaces. See the following pages for more about Spaces.

While in Mission Control, click any item or Space that you want to work with to 
bring it forward as the active item.
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In the example above: Dashboard is a Space, the Desktop is a Space, and each of the 
three apps that are open in full-screen occupies a Space of its own, for a total of five 
Spaces (at this moment) that are functional. The Space that is highlighted with a 
border is the one that is currently active and displayed in the center of the Mission 
Control screen.  

Spaces and Mission Control are intricately interwoven, so don’t worry if it’s 
confusing at this point. You’ll find it’s worth the effort to learn how to control it.

To enter Mission Control, do one of the following:

n	 Press the F9 key (the default keyboard shortcut to show “All Windows”). 
	 You may have to add the fn key (thus, press fn F9), depending on your setting 

in the Keyboard panel of System Preferences. You can change the F9 shortcut 
in the “Mission Control” preferences, shown on the next page.

n	 Press the Mission Control key (F3) on your keyboard, if you have one.  
You may have to add the fn key, as explained above.  

n	 Use gestures, if you have a trackpad or mouse that supports Multi-Touch 
gestures (combinations of finger touches and swipes to scroll, flip through 
web pages, navigate pages or windows, and more): 
	 Magic Mouse: Double-tap with two fingers on the surface.
	 Multi-Touch trackpad: Swipe upward with three fingers. 

To exit Mission Control, do one of the following:

n	 Click any item in Mission Control.
n	 Press F9 again (or fn F9 on a laptop).
n	 Magic Mouse: Double-tap with two fingers on the surface.
n	 Multi-Touch trackpad: Swipe downward with three fingers.

F3

Dashboard has its own Space, assigned by Apple (see page 306).

The currently active Space is highlighted with a border.
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Hot Corners: Assign actions that happen when you 
move your pointer to different corners of the screen.

When this option is checked, if you click the icon in the Dock of an application 
that’s already open in a certain Space, that Space opens on the screen. 

If this box is not checked, the application opens in whatever Desktop Space you 
happen to be in at the moment, which means you can open it in multiple Spaces 
(perhaps you have different documents open in each Space). To cycle through those 
Spaces, single-click that application’s icon in the Dock.

Exposé shortcuts:  
See pages 302–303.

Mission Control: See pages 296–297.

Dashboard has been 
assigned a Space. If you 
uncheck this, you can 
still open Dashboard 
from Launchpad.

Spaces
Spaces, incorporated as a part of Mission Control, is a convenient way to manage 
a variety of projects or just plain ol’ screen clutter. The idea is to create alternate 
Desktops, called Spaces, then put certain documents or applications in their own 
Spaces. When you want to work with an application, switch to its custom Space. 

There is always at least one Desktop Space, your default Desktop that you always 
see. When an application is put in full-screen mode, it automatically goes in a new 
Space of its own. Dashboard has been assigned its own Space. In addition to these 
Spaces, you can create more. 

First, take a quick look at the Mission Control preferences (click the System 
Preferences icon in the Dock or Launchpad, then click “Mission Control”). The prefer-
ences panel has an important option that affects how you interact with Spaces.
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To create a new Space, do one of the following:

n	 open an application, then put it in full-screen mode (click the full-screen 
mode button, usually in the top-right corner of the window).

Add Space
button.

Drag an item from the center section 
of Mission Control to the Spaces 
section at the top of the screen to 
create a new Space for that item.

n	 Enter Mission Control (see page 297), then hover your pointer over the 
top-right corner of the Mission Control screen. The Add Spaces button slides 
out from the corner (shown below); click it.

n	 Enter Mission Control (see page 297). Drag an item from the center section of 
the screen up to the top section, above the large Desktop background image. 
As you drag, the item becomes smaller and smaller (simulated below). Drop 
the item on or near the Add Spaces button that slides out from the top-right 
corner. A new Space is created for the item. 

Click here to create a new space that contains  
just this application in full-screen mode.  
To get out of full-screen mode, shove the pointer into 
the top of the screen to make the menu bar appear; 
click the blue arrow icon in the upper-right corner. 
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To switch between all Spaces (full-screen app Spaces, the Dashboard Space, and 
Desktop Spaces): 

	on a Magic Mouse, swipe left or right on the mouse surface with two fingers.
	Or if you have a Multi-Touch–enabled trackpad, swipe left or right on the 
trackpad surface with three fingers.

To switch between Spaces while in Mission Control, you have a variety of 
techniques available. Do one of the following:

n	 Single-click one of the Spaces thumbnails at the top of the screen.

n	 Hold the Control key and type a number key that corresponds to one of the 
Desktop Spaces in the top row. 

n	 To switch between Desktop Spaces, not full-screen app Spaces or the 
Dashboard Space (you will remain in Mission Control as you switch from  
one Desktop Space to another): 
	 Hold down the Control key and tap the left or right Arrow keys.
	 on a Magic Mouse, swipe left or right on the surface with two fingers.
	 Or if you have a Multi-Touch–enabled trackpad, swipe left or right on the 

trackpad surface with three fingers.

To remove a full-screen app from its dedicated Space, take the app out of full-
screen mode: Select the Space that contains the full-screen app, then move your 
pointer to the top of the screen until the top menu bar is revealed (below). Click  
the blue Exit Full-Screen button that appears on the top-right side of the menu bar.  
The application exits the full-screen mode and returns to its original Space. 

To help identify which Space you’re working in, you might want to choose a 
different Desktop picture for each Space (see page 291). You can change any Desktop 
picture at any time. 
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When you enter Mission Control, the currently selected Desktop Space is prominently 
displayed (Desktop 4 in this example). Click any thumbnail or the large Desktop display  
to enter that Space.

To remove a Space,
hover over a thumbnail, 

then click the x.

The name of a Space is located directly underneath its thumbnail in Mission 
Control, as shown on the previous page. However, if you add so many Spaces that 
the names get too crowded, the presentation changes to magnification mode: Space 
names don’t appear under the thumbnails until you move your pointer over a Space 
thumbnail, then the thumbnail enlarges and the name appears (shown below).

To remove a Space, hover your pointer over a Space in Mission Control until a 
circle-x button appears in the top left corner (shown below). Click the x button. 
Any windows that were open in that Space will return to their original Space or 
move to the default Desktop 1 Space. 
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Sometimes you want to get right to the Desktop/Finder. Tap the F11 key: All open 
windows temporarily move into the margins of the screen—all you can see are wee 
little edges. Tap F11 again to return the screen to normal. Try it. (If it doesn’t work, 
hold down the fn key and tap F11; see page 289, the Keyboard preferences.)

Exposé keyboard 
shortcut F10:  
Show all the open 
or recent document 
windows from a 
specific application.

Exposé keyboard shortcut F11: Show the Desktop.  
The white arrows show the window edges that are visible.

A cluttered Desktop.

Exposé
Exposé is one way to deal with a lot of open files and applications. It temporarily 
shows (or hides) open items so you can find what you need. This is how it works:

Let’s say you’ve been working in TextEdit for several days and have created lots of 
documents. Some are open on your screen, others you have saved into their appro-
priate folders. Tap the F10 key to show Application windows. All open TextEdit files 
display in the top part of the screen, while Recent (and thus closed) TextEdit files and 
those that have been minimized to the Dock appear as a row of thumbnails.  
Single-click any document to open it.
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Be careful with these—
assign a hot key to the 
corner you head for the 
least. Otherwise you’ll 
find unexpected things 
happening whenever you 
go to the Apple menu or 
try to use Spotlight.

If the Fkey commands shown above don’t work, hold down the fn key while you 
tap an Fkey. See page 289 to learn how you can change the Fkey settings in the 
Keyboard preferences.

To customize the keyboard shortcuts that control Exposé and Mission Control: 
open System Preferences from the Apple menu and choose “Mission Control.”  

Click the “Hot Corners” button in the bottom-left corner to reveal the “Activate 
Screen Corners” sheet (shown below). The four pop-up menus let you set an action 
that takes place when you move your pointer to a corresponding corner of the 
screen. For instance, in the example below, Mission Control is set to open when the 
pointer is moved to the top-left corner of the screen. To turn off the Hot Corner 
function for any screen corner, set the pop-up menu to show the dash option (-).

The lower section of the panel contains pop-up menus to set keyboard or mouse 
shortcuts for Exposé functions. In the example below, Mission Control (see pages 
296–297) is set to open with a tap of the F9 key. 

Use the left column of pop-up menus to change the default keyboard shortcut for 
any of the Exposé commands. Use the right column of pop-up menus if you want to 
set a secondary or middle mouse button click as an additional shortcut to activate 
an Exposé command. You cannot assign the same mouse button (the secondary or 
middle mouse button) to more than one Exposé command.    

Click “Hot Corners” to reveal 
the “Activate Screen Corners” 
sheet, shown above. 
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Click here to 
tell minimized 
files to hide 
behind their 
application icon 
in the Dock.

Exposé for the Dock
Dock Exposé adds even more flexibility to managing the pile of clutter on your 
Desktop. In the past, you may have minimized open windows (by clicking the yellow 
button in the window’s top-left corner) and sent them to the right side of the Dock 
to keep them accessible, but out of the way. That technique certainly works, but if 
you minimize a lot of windows, you’ll be trading a cluttered Desktop for a cluttered 
Dock. Dock Exposé solves that dilemma by sending minimized windows to hide 
behind their application icons in the Dock, completely out of sight. 

To set up Dock Exposé: 
1 open System Preferences; click the “Dock” icon.

2 Check the box to “Minimize windows into application icon,” shown below. 
Then close the Preferences window (click its red button).

Now click the yellow minimize button in an open window and watch it swoop down 
to the Dock to hide behind its application icon and out of sight. 

To show the minimized files of an application, press 
on the application icon in the Dock (shown here). A 
menu pops up that shows a list of files that have been 
minimized to this application icon. Click a file name 
in the list to open that file on the Desktop. 

Here you can see the menu listing the 
minimized files hiding behind this icon. 
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Thumbnails below this horizontal dividing line are files from the selected 
application that are open and minimized or closed but Recent. 
Items above the dividing line are files in the selected application that are 
currently open but not minimized. 

When you move the cursor over a thumbnail, a blue highlight 
surrounds it (difficult to see here) and the file name is highlighted.

Preview is the selected application.

In addition to showing a list of minimized files, the pop-up menu (shown on the 
opposite page) contains the “Show All Windows” command. Select this option to 
show thumbnails of all the minimized files for the selected application as well as 
Recent files (which have been closed), as shown below. The minimized files are 
shown in a horizontal row, just above the Dock. Files from the selected application 
that are open (and not minimized), appear in the top part of the screen.

To open a minimized file, click its thumbnail in the Dock Exposé view. 

To show a Dock Exposé view of the next open application, press the Tab key. 

If you press on an icon in the Dock for an application that is not open, you’ll see only 
a pop-up menu with a limited number of commands and options.
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take a Look at dashboard
Dashboard provides quick access to information customized just for you, displayed 
in the form of widgets. Dashboard pops up in a split second, but only when you 
want it. With the click of a button or swipe of a finger, it goes away just as quickly. 
Below is an example of a Dashboard with the Widget Bar showing (the Widget Bar 
doesn’t appear until you ask for it; see the opposite page). 

When you activate Dashboard, the widgets appear either on top of a gray overlay on 
the Desktop where you can still see any windows or applications you have open in 
the background—or they might appear as shown below, in their own Space. You can 
choose how you want Dashboard to appear, and this in turn determines how you get 
to it; see page 308.

Single-click any widget in the bar 
to make it appear on your screen. 

Single-click the tiny arrow on either 
end of the Widget Bar to view more 
widgets that are in the bar.

This is the 
Dashboard.

This is the 
Widget Bar.

Each of these items is a widget.
When the Widget Bar is closed, 
you won’t see all the xs.

This is either   
a + to show   

or an x to hide
the Widget Bar.
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Open Dashboard and the widgets
Dashboard is built into your Mac. If its icon is in your Dock, as shown below, just 
single-click on it. If Dashboard is not in your Dock, open Launchpad and single-
click the Dashboard icon from there. Or press the F12 key (if you haven’t changed 
the Dashboard preferences). Or if you have a Multi-Touch device such as a Magic 
Mouse, try swiping two fingers (three on a trackpad) to the right; this moves the 
screen into the space in which Apple stores Dashboard. Whew. once you determine 
the best way to open Dashboard, all you have to remember is that one method. 

Add widgets to your Dashboard
To add widgets to your onscreen Dashboard, first open Dashboard and bring up 
the Widget Bar: Single-click the plus sign you see in the bottom-left of your screen. 
(The plus sign then turns into an x to close the Widgets Bar, as shown, opposite.)

	 To add a widget, single-click on it. The widget appears on your screen.
	 To see other widgets that are already installed, single-click one of the  

tiny arrows that appear at either end of the Widget Bar.

Organize widgets on the screen in any arrangement you like—simply press 
anywhere in a widget and drag it around. They will stay where you put them,  
even after you put away Dashboard.

Put Dashboard away
To put Dashboard away, single-click outside of any widget, or press your keyboard 
shortcut again (probably F12) or swipe to the left. When you next reopen Dashboard, 
your widgets are right where you left them.

If you’re using a laptop, your F12 key might 
be used for something else, or you might need 
to hold down the fn key as you press F12.  
You can change Dashboard’s keyboard 
shortcut; see page 308. 
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Determine how to open Dashboard
The settings in the Dashboard preferences determine how you access Dashboard. 
You can change this at any time.

1 At the Finder, when Dashboard is not active, go to the Apple menu  
and choose “System Preferences….”

2 Single-click “Mission Control.”

If you have a multi-
button mouse, 
you can make the 
secondary button 
(or a middle mouse 
button) activate 
any of the Exposé 
commands, in place 
of (or in addition to) 
a keyboard shortcut.

To add one or more 
modifier keys to your 

shortcut, press that key(s) 
while a pop-up menu is 

open. The menu options 
will change to reflect the 

key combination you   
are pressing. 

The default settings are that tapping the F12 key will open Dashboard, 
and that Dashboard is in its own Space (see Chapter 14 about Spaces). 

 If the box to “Show Dashboard as a space” is unchecked, you need to use the 
keyboard shortcut or click on the Dashboard icon to display it. Dashboard will 
appear translucent, on top of your Desktop.

 If that Dashboard space checkbox is checked and you have a Multi-Touch 
device such as a new trackpad or a Magic Mouse, you can swipe two fingers  
to the right and Dashboard appears. 

 If that Dashboard space checkbox is checked and you don’t have a Multi-Touch 
device, press F9 (the keyboard shortcut chosen in the preferences above) to 
open all windows and choose the Dashboard space. See pages 296–301 for 
details about working with Spaces and Mission Control.  
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Both the button and the icon 
open the Widget Manager, 
shown to the right.

Uncheck widgets  
to hide them so they 
don’t clutter up your 
Widgets Bar.
To trash a widget that 
you downloaded and 
don’t want anymore, 
click its red symbol.

Manage your widgets
If you become a widget junkie and start collecting lots of them, you’ll want some 
way to get rid of the ones you don’t need anymore, or at least remove them from the 
Widget Bar. Widgets that come pre-installed by Apple can’t be deleted, just removed 
(hidden) from the Widget Bar. 

Click the Widget Manager button that appears when you click the plus sign to show 
the Widgets Bar (below-left). In the Widget Manager panel (below-right) uncheck 
the Widgets you want to hide from view in the Widget Bar. Third-party widgets 
have a red minus (–) symbol to their right. You can hide third-party widgets, or click 
the red minus symbol to delete them altogether.  

To retrieve widgets you’ve hidden, open the Widget Manager and checkmark them. 

To get more widgets, click the “More Widgets…” button in the Widget Manager, 
shown above. This takes you to the Apple web site where you can download lots of 
free widgets that do cool things. 

To make your own Web Clip widgets from Safari web pages, see page 141.
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icloud automatic Storage and Syncing
iCloud is a free service from Apple that replaces the paid MobileMe service ($99 
per year for access to email, calendars, contacts, and file storage on Apple servers). 
iCloud is replacing MobileMe, but if you already have a MobileMe account, your 
membership is automatically extended, without charge, to June 30, 2012. With or 
without a MobileMe account, you can use iCloud services for free (five gigabytes of 
file storage included).  

iCloud automatically uploads content from your email account, Address Book 
contacts, and iCal Events without you having to do anything. iCloud synchronizes 
that information to all your ioS devices. ioS devices are mobile devices, such as the 
iPhone 4, iPad, or iPod touch. iCloud requires mobile devices to run ioS 5 or later. 

When you buy content from the iTunes Store, you can set iTunes to automatically 
download the same content to your ioS devices (see the opposite page). Also, if you 
purchase content on an ioS device, it is automatically synced to your other devices 
and to your computer.

iCloud also syncs documents that were created using Apple’s native apps, such as 
Pages, Numbers, or Keynote. Create or edit a document in Pages on a Mac, and it’s 
instantly sent to iCloud (if you have an Internet connection) and synced to your 
other Mac or ioS devices (such as an iPad). iCloud acts as both a backup system and 
as file storage (five gigabytes of free storage). iCloud provides automatic updates of 
your data to all devices when content is changed anywhere.

iCloud also integrates seamlessly with a feature in iPhoto called Photo Stream. 
Photo Stream uploads your photos to iCloud, then syncs them to your other 
devices. iCloud doesn’t permanently store all your photos. only the last 1,000 
photos uploaded to iCloud will be synced to your ioS devices. Photos are kept on 
iCloud for only thirty days, enough time to make sure they’re synced to your Macs 
and devices.

You will be able to take action to protect any image from being deleted from iCloud, 
but details are not available as of this writing.

iCloud promises to be a significant feature that will 
simplify syncing and backup tasks. Many details are 
unknown as of this writing, but we’re confident that 
iCloud will be a time-saving, problem-preventing 
favorite benefit of being a Mac user.
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Enable automatic downloading
To enable iTunes on your Mac to automatically download new purchases from the 
iTunes Store that were made on your other devices, you must first choose the type 
of content to automatically download.

1 open iTunes, then from the iTunes menu choose “Preferences….”

2 Click the “Store” button (circled, below).

3 Check the type of content you want iTunes to automatically download  
(Music, Apps, Books).

To set up automatic downloading on your iPhone, iPad, or iPod touch, click the 
“Settings” icon on the device home screen, select “Store,” then select the type of 
content you want automatically downloaded.

iTunes Match
iTunes Match is an iCloud service that scans your entire music library and matches
your songs (even songs you didn’t purchase from iTunes) with Apple’s extensive 
library of music from the four major record label companies. For syncing, iTunes 
Match eliminates the need to upload your songs to iCloud, since iCloud provides 
access to duplicates of your songs. When available, iCloud substitutes a higher 
quality version than the version on your Mac or mobile device. In the rare event 
that you have some songs that can’t be matched in Apple’s massive library, you can 
manually upload those unmatched songs to iCloud.

iTunes Match costs $29.99 a year, but the amount of storage space provided is 
unlimited. If you have a huge collection of music you’ve copied from your cd 
collection, iTunes Match might be well worth a subscription.
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Set up your printers

Access the special settings 
for your printer software

Access the special settings 
for your applications

Share printers   
with other computers   

on your network

Learn some 
troubleshooting tips

Access the utilities   
for your printer

Set up and use   
your scanner 
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LESSON 17

set Up Printing  
and scanning

Printing gets easier and more reliable with every new operating 

system. The Mac recognizes and automatically sets up more print-

ers, individual applications can apply more special parameters 

to your print jobs, and sharing one printer with many computers 

gets easier all the time. Lion automates one of the most trouble-

some aspects of using a printer: When you connect a new printer, 

Lion checks to see if the proper printer driver is installed. If not, it 

automatically goes online, finds the latest up-to-date version, and 

installs the driver software for you. Lion even periodically checks 

to ensure it has the latest version of the printer driver and auto-

matically downloads new versions through your built-in Software 

Update application (found in System Preferences).
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Set up your Printer before you Print
The first time you try to print, your Mac asks to set up your printer (as shown on 
the following pages). But you can streamline the printing process by setting up your 
printer ahead of time. Any time you add a new printer to your office, open the Print 
& Scan preferences to set it up. occasionally you might need to use this pane to 
troubleshoot printing problems.

1 Make sure your printer is turned on and snugly connected to your Mac  
with the proper cables. 

 If the printer is connected to someone else’s Mac, make sure the “Printer 
Sharing” preferences on that Mac are turned on; see page 320.

2 Go to the Apple menu and choose “System Preferences….”

3 Single-click the “Print & Scan” icon to get the pane shown below.

This is what your panel 
might look like the first 
time you open the Print 
& Scan preferences. 
Or you might see one 
or more printers listed 
in the left-hand pane.

4 If your printer is in the left-hand pane and shows a green light, you’re good to 
go. Quit the System Preferences and go print.

 If you don’t see the name of your printer in the list on the left, 
click the + button (shown circled, above).

 From the menu that drops down, you will probably see the name of your 
printer. If so, select it, then skip to Step 6. 

 If your printer is not listed, choose “Add other Printer or Scanner…” from that 
menu and go to Step 5. (Although if it’s not in the menu list, that’s a clue that  
your Mac can’t find it.) 
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5 When you click the + and choose “Add other Printer or Scanner…,”  
the “Add Printer” window opens, shown below, and your Mac searches for  
and  lists every printer (and scanner) that it recognizes. 

 If your printer shows up, single-click its name to select it, then click “Add.” 

 If you don’t see your printer listed, it has most likely lost its connection.  
If you’re sure it’s plugged in properly, then you might want to try a different 
cable—they can go bad all by themselves. Another possibility is that you didn’t 
install the printer software that came with the printer, and it’s a brand that 
Apple doesn’t have access to. Install the software now (either from the disc that 
came with the printer, or go to the printer’s web site and download it, especially 
what’s called the “printer driver” software). Then try these steps again. 

6 If you have not previously installed the software to run the printer, no worries 
(most of the time). The Mac will go online (assuming you are connected to the 
Internet) and get it for you and install it, as shown below.  

Printer driver software 
needs to be updated 
regularly, which is what 
makes it especially great 
that your Mac can go get 
it for you. 

—continued
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7 If your printer is not an off-brand, your Mac will find the software it needs, 
install it, and you’re ready to print.  

The software is important
If you bought a fancy printer of some sort (meaning it cost more than a hundred 
dollars), be sure to install the software that came with it. What you particularly need 
to install is the latest “printer driver.” Although, as you’ve seen above, when you 
install a printer or first print a job, your Mac automatically checks for the appro-
priate software, and, if necessary, downloads and installs it for you. 

However, if you bought an off-brand and Apple can’t find what it needs, go to the 
web site of the printer vendor and search for the printer driver for that specific 
model that you own. Download and install it, restart your Mac, and try again. 

The more expensive your printer is, the more important it is that you have the 
proper driver. If not, you will lose some of its most valuable features. For many 
printers, the drivers that Apple has access to will probably work just fine.  

If your printer is really old and the vendor has stopped updating the drivers, you can 
try an older driver and see if it works. If not, you might have to get a new printer. 
We’ve got a seventeen-year-old Apple LaserWriter that has printed millions of pages 
and is still going strong, but when we recently gave away our last computer that 
used os x 10.5, we realized too late that we gave away its last life support. I’m going 
to mosaic the steadfast friend and set it up as a beloved piece of art. Along with my 
first scanner and my old mailbox.   

If this is the printer 
you want to use all 
the time, choose 
its name from this 
menu to set it as the 
default printer. 
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the first time you Print to your Printer
Your Mac automatically detects printers that are connected to the computer or on 
your local network. If you didn’t set it up through the Print & Scan preferences as 
explained on the previous pages, you can do it on the fly the first time you print.

To print something for the first time in your current application, press 
Command P (or go to the File menu and choose “Print”). If you see your  
printer listed in the “Printer” menu in the Print dialog, then you’re all set up. 

Usually, however, the first time you try to print, the Print dialog tells you there is 
“No Printer Selected,” as shown below. Your Mac just needs to be told to go find the 
printer and add it to its list. So:

1 Make sure the printer is connected to your Mac, that all the cables are secure, 
and that the printer is turned on.

  If you are printing over a wireless network, make sure the printer is turned on 
and that the computer to which that printer is connected is turned on and has 
turned on “Printer Sharing” in the Sharing System Preferences (see page 320). 

2 Press the menu that says “No Printer Selected.” You’ll see a list of “Nearby 
Printers” that your Mac has found. If you see the name of your printer, select it. 
Your Mac will get and install the necessary software, if it can, as shown below-
right. (This of course assumes you are connected to the Internet.) When the 
name of the printer appears in the menu, you’re good to go. 

  If your printer is not listed under “Nearby Printers,” choose “Add Printer…”  
at the bottom of that menu. Go to page 315 and follows Steps 5–7.
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If you don’t see a full window of options, 
this button probably says “Show Details.” 
Click it to display more options.

The printer 
selected above 
determines 
what the 
options are for 
that printer. 
Check this 
menu carefully.

access the Special features of your Printer
If you installed the software that came with your printer, then you probably have 
special features that allow you to choose the correct paper, the quality settings, 
adjust the colors, and more. The quality difference in output, for instance, between  
a setting for inkjet paper as opposed to glossy photo paper is quite amazing. 

To access the specific printer settings: 
1 Start to print the job (press Command P). 

2 If you see a small Print dialog box as shown on the previous page, click  
the “Show Details” button at the bottom of the dialog (see below) to reveal  
an expanded dialog.

3 In the expanded Print dialog box, click the menu circled below. 

 Depending on the printer you have selected, you’ll see such labels as 
“Print Settings” or “Image Quality.” Here you will have lots of options, 
different options for each printer you choose, and for some printers 
you can select specific paper/media (of course, you should have that 
particular paper loaded in your printer).

Cycle through 
the pages 

in your 
document 
to preview 

the print 
expectations.
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access the Special features of your Software
Not only does your printer offer special printing features, but most software appli-
cations also have special features. 

In the Print dialog box, be sure to check the pop-up menu (circled below and on the 
opposite page) to view the options for the particular software you’re using.

Below you see the print settings for Photo Booth, which is software on your Mac for 
taking photos of yourself and making movie clips (see pages 236–239). 

Applications 
often have 
specialized 
features.
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Share your Printer with Other Macs
Any printer can be set up to share, meaning any other computer in your office 
or home network can print to it without having to be directly plugged in to the 
printer. This is great because until Mac os x came along, you had to buy a special 
networkable printer. Now you can have one printer in your home or office and 
everyone can print to it. 

If the printer you want to share is plugged directly into the router or switch for your 
network, anyone can print to it no matter which other computers are turned on. 
Typically, that means it’s an Ethernet printer (it uses Ethernet instead of your usb 
port), and probably a laser printer. 

If the printer is plugged directly into a particular computer, that computer must be 
turned on for others to print to its connected printer. 

To share a printer:
1 Turn on the printer that you want to share. If the printer is connected directly  

to a computer (instead of to an Ethernet hub), that computer must also be on.

2 on the Mac that is directly connected to the printer, go to the Apple menu  
and choose “System Preferences….”

3 Click the “Sharing” icon.
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4 In the pane on the left, check the box for “Printer Sharing.” Then you should see 
the printer that is connected to your computer in the box on the right. Make 
sure there’s a checkmark next to the printer you want to share.

5 on the right side of the Sharing pane (shown on the opposite page), click the 
“open Print & Scan Preferences…” button. 

6 In the “Print & Scan” preferences, shown below, select the printer in the pane  
on the left. In the pane on the right, you should see a checkmark next to 

“Share this printer on the network.” All is well. 

You could also go 
straight to the “Print 
& Scan” preferences, 
shown here, and 
click the “Sharing 
Preferences…” button, 
which takes you to the 
preferences shown on 
the opposite page. 
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having trouble Printing? check the Queue
Apple applications will warn you that your printer has been paused, and this can 
save you a lot of time when trying to figure out what’s wrong. 

Notice the icons in the 
Toolbar that say “Hold” and 

“Pause Printer.” These are 
your clues that there are  
no jobs on hold and that 
the printer is not paused.

Not all apps are so thoughtful, however, and you can end up trying to print a job 
over and over again, only to eventually discover they are all lined up in your print 
queue, waiting for the okay. Here is how to check the queue and resume printing.

1 open the “Print & Scan” preferences: Go to the Apple menu, choose “System 
Preferences…,” then single-click the “Print & Scan” icon. 

2 Make sure the correct printer is chosen; click to highlight its name on the left.

3 on the right side of the pane, click the button to “open Print Queue….”  
This brings up the list of jobs waiting to be printed on that particular printer, 
as shown below. 

Having a queue can be useful—you 
can pause your printer intentionally, 
send a lot of jobs to the queue, and 
then when you’re ready, send them 
all through at once. 

4 Check to make sure the jobs are not on hold or paused. The buttons should  
look like the ones above (see further explanation on the opposite page). 

  When you click the “Pause Printer” button to pause a print job, the button 
changes to say “Resume Printer.” 
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  In the example above, there are four visual clues that tell you all jobs are  
on hold until you resume printing: 

 The “Hold” button in the Toolbar has changed to “Resume.”
 The “Pause Printer” button in the Toolbar has changed to “Resume Printer.”
 The printer icon has a pause symbol on it.
 The upper pane says clearly, “Printer Paused.” Twice it says “Paused.” 

  To resume printing, select the job/s in the list and click “Resume Printer.”  
Or select a job and click “Delete” to get rid of it, and then resume printing.

You can also get to this print 
queue by clicking on the 
printer’s icon that appears  
in the Dock when you print.  
I like to keep that icon in my 
Dock at all times (see below). 

The printer icon in your Dock also gives you 
visual clues about your job. Here you can see 
that two jobs are in the queue to print, and 
that the printer is on hold.

When printing a long job, hold down the Option key and this 
button will tell you which page is being printed right now. 

to put the printer icon in your dock so you can monitor printing 
easily, open the Print & Scan preferences (go to the Apple menu, choose “System 
Preferences…,” then choose “Print & Scan”). Drag a printer icon from the left pane 
and drop it in your Dock. Single-click that icon at any time to open the print queue 
and also to access the utilities for your printer (as explained on the next page). 

If you have trouble printing and you have more than one printer 
connected, always check to make sure that you chose the correct printer!  
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check your Printer Utilities
Another useful feature from the Print & Scan preferences is that you can check your 
printer’s utilities, which might include options to clean the print heads, align the 
colors, check the toner level, or other features, depending on your printer and its 
software that you installed.

open the Print & Scan preferences as usual, and choose a printer in the left pane. 
Then click the “options & Supplies…” button. What you see depends on the printer.

Poke around in the options that your printer 
supplies. Knowing what is available ahead of 
time comes in very handy. 

Some printers will give 
you an option to click a 
button to go to the Apple 
store and buy toner for 
that specific printer.
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Set up your Scanner
If your scanner is part of your printer, then setting up your printer as explained on 
the previous pages will also set up your scanner at the same time. If your scanner is 
stand-alone, install the software that came with it before you set it up (go online and 
download the software if necessary). Not all scanners work with this process.

To add a scanner, follow the steps on pages 314–316, but look for your scanner 
name rather than the printer name. Your scanner will appear in the left pane, as 
shown below.

To use your scanner, click the “open Scanner…” button. See the callouts on the 
illustrations below. Not all scanners use the same software! This is one example. 

Choose an application on 
your Mac that you want the 
finished scans to open into. 

Click here to start the process. 

Choose a folder in 
which to save your 
scans, or an app in 
which to view or send.

Click this button 
to see the scanning 
options shown to 
the right.

Click this button 
to see the options 
shown to the left.
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Understand why it’s useful 
to have multiple users   

for one Mac

Learn to create new users

Learn how to log out   
and log in

Enable fast user switching

Allow other users   
to be Administrators

Teach users to adjust some 
of their own settings 

Learn to share files with 
other users on one Mac

Apply parental controls 
from mild to stringent

Delete users with   
or without their files
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LESSON 18

share one Mac  
with Multiple Users

Mac os x is specifically built for what’s called a multiple user 

environment; that is, Apple expects that more than one person is 

probably using the same computer, whether it’s in a school, office, 

or home. You can set up another user so no one else can access 

your email, personal letters, change your sound level, poke around 

in your financial files, put up a dorky picture as the Desktop back-

ground, or change any of your settings. 

If you are the only user who ever has or ever will use this Mac, you 

can skip this lesson altogether. But are you really the only user? 

Perhaps your grandkids come over and want to use your computer. 

or maybe your husband uses your machine from time to time. or 

sometimes you have relatives staying for a week who just want to 

use your Mac to get their email. or you’re a teacher who wants 

several students to have their own private spaces. If so, set up 

other users. 
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Overview of Multiple Users
First, let me explain the concept and advantages of having multiple users on your 
Mac so you can decide if you need or want to create other users. 

You already have one user, you, which was  automatically  created when you first 
turned on your Mac and went through the setup process. You are the main user 
known as the Administrator. The password you set up when you first turned on 
your new Mac or installed Lion is your Admin password.

You might not have noticed that you are a “user” because Apple sets a default so 
when you turn on your Mac, you are automatically “logged in” without having to 
type in a password. once you have other users set up, you can change this default so 
everyone must log in with a password. If others use your Mac only occasionally, like 
your grandkids, you can leave it set to automatically let you in daily; then when the 
kids come over, you go to the Apple menu and log out, which means they must then 
log in  with their own settings, and yours will be protected. 

one user, the first one (which was you, if it’s your own Mac), is automatically 
created as the original, main Administrator (Admin) of the computer. If you  
are the only  user, you are still the Administrator. 

Limitations of other users
So you are the Admin and other people are either standard users or managed 
users. All other users are limited in certain ways: 

n	 Applications can be made available to everyone, or limited to specific users. 
This means you could install a game in your child’s Home folder and it 
won’t clutter up your own Applications folder. If the game has to change the 
resolution of the monitor and the number of colors and your child cranks the 
volume way up, it won’t affect what you see and hear when you log back in. 
You can install your financial program in your own Home folder so others 
cannot use it or access your files. 

	 With “Parental Controls” you can create managed users for young kids and 
grandkids, where you can customize their Docks so they only have access to 
certain programs. You can seriously limit with whom they chat and email and 
which web sites they visit. 

n	 Even if an application is available to everyone who uses the machine,  
an individual user can set his own preferences because the preferences  
are stored in the user’s personal Library folder. 
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n	 Every user can customize the Mail program, and all of a user’s email  
is privately stored in each user’s personal Library folder.  

n	 Every user can set up her own screen effects. Fonts, window and Desktop 
backgrounds, Sidebar, Dock placement, Mission Control, and preferences 
are individually customizable. Preferences are also individualized for the 
keyboard, mouse, web browser bookmarks, international keyboard settings, 
applications that start up on login, and QuickTime.

n	 The features that make the Mac easier to use for people with challenges can 
be customized by each user. This includes the Universal Access settings, full 
keyboard access, Speech preferences, Voiceover (having your Mac talk you 
through doing things), etc. 

n	 Users who need international settings for such things as date, time,  numbers, 
or for typing other languages, etc., can customize the Mac without bothering 
other users. If you have a laptop that you travel with, you can set up yourself 
as another user, such as “Carmen in Paris,” and customize those settings for 
that country without affecting all your settings for home. 

n	 Standard users cannot change the date or time (except for the menu bar 
settings), nor can they change the preferences for energy saving, file sharing, 
networking, or the startup disk. They cannot add new users nor can they 
change certain parts of the login process. And they cannot install software. 

n	 Managed users have all of the above limitations, plus they have parental 
controls applied. You can seriously limit a managed user; see pages 344–347.

n	 The Guest account is a special and very temporary account. Everything a 
Guest user does on the Mac completely disappears as soon as he logs out. This 
is great for someone who says, “Can I use your Mac to check my web mail?” 
She can log in as Guest, use Safari to check her mail, and leave no trace.

More than one Admin
As the Administrator, you can assign Admin status to any other user. When that 
Admin user logs in, he can make system-wide changes that standard users cannot; 
he can create and delete other users, and do most of the things you can do. But your 
personal Home files are still protected from everyone else, including other Admins.
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guest User is already created
Apple has already created a special Guest account for your guests. This is a very 
temporary account! It’s for those times when someone comes over to your house and 
wants to use your Mac to check their mail or write a quick TextEdit report. As soon 
as this person logs out, everything she did on the computer is completely erased.

There is no password for a Guest user. As soon as you enable login (explained 
below), anyone can log in as Guest, but they have no access to any of your files. 

1. Click the lock in the 
bottom-left corner to allow 
you to enable login for the 
Guest Account. You’ll need 
your Admin password to 
unlock the screen.
If you don’t enable login, a 
Guest can use the network to 
share public files, but cannot 
log in to your Mac.

2. Click “Guest User” in the 
left pane, to see the screen 
shown here. Check the box to 

“Allow guests to log in to this 
computer.”

3. Click the lock again to lock 
the panel (although it will 
automatically lock when you 
close the panel).

To log in as Guest, from the Apple menu, log yourself out. The login window that 
appears has a “Guest” button at the bottom. Single-click it. 

To log out as Guest user, go to the Apple menu and choose “Log out Guest 
Account.” There will be a warning that all files that have been created will be deleted.
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create New Users
If you are the Admin (as explained on pages 328–329), you can create standard or 
managed users (also explained on the previous pages). You’ll create the user in the 

“Accounts” pane of System Preferences, plus you’ll assign a password and a login 
picture. In the “Login options” pane (click the house icon that you see just above the 
lock icon), you can make adjustments to the login window. 

To create a new user:
1 Go to the Apple menu and choose “System Preferences….”

2 In the System Preferences pane, single-click “Users & Groups.” You’ll get the 
dialog box shown below. Your user account is also the Admin. 

3 Click the lock icon in the bottom-left corner. In the dialog that appears after  
you click the lock, enter the Admin password (the one you chose when you 
set up your Mac), then click ok. The lock in the bottom-left corner is now 
open, as shown below.

4 To add a new user, click the “plus” button. This makes a sheet drop down  
(as shown on the following page) where you will add new user information. 

—continued

If you “set” a user’s Apple Id
here, that user can use her 
Apple Id to log in to this 
computer from another 
computer on the network.
Check this box to then allow 
the user to reset her own 
password at some point (see 
page 415).

Click this Action menu to get an option to set a 
master password. With the master password, an 
Admin user can reset the password of any user. 
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5 Type the full name (or any descriptive phrase) in the “Full Name” text field.  
A short “Account name” is automatically created for you, but you can edit it. 
You will never be able to change the Account name after you leave this pane! 
The only way to “change” it is to delete the entire user and make a new one.

  The Account name should be short (eight characters or less), you can’t use 
spaces, and you should avoid non-alphabet characters (like * ! ? or /).

 Mac oS X can use either the short Accountname or long name. But the short 
name is sometimes necessary if you use ftp, Telnet, or other applications that 
let you log in to your Mac from some other location.

6 Enter a password for the user. Write this down somewhere. As you’ve probably 
seen before, you need to type in the password twice to make sure you’ve 
spelled it right, since you can’t see it. If you like, click that tiny key icon to get 
some suggestions for passwords that are very secure.

  Passwords are “case sensitive.” That means capital or lowercase  letters change 
the password: “ChoCho” is not the same password as “chocho.” So be darn sure 
when you write down your password somewhere that you make note of any 
capital letters used.

  It is possible to leave the password blank, but that makes the entire computer 
easier to get into. If privacy is an issue, be sure to assign a password.

  You can, if you like, enter a password hint. on login, if a user enters the wrong 
password three times, a message appears with this hint (see page 334 to see the 
box that must be checked to make the hint appear).

Click this to get 
secure password 
suggestions.

Choose an 
account type.
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7 Click the “Create User” button. You will be asked about Automatic Login, 
which lets you turn on your computer and automatically logs you in without a 
password. If you have security issues with your Mac, turn off Automatic Login.

8 Enter the user’s Apple id, if she has one and you know what it is. This allows 
the user to log in to this computer on the network using her Apple id and 
password (see Lesson 21). If you check the box to “Allow user to reset password 
using Apple id,” then she can, obviously, reset her own password at any time. 

  If a user does not have an Apple id and wants one, she can click the “Set…” 
button, then click “Create Apple id” to go to Apple’s site and get one. It’s free.

9 To choose a login picture, do one of the following:
n	 Single-click the existing picture you see in the window and choose another 

from the collection that appears. 
n	 Or do the step above (click the picture), then choose “Edit Picture….”   

Then skip to “Edit the image,” below.
n	 Or do the step above (click the picture), then click the button to “Take 

photo snapshot” with the computer.
n	 Or drag a photo or other image from a Finder window and drop it  

on top of the existing picture.
	 	 Now you can edit the image: Resize, reframe, take a new photo, or choose  

a different image. You can edit this at any time in the future as well. 

—continued

Press-and-drag 
this image to 
position it within 
the frame.

Click here 
to show a 
selection 
of recent 
pictures.

To resize the 
image, drag  
the round slider.

If your Mac 
has a camera, 

click this 
button to 
take your 

photo.

To choose another image 
from your Mac, click here. 

When you’re happy with 
the image, click “Set.”
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10 To give this user admin privileges so she can change preferences, install software, 
reset her password, etc., check the boxes on the main pane, shown on page 329. 

 To enable parental controls, check the box, then click the button to “open 
Parental Controls” (see pages 344–347).

11 At the bottom of the accounts pane, single-click Login Options (circled below; 
the lock must be unlocked) to assign a user the ability to automatically log in, 
as shown below. This pane is available only to Administrators (that is, standard 
and managed users will not be able to change anything on this pane). The 
options shown here are explained on the following pages. 

  I set up several new users, but my Mac will automatically log in to “robin,” 
meaning I do not have to go through the login screen and enter a password 
whenever the Mac starts or restarts. This is good for me on the Mac in my 
office because I work by myself; for my laptop that I travel with, I disable
automatic login just in case someone steals it. 

 only one user can be assigned the automatic login at a time. Whenever necessary, 
click the “Login options” button (shown on the previous page), then choose a 
different user from the “Automatic login” pop-up menu.  

Choose to turn off 
automatic login, or 
choose another user 
from this menu to 
automatically log  
in when you start  
the computer.

When fast user switching is checked, a menu list of user 
accounts is placed in the menu bar across the top of the 
screen, next to the Spotlight icon (see page 338). Users 
can choose their user names from that menu and log in. 

If fast user switching is not activated, the current user must 
log out before another user can log in. See page 337.

Click here 
to show a 

password hint 
when you’ve 
forgotten it.
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—continued

Display login window as: The “List of users” displays icons for all accounts, as 
shown below. At login, click a picture, then type the password (as shown on 
page 337). (If you have a very young user who can’t type and you feel your Mac 
is safe from strangers walking by, do not assign a password; she can just click 
her picture to log in.)

The “Name and password” option (see the previous page) displays a small log-in 
window with two edit boxes, one for the user name and one for the password. A 
user will have to type in both name and password, which makes your Mac one 
step more secure.

Show the Sleep and Shut Down buttons: If you choose to show these, you will 
be able to put the Mac to sleep or shut it down without having to first log in 
and wait for the computer to pull itself together. 

Show Input menu in login window: This gives you access to the language 
options that you may have set up in the International preferences.

Show password hints: If a user enters the wrong password three times,  
the hint that was provided in the password pane when the user was created  
is displayed. Or go ahead and click the question mark (shown on page 337) 
to provide the hint immediately. If you’ve forgotten the password and if you 
previously enabled the user to use her Apple id to reset it (see page 331), the 
question mark provides an option to do just that.
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Show fast user switching menu as: This is so cool—it allows multiple users to 
stay logged in at the same time without having to close files or quit applications 
(see page 338). The fast user pop-up menu lets you choose how a user is shown 
in the menu at the top of the screen: as a full name, short name, or icon. 

Use VoiceOver in the login window: This turns on Apple’s built-in spoken 
user interface so a visually impaired person can log in. It reads everything on 
the login screen out loud to you and tells you what is highlighted so you know 
where to type your name and password. To disable Voiceover, make sure this 
checkbox in not checked.  

12 To limit what the new user can access, see pages 344–347.  

 To choose login items that automatically open on login, see page 341.

When done, close the Users & Groups preferences pane. You can always make 
changes at any time. To make changes to other users, they must be logged out.

create a group 
You can create a Group account that consists of individual users who will all have 
access to the same files. This makes it even easier to share files with a group of 
people who are all using the same network, such as students or coworkers. You 
must first create individual users for the people you want to add to the Group.

Then make a new user account (see page 331) and choose the “Group” option from 
the “New Account” menu. After you name the group, you’ll get a pane in which you 
can add existing users to this new Group. 

To maximize the file-sharing capabilities, use the Sharing preferences (Lesson 21) to 
turn on various sharing possibilities, then add this Group to the list of sharing users. 
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Log Out and Log in
Automatic login allows one  selected user to use the Mac without having to enter  
a password. If automatic login is enabled (page 334), then you must make sure to 
Log Out (not restart or shut down) before another user can log in. This is because 
the computer will automatically log you in again when it starts up. 

If automatic login is not  enabled, then it doesn’t matter how you turn off the Mac—
it will always display a Log In screen where every user, even Admins, will have to 
enter a password.

When you log out, all of your documents will close and your applications will quit.  
If this is inconvenient, read about “fast user switching” on the next page.

To log out, go to the Apple menu and choose “Log out User…,” where “User” is the 
name of the currently active user. All applications will quit, the current screen will 
disappear, and the login window will appear, waiting for the next user to log in. Or if 

“fast user switching” is turned on (as explained on pages 336 and 338), go to the user 
menu on the right side of the menu bar, choose “Login Window…,” and the login 
screen shown on page 335 appears; your applications do not close.

To log in, click your name (or type it in) and then type your password. If the 
password is incorrect, the login window shakes back and forth, as if it’s saying “No! 
No! No!” After three wrong passwords, it will show you the hint you assigned (see 
page 332). Or at any point, click the question mark; the clue is displayed, plus if your 
account is set up with your Apple id (page 331), you can use it to reset the password.

If you checked the box 
to “Show password hints,” 
click the question mark to 
see the hint.

Click this 
arrow to 

return 
to the 

main login 
screen.

If your password isn’t 
working, check to make 
sure the Caps Lock 
symbol is not in the field! 
If Caps Lock is on, your 
password will be typed in 
all caps and won’t work. 
To take it off, press the 
Caps Lock key again.
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Switch Users with a click
The Mac has a feature called fast user switching that allows multiple users to stay 
logged in at the same time without having to close files or quit applications. 

When fast user switching is turned on, all users are listed in the top-right corner of 
your screen, next to the menu clock. The currently active user’s name appears in the 
menu bar. 

To see other user names and to see which ones are logged in, single-click the current 
user name in the menu; a menu drops down showing all users (below, right). Users 
in the list that have a checkmark next to them are already logged in. The  currently 
active user is grayed-out. 

To enable fast user switching, click the checkbox “Show fast user switching 
menu as” in the “Login options” pane of the Accounts system  preferences 
(shown above-left). See page 334 for more about fast user switching. 

To switch to another user, choose one from the user menu (above-right).  
If you (the Admin) assigned a password to the chosen user, a login window 
opens so the user can type a password. Enter the correct password and the 
user’s own personal Desktop environment opens.  

If a password was not assigned to a user, that user’s Desktop opens immedi-
ately, without a password-protected login window. Actually, it doesn’t just 
open like some ordinary computer; the entire Desktop rotates like a cube to 
the new user space.
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To open the main login window, choose “Login Window…” from the list of 
users in the menu bar, as shown on the opposite page. This is a convenient way 
to leave the screen if you have multiple users. The next user who sits down at 
the Mac just clicks her name to log in and start work (or play).

If the rotating-cube effect isn’t happening for you during fast user 
switching, the  graphics card installed on your Mac might not be able to handle 
the intense processing that this effect requires. Fast user switching will still take 
place—it’s just not quite as sexy.

Even the Admin cannot make changes to another user if that user is 
already logged in. So if you try to make changes and it won’t let you, log out that user. 

allow Other Users to be admins
An Admin can select another user and give that user Administrator privileges. 
Make sure that user is not logged in. In the Users & Groups preferences, unlock the 
lock. Select the user in the left panel, then click the button to “Allow user to admin-
ister this computer.” 

A standard user can give himself Admin privileges if he knows the name and 
password of an Administrator. All he needs to do is click the lock icon and enter  
the correct information.
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Let Users adjust their own Settings
once a standard user is logged in, she can adjust some of the login settings, even 
if she’s not the Administrator. She can change her password (she has to know 
the current password before she can assign a new one). She can change the login 
picture, and choose which applications open automatically when she logs in.

Below you see the applications that Chariclea likes to have open automatically 
when she comes to visit and uses my Mac. See the opposite page for details about 
assigning Login Items.



ptg6934589

Lesson 18 Share One Mac with Multiple Users 

341

Set Up Login items
In the Login Items pane, any standard or Admin user (including yourself ) can 
choose to have certain items automatically open during the login process. You can 
open your favorite applications, utilities, documents, even movies or music. (If you 
choose to have a document open, the application it was created in will have to open 
as well, even if you don’t have it in the list.) 

This pane applies only to the user who is  currently logged in! No other user even has 
access to the Login Items pane for someone else.  

To add items to the Login Items list, click the “plus” button circled below. A dialog 
box opens to let you choose any file or application to add to the Login Items. To add 
more items, click the “plus” button again.

The files will open in the order in which they are listed. Drag any file in the list up 
or down to change the order. 

If you don’t want to see an item right away every time you turn on your Mac, click in 
the checkbox to hide it. It will open, but its windows won’t be visible on the screen.  

To delete items from the Login Items list, first select the item, then click the 
“minus” button.

Another way to add items: Press (don’t click) or right-click an icon in the Dock. 
Choose “options,” then choose “open at Login.”  

To remove it, repeat the above to remove the checkmark next to “open at Login.”
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Share files with Other Users
once users are set up, other users can only access each other’s Public folders, the 
Drop Boxes inside the Public folders, and the Sites folders. But the Shared folder 
(which is in the Users folder, which is on your main hard disk) is available to 
everyone who uses that Mac. Here’s how it works:

n	 Put files in your own Public folder that you want others to be able to read, 
copy, or print. They have to open your Public folder to do so.

n	 other users can put files for you into your Drop Box, which is located inside 
of your Public folder. They cannot open your Drop Box, not even to see if  
their file transferred successfully. 

n	 Put files in the Shared folder that you want everyone who uses the Mac  
to be able to access. This is a good way to distribute something to everyone  
on the Mac without having to copy it to each individual’s Drop Box.

You can also change the sharing “privileges” for any folder in your Home folder.  
That is, you can turn off  the sharing privileges for the Public folder and the Drop 
Box so no one can access them, and you can also choose to share any or all of your 
other folders, with varying levels of access. See the following page for details.

Every user  
has a Drop Box  
inside his 
Public folder.

All users can access items in the Shared folder.

For easy access to 
your Public folder, 

put your Home 
folder in the Sidebar 

(use the Finder 
preferences to do 

this; see page 279.)



ptg6934589

Lesson 18 Share One Mac with Multiple Users 

343

Set Permissions for Shared files
Every file on your Mac has “permission” settings. Some of these permissions you can 
change, if you like. For instance, you might want to send a memo to all users of this 
Mac, but you don’t want them to be able to edit it. So select that document and give 
the others a permission of “Read only.” or perhaps you don’t want anyone to access 
a Screenwriting folder you made; give it a permission of “No Access.” Maybe you 
want to share your Movies folder so another user can drop movie files into it; select 
the folder and change its permission to “Read & Write” or “Write only” (which 
means they can put files into your folder but can’t take them out).

To change permissions on a file or folder:
1 Single-click a file or folder to select it.

2 Press Command I to display the Info window, as shown below.

3 Click the disclosure triangle next to “Sharing & Permissions.”

4 Click the lock icon in the bottom-right corner and enter your Admin 
password. Click ok.

5 Click the “Privilege” menu next to user names to change the permissions.

6 When you’re finished, just close the Info window. 

To revert changes or to 
apply the permissions 
to all items in a folder, 
use the Action menu.

Add users or a Group to this list 
and assign Privileges (permissions).
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apply Parental controls
There are several levels of limited user access you can create. once you apply any 
of these parental controls, the user changes from a “Standard” user to a “Managed 
with Parental Controls” user (you cannot apply Parental Controls to an Admin user). 
Choose the level of access you want to control. Each of these options is explained on 
the following pages. only an Admin can apply or change parental controls. You can 
even manage these controls from another computer.

You can limit the applications to which a user has access, the content of the 
Dictionary and web sites, whether or not a user can burn cds or modify their Dock, 
and more. You can set time limits and check logs to see where a user has been. 

The Simple Finder is the most serious limitation. This is appropriate for very young 
children who want to use their educational software and games on your Mac and 
really don’t know how to surf or chat anyway. It makes the Mac very easy for them 
to use and they can’t do any damage.

Set limitations on a user
1 In the Users & Groups preferences, set up a new user, as explained  

on pages 331–336, if you haven’t already.

2 Make sure that the user is not logged in. If she is, log her out.

3 If the lock icon in the bottom-left corner is locked, single-click on it  
and enter the Admin name and password. Click ok.

4 Select the user in the left-hand pane.

5 Check the box to “Enable parental controls.”

6 Click the button to “open Parental Controls….”

7 You’ll see the window at the top of the next page. Make sure the account to 
which you want to apply parental controls is selected on the left. 

8 The rest of the process is pretty self-explanatory—essentially, you’re going to 
choose what you want to limit. Don’t choose the Simple Finder until you read 
page 346.
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Choose which 
applications you  
will allow. 

Check to see 
where the child 
has been.

Click these tabs to 
limit other features.

To add individual 
accounts that you will 
allow contact with, 
click the Plus button 
(circled, below). 

Click here to 
automatically send an 
email to the address 
you specify whenever 
the user tries to send 
email to someone who 
is not on the approved 
email list.

open each tab and spend some time poking around to see what kind of boundaries 
you can set. You can always change them later. 
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Simple Finder
The Simple Finder (in the Apps pane in the Parental Controls settings) provides the 
most serious limitation. It’s great for young children. The illustration below shows 
what a user logged in using Simple Finder might see.

n	 The Applications and Utilities are limited to what you allow.

n	 The user has no access to a Desktop, hard disk, or other partitions. 

n	 The user cannot move files from one folder to another.

n	 The user has three folders in her Dock: My Applications, Documents,  
and Shared. The Shared folder contains items placed in it by other users  
of the computer, as explained on page 334. Anything anyone puts into the  
Shared folder (shown in the Dock) will be available even to users running 
Simple Finder.

n	 The Finder windows have no Sidebars or Toolbars. 

Shared folder.

In Simple Finder, click an icon just once to open it. 

My Applications folder.

Documents folder; all saved  
documents will be in this folder.
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To set up a user with Simple Finder:
1 Follow the steps to create a new user with parental controls (see page 344), up 

through Step 7.

2 Click the button to “Use Simple Finder.”

3 In the list of applications, uncheck the boxes to deselect applications.  
Every checked item will be available to the user in Simple Finder.

The applications list in the Parental Controls window (below) are shown in 
groups. Click the disclosure triangle next to an application checkbox to hide  
or show the individual applications in that group. 

Disable the Simple Finder
To disable the Simple Finder in a user account, the managed user must be logged 
out: From the Apple menu, choose “Log out user name.” An Admin user (or 
anyone with an Admin name and password) can then go to the System Preferences 
select “Users & Groups,” then click the padlock in the bottom-left corner; a dialog 
opens that requires an Admin name and password. Select a managed account in 
the sidebar, then uncheck “Enable parental controls.” To manage parental controls 
on one computer from another computer, click the “open Parental Controls…” 
button, then check “Manage parental controls from another computer.”

To open the full Finder while in Simple Finder, go to the Finder menu and choose, 
“Run Full Finder.” You’ll need to enter an Admin name and password. Return to 
Simple Finder via the same menu. 

The numbers in this menu 
indicate age. “Up to 4+” 
indicates an app contains 
no objectionable material. 
Up to 12+” indicates it is 
not suitable for anyone 
under 12 years of age, etc.

This lets you keep track 
of which websites this 
user has been to, which 
applications he used, and 
who he talked to on iChat.
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delete a User
Any Admin can delete a user. You have three choices about what to do with all of the 
files that belong to a user when you delete her account:

  Save the home folder in a disk image. The contents of the user’s Home 
folder will be compressed as a disk image format (.dmg) and saved into a 

“Deleted Users” folder located in the Users folder. This is a nice safety net 
in case you need to access that user’s files later—just double-click the .dmg 
file, it opens to a hard disk icon (as shown on the opposite page), and all 
the files are restored in that hard disk icon.

Don’t change the home folder. This stores the entire Home folder and 
all its contents in a folder called “username (Deleted).” All of the folders 
except Public are locked. However, you, as Admin, can open a folder’s Info 
window and change the permissions to give you access to it, as shown on 
page 343.

  Delete the home folder. Choose this if you’re certain you don’t need 
anything the deleted user may have in her Home folder. The user account  
and all of the files in the user’s Home folder will immediately disappear. 

To delete a user: 
1 From the Apple menu, choose “System Preferences…,” then click the  

“Users & Groups” icon.

2 Single-click the lock icon in the bottom-left corner. Enter the Admin name  
and password. Click ok.

3 Click once on the name of the user you want to delete. If the user name  
is gray and you can’t select it, that means that user is logged in. She must  
log out before you can delete the account.  

4 After you select the user, click the “minus” button at the bottom of the user  
account pane.

5 A sheet drops down, shown at the top of the next page, asking what you want 
to do with the files belonging to this user. Make your choice based on the 
information above.
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To access the saved user files later, double-click the .dmg file. It will open to a hard 
disk icon (shown above-right). open the hard disk icon (double-click it) and you’ll 
find all the files. 

If you choose “Don’t change the home folder,”  
the deleted user looks like this: chariclea (Deleted), 
as you can see above. The user’s files are all in this 
folder, but they’re all locked. Use the Info pane, as 
described on page 343, to unlock the folders.
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GoALS

Understand the different 
ways to access Spotlight 

and search your Mac

Choose or change the 
categories for searching

Prevent selected folders 
from being searched 

Expand the search   
with metadata

Add searchable   
keywords to files

Create Smart Folders

Take advantage of Spotlight 
in other applications
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LESSON 19

Find What You Want, 
Fast—with spotlight

Spotlight is not just a search feature—it’s a way of working with 

your Mac. once you get accustomed to its speed, versatility, and 

usefulness, you’ll find yourself using Spotlight regularly to find and 

open files instead of opening and closing folders and windows. 

Spotlight searches for more than just file names. It can search 

for keywords and comments you type into a file’s Get Info 

window, and it can search the content of documents, such as pdf 

documents, TextEdit documents, email messages, and iCal Events 

and Reminders. 

If you find you perform a certain search often, save it as a Smart 

Folder. Files that match the search criteria are automatically listed 

in the Smart Folder, and the folder updates itself every time a 

matching file is created or changed. 
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the Many faces of Spotlight
Spotlight has multiple ways of working. You’ll find yourself using different options at 
different times. Experiment with each one so you’ll know which is the most appro-
priate for what you need to do. Details for each option are on the following pages. 

Spotlight menu
To open Spotlight, click the Spotlight icon in the upper-right of the menu bar,  
or use the keyboard shortcut, Command Spacebar. 

Type your query into the field that appears and Spotlight instantly starts presenting 
results. As you type more letters, the search narrows and updates. 

Move your pointer over an item in the Spotlight list to see a Quick Look preview of 
the found item. Click the item to open it.

Access to the Spotlight menu is available no matter which application you’re using—
you don’t have to go to the Finder to run a search. See pages 360–361 for details.
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Spotlight windows
To show the Spotlight search results in a Finder window with more information: 

Click the option to “Show All in Finder” at the top of the Spotlight menu  
after you’ve made a search, as shown on the previous page. 

From the Finder menu, 
choose “Preferences…”  
and use the “Advanced” tab. 

Although it claims to 
search “This Mac,” 
Spotlight really only 
searches the active user 
(see Lesson 18 about 
multiple users).

Or use a keyboard shortcut to open a Spotlight search in a Finder window: 

If you’re in the Finder, press Command F.
If you’re in an application, press Command option Spacebar. 

When you type into the Search field in a Finder window, Spotlight instantly kicks 
in and shows you simple results directly in that window. It automatically searches 
in the area defined by the Finder preferences, as shown below-right. See pages 
362–364 for details about searching and narrowing your search.
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Spotlight-powered search in many applications
Spotlight-enabled searches are in many other applications, as shown in the examples 
below. Some applications also let you create other forms of Smart Folders (explained 
on pages 365–366).

Mail (below) and its Smart Mailboxes (page 97).

Address Book (page 368) and its Smart Groups (page 117).

Text in any application (below).

System Preferences (page 367). 

Open and Save As dialog boxes (page 369). 

TextEdit: Press Command F to make the search field appear.  
Click the magnifying glass to open the menu of options.

Number of results 
found. Click the x to 
clear all search results.

Cycle forward 
or back through 
search results.

Set search parameters, 
or select “Insert Pattern” 
to search for unknown 
email addresses, phone 
numbers, web addresses, 
and more.

Mail: The search displays results that contain either the search term (shown here); 
messages that have the search term in the Subject field; messages that have an 
attachment whose name contains the search term; etc.

Search field.
Search results.
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but before you begin
There are several things you might want to know before you start using Spotlight. 
In the Spotlight preferences, you can choose which categories of items you want 
Spotlight to search through. You can also choose certain disks and folders that 
you (or anyone using your machine) cannot search through, giving you some extra 
privacy. And on the following pages are some tips to help you make your searches 
more productive.

Choose the categories for searching
1 From the Apple menu, choose “System Preferences….”

2 Single-click the “Spotlight” icon.

3 Click the “Search Results” tab (below) if it isn’t already highlighted.

4 Uncheck boxes for categories you don’t want Spotlight to search. 

5 Drag the category items up or down to change the order in which results 
appear in Spotlight.
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Create some privacy
1 If you haven’t already, open the Spotlight preferences, as explained  

on the previous page.

2 Click the “Privacy” tab.

3 Click the + sign to open a dialog box where you can choose any folder  
or disk on your Mac that you don’t want Spotlight to search. 

 Or drag any folder or disk icon from the Finder and drop it into this pane.

 Note: This isn’t a very safe privacy feature because anyone using your 
computer can just open the preferences and remove these items  
(if they know how to do it). If you want more privacy, make a separate  
user because a Spotlight search only searches the files for the active user  
(see Lesson 18).

Keyboard shortcuts to open Spotlight
Notice in the illustration above (at the bottom of the window) that the Spotlight 
preferences also include options to change the existing keyboard shortcuts to open 
Spotlight, or to turn them off altogether by unchecking the boxes. Some applications 
might use those same shortcuts; Spotlight overrides the applications’ shortcuts, so 
if it creates a problem for you, go to the preferences above and change them or turn 
them off.

You can change these 
keyboard shortcuts if 
they interfere with your 
favorite applications.



ptg6934589

Lesson 19 Find What You Want, Fast—with Spotlight 

357

Don’t search just file names
Spotlight doesn’t just search file names. It searches the senders’ names and the 
contents of email messages; it can look through the contact information in your 
Address Book; it finds images and graphics, calendar Events and Reminders, System 
Preferences, pdf text, the contents of TextEdit pages (but not the contents of text 
clippings), even iChat conversations (if you previously chose to save them). 

Expand your repertoire of searchable items
You’re not limited to searching just for words that might be found in a file. In 
the Finder Spotlight search, you can use selected parameters to find particular 
categories of files. For instance, you can look for “music” to find all your music files, 
or choose “Image” in the pop-up menu, then add another search options bar (click 
the + button) and limit the search to “Created date within last 1 weeks” (as shown in 
the example below). 

Click the Add (+) button (circled above) to add more parameter 
bars with pop-up menus of additional search options.

Type a word or phrase here.
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Click a plus sign 
to add another 
parameter; 
click a minus 
sign to delete 
that one.

Expand the search with metadata
Spotlight also looks in the metadata that every file contains. Metadata includes 
information about who created the file, when it was created and modified, the 
copyright date, the file type, the color space for a photo or image, even what kind 
of camera a particular photo was taken with. Different kinds of files have different 
kinds of metadata associated with them. 

To make metadata attributes appear in the parameter pop-up menus: 
1 Press Command F to open a search window.

2 Click the first pop-up menu (it probably says “Kind”), and choose “other….” 

3 In the sheet that opens (as shown far below), find an attribute you want included 
in the lengthy list that appears; checkmark its box. Click ok. 
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When a file has a forgettable name, 
as above, additional information or 
keywords in Spotlight Comments 
make it easy to find the file later.

Add keywords to a file’s Spotlight 
Comments so you can search for 
it later.

If this 
field isn’t 
showing, 

single-click 
the tiny 

disclosure 
triangle.

Add keywords to files
There are some files that, even with all the options in Spotlight, still won’t be found 
because there is nothing associated with them that Spotlight can decipher. For files 
that you want to make sure you can find later, add your own keywords. For instance, 
the example below is a music file of an Elizabethan song written in the 16th century. 
I can search for “Come Away, Hecate” (if I remember the song title), but if I search 
for “elizabethan,” this piece of music won’t be found. So I added a number of 
keywords that I might use in a search to the Get Info window for this file and also 
for other Elizabethan music I have on my Mac. Now Spotlight can find them.

To add a keyword to a file: 
1 Single-click a file to select it. 

2 Press Command I to open the Get Info window. 

3 Type your keywords into the “Spotlight Comments” area.

If you have more than one file to which you want to add keywords, select one 
file, then press Command Option I (instead of just Command I). Now as you select 
other files, this Get Info window automatically displays the information for the file 
you select. 
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Spotlight Menu
The Spotlight menu is available no matter which application you’re using at the 
moment (although this is not the tool to use to search within your application, such 
as searching the text on a visible web page or in your word processor). 

To open the Spotlight menu:
1 Simply click the Spotlight icon in the upper-right of the menu bar,  

or press Command Spacebar to open it.

2 A text field appears. Start typing in it. 

  Results appear instantly in the Spotlight menu, as shown below. The more 
letters you type, the narrower the search becomes. 

Notice that Spotlight 
will also send your search 
phrase to the Dictionary, 
the web, and to Wikipedia, 
if you like. 
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To use the Spotlight menu:
Below are callouts of the various features of the Spotlight menu. Use the Spotlight 
menu for a quick search for something you think can be found easily. 

Single-click the X to delete 
everything in the search field. 

Single-click “Show All in Finder” 
to display the Spotlight window, 
as shown on the following page.

These are the categories 
that Spotlight is searching.   

See page 355 for a list of the 
categories possible.

This option 
opens the same 
preferences shown 
on pages 355–356.

Note that 
Spotlight will 
forward your 
search to the 
web and to 
Wikipedia.

Hover your pointer 
over an item to reveal a 
Quick Look preview of 

the item. Single-click 
the item to open it.
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Spotlight in the finder
There are two ways to open Spotlight in the Finder, both of which use your Finder 
window. You can do a quick search by simply typing in the search field that appears 
in the upper-right corner of every Finder window, as described below. For a more
specific search, press Command F to go straight to an empty window with an extra 
Search Parameter bar already available (as shown on the opposite page). 

Quick search in a Finder window
Below are the results of a quick search for “john.” As soon as you start typing, results 
appear in the window, and a pop-up menu shows where results are being found.  

In the Search Bar, choose a location for Spotlight to search—“This Mac,” or a selected 
folder in the Sidebar, or any “Shared” drives that are connected to your computer.

Click the + button on the right side of the Search Bar (next to the Save button, shown 
on the next page) to add Search Parameter bars for narrowing your search.

To see where a file is located, single-click it; the path to that selected file appears in 
the Path Bar at the bottom of the window (shown on the next page). If the Path Bar 
is not showing, go to the View menu and choose “Show Path Bar.”

To open the enclosing folder that holds the selected file, press Command R.

To open a file, double-click it. 

To quickly view the file, press the Spacebar to open the selected file in Quick Look.

Once you click the blue 
bar shown to the left, 
this blue tab appears; 
you can switch from 
searching filenames to 
searching everything
(content, keywords  
in Get Info, etc.) 

 If I choose this option, it will narrow the results.

The Path Bar (empty at the moment;  
see the opposite page).

Search Bar.
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Sort Spotlight’s search results
Sort search results by different criteria. Click the 
Arrange by button in the Toolbar, and choose one 
of the sort items (Name, Kind, Application, Date 
Modified, Date Created, etc.).  

Narrow the search in a Finder window
If you’ve already started a search (as on the opposite page), click the + button (next 
to the “Save” button in the Search Bar) to reveal an additional Search Parameter bar. 

If you have not yet started a search, press Command F; the active window switches 
to a blank search results window. If no window is open or active, a new one opens 
automatically.  

The only difference between the window below and the one on the opposite page is 
that this Find window automatically provides a parameter bar for you to work with. 
You can add as many parameters as you need. 

To add more parameters to narrow your search, click the plus sign. 
To delete a Search Parameter, click its minus sign. 
To change the parameters, click a parameter menu to choose a different 
option. The choice in any menu affects the options available in the next menu to 
the right, which might then create a new field in which to enter a new parameter. 

Use these pop-up menus to narrow your search in specific ways.

Arrange by options.

Click the blue tab 
to change search 
results from 
filename matches 
back to any 
match found.

The Path Bar shows the path to the selected file.
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Use a Boolean search
A Boolean search simply means that you limit the search by using the words and, or, 
or not. As you can see below, a search for “mabel” showed me three files. But a search 
for “mabel AND love” found exactly the one I was looking for—only that one. 

The Boolean operator (the and, or, or not word) must be typed in all caps. 

You can also use quotation marks, just as you probably do when searching the 
web. For instance, if you search for knitting wool without quotes, you’ll get every 
document that has the word knitting in it and every document that has the word 
wool in it. But if you search for “knitting wool” in quotation marks, you will only find 
pages with that exact phrase. 

As you type a search term, a pop-up menu shows possible matches in 
different categories. This search found only “filename” matches. 

A search for “mabel AND love” easily narrows results to the only match.
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Smart folders and Spotlight
once you create a great search in the Finder via Spotlight, you might like to make a 
Smart Folder that automatically keeps track of every file that fits that search. This 
folder doesn’t store the original files—the originals stay in their original folders, and 
the Smart Folder just keeps a list of everything so it’s easily accessible to you. 

For instance, you might want a Smart Folder that contains all the various presenta-
tions you’ve made so you don’t have to go looking through various project folders to 
find a particular one. If so, make a Smart Folder that just stores presentation files. 

Your Smart Folder keeps track of all presentation files in one place for you, even 
though the files themselves are scattered in different locations. The Smart Folder 
updates automatically as presentation files are created, changed, or thrown away. 

To create a Smart Folder:
1 In the Finder, press Command F to open Spotlight in a Finder window.

2 Define your parameters. Below is a search of all files that are presentations. 
There is nothing typed into the search field at the top of the window because 
I want to find all presentations regardless of their names.

—continued

You can also create a Smart Folder by going to the File menu and choosing 
“New Smart Folder.” The window that opens looks exactly like the one above.  
Set the Search Parameters. 
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3 Click the “Save” button below the search field (shown on the previous page). 
You will be asked to name this Smart Folder. 

 The default location for a Smart Folder is in a “Saved Searches” folder in the 
invisible Library folder, which is in your Home folder, but you can’t see it. 
That’s okay because you are not allowed to put anything in this folder yourself.

 However, you do want this folder to be accessible from the Sidebar so you can 
open files from it, so make sure there’s a check in the box “Add To Sidebar” in 
the Save dialog window (below). Then click the “Save” button.

4 Now that the Smart Folder is saved, all you need to do is single-click it in the 
Sidebar (below), and your Mac will display all the files that match the criteria  
you originally set.  
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This menu 
appears as 
you type a 
search term.

Spotlight Search in System Preferences 
As explained in Lesson 15, Spotlight also works in System Preferences. This is great 
when you know you need a System Preference to do something in particular, but 
you’re not sure which one you need. 

To search in System Preferences, simply type into the search field. As you type, 
Spotlight highlights all the possible preferences that might help you. 

When you click one of the options in the pop-up menu that appears, Spotlight 
highlights the best preference for that option in a bright white spotlight, then opens 
it for you automatically.

Spotlight Search in time Machine
If you use Time Machine to automatically back up your files, you can use Spotlight 
searches within Time Machine and find files that may not still be on your computer. 
See Lesson 20 for more about Time Machine.
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These results show messages that 
contain the word “Shakespeare.” 

Search Bar.

This menu shows results by 
category, such as messages with 

“Shakespeare” in the Subject field.      

Spotlight Search in Mail
In Mail, type a search word or phrase in the search field when you can’t find a 
particular message in a large collection of emails. Choose a folder in the Sidebar to 
search, then choose one of the parameters in the Search Bar (just below the Toolbar). 

Spotlight Search in address book
Control-click a contact name in Address Book, then choose “Spotlight: “contactname.” 
A search results window opens to show files and folders on your Mac that match the 
selected contact name. 

Control-click 
(or right-click) 
a contact name 
to reveal this 
contextual menu.

The Spotlight search 
results window.
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Spotlight Search in an “Open” dialog
When you’re working in your favorite application and want to open a file to work 
on, Spotlight can locate all the files with your search phrase in the name that 
your application thinks it can open and display, plus all folders (it will also search 
contents of files). From the File menu, choose “open….” In the open dialog, as 
shown below, you can search for a file name or for any content. 

In this example 
I narrowed the 
search to jpeg
files with the 
word “pumpkin” 
in the file name.

Spotlight Search in a “Save” dialog
When do a search in a “Save” dialog, Spotlight can find folders to save into.  
Double-click the folder into which you want to save, then click “Save.”

Start typing a search 
term and results 
appear immediately.
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LESSON 20

Time Machine Backup

We know we should back up important files every day, but really, 

“I just don’t have time today!” Surely everything will be okay for a 

couple of days until we have time to make backups. Months later, 

we finally have some extra time and the files are nowhere to be 

found. or the original version has been overwritten by a newer 

version with unwanted changes in it. oh, if only we had a time 

machine that could go back in time and grab earlier versions of 

files. And wouldn’t it be nice if the time machine did this without 

us doing anything—except maybe turning it on?

Wait . . . there is such a thing! And, amazingly, it’s called . . .  

Time Machine! 

Time Machine can even make backups automatically for you 

without having a dedicated disk assigned. 
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about time Machine
After you set up Time Machine, it backs up your computer regularly. Initially, Time 
Machine backs up everything, including system files, applications, etc. After that, 
it only backs up files that have changed. Hourly backups are stored for 24 hours; 
daily backups are stored for a month; weekly backups are stored until the disk is full. 
Because backups are stored by date, you can restore files or folders (or your entire 
system) exactly as they were at certain points in the past. 

When the backup disk fills up, Time Machine deletes the oldest files to make room 
for new ones. It could take a long time to reach this point, but be prepared to either 
replace the Time Machine disk with another one, or to let Time Machine delete 
older files as necessary. 

While Time Machine is a good solution for temporary storage of backups and is a 
great way to restore files that have been thrown away, lost, or changed, it isn’t a final 
solution for creating permanent archives. If you plan to use the same backup disk 
and let Time Machine delete the oldest files, be sure to use other methods to create 
permanent archives of important files (burn files to cds or dvds, copy items to your 
MobileMe iDisk, or copy items to other external drives). Remember, it’s safest to 
create multiple copies of items that you absolutely cannot afford to lose, and store 
those copies in several different places—if your office burns down or floods or is 
burgled, it won’t matter if you had twelve backups in that office—they’re all gone. 
Keep in mind that documents printed on paper will last hundreds of years longer 
than anything you store on any media today.  

What kind of disk to use as backup
Use a disk for Time Machine that is separate from the hard disk you work on. An 
extra internal hard disk is great, and external hard disks work fine too. The disk 
needs to be big enough to backup the drive it’s assigned to. For best results, use a 
disk dedicated only to Time Machine backups.   

Both FireWire and usb disks work with Time Machine. Time Machine backup disks 
must be formatted as Mac oS Extended (journaled), and have Access Control Lists 
(acls) enabled. Time Machine will erase and reformat the disk if necessary.
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See the next page.

Select this option to place 
a Time Machine icon in the 
menu bar that appears at 
the top of your screen.
Click the icon in the menu 
bar to access some helpful 
commands, such as “Back 
Up Now” and “Open Time 
Machine Preferences….”

create a time Machine backup
It’s very easy to start the process. Make sure you have an appropriate disk connected.

To set up Time Machine backups:
1 once you have an extra internal hard disk installed or you’ve connected 

an external hard disk, open Time Machine: Go to the Apple menu, choose 
“System Preferences…,” then click the “Time Machine” icon.

2 Click the “Select Disk…” button. You’ll get a list of possible drives that can be 
used; choose one and click “Use for Backup.” 

3 once a backup disk has been assigned, Time Machine automatically switches 
itself on and displays information about that disk, including when the first 
backup will start.  

4 Click the options button to display a sheet (shown on the next page) in which 
you can designate items you want to exclude from Time Machine backups.

—continued
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To stop a backup, 
click the x.
Or slide the on
button to off.

Receive a warning 
that Time Machine 
has started deleting 
the oldest backups to 
make room for more.

5 To add items to the “Exclude these items from backups” list, click the plus (+) 
button, circled below.

  Another sheet slides down from the title bar, covering up the one shown below. 
Select the items (drives, volumes, files, or folders) that you do not want Time 
Machine to back up. Click the “Exclude” button. This returns you to the first 
sheet, shown below. 

  To remove items from this list so that Time Machine will back them up, select 
them and click the minus (–) button on the sheet shown below.

6 Click “Save.” 

 Time Machine makes an initial backup that includes everything on your 
computer (shown in progress, below). This backup can be time consuming, 
depending on how many folders, files, and applications are on your Mac. 
Subsequent backups are faster since only changed files are backed up.
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Time Machine navigation tools.

Local Snapshots
If you don’t have an external hard disk designated for Time Machine backups, but 
would like to start making backups right away, turn on Time Machine and designate 
your internal hard disk as the backup volume. This is a temporary measure.

1 From the Apple menu, select “System Preferences…,” then click the Time 
Machine icon.

2 Click the “Select Disk…” button.

3 In the list that appears, select your hard disk, then click “Use Backup Disk.” 

4 An alert dialog opens to advise you that it’s best to use a volume on a  
different device (that is, it’s best to use a dedicated, external hard disk).  
You can set that up later, so for now click “Use Selected Volume.”  

5 Time Machine turns on and starts a backup. 

Time Machine saves hourly, “local” snapshots of files that have changed and stores 
them on your internal (local) drive. When space gets limited on your internal disk, 
older snapshots are condensed into daily or weekly snapshots. If disk space falls 
below a certain level, Time Machine stops creating snapshots until space becomes 
available again. In other words, Time Machine local snapshots are a temporary
backup solution, not a long-term solution. Later, when you connect (or reconnect) an 
external backup disk, Time Machine copies the local snapshots to the backup disk.

To recover backed up files: Click the Time Machine icon in the Dock or in 
Launchpad. Time Machine takes over the screen, as shown below. Use the forward 
and back arrows or the vertical timeline to go back in time to recover an earlier 
version of a file. The following pages explain how to do that, and more. 
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how to Use time Machine
once you’ve got Time Machine all set up, as explained on the previous pages, you’re 
ready to use it to find earlier versions of files that have changed (see below) or to 
find files that are now missing from your Mac.

To find and restore a file:
1 on your Desktop, select a file or folder. 

2 Single-click the Time Machine icon in the Dock or in Launchpad. Time 
Machine takes over the screen. It shows the current Finder window in the 
foreground, with earlier versions of that same window receding into the past. 
The file you selected is still selected.

  Notice that the middle of the horizontal bar at the bottom of the star field is 
labeled “Today (Now).” In other words, the files shown or accessed through 
this particular window are the same as what is on your computer right now.   

3 To go back in time and find previous versions of the selected file, click the 
back-in-time arrow (circled, below). Time Machine zooms back in time 
through the floating windows until it reaches a window where an earlier 
version of the selected file exists. 

Click “Cancel” to exit Time Machine, 
or press Escape on your keyboard.

Navigate back in time to older 
backups, and forward again.
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  Notice that the bar at the bottom of the window now identifies the time that 
this version of the file was last saved. 

  If this isn’t the version of the file you’re looking for, click the back-in-time 
arrow again to find earlier versions. Or drag your pointer over the vertical 
timeline on the right edge of the screen and select a backup time or date. 

4 To restore the version of the file you want, first make sure it’s selected.  
Then click the “Restore” button on the right side of the horizontal bar at the 
bottom of the screen. To go directly to a specific backup 

date and time, click in this timeline.

Restore the selected version.The backup date and time of the visible files.
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do a Search in time Machine
When you use Spotlight to search for items on your computer, the search naturally 
takes place in the “Now” time frame; in other words, it finds files in their current 
versions. But if you’ve lost or deleted files, Time Machine can zoom into the past 
and find the files in the various states in which it saved them. 

Search in Time Machine:
1 Single-click the Time Machine icon in the Dock or in Launchpad.

 The Time Machine screen appears, with Finder windows receding into the 
past. Type your search string into the Search field on the foremost Finder 
window, just as you would on your regular Desktop. 

2 Click the back-in-time arrow. Time Machine zooms back in time until it finds 
the item and displays its name. To look for an even earlier version of the item, 
click the back-in-time arrow again, or click in the timeline along the right edge 
of the screen. Notice that the time label in the horizontal bar at the bottom of 
the screen shows when the selected item was backed up.

3 When you find the item you want, click “Restore” on the right side of the bar  
at the bottom of the Time Machine screen (circled below).

To show a Quick Look preview of a selected item, tap the Spacebar.  
To close Quick Look, tap the Spacebar again.
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Tech Stuff
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GoALS

Troubleshoot your   
network settings

Create a new connection 

Use the Network 
Diagnostics tool

Connect two   
or more Macs

Share files on a network

Send files to anyone 
through Bonjour or iChat 

Share the screen of 
another computer on the 

network or in the world
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LESSON 21

Get Connected  
and share Files

on a Mac, you have various ways to connect to the Internet. You 

might have a dial-up account that goes through your phone line, 

a cable modem, a dsl modem, a wireless connection, an Ethernet 

office connection that plugs into a broadband setup, or some other 

arrangement.

And you have various ways to connect your Macs together in a 

home or office. once your computers are on a local network, you 

can transfer files between them and even access your own Mac 

from another computer.

The feature that most amazes us is screen sharing, where you can 

connect to someone else’s computer and actually see her screen 

and use her computer! It has been invaluable in allowing us to help 

friends and families on their computers across the country.
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how your Mac connects to the internet
When you first turned on or upgraded your Mac and walked through the setup 
process, you probably filled in the information for your Internet connection. The 
Network preferences is where your Mac stored that information and where you can 
change it, adjust it, or troubleshoot it. 

The Network preferences lists all of the ways that your Mac might be connected and 
displays the current status of each option. You can configure all interfaces for all 
your possible connections from this one window. 

To open the Network preferences, go to the Apple menu and choose “System 
Preferences….” Single-click the “Network” icon. 

When you first open the window, it probably looks something like the one below, 
showing you the status of any possible connections your Mac might have access to. 

The available 
“network port 

configurations” 
for your Mac are 

shown here.
This pane shows 

how you are 
connected to 

the Internet 
and to the other 

computers in 
your office. 

Open the Actions menu to change the 
order in which your Mac looks for an 
open connection; see the opposite page.
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Check the port configurations
You might have several options for connecting. For instance, your Mac might 
recognize a modem port, if you have one (whether or not you use it), and it might 
find a wireless card and an Ethernet port. Every possibility it finds is listed in the 
Network preferences, in that pane on the left side. 

As you see on the opposite page, you can open the Actions menu (shown circled) 
and choose to “Set Service order….” This is the first place we go if there is a 
connection problem because the Mac goes down this list in order and chooses 
the first interface that works. If you’re having problems making a connection,
make sure your preferred connection is at the top of the list—just drag it to the top. 
Click ok, then click the “Apply” button to force the change.

Establish a new connection
If you didn’t set up your Internet connection when you first installed Lion or turned 
on your brand-new Mac, you can always do it in this Network preferences pane. Just 
click “Assist me…” (circled above). A sheet drops down from the title bar (as shown 
on page 385). In that sheet, click the button labeled “Assistant….” It will walk you 
through the process. 

Drag these 
services into 
your preferred 
order. 



ptg6934589

Lesson 21 Get Connected and Share Files

384

troubleshoot your internet connection
If your connection doesn’t work when you first turn on your Mac, perhaps the infor-
mation you entered in the setup process wasn’t correct. or if you changed Internet 
Service Providers (isps) or changed your connection process, you might need to 
change the information. Most of the information is supplied automatically, but if 
your provider says you need to change a setting, this is where you’ll do it. There is 
also a little trick you can do here that sometimes kicks things into gear.

1 From the Apple menu, choose “System Preferences…,” then click  
the “Network” icon.

2 In the left-hand pane, you can instantly tell whether or not your Mac thinks 
your connection is working. (Sometimes the Mac swears it’s working, but it 
isn’t and you know it.) Choose the connection that you need to fix or change. 

3 First, use the technique on the previous two pages to make sure the connection 
you want to choose is the first one in the list. Click “Apply.” Wait a minute or 
two and see if your browser will connect to the Internet. If not . . .

4 This trick often works if all the settings are correct and there’s no major 
problem with your modem or router (if you have one): Change any setting; for 
instance, if you see “Using dhcp,” change it to “Manually.” Then immediately 
switch it back. This makes the “Apply” button available. Click the Apply button. 
Sometimes all it needs is a kick in the pants to make it take effect. 

Click the “Revert” 
button to restore 
settings to how 
they were before 
you started making 
changes. 

See the note on the 
opposite page to create 
a Location. Choose it, 
then click “Apply.”
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5 If you think the settings need to change, do so here; you need to click the 
“Advanced…” button to get to the rest of the settings. If you’re not sure what 
the appropriate settings are, you have two choices:

n	 Call your isp (Internet Service Provider) and ask them what to enter in 
which panes. Your isp is the company to whom you pay the monthly fee 
for your connection to the Internet. Although these windows look scary, 
there are only two or three settings you need. If you use cable or dsl  
with “dhcp,” it probably sets it up for you automatically. Click “Apply.”

	 To check, open Safari and see if it goes to a web page. If it does, you’re done.

n	 Or use the Network Diagnostics tool, as described in the following steps.  

6 Click the “Assist me…” button at the bottom of the Network pane. This drops 
down a sheet from the title bar, as shown below. For troubleshooting help,  
click the “Diagnostics…” button.  

7 The diagnostics tool will check all the relevant settings on your Mac and ask 
you simple questions. If it can’t fix the problem, it will at least pinpoint it so 
you can call your isp with the specific issue.

If you take your laptop to 
various places where the 
connections are different, 
use the Assistant to set 
up the specific settings 
for the various Locations. 
It saves the settings for 
you—choose that Location
from the Location menu in 
this pane and your laptop 
is ready to connect in that 
particular place. 
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Use the AirPort Utility
If your connection is through an AirPort wireless setup, use the AirPort Utility to 
see if it knows what’s wrong. You’ll find this tool in the Utilities folder, which is 
inside the Applications folder. Don’t randomly change settings—either let it make 
the appropriate changes, or ask someone knowledgeable. There is an option to 
restore the original factory settings and set it up again from scratch. 

Unplug everything and reboot
Your modem box, whether it’s a dial-up, cable, or dsl, usually has a tiny reset 
button. It’s often so tiny you need to poke it with a pin or paper clip. That can 
sometimes get things going again.

If not, do the unplug routine (we have to assume you’ve got all the wires in the right 
places). First, shut down your Mac. Then, if you have a number of devices in your 
system, such as a switch, a router, and a modem box, unplug the items starting with 
the smallest one, the dumbest one. That would be the switch, if you have one. Next, 
the router (which might be your AirPort Base Station). Last, unplug the modem 
itself. Let everything sit for several minutes.

Then plug everything back in again in the opposite order—start with the most 
important item first, the modem box. Let it get going and make sure all the lights 
are green. If the problem is in your modem box, call your provider.

Then plug in the router, if you’re using one, and let it get going. Then the switch.  
Let everything get running, then turn your Mac back on. 

Sometimes we go through all this and give up. Shortly thereafter it starts working 
again. Sheesh. 

Call a friend, check your cables, talk to your Isp
Call a friend in your neighborhood who uses the same isp and see if she is connected. 
If her connection is down as well, then just let go and wait until they fix it. 

Check your cables—one might have wiggled loose or gone bad. They do that 
sometimes. If you’re setting up your Internet connection for the first time and  
using Ethernet cables, make sure they’re the right kind; see page 390. 

If everything seems okay on your end and you still can’t get connected to the 
Internet, call your isp. They can check your modem from their office and help 
pinpoint the cause.  
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troubleshoot your Mail account
The problems that can happen with connectivity are different for a new account 
setup than for a working account.

Setting up a new account
If you have problems getting your email to start working for the first time, first 
make sure your Internet connection is working, of course (check by making sure 
your browser can get to the Internet). Then check your account information in Mail 
(go to the Mail menu, choose “Preferences,” and click the “Accounts” tab): 

n	 The Incoming Mail Server is information that you have to get from whoever 
hosts that particular email account. I have more than a dozen email accounts, 
not one of which is with my isp. So I need to get the Incoming Mail Server of 
each of the hosts where I have the email coming from. Typically it’s something 
like mail.domain.com or pop.domain.com. And as I mentioned in the Mail 
lesson, some providers don’t allow you to get your email through a mail appli-
cation like this; see page 79.

n	 Keep in mind that some isps have a different User Name and Password  
for your account with them than the user name and password to get your 
email. This is especially true if you’ve had the account for a long time. If your 
email account is not with your isp, then of course the account information  
in your Mail window is definitely not the same as for your isp. You might  
have to check their web site or call your email host and ask what to enter here. 

The Description is 
anything that will tell you 
which account this is. 
The Email Address and 
Full Name describe your 
mail to those you send it 
to so they know who it’s 
coming from. 

—continued
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n	 The Outgoing Mail Server (SMTP, Simple Mail Transfer Protocol) is usually 
from your isp, no matter where your email account is located. You can use 
a me.com smtp (if you have a MobileMe account) or a Gmail or other smtp, 
but if your outgoing mail is having trouble, you are assured of being able to 
send mail out if you use your isp’s smtp. If you don’t know what the smtp is, 
call and ask them or check their web site—it should be listed. For all nineteen 
of my email accounts from a variety of servers, I use the same Comcast smtp 
because that’s who connects me to the Internet.

	 To change your SMTP setting, click on the “outgoing Mail Server (smtp)” 
pop-up menu and select “Edit smtp Server List….” Click the + button to add 
an smtp server. Double-click the blue bar that appears to add the smtp name. 
Make sure that is the selected server (highlighted in blue), then click ok.

	 Some companies will not give you an smtp address unless you pay an extra 
fee. If you don’t want to pay the extra fee, you cannot use the Mail appli-
cation—you must go to the company’s web site and do all mail online. 

Reminder: where to get the information: Your email provider’s web site should 
include the information for the incoming mail server (also known as the pop 
address, Post office Protocol), user name, and password. Your isp’s web site should 
provide the smtp (outgoing mail server) address information. 

If you have a free webmail account like Google, Yahoo, or Hotmail, and it didn’t get 
set up automatically when you went through the set-up process, go to the service’s 
web site and search for pop mail instructions. or go to Google and search for 
something like “Google pop settings Mac,” or “Yahoo smtp settings Mac,” etc. 

Working account (that’s not working)
If you’ve been using Mail for a while and it stops working, try this:

n	 If an email message won’t go out and you positively know the address is 
correct, retype the address. Retype the whole thing, even if the automatic 
address appears. Retype the whole thing, and hit Return. Try sending again. 

	 Keep in mind that when sending to a list of people, if any one address is 
wrong, it can stop the whole process. So check carefully.

n	 Maybe your mailbox on the server is full. If you have a pop email account set 
up, you can tell Mail to “Remove copy from server after retrieving a message” 
(go to the Mail menu, choose “Preferences…,” click the “Accounts” tab, then 
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click the “Advanced” tab). This prevents your pop server from running out of 
storage room over time; however, sometimes Mail doesn’t remove messages 
from the server even if you’ve told it to, so check the account info: 

1 In Mail’s sidebar, select the pop Inbox that’s having trouble. 

2 Press Command I to open the “Account Info” window (as shown below). 

3 Click the “Messages on Server” tab to show the email messages that are 
on the pop mail server. Select all (or some) of the messages shown in 
the window, then click the “Remove from Server” button.

4 Close the Info window. Restart Mail and try again.

In this case,  
I had the wrong 
information in the 
Accounts pane. 

Someone might have 
sent you a two gigabyte 
attachment that needs to 
be deleted from the server.

Use the Mail Connection Doctor
If your account information is correct but email still isn’t working, check this 
utility: In Mail, go to the Window menu and choose “Connection Doctor.” You’ll 
get the window shown below; it will automatically check your accounts. If it finds 
a problem, the dot is red; depending on the problem, you may be able to click the 

“Assistant…” button (page 385) to help pinpoint the issue further.
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Share files on a Local Network
File sharing on a local network is so great—as Apple says, your Mac just “discovers” 
other Macs. But it can’t discover them unless the computers are connected in some 
way. So first, a wee bit about networking.

Simple networking
The Macs you want to share files between must be networked together—which 
means you must have some sort of cable connecting them to each other or both 
to the same printer, or AirPort cards installed so they can connect to each other 
wirelessly. Networking can get very complex and specialized! We’re only going to 
explain the simplest method to get a couple of Macs  talking to each other.  

Wireless
If you have working wireless connections on your Macs in your home or office or 
coffee shop, you’re all set. Skip to page 392, “Turn on Personal File Sharing.”

Ethernet cables
If you’re not wireless, you’ll need Ethernet cables, available at office supply stores.

n	 If the cables are going from the computer into a hub, router, or switcher,  
or into a cable or dsl modem, you need straight-through cables— 
not crossover cables. Straight-through cables are more common.

n	 If the cables go directly between two computers (or between any two Ethernet 
devices, like a Mac and a printer), you need crossover cables (see below).

To tell if an Ethernet cable is crossover or not, hold both ends up, facing the same 
direction, with the locking clips facing up. Look at the  colored wires. 

n	 A straight-through cable has the colored wires in exactly the same order. 
n	 A crossover cable does not  have the colored wires in the same order. 

Just two computers?
Two computers can be connected with one crossover Ethernet cable or a FireWire 
cable for easy and instant file sharing on two working Macs. 

If you have one Mac that is having trouble and you want to copy files off of it onto a 
reliable machine, use a FireWire cable and Target Disk Mode (see page 439). 
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What else you need
If you have a number of machines in your office (and it’s not wireless), you will 
need something called an Ethernet switch that can connect all of your machines, 
including your modem. The switch will have a number of Ethernet ports; you 
connect each Mac to that box  with straight (not crossover) Ethernet cables. (If you 
want to share printers, see pages 320–321; it’s easy once you have your network 
working.)

If you have several computers in your office, a broadband connection, and all your 
Macs get on the Internet at the same time, you’re probably using a router—you’re 
already set up for networking. An AirPort base station can function as a router.

If the router doesn’t have enough ports for the items in your office, buy the small 
hub or switch mentioned above and connect the router to it with an Ethernet cable.

Peer-to-peer network
This simple network in a small office is called a peer-to-peer network, where every 
computer is  considered a “server,” which is a computer that can “serve” files to 
others. This is  different from a client-server network in a large corporation, where 
lots of computers connect to one huge, main server and everyone gets files from that 
main server, rather than from each other’s computers. 

Sharing files on one computer
If you have created more than one user on a Mac, as explained in Lesson 18, all 
users can share files with each other yet still remain perfectly private. See page 342 
in particular. 
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Give each Mac a name 
that clearly identifies 
it. This is the name that 
other computers will see 
when connecting to you.

Turn on Personal File Sharing
Now that your computers are connected, you need to set up who is allowed to share 
and which files they can have access to. The default File Sharing settings might 
work perfectly fine for you, where any user on the network can log in with her own 
password, then see files in your Public folder and drop files into your Drop Box; any 
user with your user name and password can access all the files on your computer and 
drop files anywhere on your Mac. If the defaults sound fine, follow Steps 1–3, then 
skip to the next page. If you want to control who has access and to what, see below. 

To turn on File Sharing: 
1 on each Mac, go to the Apple menu and choose “System Preferences….”  

Click the “Sharing” icon. 

2 Your computer has a name, shown in the “Computer Name” field.  
Give it a new name that clearly identifies which Mac it is (Kitchen Mac, 
Teenagers’ iMac, Dad’s Laptop, Mom’s office Computer, etc.).

3 Put a checkmark in “File Sharing.”

4 In the bottom-right of the pane, you see that your Public folder is now shared, 
and to its right you see who is allowed in. 

5 This might be all you need, if the conditions mentioned above (in the first 
paragraph) apply to you. Skip to page 394.

Staff refers to non-admin 
users, and Everyone
really means “Everyone 
else” who is not listed 
here or is a Guest user.
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 Any user you’ve set up on a Mac can access their own Home folders (and your 
Public folder) from anywhere on the local network. They can also access the 
Shared folder and any folders for which you have provided permission.

6 If you want to be more specific about which folders others can share with 
you, add a folder to the “Shared Folders” pane, select its name, and then add 
or delete the users who are allowed to use it. Also determine what kind of 
privileges they can have.

Share files with Windows users
You can share files with Windows users: Click the “options…” button on the Sharing 
pane and check the box for smb (Server Message Block) users (Apple uses afp, 
Apple Filing Protocol). You will need to enter the Windows user’s password.

The Get Info window 
(above) for the shared 
folder displays the 
permissions you set up in 
the Sharing pane (left). 
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Your 
connection 

status is 
shown here. 

A Guest can drop 
files in the Drop 
Box. What else 
a Guest can do 
depends on the 
settings in the 
Sharing pane, 
shown on the 
previous page.

connect to another Mac
once the Macs are connected in some way and they all have File Sharing turned  
on in the Sharing preferences (as explained on the previous pages), you’re ready  
to connect.

Make sure you are in the Finder (single-click any blank space on the Desktop). Then 
follow either Process A or B. Process A is simpler, faster, and more dependable.

Process A, directly through the Finder window:
1 open any Finder window. Click the Column View icon (circled below). 

2 In the Sidebar, if your “shared” group is not visible, hover over the word 
“shared” to display the word “Show.” Click “Show” to display the other 
computers on the network. 

3 Single-click the name of the computer to which you want to connect. 

  You are automatically connected as a Guest. What you see in the window 
below is the Public folder of a shared computer on the local network. As a 
Guest, you can take a copy of any folder in the Public folder, and you can select 
the “Public Folder” and put files into the shared computer’s Drop Box.

  Now, all of this depends on what the administrator of the other computer has 
set up as privileges or permissions, but the features above are the defaults. 

To keep track of which computer you’re working on 
and which computer you are viewing in a window, use Column View 
(as above) so you can see where a folder originates.
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On your computer, this box shows 
up with your name in the “Name” 
field, deluding you into thinking 
it wants your name and password. 
Not! If you’re trying to connect 
to another computer, it wants the 
name and password of the Admin 
(or a user) on that computer!
Guess how long it took me to figure 
that out.

4 To access your own user account on this other computer, click the “Connect 
As…” button (circled on the opposite page). You need to know your name and 
password to log in as a “Registered User” (see below). Or (if the Admin user 

“set” your Apple id when setting up your account; see Lesson 18), you can log 
in “Using an Apple id” and that password. 

If you need to share files on a local network regularly, you can drag a 
folder from another computer and put it on your computer and even in your Sidebar. 
Then you can move and save files directly into that folder on the other computer. You 
don’t even have to go through the connection process—as soon as you put something 
in that folder, it acts as an alias and makes the connection.

 If you have the correct information, click the “Connect” button and log in. You 
will have access to all the files in your user account on that Mac. 

 To access all files on this other computer and to be able to copy files to it, 
you need to know the name and password of the Admin user to whom this 
computer belongs (that might be you, if you’re trying to get access to your own 
computer from somewhere else). Click the “Connect As…” button, and chose 
to log on as a “Registered User.” If you have the correct information, you will 
have full access to everything on that Mac, plus you will be able to transfer 
files onto it. 
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If you connect to the same 
computer regularly, click 
this button to put the 
address in the “Favorite 
Servers” list.

Process B, through the Go menu:

1 From the Go menu, choose “Connect to Server….” The window below appears. 

If you know the name of the Mac you want to connect to (as shown in the 
Sharing pane of the other Mac; see page 392), type it in the “Server Address” 
field, with “.local” after its name. 

Or enter the afp:// number that you see circled in the Sharing preferences pane 
on page 392.

 To connect as a Registered User, you need to enter a name and password 
of someone who has a user account on the other computer. Important! Even 
though this window shows up with your name in the field, it doesn’t want your
name and password (unless you have a user account on that machine)— 
it’s asking for the name and password of an account owner on the computer 
you’re trying to connect to! 

 To access all files as if you are the Admin of that computer, enter the Admin 
name and password as a Registered User.

3 Enter the name and password for the account on the other computer, then 
click “Connect.” 

To connect as 
a Guest, you 

won’t need 
a name and 

password; see 
the previous 

page.

2 Click the “Connect” button. You’ll see this window:

If you have a user account on the other 
computer and your Apple id has been 
set, you can log in with that Id.
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Depending on your 
Finder preferences, 
you might see the 
shared volume icon 
on your Desktop.

This icon means the disk is connected. 
Click this eject button to disconnect.

4 The next window that appears lists the available disks for that registered user. 
If you entered the Admin name and password, you will see the hard disk, the 
Home folder, any partitions or other hard disks attached to the other Mac, and 
any other volumes that are currently shared (you won’t have access to the files 
belonging to any other user account). Double-click the disk to which you want 
to connect. 

 To have access to more than one of the available volumes, Command-click the 
others. You can also repeat this entire process if you decide later you need to 
connect to another volume.

5 In the Sidebar of any Finder window on the computer you’re working from, 
you’ll see a shared volume icon, shown below-left. Single-click that icon to 
open its window, as shown below.

This is the Home folder 
of the shared computer.

It’s not easy to keep track of which windows are on which machine since the default 
folders all have the same names! Don’t open any  applications or documents from the 
window of the other Mac because you will  actually be working on the other machine 
at that point, which might affect the person using it. It’s best to drag the necessary 
documents to your own computer before you open them.
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disconnect from a Shared Server
Disconnect from any connected servers in the same way you disconnect from any 
other hard disk.

n	 Click the Eject symbol next to the server name in the Sidebar:

n	 Or if the server is visible on the Desktop, drag its icon to the Trash.

n	 Or select the server icon; go to the File menu and choose “Eject.”

n	 Or select the server icon and press Command E for Eject. 

n	 Or Control-click a server icon to get the contextual menu;  
choose “Eject ‘disk’.”

To hide or show the servers on the Desktop or in the Sidebar:
1 In the Finder, go to the Finder menu and choose “Preferences….”

2 Click the “General” tab, if it isn’t already selected.

3 Check or uncheck the box to show “Connected servers.” 
  When the box is unchecked, you won’t see the server icons on the Desktop,  

but they will all be accessible in the Sidebar.

4 You can go to the Sidebar pane in that same Finder preferences (click the 
“Sidebar” icon in the toolbar) and choose to take connected server icons  
out of the Sidebar and leave them on the Desktop.  

  Don’t take the server icons out of both the Sidebar and the Desktop  
or you won’t be able to find them!

This is a server icon.  
Whether or not a server 
icon appears on your 
screen when you’re 
connected is determined 
by the Finder preferences, 
as explained below.
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airdrop
If you have a new Mac running Lion, you’ll see “AirDrop” in your Finder window 
Sidebar. This makes it extremely easy to send files back and forth over any local 
wireless connection, as in a coffee shop, tea house, office building, or anywhere. 

Just click “AirDrop” in your Sidebar (which you’ve probably done by now). When 
anyone else on the same network opens their AirDrop window while you’re looking 
at your AirDrop window, you will all appear in the window together. Just drop a 
file on someone else’s icon. He will be asked if he is willing to receive it, and then to 

“Save” or “Save and open” the file. If you save the file, it immediately downloads into 
your Downloads folder. 

John and I both 
clicked on “AirDrop” 
in our Sidebars on 
our laptops.

On my laptop, 
I’m dropping a 
file on John’s 
handsome face. 

On John’s laptop, he 
has to approve the file 
transmission. 
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bonjour—Share files Locally through ichat
once your Mac is on a network of computers running os x (version 10.2 or later), 
you can send files back and forth through Bonjour, which is part of iChat. Unlike 
iChat, though, Bonjour only works with other iChat users on your local network.

The iChat icon might be in your Dock; if not, it’s in Launchpad or your Applications 
folder (see Lesson 9 for details about iChat and Bonjour). 

Make sure Bonjour is enabled: open iChat, go to the iChat menu, and choose 
“Preferences….” Click the “Accounts” tab, and put a check in the box shown below. 

To send files to other users on your local network: 
1 open iChat. Make sure the other users on the other computers also open  

iChat and have Bonjour enabled.

2 Click the Bonjour tab. other users on the network will be listed.

3 Drop a file on the other user’s name in the Buddies list. The other user will get  
a message to either accept or decline; he clicks “Accept” and the file transfers.

You can also start a chat with 
someone in the Bonjour list, 
and you can drop a file directly 
into the text message field.
This also works when chatting 
with anyone in your Buddies 
list, around the world. 

You can also screen share locally through Bonjour. It is exactly the same as screen 
sharing through iChat, as explained on the following pages.
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Your computer’s vnc 
number (circled) can be 
useful; see page 403. 

Choose who you want 
to have access to your 
computer through 
screen sharing.

Screen Sharing
Screen Sharing enables someone else on your local network to see your screen, 
or you can see his. This is especially great for anyone who has experienced the 
frustration of trying to give Mac support and instruction over the phone or through 
email. Now you can activate Screen Sharing and watch someone’s cursor as you give 
instructions, or take control of the buddy’s cursor while she watches and listens. 
When Screen Sharing is activated through iChat or Bonjour (pages 404–405), it 
automatically starts an audio chat so you can discuss whatever matter is at hand.

Set up screen sharing on both Macs
Before you start Screen Sharing, both computers need to turn on “Screen Sharing” 
in the Sharing pane of System Preferences:

1 From the Apple menu, choose “Preferences….” Click the “Sharing” icon.

2 Put a checkmark in the option called “Screen Sharing,” shown below.

3 If you have other users on the computer, you can choose to allow only certain 
ones to share that computer from somewhere else: Check the button, “only 
these users,” then click the + button to add the ones you want. Close the 
preferences and carry on.

—continued
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While screen sharing, 
you’ll see this icon in 
your Dock.

Screen Share on your local network via your Sidebar
Below is a fast and simple way to connect to another computer on your home/office 
network to screen the share and access the computer. Your computers must be 
connected, of course, as explained on the previous pages, and both computers must 
have Screen Sharing turned on in the Sharing preferences (see the opposite page). 

You must know a user name and password. The other user will not be asked 
permission—her screen will immediately appear on your monitor as a separate and 
moveable window, and you will have control of her mouse (she can also control it 
on her end). You will not be able to hear each other. This is kind of creepy because it 
means someone could watch what you’re doing on your Mac and you wouldn’t even 
know it (unless you notice a tiny new icon in the menu bar, towards the right, that 
looks like a monitor with spyglasses in it). 

To open a screen sharing session:

1 Make sure your Finder window is using Column View, as shown below.

2 In the list of “shared” files in your Finder window Sidebar, select another Mac. 

3 You will see a “Share Screen…” button, shown below (if you don’t see it, the 
other user has not turned on Screen Sharing, as explained on the opposite 
page). Click it, and a Finder window opens the other computer in a window  
on your Mac. Ta da. You can go back and forth between the other screen and 
your simply by clicking on your Desktop or on the screen-sharing window. 

To end a screen sharing session on the computer that started it, close the window 
as if it’s a Finder window, or go to the “Screen Sharing” menu in that window and 
choose “Close,” or go to the Dock icon, right-click on it, and choose “Quit.”

On the other computer, the user can end the session by going to the little spy 
monitor icon in the menu bar and choosing to disconnect. 
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Screen Share on your local network through the Go menu
This is another method to screen share with a user who is on the same local 
network, or with someone on the Internet if you know their static ip address  
(if neither you nor he knows if he has a static ip address, he doesn’t have one, but 
you can still use iChat; see the following pages).

1 First make sure you get the vnc address from the computer you want to 
connect to. This address appears in the Sharing preferences pane when you 
turn on Screen Sharing—you can see it circled on page 401. 

2 In the Finder, go to the Go menu and choose “Connect to Server….”  
You’ll get the window shown below.

3 Type in the vnc address as shown below. Click the “Connect” button.

If you need to share this 
screen often, click the +
button to make the address 
a favorite. It will appear in 
this pane under “Favorite 
Servers” whenever you 
open this window.

You can also use Bonjour to screen share on a local network, as explained on the 
following pages. Using Bonjour, you’ll be able to talk to each other as well, plus you 
can send files back and forth.

4 The other person’s entire computer appears in a moveable window on your 
screen. You can open his Mail and have it read aloud to him, or open Sticky 
notes and leave a message. or just spy on what he’s doing. It’s creepy.

5 To end a screen sharing session on the computer that started it, close the 
window as if it’s a Finder window, or go to the “Screen Sharing” menu in that 
window and choose “Close,” or go to the Screen Sharing icon in the Dock, 
right-click on it, and choose “Quit.”

 On the other computer, the user can end the session by going to the little  
spy monitor icon in the menu bar and choosing to disconnect. 
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In this example, I’m 
choosing to share 
my own screen with 
my Buddy instead of 
viewing my Buddy’s 
screen.

Everyone in your 
Bonjour list is on 

your local network.

Screen Share globally through ichat
of course, the buddy whose screen you want to share (anywhere in the world) must 
be using a Mac running os x 10.5 or later, have iChat turned on, and have turned on 
Screen Sharing, as explained on page 401.

1 To screen share globally through iChat or locally through Bonjour,  
open your iChat Buddies list. 

2 You can tell which buddies are capable of and have turned on Screen Sharing: 
When you select a name in the list, the Screen Sharing button at the bottom  
of the iChat Buddies list is black (instead of gray).

4 When you receive and accept the invitation to share someone’s screen, the other 
(remote) screen appears full-size on your screen, while your own Desktop 
appears as a miniature screen (as shown on the opposite page). When you 
mouse over the miniature screen, a “Switch to My Computer” message appears. 

  To enlarge your own Desktop to full-size and miniaturize the remote screen, 
click anywhere on the miniature screen. Meanwhile, the buddy who initiated 
Screen Sharing doesn’t see miniature versions on his own screen, even though 
you can now control his computer, grab files, open applications, or do anything 
he can do. 

This is the Screen Sharing button.

3 Click a buddy’s name. Click that Screen Sharing button and choose  
“Share My Screen…” or “Share (Buddy Name’s) Screen….”
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This is my computer screen, above, and John has just asked to 
share it. Now he will see my screen on his computer. He can 
control my cursor, open applications, type in documents, choose 
to play music in iTunes, or just about anything I can do. On his 
Mac, his screen appears in a little window, as shown above-right. 
He can switch back and forth between his screen and mine.

This is what screen sharing through iChat looks like:

This big sign 
disappears.

To share/copy files between computers: Simply drag a file from one screen to 
the other. If the file you want is on the miniature screen, just click the miniature 
screen and it will become large enough to find the file you need. Drag it to the [now] 
miniature other screen; as you drag, hover over the miniature screen for a few 
seconds until it enlarges to full-size, then drop the file wherever you want to place it.

To end a screen sharing session, click the circle-x in the top-left corner of the 
miniaturized screen. Or go to the iChat icon in the menu bar and choose “End 
Screen Sharing.”
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GoALS

Noisy hard disk?

Use simple troubleshooting 
techniques 

Force quit an application

Understand when   
and how to restart

Do a safe boot

Repair permissions

Delete a preference file

Check for software 
updates

Create another user to test 
software problems

Report crashes to Apple 

Force a disk to eject
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LESSON 22 

Basic Troubleshooting
All computers, even Macs, act funny at times. Fortunately, 

it’s often something that you can fix yourself.  These are the 

steps we follow to fix troubles on our Macs, before calling tech 

support. We keep going down the list until the problem is fixed 

(but also check this chapter for other problem-solving tips):

Make sure we’ve got plenty of free space on the hard disk, at least a  
gigabyte. If not, clear up space and restart. 

We quit and then restart the application that’s causing trouble. If it’s  
really having trouble, we might have to force quit the app (see page 408)  
and then relaunch it.

We relaunch the Finder (see page 409) if it’s a problem on the Desktop.

We restart the computer (or we Shut Down for a more serious but still  
quick test, then reboot). See page 409.

We do a Safe Boot (see page 412), then restart to see if that fixed it.

We repair permissions (see page 410) and see if that fixed things.

Then we might throw away the preferences file for the application that’s  
giving us trouble (see page 413) and restart the computer. 

If we had transferred the application to our Mac instead of re-installing  
it from the original disk, we reinstall the application from the disk.

And restart yet again.

In more than twenty-five years and on dozens of Macs, we’ve 

rarely had an issue that could not be resolved with the above steps. 
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hard disk is Making Noise?
If your hard disk makes noise, stop everything. Don’t create new files, copy, or paste. 
Call your tech support person right away, or shut down the Mac and take it to the 
repair shop. The hard disk should never make any sound other that an occasional 
soft whir. If it’s making noise, there is something seriously wrong that could damage 
your data.

force Quit an application 
Sometimes just one application has trouble and you need to force it to quit. There 
are two ways to force quit any application. This doesn’t affect any other application 
or the system. If an application isn’t responding to anything you ask it to do, if it’s 
hung up and the wheel keeps spinning, or it won’t let you quit, then force quit the 
app. After you’ve force quit an application, try restarting it. It should be fine. 

n	 Hold down the option key and press (don’t click) on the application’s icon  
in the Dock. A menu pops up with a choice to “Force Quit.”  Choose it.

n	 Or press Command option Esc. The window called “Force Quit Applications” 
appears. From this window, select the application you want to force quit  
(if it isn’t already selected), then click the “Force Quit” button. 
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Quit all apps before Restart
Lion has a “resume” feature in that when you restart, it automatically reopens every 
application that was opened when you chose to restart or shut down. If you’re 
troubleshooting, you usually don’t want that to happen. So quit all open apps before 
trying other troubleshooting techniques.

Restart
It’s amazing what a simple restart will fix. If you rarely turn off your Mac (like us), 
sometimes little things may start acting a bit quirky. Perhaps your Mac can’t find the 
printer you’ve been using for months, or icons for new files don’t appear. For little 
unexplainable things, restart. Because the Mac will resume all of your applications 
that you have open, it’s a good idea to first quit every application before you restart.

n	 To Restart, go to the Apple menu and choose “Restart….” 
n	 on most laptops, press the Power button for one second and you’ll get  

a little message with a button to restart.

If you can’t restart, then Shut Down; see below.

Shut down
Sometimes shutting down fixes small problems that a restart doesn’t fix. This is 
especially useful when you’re having connection problems. For a clean shut down 
and reboot, first quit all of your open applications.

n	 To Shut Down, go to the Apple menu and choose “Shut Down….” 
n	 Sometimes things are so bad you can’t even get to the Apple menu. In that 

case, hold down the Power button (the one you push to turn on your Mac) 
for at least five seconds. This forces it to shut down. 

Relaunch the finder
You can’t force quit the Finder, but you can relaunch it, which only takes a minute.  
If things are acting a little squirrely, try this. It doesn’t hurt anything.

n	 Hold down the option key and press (don’t click) on the Finder icon  
in the Dock. A menu pops up with a choice to “Relaunch.”  

n	 Or press Command option Esc (as explained on the opposite page)  
to open the “Force Quit Applications” window. Select the Finder in the list, 
and the “Force Quit” button changes to “Relaunch.” Click it.  
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Repair Permissions 
Due to occasional file corruption issues, something called “permissions” can go bad 
and cause trouble. Repairing the permissions can solve many mysterious things. 

1 open Disk Utility: open Launchpad or go to the Applications folder,  
then open the Utilities folder. 

 In the Utilities folder, find the Disk Utility and open it. You’ll see this:

2 Make sure the “First Aid” tab is selected. 

3 Select the hard disk in the left pane. 

4 Click the button to “Repair Disk Permissions.” 

 Depending on how much stuff you have on your hard disk, this can take up  
to twenty minutes or so. If the Mac finds any permissions that need to be 
repaired, it will repair them.

 If it finds things it can’t repair, then you need to go to the next step  
and verify and repair the disk. See the following page. 

5 Quit the Disk Utility.

This is the “Repair 
Disk Permissions” 
button until it’s 
in the process, as 
shown here. 
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Verify and Repair disk
First, go through the steps on the previous page to repair permissions, just to clear 
up any little issues. Don’t quit the Disk Utility yet. 

If you think the disk might need to be repaired, or if you just want to check to see if 
the disk has a problem, click the button in Disk Utility (shown on the previous page) 
to “Verify Disk.” This will check the disk to see if it really does have a problem that 
needs to be (and can be) repaired. 

If the disk needs to be repaired, restart your computer using the original oS X 
install disk or Flash drive, because Disk Utility can’t repair the same disk it’s running 
on. If you have an external drive that has been set up as a “boot” drive (with an 
operating system on it), you can use that to start up your computer.

So get the original install disk/Flash drive that came with your Mac, or attach your 
boot drive. Then:

1 Insert the original install disk. Double-click the “Install” icon as if you were 
going to install the system again. 

2 At the Welcome window, do not install! Go to the Utilities menu at the top 
of the screen. Choose “Disk Utility….” 

3 You get the window shown on the previous page. Now you can click the button 
to “Repair Disk.” Let it run through its process. It might take up to a half hour 
or more. Be patient.

4 When it’s done, it will probably tell you it has repaired the disk. If it can’t, it 
must be a serious problem and you need to take it to a repair shop. 

5 Quit Disk Utility and quit the installer. 

6 It might ask you to choose a startup disk because if you don’t, when you restart 
your Mac, it will boot up from the disk again. If it asks, you will see the disk 
options; single-click your internal hard disk, then click the “Restart…” button.

 or restart without choosing a disk and hold the mouse button down until 
it has restarted. Holding the mouse button down forces the disk to eject so 
it can’t be used to boot the machine. If you’re using a trackpad, press on the 
lowest area of the trackpad, the part closest to you.
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Safe boot
This is one of our favorite troubleshooting techniques. During a safe boot, the Mac 
actually goes in and fixes little things, such as minor file corruptions that build up 
over time, eventually causing problems. If you’ve ever used the terminal commands 
to do the fsck (file system check) technique, you’ll be pleased to know the safe boot 
does the same thing but without having to use the terminal. This is safe, easy, and 
comfortable, and fixes lots of mysterious problems.

1 Go to the Apple menu and choose to “Restart….” If you’re having such 
problems that you can’t even get to the Apple menu, hold down the Power  
key for five seconds to shut down the machine. Then push the Power button 
again to restart.

2 Immediately upon hearing the startup sound, hold down the Shift key and 
keep it held down. This might take a while, five minutes or even more.  
Be patient. Keep that Shift key down. You’ll eventually get to a log in screen 
that says, in red, “Safe Boot.” If not, start over—perhaps you didn’t get the Shift 
key down in time.

3 When you get to the Desktop or to the log-in screen, restart again (either 
click the restart button if you see one, or go to the Apple menu and “Restart”). 
Because a safe boot turns off everything that’s not essential to run the 
operating system, the Mac needs to restart to put everything back and  
turn everything on. See if things work a little better now. 
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delete the application Preference file
Another tip to troubleshoot an application that isn’t acting right is to delete that 
application’s preference file. This is perfectly safe—when the application opens up 
again, it will recreate a new preference file from scratch. You will lose any prefer-
ences you had personally changed in the application, but it can be worth it because 
this works pretty well to solve inexplicable annoyances in applications.

1 Quit the application.

2 open a Finder window and view it by columns, as shown below.

3 open the Go menu; hold down the option key and you’ll see a new item 
appear called “Library”—choose “Library.” 

4 The Library folder appears in the Home column of the Finder window,  
and it is selected, displaying its contents in a column to the right.

5 In that Library contents column, single-click the “Preferences” folder.

6 In the next column to the right, find the “.plist” file for an application that’s 
giving you trouble. That is the preferences file.

7 Drag the application’s preference file to the Trash. Empty the Trash. 

8 Restart the application and hope it works better. The Library folder will 
disappear all by itself.

The preferences for non-Apple applications may have their own method to delete 
preferences—check the support pages for your app.
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check for Software Updates
Make sure you are using the latest versions of all your software. For your Mac oS
software, use the Software Update preferences to see if everything is up to date (open 
it in the System Preferences from the Apple menu). It’s especially important to check 
for updated application software when you update your operating system, just as 
you would do when moving from any other oS to Lion. 

If your connection to the Internet is a dial-up through a telephone 
modem or some other really slow connection, do not check the boxes to “Check for 
updates: Daily/Weekly/Monthly” and “Download important updates automatically” 
because it will tie up your connection for hours. Instead, check for updates manually: 
Click the “Check Now” button.

create another User and test
If you install new software and it just won’t work right, or perhaps it won’t even 
open, one good troubleshooting technique is to create another user (see Lesson 18) 
and install the software in that user’s Home folder. open the application and see if it 
works properly. If it doesn’t work for the new user, the software itself has a problem 
(we have to assume you checked to make sure it works with your operating system 
before you installed it).

If the software does work for the other user, that indicates there is something in your 
system that is conflicting. Try throwing away the preferences, as explained on page 
413. If it still doesn’t work, you may need to contact the vendor to find out what may 
be conflicting with that particular software. 
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if you forgot your Password
If you forgot the password you chose when you first set up your new Mac or 
installed your new system (called the Admin password), you can change it if you 
also set up your Apple id or if you have the original install disk or thumb drive.

With your Apple Id
When you log in, you’ve probably noticed a question mark in the password field. 
Click that question mark to get the hint for your password, as well as an option to 
use your Apple id and password to change your user password. This only works, 
however, if you previously “set” your Apple id in the Users & Groups system 
preferences and checked the box to “Allow user to reset password using Apple id,” 
as shown on page 331. If you didn’t, an Admin user can log in and do that for your 
account so next time you forget your user password, you’ll be able to change it.

With the original disk or drive 
You can use these steps to change the password of any user. 

1 Get the original disk or thumb drive. Put it in and double-click the “Install” 
button. Follow the directions to restart. No, you are not really going to 
re-install the entire system. 

2 Wait until the Welcome screen appears. Then go to the Utilities menu  
at the top of the screen and choose “Reset Password….”

3 Enter your new password—twice. And add a hint.  
 And write that password down where you can find it again. Click ok.

4 Quit the installer from the Installer menu. Your Mac will restart: If you have 
a dvd in the Mac, hold down the mouse button during the restart to force 
the disk to pop out so it won’t restart from the disk again. If you accidentally 
restart from the disk, go to the Utility menu and choose “Startup Disk” to tell 
the Mac to start up from its internal drive. 

If you did not enter a password when you first set up your Mac, then you can leave 
the password field empty; just hit the “ok” or “Continue” button and it will work just 
fine (although it’s not secure at all). The problem with not having a password is that 
you will probably forget there is no password and so when it asks you for one, you’ll 
spend hours trying all sorts of possibilities that don’t work before you remember 
that there is no password. Guess how I know this.  



ptg6934589

Lesson 22 Basic Troubleshooting

416

Use target disk Mode
It’s not unusual to need to move lots of files from one computer to another. If both 
computers are working fine and you just need to share files, there are lots of ways to 
do it. Please see Lesson 21, and check the index for “sharing files.”

But sometimes one computer is just about defunct or maybe won’t wake from sleep 
and you’ve got to get the files off quickly. Use FireWire Target Disk Mode. This 
makes the other computer act as a hard disk that you’re connected to. You’ll need 
a FireWire cable that can connect to both Macs—check your ports carefully before 
you buy!

n	 Unplug all FireWire devices from both computers that you are going  
to connect to each other. 

n	 If FileVault is enabled on the computer you want to take files from,  
turn it off. 

n	 If either machine is a laptop, plug in its power source. 
n	 The machine you are going to transfer files to is the host computer. 

The machine you are going to take files from is the target computer. 

In this process, the target computer will appear as a hard disk icon on the Desktop 
of the host computer and you can copy files to and from it.  

1 Turn off the target computer (the one that’s probably going bad).  
The host computer can stay turned on.

2 Connect the two computers with the FireWire cable.

3 Turn on the target computer and immediately hold down the T key and keep 
it down. Keep it held down until you see a FireWire symbol (shown to the left) 
moving about its screen. 

4 on the host computer, you will see a hard disk icon representing the target
computer. You can copy files from the target computer and put files onto it. 

 If you don’t see the target computer’s hard disk on the host screen, make sure 
all the cables are securely attached and reboot the host computer.

5 When you’re done, eject the target hard disk icon from the host computer—
drag it to the Trash, or select it and choose “Eject” from the File menu.

6 Press and hold the target computer’s power button until it turns itself off.

7 Unplug the FireWire cable. 
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force a cd or dvd to eject
If a disk is stuck in the drive and won’t come out, this trick almost always works:

1 First make sure you’ve unmounted the disk: Click the eject icon next to its name 
in the Sidebar of the Finder window,  
or drag the disk icon to the Trash,  
or Control-click (or right-click) the disk icon and choose “Eject disk.” 

  But you’re probably reading this page because you already did that and there  
is no icon on the screen and you can’t get it out. So . . .

2 Restart your Mac. Immediately hold the mouse button down. Hold it down until 
the disk pops out.

  on a laptop, press the area at the bottom of the trackpad instead of the mouse 
(unless you have a mouse attached to your laptop). 

If that doesn’t work, see if there is a tiny hole next to the cd/dvd drive slot. Not all 
Macs have a tiny hole here. But if you see one, that hole is specially made for a paper 
clip (not the kind with the plastic coating). Unfold a metal paper clip and gently but 
firmly press it into the hole to snap open the mechanism.

one thing that can cause a huge problem in a cd/dvd player is a disk with a paper 
label glued to the top. If the tiniest little edge peels up, it can get stuck in the drive 
and ruin not only the disk but the drive itself. So don’t buy those cd labels that you 
can print yourself, and don’t put any disk with a paper label into your Mac!

one last warning: Never put one of the mini-disks into a slot-loading optical drive! 
If your computer has a tray-loading optical drive, you should be able to put a 
mini-disk in it and eject without a problem. However, the safest thing to do is just 
use standard disks. 

Report crashes
often when an application crashes, an alert box appears and asks if you want to 
send a report to Apple. Now, Apple is not going to write you back—this is just an 
anonymous report you send in so Apple can figure out if there are common issues 
among many users, enough to warrant looking into. It’s good to go ahead and send 
in the report.
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Learn your   
security options

Use passwords   
to log on to your Mac

Require a password   
to wake computer   

and unlock preferences 

Securely empty the Trash

Protect information   
using Keychain Access

Use FileVault   
to secure data
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LESSON 23

secure Your Mac  
and its Files

In these days with so much of our personal and financial data 

being stored on our computers and rampant identity theft, it’s 

important to take some precautions to make it more difficult for 

trouble-makers to gain access to our Macs. 

The tips in this lesson will make your files more secure, plus you’ll 

discover some useful tricks that help ensure your privacy, such as 

password information, Keychain Access, and securely emptying 

your Trash. 
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know your Security Options
There are a number of security features on your Mac. Apple has installed lots of 
security stuff like Kerberos, Secure Shell, Wired Equivalent Privacy (wep) data 
encryption, Virtual Private Network (vpn), firewalls, and other features. It doesn’t 
matter to most of us what those are—they work behind the scenes. Your Software 
Update software (found in System Preferences) can automatically update security 
features through the Internet as Apple releases them. 

The above features work without you having to do anything. The features that 
require your participation are explained on the following pages:

n You might need security from humans who walk past your desk when 
you’re not there. Your Mac has a number of low-level security features
to protect your information from the curious. These are good for laptops 
as well.

n	 There are a number of password-protect options on your Mac that  
make it difficult for others to gain casual access.

n Keychain Access stores many of your passwords in locked “keychains.”  
This includes passwords to your MobileMe account, servers, eBay account, 
PayPal, and more. Keychain Access also lets you store passwords and 
codes for other things, such as credit card numbers you might like to 
use while shopping online. Keychain Access does double-duty—it makes 
things easier for you and harder for thieves. See pages 428–429 for details.

n If you have highly personal or valuable files on your Mac, you can use 
FileVault for maximum security. If you have a laptop, this is especially 
important to prevent thieves from accessing your data. See pages 
430–431.  

n And don’t forget about the Secure Empty Trash feature. This deletes files 
from your Trash in such a way that no one can retrieve them again. See 
page 427.
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Passwords on your Mac
You have several different passwords on your Macintosh. 

n Administrator password: When you first turn on your Mac, you are asked 
to create a password. Write this down in a safe place! You will need this 
password whenever you install new software or when you make certain 
system-wide changes.

	 You can choose not to have a password. Your Mac will still ask you to enter a 
password, however—if you never created one, just leave the password field 
blank, and click ok or the “Continue” button. But keep in mind that it’s not 
very safe (from a security perspective) to neglect this password.

n Apple id: An Admin user can change her own password or allow another 
user to change her own password using their own Apple ids; if the user 
doesn’t have an Apple id, she can get one on the spot. Go to the Users & 
Groups preferences to set this option (see Lesson 18, page 331).

—continued

Many operations, such as 
changing settings in various 
System Preferences, 
require an Admin name and 
password to allow changes.

If you or the user you 
are creating have an 
Apple Id, set it here 
(or click here to go get 
one), then check the 
box below.
These two settings 
allow any user to use 
an Apple Id to reset 
his own password.  
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If you don’t know (or forgot) your Admin password and you did not set up the use 
of your Apple id, use the original install disc or usb Flash drive installer to reset the 
Admin password:

1 Insert the original Mac oS X installer disc or usb Flash drive. 

2 Double-click the “Installer” icon to start the process of reinstalling.   
You are not really going to reinstall!

3 When you get to the Install screen, go to the Utilities menu.  
Choose “Reset Password….”

4 Enter your new password. Write it down in a safe place!

5 Quit the Installer from the Installer menu.

n Login passwords: If you have set up multiple user accounts on one Mac, each 
user has his own password to log in. An Admin password is also the login 
password for that Admin user. By default, your Mac is set to auto-login the 
Admin so you don’t need your password at startup, but you can turn this off 
to make the computer less accessible. 

If a standard user forgets his password, the Administrator (or anyone who 
knows the Admin password) can reset the user password in the Users & 
Groups preferences. If you gave that user the ability to reset his own password 
using his Apple id, then he can reset it himself.

n Keychain Access password: This is the same as the login password, whether 
you are a standard user or the Admin. Keychain Access is the application on 
your Mac that keeps track of a variety of passwords for you (and other info,  
if you choose). See pages 428–429.

Password tips
n A password should be difficult for others to guess, but easy for you to 

remember.
n Don’t use a word that can be found in a dictionary. Some hackers use software 

that tries every word in the dictionary in a matter of minutes.
n Combine caps and lowercase and numbers. 
n Most passwords are case-specific, meaning a lowercase “r” is completely 

different from an uppercase “R.” Take advantage of this and use capital letters 
where someone wouldn’t expect them. 



ptg6934589

Lesson 23 Secure Your Mac and its Files

423

Security System Preferences
Apple makes it easy for you to turn on a number of the low-level security features in 
one place, the Security system preferences. 

1 Go to the Apple menu and choose “System Preferences….” 

2 Click the “Security & Privacy” icon. 

3 Click the “General” tab, as shown below.

Require password       after sleep or screen saver begins: See page 426.

Disable automatic login: See page 425 for an explanation of auto login.

Require an administrator password to access system preferences with lock icons:
This prevents any user without an administrator password from changing  
any locked preferences.

Log out after __ minutes of inactivity: Self-explanatory. Combine this with 
“Disable automatic login,” so when the Mac logs you out after this amount of 
time, no one can get in without a password.

Show a message when the screen is locked: To lock your screen, see page 426. 

Disable remote control infrared receiver: Click the box to disable all remotes, 
which prevents random things from happening on your computer when people 
in your home or office use their Apple remote.
Click the “Pair…” button to pair a remote and enable it to work with just your 
Mac and not impact the Macs around you.

To pair (connect) 
an Apple remote 
control with just this 
computer, click “Pair…” 
to reveal some simple 
instructions. 
To disable all remotes 
so none works with 
this computer, click 
the checkbox.
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The Firewall pane of the Security & Privacy preferences is not something you will 
mess with very often, if at all. The most important thing to understand is that as you 
use Sharing features (in the Sharing preferences), the Mac lets down the firewall 
(a protective barrier) for the features you have turned on so others can access your 
machine to share. This means 
you are at a little more risk than 
if that feature was not turned on. 
So if you’re not using a sharing 
feature, turn it off so the firewall 
goes back up.

To disable various sharing 
features (Screen Sharing, File 
Sharing, Bluetooth Sharing, etc.), 
go to the Sharing preferences 
pane and uncheck them.

Click the “Stop” button (shown above) to toggle between “Stop” (off) and “Start” 
(on). When the Firewall is “on,” your Mac determines which programs are allowed 
incoming connections based on your “Sharing” preferences. If you want to override 
any of those settings and allow or block specific applications or services, click the 
“Advanced…” button in the lower-right corner. A dialog sheet drops down, as shown 
below. To add items to the list, click the + button; to block a service or application, 
select it, then click the – button. 

After you customize your settings, click “ok.”

This option permits “trusted” 
sites to make an incoming 

connection and provide services 
accessed from the Internet. 
“Trusted” sites have been 

verified as authentic and secure.

This option provides an extra 
level of security and privacy.
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Low-Level Security features
Here are some simple and quick features to use if you have any worry at all about 
casual access to your computer.

Automatic login
n Turn off automatic login: Automatic login lets your Mac start up without 

a password—it automatically logs in to the account of the person who has 
chosen “automatic login.” This means anybody can log in to that computer!

Turn off automatic login and then be sure to log out before you leave your 
computer for a while. This ensures that people walking by will need a 
password to log in to your account, even if they restart your Mac. Laptops 
should always require a login password (because they’re easy to steal or lose).

You can also disable automatic 
login for all users in the 
Security preferences pane,  
as shown on page 423.

If this box is checked, you can 
lock your screen instantly at 
any moment—just go to the 
login menu in the upper-right 
of the screen and choose 

“Login Window….”

n If you don’t want to turn off auto-login, you might want to at least take the 
extra step to uncheck the box to “Show the Sleep and Shut Down buttons.” 
If auto-login is on and you log out and leave your Mac, the login screen 
appears and you think you’re safe. But someone can just click the Shut Down 
button. When the computer starts back up again, it automatically logs in to 
your account (if automatic login is enabled). By unchecking this box, no one can 
restart your computer so easily.

However, this precaution isn’t going to help much if your laptop is stolen 
because someone can just reboot the computer and it will automatically log in. 

—continued
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n Mac oS X lets you have multiple users on one computer, and each user has 
a separate, private Home area (see Lesson 18 for details). Even if you are the 
only one using this Mac, you can create another user, a standard user who 
has no administrative privileges, and regularly log in as the standard user. This 
is a simple step that just makes it one level more difficult for someone to get 
into your main account and make system-wide changes. It won’t protect any 
data that you create as that user, but it will make it more difficult to get into 
your Mac as an Administrator with privileges.

Require a password to wake your Mac
To prevent access to anyone walking by your computer, you can use these simple, 
yet effective, features. open the System Preferences from the Apple menu, and then:

	 1	 Use the “Security & Privacy” preferences to require a password to wake up 
the Mac from sleep or from the screen saver (see page 423). You can add a 
delay of five seconds to four hours before the password is required.

2 Go to the “Desktop & Screen Saver” preferences to choose a screen saver and 
tell it when to start. 

3 Then go to the “Energy Saver” preferences to tell your Mac to put either the 
computer and/or the display (the screen) to sleep after a certain amount of 
time. Now when the screen saver comes on or your Mac goes to sleep, you’ll 
have to enter your password to get back in to it.

An alternative technique is to set up your Mac so you can lock it with a mouse click,
not just when the screen saver comes on or when it goes to sleep. 

1 open Keychain Access (open Launchpad, click the “Utilities” icon, then click 
the “Keychain Access” icon).

2 From the Keychain Access menu, choose “Preferences….”

3 Check the box to “Show keychain status in menu bar.” A padlock icon appears   
on the right side of your menu bar, as shown here.

4 Quit Keychain Access.

5 Click the padlock icon that now appears in your  
menu bar to get the menu shown to the right.

6 Choose “Lock Screen.” The screen saver will start 
and no one can access your Mac unless they know your login password.
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higher-Level Security features
n Secure Empty Trash: You might think that after you empty the Trash,  

it’s gone. But it’s possible to recover many deleted files using special data-
recovery software. To completely overwrite deleted files (several times) that 
are in the Trash so no one can ever get to them, go to the Finder menu and 
choose Secure Empty Trash…. This might take several minutes. 

n Encrypt a disk image: Using Disk Utility, you can make a password-protected 
“disk image” of a hard disk, a folder, a cd or a dvd (not an individual file, 
unless it’s in a folder). The disk image can then be stored or transferred via 
email or any other method without any security concerns. A disk image acts 
just like any other hard disk—you can move files into it, copy files to it, and 
delete files from it. 

To create a disk image:
1 open Disk Utility: open Launchpad, click the “Utilities” icon, then click  

the “Disk Utility” icon. 

2 From the File menu, choose “New,” then select one of these options:  
“Blank Disk Image…” (if you don’t know what files you’ll be adding) or 
“Disk Image from Folder…” (if you already have a folder of files you want 
to make a disk image with).

  With either of these methods you can enable adding or removing files at 
any time: Choose “read/write” from the “Image Format” pop-up menu.

3 If you choose “Blank Disk Image,” set your options, including a name  
and location for the disk image. Choose settings for the other options: 
Use the “Encryption” pop-up menu to choose an encryption method,  
or choose “none.” If you choose an encryption option, a password dialog 
opens after you click “Create.” 

4 If you choose “Disk Image from Folder,” select a folder that you want to 
make a disk image of, then click “Image.” A dialog lets you set a name, 
location, and other options for image format (read/write) and encryption. 
If you choose encryption, a password dialog opens after you click “Save.” 

5 Click Save.

Double-click this icon to 
open the volume that you 

can move files in and out of.

This is the actual 
volume that stores 
the files.
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Use keychain access for Protection
Keychain Access provides a secure place to store information that can only be 
accessed with a user name and password. Keychain automatically and safely stores 
the passwords you create on your Mac, like those for web sites you go to, servers 
you connect to, email accounts, etc. Every time you see one of those messages that 
asks if you want your Mac to remember this password in your keychain, it gets 
stored here in Keychain Access.

You can also add your own secure collections of Keychains to store your credit card 
numbers, pins, bank card information, private notes, passwords, and other things 
that you want easy access to, but you want them to be secure. They won’t be entered 
automatically anywhere—it’s just a safer place to store them than on a sticky note. 

Keychain Access sets up your initial Keychain file, the one based on your user name 
and password, as the default Keychain. This default Keychain automatically opens 
when you log in. To make other Keychains more secure, such as your list of credit 
card numbers or banking passwords, be sure to make new Keychain files for them 
instead of adding them to your default file. 

To open Keychain Access, click Launchpad in the Dock, then click the “Utilities” 
icon, then click the “Keychain Access” icon. 

Click this button to show or hide the list of Keychains, 
now showing at the top of the Sidebar. Any new keychain 
you create will appear in that list.
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To access any password Keychain has been storing for you:
1 Find the item in the list of “Passwords,” shown on the opposite page. 

2 Double-click that item in the list (the list displayed in the large pane on the right 
side of the window). You will be asked for your Keychain password, which is 
the same as your login password. If you are the only user of the Mac, it’s the 
password you assigned yourself when you first set up your Mac, the Admin 
password. A window like the one below appears.

3 Check the box to “Show password.” Your password appears!

To create a new Keychain: Go to the File menu and choose “New Keychain….” Give  
it a descriptive name, such as Credit Card Info, then click the “Create…” button. In the 
dialog that opens, create a password you will remember (cuz tough luck for you if you 
forget it), then click ok. This Keychain will appear in the top portion of the Sidebar, 
shown on the opposite page. You will need to know that Keychain’s password if you 
want to access things in it!

With that Keychain selected, go back to the File menu and choose to create a  
“New Password Item” or a “New Secure Note Item” to store in it. 

Keychain is a very powerful and complex application. To use it wisely and well, 
please study the Keychain Help files.
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consider fileVault for heavy-duty Protection
FileVault encrypts, or scrambles, the data on your Mac so unauthorized people 
or software cannot read it. While you are working on your Mac with FileVault 
turned on, you won’t notice a difference, but everything on the startup disk will be 
encrypted, safely protected from prying eyes. When you access any of those files, 
they are automatically decrypted. 

Remember, this is an optional security measure. If you don’t have extremely 
sensitive data on your Mac, you probably don’t need this level of protection.

To turn on FileVault:
1 Before you begin, make sure you are the Admin of this Mac and that you know 

your Admin name and password, as well as the passwords for any additional 
user accounts for which you want to activate FileVault.  

2 From the Apple menu, choose “System Preferences….”

3 Click the “Security & Privacy” icon, then click the “FileVault” tab. 

  Read the warning! If you forget your password or lose the recovery key that 
Apple gives you, your data (every tiny bit of it) is lost. 

 If you’re sure you want to use FileVault, click the lock icon in the bottom-left 
corner and enter an Admin name and password. 

4 Now click the “Turn on FileVault…” button.

5 A sheet slides down to show a list of users. A green checkmark appears to the 
right of users who have passwords set. 

This user has a password.
This user has no password.
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Laptop Precautions
Every year, millions of laptops get stolen or lost. They get stolen not only for the 
hardware, but more and more often for the valuable personal data that is stored on 
them. So it is imperative if your laptop does happen to get lost or stolen that the 
data inside is as safe as possible. Here are a few features (most from this chapter)  
to seriously consider.

n	 Do not set automatic login for your laptop—use a password to log in.
n	 Set a firmware password; see page 436. It prevents someone from booting 

your computer with another disk.
n	 Password-protect the screen saver and sleep so if the screen saver turns on  

or the Mac goes to sleep, you need a password to get back in. 
n	 Turn on FileVault (but never forget the users’ passwords). FileVault automati-

cally encrypts everything on your startup disk and decrypts it when you want 
to access it. (If FileVault is enabled, you can’t use your Apple id to change the 
password.)

n	 You can subscribe to services that can track a stolen laptop as soon as a 
person logs on to the Internet with it. Search the web for laptop security 
devices and services. 

  If a user doesn’t have a password, you must assign one in order for that user to 
use FileVault. Click the “Set Password…” button. After you set a password, click 
the “Enable User” button, enter the user’s password, then click ok.

6 Back in the sheet that shows a list of users, click the “Continue” button.

7 Another sheet slides down with a 24-character recovery key. This key can be 
used to unlock the disk if you forget your password. Write down this recovery 
key and don’t lose it. Click “Continue.” 

8 The next dialog lets you choose to “Store the recovery key with Apple.” If you 
forget your password and lose the recovery key, you can contact Apple to 
retrieve it. Apple encrypts the key using the answers to three questions you 
choose from pop-up menus. If you forget the answers to those three questions, 
you’ve got a serious problem.

9 Click “Restart” to begin the encryption process. You can continue to use your 
Mac while the FileVault encryption takes place. To check on the encryption 
progress, return to the “Security & Privacy” preferences.
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LESSON 24

Upgrade Your Mac 
and Migrate Your Files

You may have just gotten a brand-new Mac with Lion already 

installed, in which case you can skip this chapter altogether (unless 

you want more information about transferring your files from an 

old machine to your new one). 

If you upgrade using a Lion installation disk or usb Flash drive, 

the installer presents you with a few options from which to choose 

before you upgrade. This chapter explains the choices you will 

need to make along the way and provides some tips for migrating 

user accounts and files from one Mac to another. 

Remember, before you do anything serious like upgrade your 

operating system, first back up your important files. The easiest 

thing to do is drag your important folders and files onto an exter-

nal hard disk. Always create at least two backups and store them in 

different places—it won’t do any good if all your important back-

ups are in the same office that gets burglarized or flooded! 
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Remember, always before upgrading or installing, make backups 
of your important files. If you don’t have the install disks for certain 
applications or fonts, back them up to disks before you upgrade or install!

Upgrade to Lion
To install Lion, your Mac must have at least an Intel Core 2 duo processor.  
To see what kind of processor your Mac has, go to the Apple menu and choose  

“About This Mac.” If your Mac is using something like an i3 or i5, that’s even better 
than a Core 2 duo. 

If your Mac is running Snow Leopard Mac oS X 10.6, you can upgrade through the 
App Store (if the App Store icon is not in your Dock, check your Applications folder, 
or go to apple.com/mac/app-store ). Or you can order an install disk or Flash drive 
from Apple. 

If you download Lion from the App Store, follow the on-screen instructions. If you 
install from a disk or usb Flash drive, insert the disk or Flash drive, double-click the 

“Install Mac oS X.app” icon, and follow the directions.  

Install as an upgrade
A regular install of Lion upgrades your existing operating system, but leaves all 
of your files untouched, and most, if not all, of your custom settings for system 
preferences and applications. Upgrading is faster and more convenient than a clean 
install, described on the following page. But you still should make a backup of 
important files because strange things have been known to happen while upgrading 
an operating system.
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Optional clean install
To ensure a pristine computer environment, some people like to completely erase 
the hard disk before installing a new operating system. This is called a clean install.
It ensures that you don’t inherit any little corruptions or problems or puzzling 
behavior that might have been occurring in your previous operating system. 

of course, in the case of a clean install, first make sure all important information, 
applications, and files are backed up to another disk because this process erases 
everything on the computer. The easiest thing to do is go to the office supply store 
and buy an external hard disk, then transfer your files to it. If you want the fonts you 
may have bought, make sure you copy those as well (where they are stored depends 
on how you installed them; see the Help files for your font application). Later you 
can transfer these to your new machine. You will need to reinstall most of your 
third-party applications from the original disks or download them again. 

once everything is backed up, follow these steps: 

1 Click the “Install Mac os x.app” icon that you see on the disk.

2 In the next window, click “Restart.”  

3 After restart, from the Utilities menu, choose “Disk Utility.”   

4 Select your hard disk, listed in the left sidebar of the Disk Utility window, 
then click the “Erase” tab to show the Erase options. 

5 Click the “Erase…” button. After the disk has been erased, the installation  
process continues.
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take advantage of the Utilities in the installer
When you run the upgrade or installer and get to the first screen, you’ll see a menu 
item called “Utilities.” This menu gives you access to a number of troubleshooting 
features on your Mac. If you like, you can stop here before installing Lion and use 
the Disk Utility to partition your Mac (divide it into several drives; only do this if 
you know why you are doing it). 

All of the utilities mentioned below, except “Reset Password,” are in your Utilities 
folder, which is in your Applications folder. You don’t need to use an Install disk 
or install Flash drive to access them. But if your Mac has totally crashed and you 
can’t get anywhere at all, insert the original Lion install dvd or usb Flash drive, then 
restart your Mac. Immediately hold down the letter C key to make sure it boots 
from the install disk or device. Do not click any of the installation buttons, but 
use the tools that are available here. 

From the Utilities menu, choose the appropriate tool:
n	 Startup Disk: Choose which disk you want your Mac to check first when 

starting up. only disks that contain operating systems can be used as  
startup disks.

n	 Reset Password: Here you can reset not only the Administrator password, 
but the passwords for every user on the Mac. You do not need to know the 
original passwords to set new ones. 

n	 Firmware Password Utility: This option prevents others from starting your 
computer with a different disk. If someone stole your laptop, this won’t get it 
back for you, but setting this password does make it much more difficult for 
anyone to log in and get your data. Write down the password!

n	 Disk Utility: Select your hard disk and use the “First Aid” pane to see if 
anything’s wrong with the hard disk. The “Repair Disk Permissions” feature 
has solved some odd problems for our Macs (see page 410). This is also where 
you can partition the hard disk before (or after) you install. 

n	 Terminal: The Terminal lets you use unix commands to do all sorts of things. 
If you don’t know anything about unix or how to use the Terminal, skip this 
altogether.

n	 System Profiler: The System Profiler tells you all the gory details about your 
Mac, the cpu type, the audio, what kinds of devices are attached to your Mac, 
the speed of everything you can think of, and oh so much more. It will even 
tell you the serial number of the computer. Much of this information is also 
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do you Own two Macs? Migrate!
If you have important information on another Mac (a different computer from the 
one you’re installing Lion onto) or a partition or volume on the new Mac, you can 
transfer the information from the older machine, partition, or volume to this new 
Mac. You’ll use a feature called Migration. You can either use the Setup Assistant 
during the Lion installation (it walks you through it easily) or at any time in the future.

The migration process can automatically transfer:
n	 Network and computer settings.
n	 User accounts, preferences, and email.
n	 Documents and other files.
n	 Applications. 

Some applications, however, will need to be reinstalled from their original 
disks because they install necessary files in different system folders. All you 
can do is transfer them, then open them and see if they work. The more 
expensive and complex an application, the less likely it will transfer perfectly.

Requirements for the Migration Assistant
The old Mac must: 

n	 Be running Mac os x version 10.1 or above. 
n	 Have a built-in FireWire port or be on a local network with the new computer.
n	 Support “Target Disk Mode” if you plan to connect the two computers with a 

FireWire cable. 

available at your Desktop: Go to the Apple menu, choose “About This Mac,” 
and click the button labeled “More Info….”

n	 Network Utility: This utility has a number of great tools. If you know what 
it means to finger someone, ping your modem, run a lookup or a port scan, 
or when to use whois, then you’ll have fun with this utility. It’s also in your 
Utilities folder (which is in the Applications folder) in case you need it.

n	 Restore System From Backup: This utility uses Time Machine. It can’t 
restore the system from a backup unless you’ve first put it all on Time 
Machine (see Lesson 20). But once you’ve done that, you can use this option 
to restore your system back to a certain date.

—continued
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You’ll also need:
n	 A FireWire cable (if you’re using “Target Disk Mode”) that is long enough to 

reach between the two computers, or temporarily move the computers closer 
so they can connect via the cable. Be sure to check the ports (where you plug 
the cable in to the computer) to make sure you get a FireWire cable that can 
connect the two computers. Not all FireWire ports are shaped the same! 

n	 An Administrator name and password (unless you’re doing this during  
the Lion installation).

Be aware that:
n	 This process will tie up both your Macs for hours!  
n	 This process will not automatically migrate songs that you bought from the 

iTunes Store. If you want to migrate all of your songs, including those you 
bought at the iTunes Store, you must first deauthorize the old Mac before 
you migrate files: 

1 open iTunes on your old Mac.

2 From the Store menu, choose “Deauthorize Computer….” 

3 Enter your account and password. Click the button to “Deauthorize,”  
then click ok. 

4 To deauthorize any Audible content (books) so you can migrate them 
over to the new machine, go to the “Advanced” menu and choose 
“Deauthorize Audible Account….” You’ll need your Audible.com name 
and password. 

Migrate now
Use the Migration Assistant: Single-click the Launchpad in the Dock, then single-
click the “Utilities” icon, then single-click the “Migration Assistant” icon. 

The instructions on screen are easy to follow and self-explanatory. You can migrate 
the files from the Administrator (main user), from any individual user, or from both. 
The information on the old Mac or the partition is not affected at all.
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Migrate additional users 
At any time you can migrate additional users and their files from other computers. 
Just follow the directions on the previous pages. 

You can also use Target Disk Mode at any time to transfer files from one Mac to 
another; see page 416. This technique is especially useful if one Mac is dying because 
in Target Disk Mode, the target computer does not use its operating system—it acts 
like a plain ol’ hard disk that shows up as a disk icon on the Desktop of your healthy 
computer. 

What to do after migrating
It’s a good idea to do a quick check of the files on your new Mac after migrating. 
open every application to make sure it works okay—make a quick file and try to 
save it. If an application doesn’t work, you will just have to reinstall it from the 
original disks. 

open sample files by double-clicking them to make sure they can open in the 
correct application and that their fonts appear correctly.

Connect to the Internet, check your mail, and take a peek at your System 
Preferences to make sure things are really how you like them. 

Disconnect after migrating
Do not unplug the FireWire cable before you unmount the icon of your old Mac 
from your new Mac running Lion! Even though it’s “hot swappable” (which means 
you don’t have to shut down before you unplug), it’s still possible to lose data if you 
unplug the other computer while the FireWire icon is still visible on the screen.

To disconnect: Find the hard disk icon of your old Mac on the Desktop of the Lion 
computer. Drag the computer disk icon to the Trash, or click the Eject button next to 
that computer’s name in the Finder window Sidebar.
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Other Ways to transfer files from Mac to Mac 
The migration process can take quite a long time because it gathers up thousands 
of files. If you want to transfer just selected files, you might want to consider these 
other options. Some you can do before you install Lion; others are new techniques 
that can only be accomplished in Lion (or Leopard or Snow Leopard).

Use an external disk  
on many older Macs, the best option can be to attach an external hard disk with 
a usb or FireWire connection. It can be worth it to buy a new drive just for this 
process. Copy files onto the external disk as you usually would from your old 
machine (drag them from the hard disk of your old Mac onto the external disk’s 
icon). Then connect the external drive to the new machine and drag the files from 
the external disk to the newer Mac.

burn a cd or dvd
If your old machine can burn a cd or a dvd, you can transfer quite a few files by 
burning disks and moving them to the new machine. Plus you’ll have ready-made 
backups (always the smart thing to do).

Send attachments in email
If you don’t have huge files, send them as attachments through email. It’s kind of 
funny to send your files around the world to get to the machine sitting two feet away. 

Use your MobileMe account
If you have a MobileMe account, put the files from your old Mac onto your iDisk 
(see www.me.com). on your new Mac, download the files from your iDisk. Also 
take advantage of syncing your Macs through MobileMe, a terrific option—just be 
sure to check to see exactly what sorts of files get synced so you can make sure you 
know what else you need to transfer manually.

Send files through the network
If both machines are on the same network, connect the two computers and copy 
files directly from one to the other through a variety of methods, including the 
Bonjour list in iChat. See Lesson 21 for all the details. It’s really easy and you’ll love 
knowing how to do it.

www.me.com
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Use a fireWire cable
Connect a FireWire cable between two Macs. The other Mac will appear in the 

“Shared” group in the Sidebar of a Finder window. You will probably be able to 
screen share (see pages 402–403). or at least you can connect to each other and 
easily move files back and forth (see Lesson 21). Also consider the FireWire Target 
Disk Mode option; see page 416.

Remote install
A MacBook Air has no dvd drive in which to insert a Lion install disk, but you 
can use a usb Flash drive with the Lion installation software on it. Or you can buy 
an external usb optical drive (a cd/dvd drive) from Apple and connect it to your 
MacBook Air. This is an easy solution, and the drive is barely larger than a cd or dvd. 

Another solution is to use the optical drive on another computer and install Lion 
over a local network, explained below.   

To install Lion on a Mac that doesn’t have an optical drive, such as a MacBook 
Air, find a nearby Mac that has an optical drive and insert a Lion install disk. Both 
computers (the one with the drive and the MacBook Air) must be on the same local 
network, either an AirPort (Wi-Fi wireless) or an Ethernet network. (If you need to 
use an Ethernet connection, you’ll need to get a usb Ethernet adapter to connect to 
the MacBook Air.)

open the Utilities folder (inside the Applications folder or Launchpad), double-click 
“Remote Install Mac os x.app,” then follow the on-screen directions. 

After you choose a network type, you’ll be prompted to hold down the option key 
while you restart the computer (the one with an install disk inserted). When you see 
a list of available startup disks on the network, choose your computer’s startup disk, 
then continue to follow the on-screen instructions.

You can also use the “Remote Install Mac os x” app to access the “Disk Utility” from 
the external drive for computer repairs and troubleshooting when certain tasks have 
to be done with tools that are on a separate disk from the one being repaired.
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Mini-GlossaryMost words are explained as we use them—please see the index!

active window
The active window is the one that is in front of 
everything else and is selected. You can tell if a 
window is active because the three little  buttons 
in the top-left corner are in color, and the title 
bar icon is not dimmed. It’s important to become 
aware at all times of which window is active 
because that is the window that will accept any 
command. For instance, if you press Command 
Shift N to create a new folder, that new folder 
will appear in the active Finder window (or on 
the Desktop, if the Desktop is active). If you 
press Command W in just about any application 
or in the Finder, it will close the active window. 
To make any window active (or the Desktop), 
single-click on it. 

alias
An alias is a “go-fer”—it goes for things and gets 
them for you. It’s nothing all by itself; it’s merely 
a representative icon (only 2k or 3k in file size) 
that is linked to the original. You double-click 
the alias, and it finds and opens the real thing 
for you. The advantage of this is that you can put 
aliases in multiple places for easy access; in fact, 
you can have as many aliases of an item as you 
want. Some applications cannot open properly 

if you move them out of their folders, but if you 
make an alias of that application, you can put it 
anywhere. 

An alias icon has a visual clue, a tiny arrow in the 
bottom-left corner of the icon (shown below-left) 
so you know it’s a go-fer.

You can throw away an alias and it does not affect 
the original at all. You can move an original or 
rename the original or the alias and everything 
still works fine. 

To make an alias, select a file; press Command L. 
Or hold down the Command and option keys 
and drag the file into another folder or onto the 
Desktop. As you drag, you’ll see the tiny alias 
arrow that tells you that you are indeed dragging 
to create an alias.

colored labels 
To color-code a file, Control-click on it and 
choose a “Color Label” from the menu that pops 
up. once a file is color-coded, you can search for 
it by its label, organize your files, etc. 

To change the names of the labels, use the 
Finder preferences: Go to the Finder menu and 
choose “Preferences….” Click the “Labels” menu 
and change the names. For more details, please 
see page 268, and check the index for “color 
labels.” This is a great organizational tool.

The tiny arrow is your 
visual clue that this file 
is an alias.
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default
A default is something the Mac has chosen 
for you, until you make your own choice. For 
instance, TextEdit must have a font chosen to 
type in, so your Mac chooses one for you. A 
default window view is chosen for you. But you 
can at any time change just about anything to 
something of your own choice.  

extension
A file extension refers to the short code at the end 
of a file name, which might be from two to six 
letters. This extension tells the Mac what to do 
with that file. 

You might not see the extensions. If you like to 
have them visible all the time, go to the Finder 

not open if you change its extension without 
knowing what you are doing. 

permissions
You might run across a file that tells you that 
you don’t have permission to use it, or perhaps 
you just can’t open it or save changes in it. 
Permissions are set in the Get Info windows 
(see page 343). If you have an Admin name and 
password, you can change permissions on the file. 
These are the options:

Read & Write: This gives you full rights. A user 
can open, change, and save changes. 

Read Only: A user is allowed to open the item to 
view/read its contents, but cannot edit or save it.

Write Only: This option turns a folder into a 
Drop Box—any user can put items into a Drop 
Box, but only the owner of the Drop Box can 
open it or take things out of it. See page 342 
about the Drop Box. 

No Access: This item blocks all access to an item.

screenshots 
To make different kinds of screenshots (pictures 
of the screen), use these shortcuts:

Full screen: Command Shift 3

Selection: Command Shift 4, then let go. Use 
the target cursor that appears to select the area 
you want to capture as an image: just press in 
one spot and drag to another spot, to capture 
the image inside of this invisible box.

once you’ve got that down, try this: Press 
Command Shift 4 to get the target cursor, then 
while you’ve got it, let go of the keys but not 
the mouse button. With the mouse button still 

The extension, .webloc, 
tells the Mac this is a 
web page location.

preferences (from the Finder menu, choose 
“Preferences…”). Click on the “Advanced” tab. 
Put a check in the box to “Show all filename 
extensions.”

To show the extensions temporarily or to check 
to see what the extension is for a particular 
file, use the Info window (explained in the next 
column). You’ll see an option to see “Name & 
Extension” information that tells you what kind of 
file it is, and lets you hide or show the extension 
for that selected file. 

Do not add or change the extensions yourself ! 
The Mac has become very fussy about these 
extensions, and you run the risk that the file will 
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down, press the Shift key and you can resize 
the selected area in the direction you first move 
the mouse. Or press the option key and resize 
from the middle (that is, the center will stay in 
the same place). Or press the Spacebar and you 
can move the selection area around. To take 
the shot, let go of the mouse button.

To take a screenshot of a pulled-down menu, 
press Command Shift 4 and drag the target 
cursor around the menu.

Window or the menu bar: Command Shift 4, 
then let go. Tap the Spacebar and a camera 
icon appears. As you move the camera icon 
over the menu at the top of the screen or over 
different windows, even those that are hidden, 
you’ll see that window highlight. Click on the 
one you want an image of.

To take a screenshot of a pulled-down menu 
without its title, use the above technique. 

All of the above screenshots land on your 
Desktop and are labeled “Screen Shot” with the 
date and time in the file name. They are in the 
png file format.

Symbols
	


  ⎋ Escape (esc)
	   ⇞	⇟ Page Up or Page Down
	   ⌫ Delete
	   ↑↓←→ Arrow keys
	   ⌤ Enter

▲ Eject

Selection you can paste: Press Command 
Shift 4 and the target cursor appears; you can 
let go of the keys. Now hold down the Control 
key and drag to select the area, which copies
that screenshot image to the Clipboard. You 
can paste the screenshot somewhere else. 

string
A string is simply a line of characters that you 
type. If someone tells you to “enter a search 
string,” all it means is to enter the words you want 
to search for. 
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Index
abbreviations at ends of file names,  

73, 279, 443
Action menu, 43, 53
Active Screen Corners, 298, 303
active window, what is it? 443
Address Book, 109–127

add contacts
from Mail messages, 110
manually, create a new card, 111
with data detectors, 103

alphabetize contact list, 111
autofill info in Safari windows, 135
back up entire database of contacts, 126
birthdays, add them to iCal, 161
data detectors can add info, 255
display addresses, 110
display single card or card and list, 111
edit an existing card, 111
envelopes, print them, 124–125
export archive as backup, 126
FaceTime, make video call from, 115
fields on contact cards

add fields to one card or all cards, 114
delete fields, 111, 114
fields are missing, 111

Groups
create, send to, delete, 116
show Group list, 110, 116
Smart Groups, 117

iCal events, invite contacts to, 121
icon in Dock, 22
labels for fields, change them, 111
large type, show phone or fax  

numbers in, 115
Mail

add sender to Address Book, 110
send email from contact card, 115

mailing labels, print them, 124–125
merge duplicate cards, 120
My Card, 113
open card in its own window, 111

show multiple contact cards, 127
phone numbers, auto format, 111
photographs

add photos to Mail, 82
add photos to contact cards, 112
use Photo Booth to add, 236–239

print in a variety of formats, 124–125
privacy, keep some of your vCard  

info private, 113

red buttons delete fields, 111
resize the Address Book window, 110
scroll bars in, make them show, 115
search all contacts, 118–119, 368
send 

a contact card to others, 119, 266
send email from contact card, 115

share your contact list, 122–123
show contacts, 110

show many cards, 127
silhouette of tiny man in card, 113
subscribe to someone else’s  

Address Book, 123
transfer Address Book info, 76
vCards

what are they? 111
send them to others, 119
make a vCard backup of entire 

Address Book, 126
send through email, 266

address detection, 70
Adobe InDesign to create this book, 269
afp for file sharing, 396
AIM account, 168
AirDrop to share files, 399
AirPort wireless

AirPort Utility, 386
base station acts as a router, 391

aliases
what are they? 443
create with page proxy, 267
in Burn Folder, 224

All My Files, 9, 13
arrangement of the files, 13
remove it from Sidebar, 279

alphabetize items in a folder, 284
AOL, set up account, 76
Apple

find information from, 259
Mac video tutorials for users, 33
Magic Mouse, options for, 290
MobileMe tutorials, 33.  

Also see MobileMe.
report crashes to, 415
support pages for users, 33

Apple ID
get one, 421
change your own password with,  

331, 333, 337, 415, 421
connect to another computer using 

Apple id, 394–395
share songs on Home Sharing  

in iTunes, 192–193
Apple menu, where is it? 4
application menu, 4–5, 50

applications  
Also see Applications folder.

access special printing features, 319
buy more in the App Store, 222–223
change default app to open files, 72
force quit an application, 408
full-screen mode

how to use full-screen mode, 54
apps are in their own Spaces, 296–301

hide the open app or other apps, 263
Launchpad, view all your apps, 49
open an app from the Dock, 22
quit an application, 263
Spotlight can search in many 

applications, 354
switch between open applications, 

262–263
windows for applications

show and hide from the Dock, 
304–305

show and hide on the Desktop, 302
Applications folder

Dock, add Applications folder to, 48
Launchpad to access apps,  

icon in Dock, 22
view in Finder window, 48

Application Switcher, 262–263
App Store 

what is it? 222–223
download Lion from, 434
icon in Dock, 22

Arabic characters, 254
Audible account, deauthorize your Mac 

before migrating files, 438
audio recordings

audiobooks, buy/listen to in iTunes, 196
make your own 

in Photo Booth, 239
in QuickTime Player, 244

QuickTime Player
listen to in, 240
trim recordings in, 242

AutoSave, in TextEdit, 59

B
Back and Forward buttons, 7
backup your files

Address Book database, archive it, 126
Local Snapshots in Time Machine, 375
make backups before upgrading os, 434
on paper, 372
Restore System from Backup, 437
store in two different places, 433
versions, temporary backups, 59, 203
with Time Machine, 371–378
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battery power
keyboard, how much is left in, 289
mouse, how much is left in, 290

Bing, search with in Safari, 130
Bonjour, as part of iChat, 182, 400
bookmarks 

Safari bookmarks, 132
dvd movies, make bookmarks in, 226

Boolean operators, search with, 364
browser. See Safari.
Burn Folder to burn a cd or dvd, 224, 225

C
calendar software. See iCal.
Carter, Ross, 57 (Pagehand), 228
CDs and DVDs

audio cds
import music into iTunes, 191
burn audio disks, 194

burn disks
of data, 224–225
of music, 194

disk is stuck in the drive, 417
eject a cd, 37
how much do they hold? 224, 225
icon in Finder window Sidebar, 37, 276
icon on Desktop, hide or show, 37
transfer files with, 440
unburned disk, how to eject, 225

Characters viewer, how to use it, 254
chat. See iChat, FaceTime.
Chinese characters, 254
clean install Lion OS, 435
Clean Up windows or Desktop, 281, 287
clip art, how to add to text, 254
clutter on your Desktop, manage it  

with Mission Control, 296–305
color labels, 278, 443
Colors panel, 256
Column View in Finder windows,  

16–17, 38
add other sort columns to window, 278
file sharing, keep track of which 

computer you’re using, 394
customize the Column View, 285
rearrange the columns, 278

can’t rearrange the columns, 280–285
resize text and icons in, 285
select multiple items in, 40–41

Command key
keyboard shortcuts with, 28–29
select multiple files with, 40

computer name, 392

connect to the Internet, 382–405
assistance for connecting

ISP (Internet Service Provider),  
385, 386

online, 383
Locations for connectivity, 384–385
Network Diagnostics tool, 385
Network system preferences, 382–385
reset button on modem box, 386
set the connection order, 383
troubleshoot your connection, 384–386

contact sheet of photos
in Mail, view attachments as, 106
in Preview, 202, 208
in Quick Look, 21

contextual menus
how to use them, 42–43
Address Book contact search, 368
change default app to open files with, 72
change toolbar view, 43
Control key symbol, 28, 443
data detectors, 255
dictionary 

access Dictionary at any time, 71
add words to user dictionary, 249, 251
Dictionary panel and more, 259

Get Info on a file, 283
labels, apply colored labels to files, 278
Mail icon in Dock shows messages, 98
read text aloud, 43
set up the secondary click/ 

right-click, 290
show Inspector pane, 283
spelling

spell check, 43
add the word to the dictionary,  

249, 251
fix spelling, 251

contiguous, what is it? 67
Conversations in Mail, 84–85
copy

documents with the page proxy, 267
music from iTunes, 192–193
paste and match style, 61

Cover Flow view
of bookmarks in Safari, 133
in Finder windows, 18
select multiple items in, 40–41

crop a photograph in Preview, 204
currency symbols, 254
Cyrillic characters, 254

D

Dashboard, 306–311
how to open it, 307, 310
manage your widgets, 311
occupies its own Space, 297, 298
web clip widget, make one in Safari, 141
Widget Bar, hide or show it, 306–307

data detectors
overview of, how to use, 255
icons to open in Quick Look, 21
in Mail, 82, 102–103
in TextEdit, 70

Date & Time preferences, 291
deauthorize computer, 438
DemonBells, 84–85, 104–107
Desktop

what is it? 4–5
contextual menu for, 42
customize 

the Desktop background, 291
the Desktop view of files, 287

Desktop folder in Home folder, 9
Hard Disk icon on Desktop, 4, 276

Desktop & Screen Saver preferences, 291
Devices item in Finder windows, 37

hide the device names, 6, 36
dial-up connection, Mail preferences  

for checking Mail, 81
Dictionary application

Dictionary contextual menu, 71, 259
Spotlight search accesses Dictionary, 360
widget for Dictionary, 309

disconnect from shared volumes, 398
disk images, create encrypted ones, 427
disks

burn data onto, 224–225
burn music onto, 194
is stuck in the drive, 417 
encrypt a disk image for security, 427
external disk for transferring files, 440
partition the hard disk, 436

Disk Utility
partition the hard disk, 436
repair disk permissions, 410, 436
repair disk, 411

dividing line in the Dock, 22–23
divination characters, 254
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Dock
what is it and how to use it, 22–25
Applications folder, add to Dock, 48
App Store icon in, 222
customize it to suit your needs, 274–275
dividing line, options on, 275
Dock Exposé for managing application 

windows, 304–305
Downloads folder in, 105

view contents in and customize view, 107
hide or show the Dock, 274–275
icons in Dock

make them bigger, 274–275
minimize application windows  

behind icon, 275
show indicator lights for open apps, 

274
minimize windows to Dock, 275
missing Dock, how to find it, 23
position Dock on left or right of screen, 

274–275
printer icon, put it in Dock, 323
spring icon on right side of Dock, 266
System Preferences for, 274–275
web locations in, 23, 266

Dock Exposé
manage application windows, 304–305
show Address Book contacts in, 127

documents
drop on application icon to open, 268
page proxy, take advantage of it, 

267–268
saving your documents

make versions of documents, 59, 203
save into a particular folder, 44, 266

throw away a file, 26–27
Documents folder

in Dock, 24–25
in Home folder, 9

dot Mac account. See MobileMe.
downloads, Downloads folder

attachments in email, how to download, 
105, 107

in Dock as a stack, 24–25, 107
in Home folder, 9
AirDrop files are saved into folder, 399
view contents in and customize view, 

24–25, 107

drag-and-drop
contact info, send through email, 266
Mail, add name to message, 265
miscellaneous tasks with, 269
open documents into other apps, 268
page proxy to copy, email, iChat, 267
save a file into a specific folder, 44, 266
spring-loaded folders, drop files into, 268
text clippings, how to make, 265
text from one app to another, 265
text in a document window, 264
web location file, how to make one, 266

Drop Box
set permissions to create, 444
share files through

from another computer, 394
users on one Mac, 342

DVD Player, 226–228
bookmarks in a dvd, how to create, 226
disk jacket, create one for a dvd, 228

DVDs
burn a data dvd, 224–225
create personal disk jacket for display, 

228
eject a dvd, 37
how much does a dvd hold? 224, 225
icon in Finder window Sidebar or on 

Desktop, hide or show, 37, 276
idvd is not covered in this book, 55
movies, watch with dvd Player, 

226–228
region code, change it, 227
stuck disk, how to get out, 417
unburned disk, how to eject, 225

E
Edit menu, 50
eject

disk is stuck in computer,  
how to get it out, 417

symbol for, 37
unburned disk, how to eject, 225

email. See Mail
emoticons, add to your text, 254
empty the Trash, 26–27

Empty Trash securely, 279
put back an item you put in Trash, 27

encryption
encrypted disk images, create them, 427
FileVault encrypts your Mac, 430–431

Ethernet switch to network Macs, 391
Exchange

set it up calender in iCal, 156
set it up in Mail, 77–79
set it up in System Preferences, 76
sync Address Book with, 111

Exposé
Address Book contacts in, 127
Dock Exposé to manage app windows, 

304–305
preferences for, 298, 303

extensions
what are they? 444
hide or show extensions, 73, 279

F
FaceTime 

how to use it, 185
Address Book, make video call from, 115
icon in Dock, 22

fast user switching, 334, 336, 338–339
fav icon in Safari location field, 266
Favorites section in Finder windows, 36
faxing

pdfs, send to fax, 230
Preview, fax from it, 219

feet and inch marks, 68
file formats

extensions indicate the file format,  
73, 279, 444

Preview can change file formats, 207
save as a different file format, 73

File menu, 50
files

attach to email, 104
comments, add to a file, 283
display file size of graphics, 281, 282
find earlier versions through 

Time Machine, 376–378
hide or show extensions to names, 73, 279
lost files, search Time Machine, 378
open a file you created earlier, 44
organize files with colored labels, 278
Postscript, save a file as, 230
save a file into a particular folder, 44
secret love notes in a file, 283
versions of, 59, 203

file sharing
afp for file sharing, 396
AirDrop, share files with, 399
Apple id, connect using it, 394–397
Bonjour, share files locally, 182–183, 400
connect to another Mac to share files, 

394–397
disconnect from other Macs, 397, 398
Drop Box

share files between users, 342
share files from another computer, 394

Go menu 
connect to other Macs, 396–397
screen sharing, connect to server, 403

Group user account and file sharing, 336
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Guest, connect as, 394–397
iChat

share files locally with Bonjour, 400
share iPhoto, 181
share movies or files, 180
share web pages, 181

keep track of which computer  
you’re looking at, 394

local network, what is it? 36
migrate files from one Mac to another, 

437
movies, share via YouTube, iTunes, 

MobileMe, 242–243
music, share yours in iTunes, 192
name and password on the other 

computer, 395, 396
one Mac, share files with other users, 

342
permission settings, who gets to share, 

343, 392–393, 444
Personal File Sharing, 392–399
Public Folder file sharing, 342, 392–393
Registered User, connect as, 394–397
send files by email, 104
Shared folder for users on one Mac, 342
sharing folders in your Sidebar, add one, 

36, 395
Target Disk Mode to transfer files, 439
transfer files, a variety of methods, 

440–441
Windows users

share files with, 393
share music with, 192–193

FileVault, for heavy-duty security, 430
Finder

what is it? 4–5
background image on, 291
customize the Finder, 276
Hard Disk icon on Desktop, 4
relaunch the Finder when it acts funny, 

409
Finder preferences

advanced preferences, 279, 353
Desktop

background image for, 291
Hard Disk icon, show on Desktop, 4, 276
show connected servers on Desktop, 398
preferences for view, 276, 287

general preferences, 276–277
label colors for files, 278, 443
search options in, 353
Sidebar items, hide or show, 13, 279

show connected servers in Sidebar, 398

Finder windows
what are they? 4
window features explained, 6
arrangement of items in window

Arrange by menu, 6, 280–285
in Icon View, 280–281
in List View, 282–284

change the view of, 14–18
Column View

basics of, 16–17
customize the Column View, 285
resize text and icons in, 285

Cover Flow View in, 18, 286
defaults

create defaults for window views, 280
restore window to original view 

defaults, 280, 282
grid spacing in windows, control it, 281
Home folder icon in, 8–9, 279
icons

enlarge size of text label, 281
eyeball in Toolbar (Quick Look), 20–21
resize icons 

in Column View, 285
in Cover Flow view, 286
in Icon View, 6, 280–281
in List View, 282

show previews of files, 281
Icon View in

basics of, 6, 14
customize the view of, 280–281
rows of files, why is that? 280–285

labels column, show it, 278
List View in

add color labels column in, 278
add comments to a view and  

view them in the window, 283
add or delete columns, 282–283
basics of, 15
customize the List View, 282–284
organize the columns in, 284

minimize windows
choose Genie or Scale effect, 275
click the yellow button, 7, 304–305

move a window, 6, 50
open windows

in a new, separate window, 17
control windows with Exposé, 302–305

Path bar in, 6–7
preferences for, 276–279
Quick Look icon in Toolbar, 20–21
red, yellow, green buttons in, 7
resize the window, 6
rows of files, why is that? 280–285

Sidebar
add or remove items from, 279
Burn Folder, add to Sidebar, 224
gear icon in, Smart Folder, 366

sort items with or without  
an arrangement, 285

spring-loaded folders and windows, 276–277 
Status bar in, 6–7
text size of the labels, resize it, 280–281, 

282, 285
Title bar in, 6
Toolbar in, 6–7
View buttons in, 6

finger someone, 437
firewalls

Firewall pane in Security prefs, 424
part of security on Mac, 420

FireWire
icon for FireWire, 416
share files via FireWire, 441
target disk mode, how to use it, 416

Fkeys, 28
Flash drive installer

order for upgrading to Lion, 434
reset Admin password with, 422

Flickr, export movies to, 242–243, 245
fn key

affects keyboard shortcuts, 289
use in combination with F9, 297

folders
add notes to a folder file, 283
application folders, 48
Burn Folder to burn a cd or dvd, 224
contextual menu for, 42
create a new folder 

from a selected group of files, 42
create your own new folders, 10

display number of files in folder, 281
Dock, add folders to, 23
Launchpad folders look different, 49
move a folder, 11
open a folder, 11, 276–277
organize them with colored labels, 278
Public Folder, use it to share files, 342, 

392–393
put something inside a folder, 11
rename a folder, 11
save a file into a particular folder, 44

drag the folder to the Save As window, 266
share specific folders with other computers, 

392–393
spring-loaded folders, 276–277
stack folders look different, 25

Font Book, 232–233
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fonts
Characters viewer, how to use it, 254
clip art, how to add to text, 254
disable specific fonts, 233
Fonts panel, 252–253
install fonts with Font Book, 232–233
preview fonts, 232–233, 252
shadow effects, add them, 253
stored in Library folders, 39
view only English language fonts, 233

force quit an application, 408
Foz, 286
full-screen mode

apps occupy their own Spaces,  
297, 299

as part of Mission Control, 296–301
how to enter and exit, 54, 299, 300
in iCal, 164

G
GarageBand

icon in Dock, 22
not covered in this book, 55

gear symbol 
Action menu, 43
Smart Folder, 366
Smart Mailbox, 92–93, 97
Smart Playlist, 191

gestures
choose the ones you want to use, 290
examples of using on your Mac, 7, 19

Address Book, show Exposé  
view of, 127

iCal, turn calendar pages with, 156
Mission Control, use with, 297
Safari, browse web pages with, 152
Spaces, maneuver with, 300

Get Info window
what is it? 443
add keywords for searching, 359
disk, how much space to burn, 225
file sharing permission in, 343,  

393, 444
store comments in Get Info window,  

283, 359
glyphs, preview available ones, 233
Go menu

file sharing, connect to servers, 
396–397

screen sharing, connect to server, 403

Google
Gmail and other accounts

set it up in System Preferences, 76
set it up in Mail, 77–79

Google calendar
set it up in System Preferences, 76
set it up in iCal, 156

Google Talk account, 168
map a location

from an Address Book contact, 115
from an email message, 103

grammar check, 248–251
gray vs. black commands in menu, 29
Greek characters, 254
green button to resize window, 7
green dots under words, 248, 250
green plus sign when dragging, 267
Grid view of Dock folder contents, 25

H
Haney, Brianna Nora! 234
hard disks

icon on Desktop, show or hide it, 276
makes noise? 408
name in Sidebar, 37
path to see files, 38
Target Disk Mode, use another 

computer as a hard disk, 416
Hebrew characters, 254
Help files, where are they? 32
hide all other or the open application, 

263
Home folder

what’s in it? 8–9
add your Home to the Sidebar, 8, 279
view its path, 38

Home Sharing, 192–193
Hot Corners for screen activity, 298, 

303
hover

what is a hover? 31
display tool tips, 30
hide or show items in Sidebar, 36
show items in Sidebar, 394

HTML mail, 88–89
hub for connectivity, 391

I

iCal, 156–165
overview of window, 156
backup calendar data, 162
birthdays calendar, 161
calendar settings, set up in Mail, 76
calendars list, 157
create a new calendar, 157
data detectors 

can add info to iCal, 255
in Mail, use to create Events, 102

delete a calendar, 157
email

an invitation or notification, 159
a reminder to someone, 160

Events
create Events, 158
invite contacts from Address Book, 121
link them to Reminders, 162
notify others of Events,  

get responses, 159
preview files attached to Events, 162
publish your calendar of Events, 163

full-screen mode, 164
group calendars, 157
icon in Dock, 22
invitations, send to people, 159
invitees are highlighted blue or not, 121
printing calendar pages, 165
Reminders, 160

link them to Events, 162
subscribe to a calendar of Events, 163

iChat, 167–185
account, get a chat account, 168
audio chat, 174–175
backgrounds for fun effects, 178–179 
Bonjour to share files or chat  

on local network, 182–183
Buddies list, how to make one, 170
buddy name, where to get one, 168
chat rooms for groups of people, 173
data detectors, watch for them, 21
effects and backgrounds, 178–179 
emoticons in, how to add, 171
enable the account, 169
end a chat, 171, 173
examples of chats, 168, 171

of group chat, 173
file sharing

with Bonjour on local network, 400
with iChat Theater, globally, 180–181
with screen sharing, globally, 404

fonts and colors in chat,  
customize them, 169
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green orb in Mail, 83
Group buddy list, 170
group of people, chat all together, 173
merge chats into one window, 172
message cloud, 182
multiple chats in one window, 172
organize your Buddies list, 170
phone, send text messages to, 170
photographs

photo of you or buddy, change it, 174
use Photo Booth to take photos, 

236–239
record an audio or video chat, 184
save your text chats, 169
send a file with a page proxy, 267
set up a new account, 76
share files, movies, web pages  

with others, 180
smileys in, how to add, 171
Tab Bar in, 172
text chat 

one on one, 171
with a group, 173
to a phone, 170

tool tips in, 31
track iChat use for a managed user, 347
video chat, 176–177
visual effects and backgrounds  

for fun, 178–179
icons

arrow (teeny tiny arrow) in bottom-left 
corner is an alias, 224, 443

Dock icons, 22
double arrows in right corner of 

windows (full-screen mode), 54
FireWire icon, 416
preview file image in Column View, 285
resize icons in Finder window

in Column View, 285
in List View, 282
in Icon View, 6, 14, 280–281

resize icons on the Desktop, 287
shared volume icon, 397

Icon View
arrangement of window, 280–281
enhanced Icon View, 14
preview movies and documents in, 14
resize icons in, 6, 280–281
select multiple items in, 40
View options for, 14, 280–281

iCloud, 310–311
iDisk, storage space in MobileMe, 37
iDVD, not covered in this book, 55

IMAP account, when to choose, 77
iMovie

icon in Dock, 22
not covered in this book, 55

IMs. See iChat.
inch marks, 68
Incoming Mail Server, 78
Info window

disk, how much space to burn, 225
store comments in the  

Info window, 283
Inspector window, 

how to open the Inspector, 283
add keywords for searching, 359

instant messages. See iChat.
Intel Core 2 duo processor, 434
international

Characters panel lets you access 
international characters, 254

change keyboard language, 293
listen to radio from around the world, 

196
region code for dvds, change it, 227
time zone, set it for your Mac, 291
type quotation marks for other 

languages, 68
Internet

browse the web. See Safari.
connect your Mac to the Internet, 

382–405
iPad

FaceTime, make call to/from  
Address Book, 115

sync Address Book contacts, 110
iPhone

add photos to Address Book contacts, 
112

FaceTime for video chat from 
computer, 185

send text messages via iChat, 170
sync Address Book contacts, 110
sync Mail Notes, 100

iPhoto
not covered in this book, 55
album metaphor in, 52
Desktop background pattern,  

use your own photo, 291
icon in Dock, 22
Mail, access iPhoto to add photos,  

89, 104
save photo email attachments  

to iPhoto, 105
share albums through iChat Theater, 

181

iPod
disconnect from Mac, 37
icon in Finder window Sidebar or  

on Desktop, hide or show, 37
ISP, help for Internet connection, 385–386
iTunes, 187–199

overview of the iTunes window, 188
account, get one, 189
add text as voice to iTunes, 257
album art, display it, 188, 189
audiobooks, buy and listen to, 196
buy music, movies, or tv shows, 189
controls for movie watching, 195
copy songs from one Mac to another, 

192–193
deauthorize your Mac before migrating 

files, 438
DJ, automatic mixes, 197
full-screen mode

button for, 188
while watching movie, 195

Genius Playlist, automatic list  
from your Library, 197

Genius Sidebar, 197
show or hide Sidebar button, 188, 197

Home Sharing, 192–193
icon in Dock, 22
import songs from cds, 191
iTunes DJ, automatic mixes, 197
iTunes Match, 311
iTunes U, 187
lectures and courses, iTunes U, 187
movies

export from QuickTime Player, 242, 
245

transfer a movie from one  
Mac to another, 192

watch movies in iTunes, 195
pdfs, add to iPhone or iPad, 230
Ping, 188, 198
Playlists

album art, display it, 188, 189
control playback, 188
create Playlists, 190
Genius Playlist, 197
iTunes DJ, 197

play songs, 188
preferences

choose what to display in Sidebar, 190
share your music, 192

print cd covers, 198
recommends songs for you, 197
search field, 188
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share your music on a local network, 
192–193

shuffle music playback, 188
Sidebar in, 52

choose what to display in, 190
gear icons, Smart Playlists, 191
Genius Playlist in, 197
iTunes dj in, 197

Smart Playlists
create them, 191
examples of in Sidebar, 190

sync Address Book to devices, 110
sync Mail Notes to iPhone, 100
television shows, watch them  

in iTunes, 195
transfer songs or movies to another 

computer, 192–193
Visualizer, visual reactions to music, 

199
iWeb, not covered in this book, 55

J
Jabber account, 168
Jonson, Ben, 31
JPG files, change to another format, 207

K
Kerberos, 420
keyboard

change keyboard language, 293
system preferences for, 289
wireless keyboard, how much battery 

power is left? 289
keyboard shortcuts

how to use them, 28–29
fn key affects shortcuts, change  

its setting, 289
modifier keys for, 28, 445
paste and match style, 61

Keychain Access
what is it? 420
how to use it, 428–429
password for Keychain Access, 422
screen saver lock for security, 426

Keynote, not covered in this book, 55
keywords, add to files, 359
Korean characters, 254

L
labels

what are they? 443
organize files and folders  

with colored labels, 278
languages

currency symbols, 254
quotations marks for, 68
special characters in, type them, 254
spell check in another language, 248

laptops
date and time, set it for traveling, 291
fn key use, 289, 297
restarting, 409
security precautions for, 431
trackpade use. See trackpad.

Launchpad
how to use it, 49
icon in Dock, 22

Library folders
access Home Library folder, 413
access the invisible user Library 

folder, 39
List View

can’t rearrange the columns, 283, 284
comments column available in, 283
customize the List View, 282–284
organize the items in, 284
select multiple items in, 40–41

Little Mac Book
learn to use a word processor in, 57
proceeds at a slower pace, 3

local network
what is a local network? 36
devices show in Sidebar, Shared, 36
file sharing on. See file sharing.

Local Snapshots in Time Machine, 375
Locations for Internet connectivity, 

384–385
Lock Screen option in menu bar, 426
login to, logout of Mac

as Guest, 330
automatic login, 334, 337

turn it off for security, 425
login window, customize it, 335
log out

how to, 337
auto logout after certain number  

of minutes, 423
password hint for login, 335, 337

lookup, run one, 437
love notes, add to file Info box, 359, 

283

M
MacBook Air, remote install OS, 441
Magic Mouse

general use of with gestures, 7, 19
gestures

in Address Book contacts,  
show Exposé view of, 127

in Mission Control, 297
in Safari, browse web pages, 152
in Spaces, move between Spaces, 300
in iCal, turn calendar pages, 156

options for, set them up, 290
Magic Trackpad. See trackpad.
magnifying glass in corner of screen, 352
Mail

accounts
choose from which account to send 

mail, 87
edit an existing account, 80
new email account, set it up,  

76–79, 80
put an account on hold, 80

address a message
To field, 86
drag address from Address Book, 265

add sender to Address Book, 110
attachments

attach a file to a Note, 101
attach a file to outgoing message, 104
download attachments, 105 , 107
export attached photo to iPhoto, 105
view as a contact sheet, 106

Bcc, what is it? 87
blue orb, 81, 83
Cc, what is it? 87
Characters viewer, how to use it, 254
classic version of Mail, revert to it, 81
compose a message, 86–87
Connection Doctor, 389
Conversations

delete one, delete them all, 85
examples of, 82, 84–85
how to work with them, 84–85

data detectors in, 82, 102–103
date, organize messages by, 82
dictionary, look up a word in, 259
Dock icon

Downloads folder icon in,  
manage it, 105, 107

Mail icon, take advantage of it, 98
email

add a link or a web page, 139
add attachments to, 105
won’t go out, what to troubleshoot, 

388–389
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Favorites Bar in
add, delete, or rearrange items in, 82
turns into Search Bar, 96–97

filters, also called Rules, 91
flagged messages, 90, 96

color coded, 100
Fonts panel in, preview fonts, 252–253
formatting options in, 86

if you can’t format the text, 87
forward messages, 86
full-screen view, 82
green orb, 83
hover to display tool tips, 31
html mail as stationery, 88
iCal, data detectors to create Events, 

102–103
icons in Mail

compose new Note, 99
delete icon, 81
Forward this message, 81
gear icon in Sidebar, 92
gray border, gray triangle, 102–103
New Message icon, 81
paperclip, 104
Photo Browser, 89, 104
Reply, Reply All, 81
Send icon, 86, 104
stationery, 88

Incoming Mail Server, 387
junk mail, resize pane to avoid 

viewing, 83
mailboxes

what are they? 90
filter incoming messages into, 91
make new mailboxes, 90
Smart Mailboxes, 92–93, 97

Mail Connection Doctor, 389
make a movie of yourself at the 

computer and email it, 239, 
244–245

Message List
what is it? 83, 84
display photos in, 82
organize (sort) the Message List, 82

Message Pane
what is it? 83, 84
format text in, 86
number in message, 84
photos display in, 81
resize it to avoid viewing junk mail, 83

message windows
drag text and drop on Mail icon  

in Dock, 269

open email message in separate 
window, 81

options in window, 86–87
search an individual message, 97
send fancy stationery, 88–89

MobileMe accounts in Sidebar, 90
Notes, 99–101

create a new Note, 99
display in Message List, 99
send a Note as an email, 101
sync Notes with iPhone, 100

outgoing Mail Server (smtp),  
78–79, 388

send email from a different  
smtp account, 87

paste and match style, 61
pdf, create and email one, 230
Photo Browser

add photos to mail messages, 104
add photos to stationery, 89

photos
appear in Message Pane, 81
email photos of yourself, 236
how to make them appear, 82

Plain Text does not allow formatting, 87
preferences you can change

Composing preferences, set defaults, 
87

how often to check for mail, 81
number of lines that show in the 

Message List, 81
Rules to filter incoming mail, 91
sending to a Group, do not include 

all addresses, 116
text labels under toolbar icons, 81

Previous Recipients list, 86
prioritize an outgoing message, 86
Quick Look to view attachments, 106
read your email, 81–85

open email message in separate 
window, 81

red dotted lines in message, 86
reply, reply all to messages, 86–87
Reply to (another address), 87
resize

Mail window, 82
panes, 82

Rich Text, allows formtting, 87
Rules to filter messages, 91
save as draft, 83
search messages, 96–97

Spotlight search in, 354, 368

send 
a file with a page proxy, 267
a message, 86–87
attachments, 104
messages to a Group of people, 116

Sidebar
gear icon in, Smart Mailbox, 92
hide or show it, 83
in typical Mail layout, 84
mailboxes in, 90
Notes in, 99–101, 100–101

signatures
create your own, 94–95
menu listing signatures, 87

Smart Mailboxes, 92–93, 97
smtp (outgoing Mail Server),  

78–79, 388
send email from a different  

smtp account, 87
speech, have text read aloud to you, 257
spell checker, 248–251

with contextual menu, 43
stationery, how to create it, 88–89
threads in. See herein Conversations
toolbar

customize the toolbar, 82
view text labels under icons, 81

tool tips in, 31
troubleshooting

email won’t go out, 388–389
Mail account in general, 387–389

unfolds itself, the message, 82
User Authentication, 79
user name and password

enter to create account, 76–80
vendor account password might  

be different, 387
vCards for contact info, 266

Mail, Contacts & Calendars, 76
map a location, 103, 115
MarinerWrite, 57
master password, 331
math symbols, how to type, 254
McDonald, Nikki, 84–85, 91
McMillin, Jamie and Carla, 81–83, 99
McNally, Barbara, 203, 251
menu bar and menus

where is the menu bar? 4
date and time in menu bar,  

customize the display, 291
finds commands in menus, 32
keyboard shortcuts instead of using 

the menu, 28–29
symbols for modifier keys, 28, 445
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metadata, make it searchable, 358
migrate your files, 437–439
Microsoft Exchange

Exchange calendar
set it up in System Preferences, 76
set it up in iCal, 156
set it up in Mail, 77–79

sync Address Book with Exchange, 111
Microsoft Word

open Word docs in TextEdit, 72
save files as Word docs in TextEdit, 73

migrate your files, 433–441
minimize windows

Dock Exposé to minimize and display 
application windows, 304

preferences for minimizing, 275 
yellow button to minimize, 7

Mission Control, 296–305
example of screen, 296
preferences for, 298, 303–306

MobileMe
free chat account with, 168
free email account with trial, 76
iDisk, use it to transfer files, 440
mailboxes in Mail, 90
movies, export from QuickTime Player, 

242–243, 245
set up account easily, 76
share Address Book contact list, 122–123
share iCal calendars, 163
sync Address Book with, 111
tutorials for, 33

modifier keys for keyboard shortcuts, 
28, 445

mouse
contextual menus with, 42–43
gestures with mouse, 19, 290
hover, how to, 31
right-click, turn it on for your mouse, 

290
system preferences for, 290

movies
bookmarks in a dvd movie, 226
full-screen dvd view, toggle between, 

228
iChat Theater to share movies, 180
make a movie of yourself at the 

computer
with Photo Booth, 239
with QuickTime Player, 244

special effects in, create in  
Photo Booth, 237

trim movie clips in QuickTime Player, 
242

watch movies
in iTunes, 195
in QuickTime Player, 240–241
with dvd Player, 226–228

Movies folder in Home folder, 9
Multi-Touch gestures. See gestures.
Multi-Touch input device, 7, 19
music. See iTunes.
Music folder in Home folder, 9
music symbols, how to type, 254

N
name of your Mac, 392
Nelson, Jan, 184
networking

Location settings, 384–385
Network Diagnostics tool, 385
network port configurations, 382–383
Network preferences, 382–385
network your computers, 390–391
peer-to-peer network, 391
set service order for connectivity, 383

news. See RSS feeds.
Next and Previous buttons in Finder 

windows, 7
No Access to a file, 444
non-contiguous, what is it? 67
Non-Designer’s Presentation Book, 55
numbered list 

example of in Mail’s Notes, 99
example of in TextEdit, 64

Numbers, not covered in this book, 55

O
Open dialog box

open a file you created earlier, 44
search for files in, 369

organize
color labels to color-code files, 278
columns, add sorting columns, 278

Outgoing Mail Server (SMTP),  
78–79, 87, 388

P
Pagehand, 57
page proxy, take advantage of it, 267–268
Pages, not covered in this book, 55, 57
pair a remote with your Mac, 423
parental controls

on the web in Safari, 144
user account and parental controls, 

344–346
partition the hard disk, 436

passwords
Admin password, 421

versus login password, 422
Apple id to reset password, 331, 337, 

415, 421
choose not to have a password, 421
email account password versus  

Internet account password, 79
forgotten passwords, how to change, 

415, 422
hint for forgotten password, 332, 

334–335, 337
Keychain access stores passwords, 420
login passwords, 337, 422

master password, 331
require password to wake from sleep, 426
reset Admin password, 436
set a firmware password, 436
tips for choosing, 422

paste and match style, 61
Path bar in Finder window, 6–7
PDFs

add to iPhone or iPad, 230
annotate a pdf, 212–213, 214–215
make a pdf, 229–231, 258
Preview

use it with pdfs, 208–217
Bookmarks in pdfs, 210
copy editable text from, 211
search a pdf in, 209

preview a document as a pdf, 53, 258
save Address Book info as pdf, 124
save documents as, 73
save to Web Receipts Folder, 230–231
send as attachment, 104
signature, digitize it for documents, 216

peer-to-peer network, 391
permissions

what are the options? 444
Get Info pane, set and change 

permissions, 343, 393, 444
Personal File Sharing, 392–399
phone

audio chat via iChat, 174–175
FaceTime for video chat from computer, 

185
send text messages via iChat, 170

Photo Booth, 236–239
4-up, old photo booth photos, 238
icon in Dock, 22
make a movie of yourself  

at the computer, 239
printing options in, 319
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photographs
add to Address Book contacts, 112
add to Mail stationery, 89
attach to email, 104
change to another file format, 207
crop a photo in Preview, 204
download from email, 105
import images into Preview from  

a camera, 207
Quick Look 

view photos in Mail, 106
view photos on the Desktop, 20–21

sepia tone, change photo to, 205
share through iChat Theater, 180–181
use as your Desktop background, 291
use Photo Booth 

4-up photo booth photos, 238
create special effects in, 237
to take photos, 236–239

Picture 1, Picture 2, etc., 444
Pictures folder in Home folder, 9
ping your modem, 437
Ping in iTunes, 188, 198
.plist file, 413
PNG files, change to another format, 207
pointers, tip is the only hot spot, 26
POP account

set it up in Mail, 76–79
user name and password might be 

different from email, 78
when to choose, 77

port configurations, 382–383
port scan, 437
Postscript, save a file as, 230
preferences. See also System 

Preferences and individual apps
brief overview, 51
delete preferences file to troubleshoot 

an app, 413
delete third-party system prefs, 292

Preview application, 201–219
open images or documents in Preview, 

202
colors, adjust them, 205
Contact Sheet view, 202, 208
Continuous Scroll option, 208
crop an image, 204
duplicate a file, 203
fax a document from, 219
icon in Dock, 22
import images into Preview  

from a camera, 207

pdfs, how to work with, 208–217
annotate a pdf, 212–213, 214–215
Bookmarks in pdfs, 210
copy editable text from a pdf, 211
create page or web links on a pdf, 

214–215
display facing pages or continuous 

pages, 208
open multiple pdfs simultaneously, 

208
search a pdf, 209

preview page before printing, 53, 258
print documents or images from, 218
scan images into Preview, 207
screenshots, how to make them, 206
sepia tone, change photo to, 205
Sidebar

open thumbnails in, 202
results of pdf search in, 209
view multiple pdfs in, 208

signature, digitize it for documents, 216
size, resize an image, 205
Thumbnails view, 202, 208
tool tips in, 30
unlock a file, 203
versions of files, 203

Previous and Next buttons, 7
printing, 313–325

access special features
of your printer, 318
of your software, 319

add a printer, 314–316
drivers for printing, 314–316
how many pages left to print? 323
icon in Dock for printer, 323
pdfs, create through the Print  

dialog box, 229
preview before you print, 53, 258
printer utilities, how to access, 324
Print & Scan Preferences, 314–316, 324
print these items:

cd covers from iTunes music, 198
contact list of addresses, 124–125
documents, 317–319
envelopes, 124–125
iCal calendar pages, 165
mailing labels, 124–125
Preview, print documents or images 

from, 218
Safari, print web pages, 142

problems, troubleshooting, 322–323
queue in printing process, 322–323
share a printer, 320–321
software for printing, 315–316
toner levels in printer, 324

Print & Scan preferences, 314–316
privacy

Address Book, keep some of your  
info private, 113

limitations on others searching  
your Mac, 356

Safari, private browsing in, 143
Security & Privacy preferences, 

423–424, 430–431
track a managed user’s use  

of the computer, 347
privileges, 343, 393, 444
Public folder

where is it? 342
in Home folder, 9
share its contents with others,  

342, 392–393
Pumpkin, 361
Put Back an item you threw away, 27

Q
queue in printing process, 322–323
Quick Look

attachments in email, 106
how to use it, 20–21
preview of search results in Spotlight, 

352, 361
QuickTime Player, 240–245
quit the open application, 263

force quit an application, 408

R
radio, listen to in iTunes, 196
Read Only permissions, 444
Read & Write permissions, 444
Recent files, display on screen, 302–305
red button in Finder window, 7
red dots under words, 66, 248, 250
region codes in DVDs, 227
relaunch the Finder, 409
remote, Apple remote

prevent it from controlling computers 
around you, 423

Remote for iPhone or iPad, 197
remote install Lion on a MacBook Air, 

441
repair disk, 411
repair permissions, 410, 436
replace text, 60
reset button on modem box, 386
restart to fix minor Mac problems, 409
Restore System From Backup, 437
resume feature in Lion, 409
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right-click
contextual menus and, 42–43
set it up as the “secondary click,” 290
when it might be a left-click, 290

Riley, Barbara, 368
Rosetta, 352
rotating cube Desktop, 338–339
RSS feeds in Safari, 145–151

S
Safari

Auto-Click to open collection in tabs, 134
AutoFill, fill in user ids and passwords 

automatically, 135
block pop-up windows, 135
bookmarks

Auto-Click to open all bookmarks, 134
Cover Flow view, hide or show it, 133
open a collection of bookmarks  

in tabs, 134
organize bookmarks into folders, 

132–133
rss feeds, bookmark them, 148
show all bookmarks, 130
+ sign to add a bookmark, 130
tabs, create bookmark folder from, 153

Bookmarks Bar
where is it? 130, 132
open a collection of bookmarks  

in tabs, 134
save a bookmark or folder into 

Bookmarks Bar, 132
Bookmarks Menu, 132
children browsing the web,  

make it safer, 144
Collections (of bookmarks), 132–133

make a collection from tabbed 
windows, 153

dictionary, look up a word in, 259
downloads, keep track of them, 153
email a web page or a link, 139
enlarge or reduce contents  

on a web page, 136
fav icon in address field, 266
favorite web pages, easy access to, 131
fraudulent site, warn when visiting, 152
full-screen mode, 130
History menu

private browsing does not track  
history, 143

reopen windows, 153
search the History, 133

icon in Dock, 22

icons in Safari toolbar
A, large and small, 136
book icon, 132, 133
book icon with lock on it, 144
circle with arrow, 130
double arrow on right end, 130
downward arrow on right end, 153
eyeglasses for Reading List, 151
magnifying glass, 130
Mail icon, put one there, 139
number in parentheses, 148
orange arrow in circle, 136
plus sign +, 130, 153
Reader badge in address field, 150
rss, 145–150
scissors (web clip widget), 141
square next to name  

in Bookmarks Bar, 134
Top Sites (grid icon), 131
triangle in Bookmarks Bar, 148

parental controls for, 144
pdf documents, view in Safari, 139
pop-up windows, block them, 135
print web pages, 142
private browsing, 143
Reader view, 150
Reading List feature, 151
reload a web page, 130
resize 

the browser window, 130
the text on the web page, 136

rss feeds, 145–150
as screensaver, 150
bookmark them, 148
open a collection of feeds in tabs, 134

save 
an entire web page, 140
an image from a web page, 140

scrolling with gestures, 152
search in Safari

Bing, from Google search field, 130
find a word or phrase on the current 

page, 138
Google and others, 130
SnapBack to a search results page, 136
use tabs to open results pages, 137
Yahoo! from Google search field, 130

Services available in menu, 270
SnapBack to a search results page, 136
speech, have text read aloud to you, 257
Spotlight search will send to web, 360
status bar in browser window, 31, 130

tabs
how to use them, 137
close one tab or all tabs, 134, 137
merge windows into tabs, 153

Toolbar
customize it, how to, 130
add Mail link, 139
add resize text button, 136
add web clip widget, 141

tool tips in, 31
Top Sites, 131
web clip widgets, 141
web location file, add to the Dock, 266
web pages know my contact 

information—stop it! 135
web pages—scroll, swipe, arrow keys, 153

safe boot to fix minor problems, 412
save your files

save a duplicate, 59
save as a different file format, 73
save into a particular folder, 44, 266
save versions of a file, restore a previous 

version, 58–59
search the Save dialog box for folder  

to save into, 369
scanning

scanner, set it up, 325
use Preview to scan, 207

screen saver
preferences to set it up, 291
rss feeds as screen saver, 150
set a lock on it for security, 426

screen sharing
globally, over the Internet

via iChat, 404–405
via the Go menu, 403

locally, on the network
via Bonjour, 404
via Finder window, 402
via Go menu, 403

end screen sharing
through the Sidebar, 402
through the Go menu, 403
through iChat or Bonjour, 405

Sharing preferences pane for, 401
screenshots

make screen recordings, 245
make screenshots with keyboard 

shortcuts, 443–444
make with Preview, 206

scrolling, scroll bars
change the scrolling preferences, 115
hidden until you swipe, 6
hide or show the scroll bars, 6
scroll with inertia, 290
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search
in Address Book, 118–119, 368
in Mail, 96–97
on your Mac, use Spotlight, 352–369
search field 

what it looks like, 53
x in search fields, 309

Secure Shell, 420
security on your Mac, 419–431 

See also privacy
automatic login, turn it off, 425
disable remote control receiver, 423
encrypted disk images, create them, 427
FileVault for heavy-duty protection, 

430–431
firewalls, 420, 424
Keychain Access

what is it? 420
how to use it, 428–429
set up screen saver lock for security, 

426
laptops, special security tips for, 431
login, logout

disable automatic login, 334
login as standard user, 426
loutout after certain number  

of minutes, 423
passwords

forgot your Admin password? 422, 436
require password to wake from sleep, 

426
set up screen saver lock, 426
tips for creating passwords, 422

require Admin password to change 
preferences, 423

require user password to wake from 
sleep, 426

Safari, warn when visiting a fraudulent 
website, 152

Security & Privacy preferences, 
423–424, 430–431

set a firmware password, 436
Trash, empty it securely, 427
turn off Sleep and Shut Down buttons 

at login, 425
selecting documents and files in Finder 

windows, 40–41
Services

overview of and how to use, 270
add text as voice to iTunes, 257

Shared folder,  342
Shared item in Finder window

hide the shared names, 6, 36
share your printer with other Macs, 

320–321

sharing files. See file sharing
Sharing system preferences, 392–393

share a printer, 320–321
Sheldon, Carmen, 329
Shift key

select multiple files with, 41
use in keyboard shortcuts, 28, 445

Show View Options
for Column View windows, 285
for Cover Flow View windows, 286
for Icon View windows, 280–281
for List View windows, 282–284
for the Desktop, 287

Shut Down to fix minor problems, 409
Sidebar

AirDrop, share files via, 399
Burn Folder, add to Sidebar, 224
shared volumes in, 397

disconnect from, 398
screen share via a shared volume, 402
show Shared volumes in, 394, 398

Sidebar in Finder windows
where is it? 6, 12–13
add folders to the Sidebar, 8, 12

add files to a folder in the Sidebar, 12
Applications folder, 48
customize the Sidebar, 9, 12, 13
delete folders from the Sidebar, 9, 12
Devices in, 37–38, 276
eject symbol in, 37
Favorites in, add or remove, 36
gear icon in, saved search in  

a Smart Folder, 366
hide the Sidebar, 6
Home, add yours to the Sidebar, 8, 279
resize the Sidebar, 6
Shared in, 37–38

signature 
digitize your real signature, 216
Mail signatures, 94–95, 87

Simple Finder, 344–347
slideshows

in Cover View in Finder windows, 18
in Mail, view email attachments as, 106
in Photo Booth, 238

Smart Folders
in Spotlight, 365–366
Smart Mailboxes based on search 

parameters, 97
Smart Quotes in TextEdit, 68
SMTP (Outgoing Mail Server),  

78–79, 388
send email from a different smtp 

account, 87

Software Update preferences
to help troubleshoot, 414
update security features, 420

Spaces
how to set up and use Spaces, 298–301
add a new Space, 299
Dashboard

is in a Space by default, 310
remove Dashboard from a Space, 298

examples of Spaces on screen, 299
remove a Space, 301

speech, speak aloud
have text read aloud to you, 257
mail messages, 43
TextEdit text, 71

spell checker, 248–251
in TextEdit, 66
with contextual menu, 43

Spotlight
how to use Spotlight, 352, 360–361
comments in Get Info panel, 283
Finder window search

do a quick search, 353, 362
narrow the search with Boolean 

operators, 364
narrow the search with parameters, 

363
keywords, add to files for searching, 359
metadata, make it searchable, 358
preferences

Finder preference to search this Mac, 353
keyboard shortcuts for, 356
search results found in, 355

privacy features in, 356
search in

Address Book, 118–119
Mail, 96–97, 354, 368
Open dialog box, 369
Save dialog box, 369
System Preferences, 293, 367
TextEdit, 354
web pages, send search to, 354

search for attributes, not just file names, 
357, 358

Smart Folders for automatic searches, 
365–366

sort the search results, 363
spring-loaded folders, 268, 276–277
stacks in Dock, 22–25
startup disk, choose which to  

start up from, 436
Status Bar

in Finder window, 6–7
in Safari window, 31, 130
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Stickies application, 234–235
string, what is it? 444
support communities for the Mac, 33
swipe, swiping. See gestures
switch for connectivity, 391
System Preferences

overview of, 288–289, 293
alphabetize the System Preferences 

pane, 288
customize the pane, 292
delete third-party preferences, 292
Finder preferences, 276–279
icon in Dock, 22, 288
require Admin password, 421
scroll bars in windows, 6
search for the one you need, 293, 367
specific preferences

Dashboard (widgets), 298, 310
Date & Time, 291
Desktop & Screen Saver, 291
Dock Exposé, 304
Dock preferences, 22, 274–275
Exposé, 298, 303
Keyboard, 289
Mail, Contacts & Calendars, 76
Mission Control, 298, 303, 310
Mouse, 290
Network, 382–385
Print & Scan, 314–316, 321, 324
Safari, 51
Scanner prefs (Print & Scan), 325
Security & Privacy, 423, 430–431
Sharing, 320, 392–393, 401
Software Update, 414, 420
Spotlight, 355, 367
Trackpad, 290
Users & Groups, 421, 425–426

speech, voice used for, 257
tool tips in, 289

T
tables in word processing, 65
tabs and indents in TextEdit, 62–63
Target Disk Mode to transfer files, 416
technical symbols, how to type, 254
television shows, watch in iTunes, 195
text clipping 

make a text clipping, 265
Spotlight can’t search in, 357 

TextEdit
AutoSave in, 59
can’t format text? 71
capitalize first letters, 70
case, change upper- and lowercase, 70

Characters viewer, how to use it, 254
Complete command to finish typing  

a word, 71
data detectors in, 70
dictionary access in, 71, 259
drag text and drop on Mail icon  

in Dock, 269
duplicate file, 59
find and replace, 60
Fonts panel in, preview fonts, 252–253
links in, email and web, 68–69
new document, create one, 58
numbered lists, 64
page numbering in, 66
page proxy, take advantage of it, 

267–268
paste and match style, 61
pdf, save documents as, 73
quotation marks in, 68
Recent files, display on screen, 302–305
ruler, hide or show it, 71
saving files in, 59
search in document, 354
select non-contiguous text, 67
speech, have text read aloud to you, 257
spell check in, 43, 66, 71, 248–251
style sheets in, how to create and use, 61
Substitutions, 68–70
tables, how to create, 65
tabs and indents, 62–63
text clipping, make one, 265
text 

can’t format the text, 71
runs across the entire page, 71

thesaurus, look up a word in, 259
tool tips in, 30
Transformations in, 70
unsaved changes, save them, 58
versions in, restore previous, 59
Wikipedia, look up a word in, 259
Wrap to Window or Wrap to Page, 58

thesaurus, 259
throw away a file, 26–27
thumb marks

in Column View, 16
in Cover Flow View, 18

TIFF files, change to another format, 207
Time Machine, 371–378

Local Snapshots, 375
restore system from backup, 437
Spotlight search in, 367
TextEdit versions are similar, 59

time zone, customize it for your Mac, 291
title bar in Finder window, 6

Toolbars
contextual menus in, 43
customize the Toolbars, 51
hide Finder window Toolbar, 7

tool tips
what are they? 30–31
in System Preferences, 289

Top Sites in Safari, 131
trackpad

general use of with gestures, 7, 19, 290
gestures

in Mission Control, 297
in Safari, browse web pages, 152
in Spaces, move between Spaces, 300
iCal, turn calendar pages with, 156

system preferences for, 290
transfer files. See also file sharing.

from one Mac to another, 437–439, 
440–441

transfer music, 192–193 
Trash, 26–27

empty it securely, 279, 427
icon in Dock, 22
Put Back an item you trashed, 27
warning, turn it on or off, 279
what’s in it? 27

troubleshooting
Address Book, my contacts won’t  

show up, 118
can’t change the background  

or color of a Finder window, 280
columns in window won’t move,  

278, 283
computer is dead, use Target Disk Mode 

to transfer files, 439
delete preference file for an application, 

413
dial-up connection keeps trying  

to log on, 81
disk is stuck in the drive, 417
Disk Utility

repair disk permissions, 436
reset passwords, 436

Dock is missing, 23
double-click, can’t do it fast enough, 

290
empty Trash warning, turn it off, 26–27
files

file is locked, 343
file won’t open, 343

file sharing, I get confused which 
computer I’m looking at, 394

find earlier versions through  
Time Machine, 376–378



ptg6934589

Users & Groups

459

fonts
are available only to one user, 232
can’t make font bold or italic, 71, 87

force quit an application, 408
forgot your Admin password, 415, 422
fsck technique (use safe boot), 412
green dots under words, 248, 250
hard disk makes noise, 408
Help files for, 32
icons won’t stay where I put them  

(snap to grid), 281
Internet connection troubles, 383, 

384–386
keys keep repeating themselves, 289
lost files, search Time Machine, 378
Mail

can’t format the text, 87
every time I get mail, I hear a noise, 91
messages are colored, 85
search won’t find a word I know  

is there, 96
Mail account, 387–389
menu bar disappeared, 164
mouse doesn’t right-click, 290
movies, menu bar disappears  

while watching, 226
nothing’s on my Mac! 344–346
passwords

forgot your Admin password, 415, 422
login password doesn’t work, 331, 337, 

415
Mac asks for password when installing 

new software, 421
master password, 331

pointer takes forever to move across  
the screen, 290

printing problems, 322–323
privileges or permissions for opening 

files, 343, 444
quit all open apps, 409
red dots under words, 248, 250
relaunch the Finder, 409
remote control indiskriminately 

controls other computers around 
me, 423

repair disk, 411
repair permissions, 410
report crashes to Apple, 415
restart to fix minor problems, 409
right-click, my mouse doesn’t do that, 

290
Safari, information doesn’t display, 135
safe boot to fix problems, 412
scrolling, things go flying off on their 

own (inertia), 290

server icons connected to Mac,  
can’t find them, 398

Shut Down to fix minor problems, 409
Sidebar is missing from my Finder 

window, 7
System Preferences, I can’t change 

them, 289
target disk mode to get data from  

a computer, 416
test in another user, 414
things just happen

all my windows disappear, 302
application fills the screen,  

how to get back to the Desktop, 300
folders spring open, 268
thumbnail pictures appear  

at the top of the screen, 299
when I click a Dock icon,  

the screen jumps, 298
when my cursor gets close to a corner 

(hot corners), 298, 303
Toolbar missing from Finder window, 7
typing, text

can’t format text, 71, 87
green or red dots under words,  

248, 250
keeps changing automatically,  

fixing the spelling, 250
keys keep repeating themselves, 289
won’t drag anywhere, 264
types the entire width of page, 71

update your system software, 414
user account, can’t change it, 339
use the Install disk to troubleshoot, 436
web browser knows my contact 

information, 135
window is missing the Sidebar, Toolbar, 

etc., 7
windows spring open and I don’t  

like it, 277
tutorials for Mac support, 33
two-button mouse

contextual menus with right-click, 42
set it up for right-clicking, 290

typographer’s quotes, 68

U
update your system software, 414
upgrade to Lion, 433–441

backup before upgrading, 434
clean install instead of upgrade, 435
migrate your files, 437–439
on a Mac that doesn’t have an optical 

drive, 441

USB Flash drive
install with, 436–437
reset Admin password with, 422

user accounts, 327–349
overview of multiple users, 327–328
Admin user, 328–329

give others Admin privileges, 339
preferences are locked, you can unlock 

them globally, 423
Apple id

allows login from another computer, 
331, 333, 421

allows user to change her own 
password, 331, 333, 421–422

automatic login, 334, 337
create new users, 331–336
delete a user, 348–349
fast user switching, 334, 336

set it up and use it, 338–339
lock screen instantly through  

this menu, 425
file sharing with other users, 342
Group account, make one, 336
Guest account, 329, 330
login, logout

automatic login, 334, 337, 425
disable automatic login, 423, 425
Login Items, set them up, 341
login picture for, 333
logout, 337

managed users
overview of, 328–329
parental controls for, 344–347
run full Finder while in Simple Finder, 

347
passwords, 332

Admin password versus  
login password, 422

password hint, 332, 334–335 , 337
reset password if you forgot, 422
tips for creating passwords, 422

Simple Finder, 344–347
disable it, 347

standard user, 328–329, 340
can act as a security measure, 426
can change her own password  

with Apple id, 421–422
users

fonts, install for just one user, 232
forgot your Admin password, 415
Spotlight search in, 353
System Preferences for invidual users, 

289
troubleshoot new app in a new user, 414

Users & Groups, 421
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V
vCard, or virtual card, 111

send one to others, 119
versions 

in Preview, 203
in TextEdit, 59

video chat
one-on-one in FaceTime, 185
with up to three others, 176–177

video tutorials for the Mac, 33
View Options pane

for Column View windows, 285
for Cover Flow View windows, 286
for Icon View windows, 14, 280–281
for List View windows, 282–284
for the Desktop, 287

visual clues
blue column heading in Finder 

windows, 15
corner dots to enlarge or reduce  

widget window, 309
magnifying glass in corner of screen, 

352
menu items are gray or black, 29
printing clues, 323
Quick Look, icons to open in, 21
TextEdit unsaved changes, 58
tiny arrow in left corner, 267
triangles in column heading of Finder 

window, 15
vnc address, 401, 403
VoiceOver, at login window, 336
VPN, Virtual Private Network, 420

W
wallpaper, set the Desktop background, 

291
web clip widgets, 141
web links in TextEdit, 68–69
webloc, web location file, 444
web pages

add a web location to the Dock, 23, 266
browser for. See Safari.
iChat Theater to share web pages, 

180–181
pdfs, create web page links in, 214–215
save shopping receipts, 230–231

Web Receipts Folder, 230–231
WEP, Wired Equivalent Privacy, 420
whois, check it, 437
widgets, 306–311

web clip widget, 141
Wi-Fi connection.  

See connect to the Internet.

Wikipedia 
Dictionary panel can access, 259
Spotlight search sends to Wikipedia, 360

Williams family
Florence Weber, 89
Gerald Williams, 89
Jimmy Thomas, 88, 112
John Tollett, 89
Pat Williams, 89, 309, 333
Pauline Williams, 89, 269
Ryan Williams, 84–85
Scarlett Williams, 140
Shannon Williams, 185
Tyler Williams, 89

windows. See Finder windows
Windows

share files with Windows users, 393
share music with Windows users, 

192–193
wireless

keyboard, battery power of, 289
mouse, preferences for, 290
trackpad, preferences for, 290

word processing. See also TextEdit
find and replace example, 60
numbered list, example of, 64
open and save Word files in TextEdit, 

72–73
style sheets in, example in TextEdit, 61
tables, example of in TextEdit, 65
tabs and indents overview, 62–63

Write Only permissions, 444

Y
Yahoo!

search with Yahoo! in Safari, 130
sync Address Book with, 111
Yahoo calendar

set up in iCal, 156
set up in System Preferences, 76

Yahoo! Messenger chat account, 168
yellow button to minimize window,  

7, 275, 304–305
YouTube

make a movie of yourself
in Photo Booth, 239
in QuickTime Player, 244

movies
export from QuickTime Player, 

242–243, 245

Z
Zaorski, Linnzi, 52, 189
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